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Введение

Моделирование электрических схем непосредственно связано с проек-
тированием соответствующих устройств.  В системах конструкторского 
проектирования электронных устройств широкое распространение полу-
чили  программы  моделирования,  объединенные  общим  названием  – 
SPICE-программы (например, программы PSpice,  TSpice,  XSpice и т.д.). 
Текстовая  форма  описания  электрических  схем  для  SPICE-программ 
фактически стала мировым стандартом для систем автоматизированного 
проектирования. Настоящее пособие посвящено программе моделирова-
ния LTSpice, входящей в систему SwitcherCAD III.  Базовым материалом 
послужило  руководство  пользователя  этой  системы  [1],  а  так  же 
описание традиционных правил применения языка для SPICE-программ 
[2, 3].

Поскольку пособие предназначено для студентов-электроприводчиков, 
то  в  него  включены  материалы,  относящиеся  к  разработке  моделей 
электрических машин и схем электропривода на языке SPICE-программ.

SwitcherCAD III -  третье  поколение  системы  проектирования  им-
пульсных  регуляторов  компании  Linear Technology.  Особенность  про-
граммы  моделирования  LTSpice  состоит  в  том,  что  она  содержит 
встроенные  макромодели для мощных импульсных контроллеров и ре-
гуляторов. Кроме  SPICE-программы, система проектирования включает 
схемный редактор и средства отображения результатов моделирования 
(графический постпроцессор), позволяющие проводить дальнейший ана-
лиз.  В  состав  системы  входит  также  встроенная  база  данных  для 
большинства импульсных устройств компании Linear Technology и мно-
гих пассивных компонентов. База данных устройств, схемный редактор, 
программа  моделирования  и  система  графического  отображения  ре-
зультатов интегрированы в одну систему.

Пакет  LTspice/SwitcherCAD III полностью доступен  для  общего ис-
пользования. Распространено более чем 500 000 копий. Для большого 
числа пользователей система  LTspice/SwitcherCAD III стала  основным 
инструментом моделирования.

Система  LTspice/SwitcherCAD III была разработана для моделирова-
ния импульсных систем питания и регулирования и отличается от других 
SPICE-программ специальной логикой, управляющей переключениями, 
обеспечивая  приемлемое  время  моделирования.  Современные  им-
пульсные источники питания имеют систему управления с различными 
режимами работы. Например, могут измениться режимы модуляции в за-
висимости от  режима работы схемы и т.д.  Оригинальный компилятор 
SwitcherCAD III,  позволяет достаточно быстро и точно смоделировать 
подобного рода устройства. Кроме того, система моделирования позво-
ляет получить практически произвольную форму импульсов. В  LTSpice 
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встроены схемные  элементы  соответствующие  физически  существую-
щим компонентам. Конденсаторы и катушки индуктивности могут быть 
смоделированы с последовательными сопротивлениями и другими пара-
зитными элементами, без использования подсхем или внутренних узлов. 
Это позволяет учесть конечное внутреннее сопротивление элементов на 
всех частотах. Элементная база развита для мощных МДП-транзисторов 
в части их моделирования в ключевых режимах, также без использова-
ния подсхем или внутренних узлов. Сокращение числа узлов, которые 
программа должна рассчитать, значительно сокращает затраты на  вы-
числения, без потерь точности или потерь в части детальности описания 
форм импульсов.

В  настоящее  время  имеется  около  семисот  изделий,  выпускаемых 
компанией Linear Technology, смоделированных в SwitcherCAD III. Про-
грамма свободно распространяется через вебсайт этой компании. В па-
кет включены  файлы со схемами, которые полностью подготовлены для 
демонстрации всех возможностей программы. Программа является пол-
нофункциональной и позволяет  пользователю разрабатывать  собствен-
ные схемы.  Вместе  с  тем,  как  отмечается  в  руководстве пользователя 
SwitcherCAD III, надо понимать, что пакет не предназначен для автома-
тического получения готовых решений. Это - только инструмент, облег-
чающий проектирование, которое предполагает еще макетирование и ис-
пытание.  Поэтому результаты моделирования во всех случаях  следует 
дополнять здравым смыслом [1].
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Схемный редактор.
Схемный редактор применяется для редактирования и создания схем, 

включая иерархические схемы. Размер схемы и глубина иерархии огра-
ничены только компьютерными ресурсами.

В элементную базу входит приблизительно  800 символов. Эти симво-
лы охватывают большинство мощных электронных устройств, операци-
онных усилителей, компараторов и многих других устройств для проек-
тирования электрических схем. Можно разрабатывать пользовательские 
символы.

Пиктограммы  на  главной  панели  имеют  назначение,  показанное  на 
рис.1.

На рис.1 обозначено:
1 – ввод проводников; 2 – ввод глобального узла ("земли"); 3 – ввод пор-
та или имени проводника; 4 – ввод резистора; 5 – ввод конденсатора; 6 – 
ввод индуктивности; 7 – ввод диода; 8 – ввод схемных элементов; 9 – за-
дание режима перемещения отдельных объектов схемы; 10 – задание ре-
жима  перемещения  схемных  элементов;  11,12  –  вращение  элемента 
(Ctrl+R); 13,14 – зеркальное отображение элемента (Ctrl+E); 15 – ввод 
комментария; 16 – текстовый ввод Spice-директивы.

Для работы с объектами схемы – их перемещением, удалением, враще-
нием или зеркальным отображением, необходимо нажать на соответству-
ющую пиктограмму, затем навести курсор на объект схемы. Курсор по-
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сле нажатия на пиктограмму видоизменяет свою форму. Можно работать 
с группой объектов, если курсором "оттянуть" прямоугольник, захваты-
вающий объекты.

Пиктограммы главной панели могут быть вызваны командой Edit, ре-
зультат действия которой показан на рис.2. 

Рис.2. Команда Edit главного меню.
Особенности команд редактирования схемы:
Undo: Отмена последней команды.
Redo: Восстановление последней команды Undo.
Text: Размещение текста. Введенный текст не влияет на моделирова-

ние.
SPICE     Directive  : Размещение текста в список соединений схемы. Так как 

по списку соединений выполняется моделирование, то появляется воз-
можность вводить данные для моделирования в текстовой форме. Это 
позволяет  устанавливать  варианты  моделирования,  файлы,  которые 
содержат модели, определить новые модели, или использовать SPICE-
команды. Можно ввести текстовое описание подсхемы, для которой 
отсутствует графический символ. Имя этого элемента должно начи-
наться с символа Х. Правила текстового описания таких элементов-
подсхем приводятся далее.

SPICE     Analysis  : Ввод/редактирование задания на моделирование.
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Resistor,  Capacitor,  Inductor,   Diode,  Component –  были рассмотрены 
выше.

Rotate, Mirror: – были рассмотрены выше.
Draw     Wire  :  Ввод проводника осуществляется при нажатии левой кнопки 

мыши. Каждый щелчок мыши определит новый сегмент проводника. 
Для подсоединения к другому проводнику надо кликнуть левой кноп-
кой мыши при наведении курсора на этот проводник. Правый щелчок 
отменяет ввод текущего проводника. Еще один щелчок правой кноп-
кой отменит команду ввода проводников. Можно вводить проводники 
через  компоненты  типа  резистор.  Провод  будет  автоматически  вы-
резан так, что резистор окажется соединенным последовательно с про-
водом. При нажатой CTRL проводники можно укладывать под разны-
ми углами, определяемыми узлами сетки.

Label     Net  :  Программа  автоматически  именует  проводники  некоторым 
стандартным образом. Эта команда позволяет назначить уникальные 
имена проводникам. 

Place     GND  : Размещение символа "земля" (GROUND).  Это нулевой про-
вод, он имеет глобальное имя "0". Присутствие его на схеме является 
обязательным. Относительно этого узла выполняется расчет узловых 
потенциалов схемы.

Delete: Удаление объектов.
Duplicate: Копирование объектов. Можно копировать объекты из разных 

схем, если они открыты одновременно. Для вставки скопированных 
фрагментов во вторую схему достаточно набрать Ctrl-V.

Move: Перемещение отдельных объектов схемы.
Paste: Вставка объектов, выбранных командой копирования.
Drag: В отличие от перемещения отдельных объектов, этой командой 

перемещаются целые компоненты вместе с их именами и другой со-
проводительной  текстовой  информацией.  Кроме  того,  компоненты 
перемещаются вместе с проводниками, которые становятся "резино-
выми нитями".

Draw     команда ввода графических объектов – линий, дуг и т.д. Введен-
ные объекты не влияют на схему и могут использоваться для оформ-
ления комментариев или примечаний к схеме. По умолчанию введен-
ные графические объекты фиксируются в узлах сетки. Для их произ-
вольного расположения достаточно при их позиционировании удер-
живать клавишу CTRL.

Draw  =>  Line  : Рисование  линий.  Draw  =>  Rectangle  : Рисование  прямо-
угольников.  Draw  =>  Circle  : Рисование  окружностей.  Draw  =>  Arc  : 
Рисование дуг.
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Именование проводников
Каждый узел в схеме должен иметь уникальное имя. Имя узла может 

быть назначено пользователем отдельной командой.  После  ввода этой 
команды появляется окно, изображенное на рис.3а. 

Для именования нулевого узла, который является по умолчанию гло-
бальным,  может  быть  использован  специальный  графический  символ 
"GND".

Есть также графический символ, определенный как узел "СОМ". Этот 
узел не имеет никакого специального значения и введен для удобства 
чтения схемы. Узел может быть портом ввода, вывода или двунаправлен-
ным узлом. Соответствующее графическое изображение можно выбрать 
на развороте Port Type. Эти изображения никакого влияния на список со-
единений  не  оказывают  и  служат  также  для  удобства  чтения  схемы 
(рис.3б).

Если  узлу   дать  имя,  начинающееся  с  символов  "$G_ ",  например, 
"$G_VDD", то этот узел станет глобальным независимо от того, в какой 
подсхеме он находится.

                
а)                                                                б)

Рис.3. а - окно именования узлов; б – графические изображения портов.

Цвета схемного редактора
Командой главного меню Tools=>Color Preferences можно назначить цве-

та для объектов схемного редактора. В ре-
жиме  этой  команды  надо  кликнуть  на 
объект и в появившемся окне использовать 
красные, зеленые и синие слайдеры, чтобы 
назначить  цвет  для  объекта.  Текстовые 
комментарии, атрибуты и другие объекты, 
связанные  с  компонентой,  отобразятся  в 
том же цвете, что и компонента.

Рис.4.  Окно назначения  цветов  для  схем-
ного редактора.
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Размещение компонент.
Часто используемые компоненты – резисторы, конденсаторы, ка-

тушки индуктивности,  могут 
быть выбраны кнопкой глав-
ной  панели.  Другие  компо-
ненты  могут  быть  выбраны 
через команду главного меню 
Edit=>Component. В результа-
те появится окно ввода, изоб-
раженное на рис.5

Рис.5.  Окно  ввода  схемных 
компонент.

Программирование горячих клавиш
Командой  главного  меню  Tools=>Control Panel=>Drafting Op-

tions=>Hot Keys можно запрограммировать клавиатуру для быстрого вво-
да большинства команд.  После ввода команды главного меню, в появив-
шемся окне надо щелкнуть мышью на команде и затем нажать ключевую 
комбинацию,  которой  надо  закодировать  эту  команду.  Чтобы  удалить 
ключевую комбинацию, надо после клика мышью по команде,  нажать 
"Delete".

Рис.6. Программирование горячих клавиш.
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Создание списка соединений для проектирования печатных плат.
Командой  Tools=>Export Netlist создается список соединений для 

проектирования печатных плат.  Следует обратить внимание на то,  что 
порядок следования выводов в схемном элементе должен соответство-
вать  порядку  выводов  соответствующего  технологического  элемента, 
размещаемого на печатной плате. Например, если требуется импортиро-
вать список соединений, сгенерированный в LTSpice, в систему проекти-
рования печатных плат  ExpressPCB ("http://www.expresspcb.com"), надо 
создать компоненты или в LTSpice, или в  ExpressPCB так, чтобы поря-
док следования и номера выводов этих компонент совпадали в LTSpice и 
ExpressPCB. Иначе будет нарушена схема соединений выводов.

Доступны следующие форматы:  Accel,  Algorex,  Allegro,  Applicon 
Bravo, Applicon Leap, Cadnetix, Calay, Calay90, CBDS, Computervision, EE 
Designer, ExpressPCB, Intergraph, Mentor, Multiwire, PADS, Scicards, Tan-
go, Telesis, Vectron, and Wire List.

Редактирование параметров компонент
Параметры компонент могут быть отредактированы двумя или тремя 

различными способами, в зависимости от типа компонента:
1. Видимые на схеме параметры могут быть отредактированы, непо-

средственно переводом курсора на параметр и правым кликом мыши. 
Курсор мыши при наведении на текст превращается в текстовый символ.

2. Достаточно большое число компонент –  резисторы, конденсато-
ры, катушки индуктивности,  диоды, биполярные транзисторы,  транзи-
сторы MOSFET, транзисторы JFET, независимые источники напряжения, 
независимые источники тока, иерархические блоки схемы имеют специ-
альные редакторы. Эти редакторы могут обратиться к соответствующей 
базе данных устройств. Для использования этих редакторов, надо наве-
сти курсор на саму компоненту, и кликнуть правой кнопкой мыши.

3.  Поместить  курсор  поверх  компоненты,  удерживая  клавишу 
CTRL, нажать правую кнопку мыши. Появится диалоговое окно, в кото-
ром можно отредактировать все доступные атрибуты компонента. Рядом 

с каждым полем можно установить флажок, 
чтобы указать отображение атрибута на схе-
ме.

Редактирование видимых атрибутов
Видимые на схеме параметры компонент 

могут  быть  отредактированы,  указанием 
курсора  на  параметр  и  правым  кликом 
мыши.  Курсор  мыши  при  наведении  на 
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Рис.7.  Редактирование  па-
раметра индуктивности.



текст превращается в текстовый символ. Это самый удобный способ из-
менить значение компонента. На рис.7 приведен пример редактирования 
параметра индуктивности.

Специализированный редактор параметров компонент
Резисторы,  конденсаторы,  катушки индуктивности,  диоды,  биполяр-

ные  транзисторы,  транзисторы 
MOSFET, транзисторы  JFET, независи-
мые  источники  напряжения,  независи-
мые  источники  тока,  иерархические 
блоки схемы имеют специальные редак-
торы. Для использования специального 
редактора, надо навести курсор на саму 
компоненту, и кликнуть правой кнопкой 
мыши.

Рис.8.  Редактирование  параметров  ин-
дуктивности в специальном редакторе.

Общий редактор атрибутов
Иногда желательно иметь прямой доступ к каждому доступному атри-

буту для редактирования его содержания и видимости на экране.  Для 
запуска  соответствующего  редактора,  надо  поместить  курсор  поверх 
компоненты, удерживая клавишу CTRL, нажать правую кнопку мыши. 
Появится диалоговое окно,  в  котором можно отредактировать  все  до-
ступные атрибуты компонента.  Рядом с каждым полем можно устано-
вить флажок, чтобы указать отображение атрибута на схеме.

Рис.9. Редактирование параметров индуктивности в редакторе атрибутов
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Атрибуты SpiceModel,  Value,  Value2,  SpiceLine, и SpiceLine2 – полностью 
определяют все значения компонента. В списке соединений, генерирует-
ся строка в SPICE-формате примерно такого содержания:
<name> node1 node2 [...] <SpiceModel>
+ <Value> <Value2> <SpiceLine> <SpiceLine2>

Префиксный символ – это символ, по которому программа узнает тип 
компонента. С префиксного символа должны начинаться схемные имена 
(InstName) компонент. Но бывают случаи, когда схемное имя может на-
чинаться с произвольного символа. Тогда в списке соединений префикс-
ный символ  и  схемное  имя  (InstName)  будут  отделены символом  '§'. 
Например, если в строке префиксного атрибута Prefix записано "M", а в 
строке атрибута InstName записано "Q1", то в списке соединений в поле 
имени компонента (<name>) появится имя  M§Q1.

Есть три исключения к вышеупомянутому правилу. 
Существует специальный символ, перемычка, которая не транслирует-

ся  в  элемент  схемы,  в  этом  случае  посылается  директива  генератору 
списка соединений, что есть два различных имени для одного и того же 
электрического узла. 

Другое исключение - символ, с префиксом 'X' и атрибутами, опреде-
ленными в полях Value и  Value2. Такой компонент в списке соединений 
будет присутствовать как две SPICE-строки:
.lib <SpiceModel>
<name> node1 node2 [...]  <Value2>

В этом случае автоматически подключается библиотека,  которая со-
держит описание подсхемы, с именем компоненты. Компилятор списка 
соединений удалит дубликат .lib инструкции. Следует обратить внима-
ние на то, что такие компоненты не доступны в схемном редакторе.

Третье исключение – также символ с префиксом 'X', описание подсхе-
мы имеется в файле с именем, которое задается атрибутом <ModelFile>. 
Такой компонент также представлен в списке соединений как две SPICE-
строки:
 .lib <ModelFile>
 <name> node1 node2 [...] <SpiceModel> <Value>
+ <Value2> <SpiceLine> <SpiceLine2>

Этот метод используется в том случае, когда описание подсхемы со-
держится в отдельном файле и в тоже время имеется доступное для ре-
дактирования  графическое изображение компонента. Символы в атрибу-
те SpiceModel  - это имя подсхемы в библиотечном файле, который имеет 
имя <ModelFile>. SpiceModel – это еще и имя графического изображения 
компоненты.
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Редактирование и создание компонент
Компоненты  (или  символы)  могут  представлять  собой  простейшее 

устройство вроде резистора или конденсатора, библиотечную подсхему в 
отдельном файле или отдельную страницу схемы. 

Создание нового символа начинается командой меню File => New Sym-
bol.

Создание изображения символа
Символ создается из набора линий, прямоугольников, кругов и дуг, а 

также текста. Эти объекты никак не влияют на схему. Точки привязки 
этих объектов отмечаются маленькими красными кругами.  Точки при-
вязки  нужны  для  удобства  перемещения  объектов.   Их  можно 

включить/выключить  командой 
View=>Mark Object Anchors. Окно ре-
дактора при создании символа пока-
зано на рис.10. Внимание: перемеще-
ние линий и других объектов произ-
водится на более мелкой сетке, отно-
сительно той, которая видна на экра-
не. С помощью точек привязки можно 
точно установить объект в узлах ви-
димой сетки.

Рис.10. Окно редактора символа.

Ввод контактов
Ввод контактов выполняется командой  Edit=>Add Pin/Port. На рис.11 

показано  окно  редактиро-
вания свойств контактов. В 
поле Label указывается имя 
контакта. В поле Netlist Or-
der указывается  поряд-
ковый  номер  контакта  в 
списке  соединений.  Часть 
окна,  озаглавленная,  "Pin 
Label Position"  определяет 
расположение контакта от-
носительно  его  имени: 
"сверху"  ("TOP"),   "снизу" 
("BOTTOM"),  "слева" 
("LEFT")  и  "справа" 
("RIGHT"). Например, если 
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Рис.11. Окно редактирование свойств 
контактов.



отмечена радиокнопка "сверху" ("TOP"), контакт будет расположен свер-
ху его имени. Если символ представляет примитивный  SPICE элемент 
или библиотечную подсхему,  то  имя контакта  может  быть произволь-
ным, здесь имеет значение его порядковый номер. В последствие, при 
моделировании схемы с созданным элементом, узлы элемента будут рас-
познаны по их порядковому номеру. Если символ представляет иерархи-
ческую схему (или, что то же самое - схему замещения), то имя контакта 
имеет значение и должно совпадать с именем соответствующего провода 
схемы замещения символа.

Ввод атрибутов
Для ввода атрибутов символа, используемых по умолчанию, использу-

ется команда  Edit=>Attributes=>Edit Attributes.  Наиболее важные атри-
буты определяются префиксом – сим-
волом, с которого начинается имя эле-
мента.   Префикс определяет  базовый 
тип символа.   Если символ представ-
ляет  SPICE-примитив, то символ дол-
жен иметь соответствующий префикс: 
R для резистора,  C для конденсатора, 
М для  MOSFET и  т.д.  Описание  все 
префиксов  имеется  в  соответствую-
щем  разделе.  Если  символ  представ-
ляет  подсхему,  определенную  в  биб-
лиотеке, то префикс должен быть 'X'.

Рис. 12. Окно редактирования атрибу-
тов.

Например, в базе данных имеется символ для MOSFET с префиксным 
атрибутом 'М', можно заменить префиксный атрибут на 'X', чтобы тран-
зистор мог быть смоделирован не как встроенная модель, а как пользова-
тельская подсхема.

Приведем специальную комбинацию атрибутов, которые автоматиче-
ски подключат требуемую библиотеку в каждое схемное решение, где бу-
дет использован символ:
Prefix: X
SpiceModel: < имя файла с моделью>
Value: <те параметры, которые должны быть видимы на схеме>
Value2: <параметры, включаемые в список соединений>
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Атрибут Value2 служит для передачи дополнительных параметров.
Для того, чтобы символ представлял страницу иерархической схемы, 

для всех атрибутов надо оставить пробел, а в поле "Symbol Type" надо 
установить "Block". 

Атрибут ModelFile задает имя файла, который будет включен в список 
соединений как библиотека. См. примеры для  .\lib\sym\Opamps\1pole.asy 
и  .\lib\sub\1pole.sub. Если префиксный атрибут - 'X'  ,  то в строке  Spice-
Model определяется  имя  подсхемы,  которая  описана  в  библиотечном 
файле ModelFile.

Установка видимости атрибута
Атрибут  можно  сделать  видимыми,  если  задать  команду  Edit=>At-

tributes=>Attribute Window.   В  появившемся  диалоговом окне  (рис.13) 
можно выбрать атрибут и затем позиционировать его на редактируемом 
поле. Если навести на установленный атрибут курсор и кликнуть мы-
шью, то в появившемся окне можно изменить его текстовое выравнива-
ние и содержание (рисю14).

Создание иерархических схем
Большие схемы могут быть представлены как иерархические схемы с 

разной степенью детализации. 
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Рис.13. Окно позициони-
рования атрибута.

Рис.14. Окно для текстового вы-
равнивания атрибута.



Правила построения иерархических схем
Некоторая  схема  может 

быть  представлена  как  блок 
в схеме более высокого уров-
ня.  Этот  блок создается  как 
компонента (символ) и запи-
сывается в файл с таким же 
именем, как и электрическая 
схема,  которая  представляет 
этот блок.  Затем блок поме-
щается  как  компонента  в 
схему  более  высокого  уров-
ня.  Например,  если в  схему 
topXYZ.asc включена компо-
нента  из  файла  preamp.asy, 
то  схема  замещения  этой 
компоненты  должна  быть 

размещена в файле с именем preamp.asc. Электрическая связь с блока со 
своей схемой обеспечивается одинаковым именованием контактов блока 
и  соответствующих  проводников  схемы  замещения  этого  блока  (см. 
рис.15).  

Схема верхнего уровня, схема замещения символа и сам символ долж-
ны быть размещены в одном и том же каталоге. Созданный символ, кото-
рый представляет схему низшего уровня, не должен иметь атрибутов.

Навигация по иерархической схеме
Любой  файл,  который  открывается  командой  File=>Open,  считается 

схемой верхнего уровня. Можно вы-
полнить моделирование при добав-
лении   SPICE-директив  в  любые 
схемы низшего уровня. 

Чтобы открыть схему замещения блока, надо сначала открыть высоко-
уровневую схему  и  затем,  поместив  курсор  на  символ  блока,  дважды 
кликнуть левой кнопкой мыши. Либо, после наведения курсора на сим-
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Рис.15. Создание иерархических схем.

Рис.16. Окно навигации по иерархи-
ческой подсхеме.



вол, кликнуть правой кнопкой мыши. Тогда появится окно, показанное 
на рис.16, в этом окне можно открыть схему замещения, а так же ввести 
параметры ее элементов.

Для того, чтобы отобразить напряжения и токи в подсхемах, надо в па-
нели управления (Simulate=>Control Panel) на закладке Save Defaults по-
метить  опции "Save Subcircuit Node Voltages"  и  "Save Subcircuit Device 
Currents". При подсвечивании узла на схеме верхнего уровня, этот  же 
узел будет подсвечен на схеме  более низкого уровня.

Краткий обзор LTspice
LTSpice может использоваться как универсальная SPICE-программа. 

Проектирование  схем выполняется  во  встроенном схемном редакторе. 
Команды моделирования и параметры размещаются в текстовом формате 
на схеме, используя стандартный SPICE-синтаксис. Отображение графи-
ков может быть выполнено щелчком мыши на узлах схемы в течение или 
после моделирования.

Описание схемы
Состав схемы определяется текстом списка соединений.  Список со-

единений состоит из списка элементов схемы и их узлов, описаний моде-
лей, и других SPICE-команд.

Список соединений обычно вводится в виде графического изображе-
ния схемы.  Для загрузки схемы надо в меню задать команду File=>Open. 
Появится окно просмотра файлов. Далее можно выбрать существующую 
схему и сохранить ее под новым именем или напечатать новое имя, что-
бы создать пустой схемный файл.  LTspice использует много различных 
типов файлов и документов. Для схемных файлов необходимо расшире-
ние ".asc". Команды схемного редактора находятся в меню Edit. Горячая 
клавиатура  для  команд  перечислена  в  разделе  Схемный  редактор/про-
граммирование горячих клавиш.

При моделировании схемы, из графической информации, представлен-
ной в схемном редакторе, извлекается список соединений и размещается 
в файл с тем же именем, но расширением ".net". Далее LTspice читает  и 
обрабатывает этот файл.

Можно также открыть и отредактировать сгенерированный в  LTspice 
текст  списка  соединений.  Вместе  с  тем,  этот  текст  можно  составить 
вручную или сгенерировать любой другой внешней программой. Файлы 
с расширениями ".net", ".cir" или ".sp" LTspice распознает как список со-
единений. То есть вместо файла с графической схемой можно открыть 
соответствующий файл со списком соединений и выполнить моделиро-
вание.
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Внешние списки соединений
Можно  открыть  список  соедине-
ний созданный или вручную, или 
другими  схемными  редакторами. 
Встроенный редактор ASCII  под-
держивает  неограниченный  раз-
мер файла, и неограниченное чис-
ло  undo/redo.  Может  использо-
ваться команда меню Tools=>Color 
Preferences  для регулировки цве-
тов, используемых во встроенном 
редакторе ASCII.

Рис.17. Текстовый редактор списка соединений. 

Общая структура и соглашения
Анализируемая схема описывается текстовым файлом,  носящим на-

звание список соединений. Первая строка в списке соединений игнори-
руется и ее, как правило, используют как комментарий. Последняя стро-
ка списка соединений - обычно просто строка ".END", но она может быть 
в LTSpice опущена. Любые строки после строки  ".END" игнорируются.

Порядок строк в списке соединений между первой строкой и послед-
ней может быть произвольным. Строками могут быть комментарии, объ-
явления элемента схемы или директивы моделирования. Пример:
* Эта первая строка игнорируется
* Схема ниже представляет R-C схему, на которую поступают
* импульсы частотой 1MHz 
R1 n1 n2 1K   ; резистор 1 кОм расположен между узлами n1 и n2
C1 n2  0 100p ; емкость 100пФ расположена между узлом n2 и землей
V1 n1  0 PULSE(0 1 0 0 0 .5µ 1µ) ;импульсный источник частотой 1МГц 
.tran 3µ      ; длительность переходного процесса 3µс
.end

Первые две строки - комментарии. Любая строка, начинающаяся с "*" 
является комментарием и игнорируется.  Строка,  начинающаяся с "R1" 
объявляет, что резистор 1 кОм, расположен между узлами n1 и n2. Обра-
тите  внимание,  что  точка  с  запятой  ";" используется для размещения 
комментария в середине строки.  Строка,  начинающаяся с  "C1"  объяв-
ляет,  что  конденсатор  100пФ расположен между  узлами  n2 и  землей. 
Узел "0" – это глобальный общий  провод схемы ("земля").
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Ниже приводится краткий обзор словаря LTspice:
- регистр, первые пробелы, пустые строки и позиции табуляции игнори-
руются.
- первый знак строки (кроме пробела) определяет тип строки.
1-й символ    -     тип строки
*    (звездочка)    комментарий
A – Z  элемент схемы, например, "R" для резистора, "C" для конденсато-
ра, "L" для катушки индуктивности, и так далее. Каждый элемент в схе-
ме определен по имени, по узлам схемы, с которыми элемент связан и 
значения параметров, которые определяют электрические характеристи-
ки элемента. Первый символ имени элемента определяет тип элемента. 
Следовательно, R, R1, RSE, ROUT и R3AC2ZY - допустимые имена ре-
зистора.  Имена  элемента  должны  быть  уникальны;  например,  может 
только быть один R1 в схеме. Электрическое поведение некоторых эле-
ментов может быть определено моделью.
.      (точка)  Директива моделирования, например:  .options reltol=1e-4
+      (плюс)  Продолжение предыдущей строки.  

Числа могут быть выражены не только в экспоненциальном формате, 
например, 1e12, но также и с техническими множителями. То есть числа 
1000.0 или 1e3 могут также быть написаны как 1К. Ниже приводится та-
блица допустимых множителей:
   T -  1e12;   G -   1e9;   Meg - 1e6;   K - 1e3;   Mil - 25.4e-6;   M - 1e-3
   u (или µ) - 1e-6;   n - 1e-9;   p - 1e-12;   f - 1e-15.

Не распознанные  символы  расположенные  сразу  после  номера  или 
технического множителя игнорируются. Следовательно, 10, 10V, 10Volts 
и 10Hz все представляют то же самое число. М, MA,  MSec и  MMhos - 
все представляют тот же самый масштабный коэффициент (1e-3). Часто 
ошибочно резистор вводится со значением 1M, предполагая номинал в 
один мегаОм, однако 1M интерпретируется в LTSpice как один миллиОм. 
Это правило используется для совместимости со стандартом SPICE.

LTspice понимает числа, написанные в форме 6K34, для обозначения 
6.34к. Такое правило применимо для любого из множителей, описанных 
выше.  Правило  может  быть  выключено  командой  Tools=>Control Pan-
el=>SPICE, сняв отметку "Accept 3K4 as 3.4K".

Имена узлов могут быть произвольными символьными строками. Гло-
бальный общий узел имеет по умолчанию имя "0" или "GND". Обратите 
внимание, так как узлы - символьные строки, то "0" и "00" - разные узлы.

Всюду далее угловые скобки применяются для полей данных, которые 
должны  быть  обязательно  заполнены  определенной  информацией, 
например, "<srcname>" имя некоторого определенного источника. Квад-
ратные скобки указывают, что включенное поле данных является допол-
нительным.
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Краткий справочник по схемным компонентам

Компонента Синтаксис
специальная функция Axx n1 n2 n3 n4 n5 n6 n7 n8 <model> [внешние па-

раметры]
произвольный
функциональный
 источник

Bxx n+ n- <V=... или I=...>

емкость Cxx n+ n- <емкость> [ic=<val.>] [Rser=<val.>]
+[Lser=<val.>] [Rpar=<val.>] [Cpar=<val.>]
+[m=<val.>]

диод Dxx A  K  <модель> [area]
источник напряжения, 
управляемый напряжением

Exx n+ n- nc+ nc- <коэфф.усиления>

источник тока,  управляе-
мый током

Fxx n+ n- <Vnam>  < коэфф.усиления >

источник  тока,  управляе-
мый напряжением

Gxx n+ n- nc+ nc- <коэфф.передачи>

источник  напряжения, 
управляемый током

Hxx n+ n- <Vnam>  < коэфф.передачи.>

независимый источник тока Ixx n+ n- <ток>

JFET транзистор Jxx D G S <модель> [area] [off]
+[IC=<Vds,Vgs>] [temp=<T>]

взаимная индуктивность Kxx L1 L2 <coeff.>
индуктивность Lxx n+  n-  <индуктивность>  [ic=<val.>] 

[Rser=<val.>]
+ [Rpar=<val.>] [Cpar=<val.>] [m=<val.>]

MOSFET транзистор Mxx D G S B <модель> [L=<len>] [W=<width>]
+[AD=<area>] [AS=<area>] [PD=<perim>]
+[PS=<perim>] +[NRD=<value>] [NRS=<value>]
+[off] +[IC=<Vds, Vgs, Vbs>
+ [temp=<T>]

линия передачи с потерями Oxx L+ L- R+ R- < модель >

биполярный транзистор Qxx C B E [S] < модель > [area]
+ [off] [IC=Vbe,Vce][temp=<T>]

резистор Rxx n1 n2 <value>
ключ,  управляемый напря-
жением

Sxx n1 n2 nc+ nc- < модель > [on,off]

линия передачи без потерь Txx L+ L- R+ R- ZO=<value> TD=<value>
RC-линия Uxx n1 n2 ncommon <модель> 

+L=<len> [N=<lumps>]
независимый  источник 
напряжения

Vxx n+ n- <напряжение>

ключ, управляемый током Wxx n1 n2 <Vnam> <model> [on,off]
подсхема Xxx n1 n2 n3... <имя подсхемы>
MESFET транзистор Zxx D G S <модель> [area] [off] [IC=<Vds,Vgs>]
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Описание схемных компонент.
1.

A. Специальные Функции
Символьные имена:
 INV, BUF, AND, OR, XOR, 
SCHMITT, SCHMTBUF, SCHMTINV, DFLOP,
 VARISTOR, и MODULATE
Синтаксис: 
Annn n001 n002 n003 n004 n005 n006 n007 n008 <модель> [параметры]

Функциональные элементы для моделирования аналого-цифровых 
устройств.  Являются частной разработкой Linear Technology Corpora-
tion's. Для большинства из них нет полного описания, так как они часто 
изменяются с каждым новым набором моделей, доступных в LTspice. 
Описание имеется для наиболее общеупотребительных элементов.

INV,BUF,AND, OR, и XOR - универсальные идеализированные логи-
ческие элементы. Все элементы  имеют восемь контактов, не требуют 
питания. Контакты 1 – 5 считаются входными, контакты 6 и 7 - выходы, 
контакт 8 – общий узел. Неиспользованные входы и выходы распознают-
ся компилятором LTSpice и удаляются из моделирования.

Входы и выходы логических элементов могут быть соединены с ана-
логовыми элементами или выводами логических элементов. Для расчета 
токов и напряжений должны быть заданы соответствующие параметры 
логических элементов.  8-й контакт логического элемента используется 
для его включения в электрическую схему, если этот контакт оставить 
свободным, то он автоматически будет соединен с общим узлом электри-
ческой схемы.

По  умолчанию  считается,  что  логическому  нулю  соответствует  0 
Вольт, а логической единице соответствует 1В. Порог перехода от логи-
ческого нуля к логической единице соответствует 0,5В. Входное и вы-
ходное сопротивление элемента равно 1Ом. Задержка сигнала отсутству-
ет. Параметры элементов приведены ниже в таблице.

Обратите внимание на то, что не все параметры могут быть определе-
ны одновременно, например, характеристики выхода задаются или дли-
тельностью фронтов или RC постоянной времени, но не обоими.

По умолчанию задержка распространения равна нулю или устанавли-
вается  параметром Td. Задержка по входу равна задержке распростране-
ния.

Входные логические пороговые значения по умолчанию вычисляются 
по формуле 0,5 ∙ (Vhigh+Vlow), но могут быть установлены с парамет-
ром Ref . Время задержки равно задержке распространения.
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пара-
метр

по умолчанию значение

Vhigh 1V логический высокий уровень
Vlow 0V логический низкий уровень
Ihigh 1A ток при высоком логическом уровне
Ilow 0A ток при низком логическом уровне
Trise 0 длительность переднего фронта
Tfall Trise длительность заднего фронта
Tau 0 выходная RC-постоянная времени
Cout 0 выходная емкость
Rout 1 выходное сопротивление
Rhigh Rout Выходное сопротивление высокого логи-

ческого уровня
Rlow Rout Выходное сопротивление низкого логиче-

ского уровня

Триггер Шмитта имеет характеристики аналогичные рассмотренным. 
Напряжения переключения определяются параметрами Vt и Vh. Низкий 
уровень переключения Vt−Vh,  высокий уровень  Vt+Vh.

VARISTOR –  управляемый  напряжением  варистор.  Его  напряжение 
пробоя устанавливается напряжением между контактами 1 и 2. Аварий-
ный импеданс определяется параметром  rclamp. См. схемное решение в 
файле  .\examples\Educational\varistor.asc. 

MODULATE  - управляемый напряжением осциллятор (генератор си-
нусоидального  напряжения).  См.  схемный  пример 
.\examples\Educational\PLL.asc.  Мгновенная частота колебаний устанав-
ливается напряжением на входе FM. Преобразование  напряжение-часто-
та линейно и устанавливается двумя параметрами -  mark и space. Пара-
метр mark - частота, когда на входе FM  1В, параметр space устанавлива-
ет частоту, когда на входе FM  0В. Амплитуда устанавливается напряже-
нием на входе AM,  если этот вход не используется, то по умолчанию 
устанавливается амплитуда 1В.

B.  Функциональный источник напряжения или источник тока.
Имена: BV, BI, BI2
Синтаксис:
для источника напряжения
Bnnn n001 n002 V=<выражение> [ic=<значение>]
+ [tripdv=< значение >] [tripdt=< значение >]
+ [laplace=<выражение> [window=<time>]
+ [nfft=<число>] [mtol=<число>]]
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для источника тока:
Bnnn n001 n002 I=<выражение> [ic=< значение >]
+ [tripdv=< значение >] [tripdt=< значение >] [Rpar=< значение >]
+ [laplace=< выражение > [window=<time>]
+ [nfft=< число >] [mtol=< число >] ]
<выражение> - функциональное выражение.

tripdv и  tripdt определяют шаг изменения сигнала источника. Если, 
например, напряжение меняется больше чем на tripdv вольт за tripdt се-
кунд, тот временной шаг моделирования игнорируется. 

Для источника тока, параллельное сопротивление может быть опреде-
лено параметром Rpar.

Приведенные ниже в таблице операции сгруппированы в обратном по-
рядке старшинства вычисления:
& преобразование операнда к Булевской переменной и выполнение опе-

рации И

| преобразование операнда или выражения к Булевской переменной
и выполнение операции ИЛИ

^ преобразование операнда или выражения к Булевской переменной 
и выполнение операции исключающее ИЛИ

< истина, если выражение слева - меньше чем выражение справа, иначе 
ложь

> истина,  если выражение слева больше чем выражение справа,  иначе 
ложь

<= истина, если выражение слева меньше чем или равно выражение спра-
ва, иначе ложь

>= истина, если выражение слева больше чем или равно выражение спра-
ва, иначе ложь

+ сложение с плавающей запятой
- вычитание с плавающей запятой 
* умножение с плавающей запятой 
/ деление с плавающей запятой 
** возведение в степень 
! преобразование выражения к Булевской переменной и инвертирование
@ оператор выбора шага

К току или напряжению можно применить преобразование Лапласа, 
которое задается как функция переменной s. В этом случае оператор "^" 
распознается как возведение в степень "**". Поведение во временной об-
ласти определяется импульсной передаточной функцией, найденной Фу-
рье-преобразованием отклика в частотной области.  LTspice автоматиче-
ски  определяет  соответствующий  диапазон  частот  и  разрешающую 
способность. Можно эти значения откорректировать, явно устанавливая 
параметры nfft  и window. Обратная величина значения window  - разре-
шающая способность по частоте. Значение  nfft – наибольшее значение 
частоты.
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Доступные математические функции приведены в следующей табли-
це.

abs(x) абсолютное значение
acos(x) арккосинус x

acosh(x) гиперболический арккосинус
asin(x) арксинус

asinh(x) гиперболический арксинус
atan(x) арктангенс

atan2(y, x) четырехквадрантный арктангенс у/х
atanh(x) гиперболический арктангенс
cos(x) косинус
cosh(x) гиперболический косинус
exp(x) экспонента
ln(x) натуральный логарифм

log(x) натуральный логарифм
log10(x) десятичный логарифм
sgn(x) знак
sin(x) синус
sinh(x) гиперболический синус
sqrt(x) квадратный корень
tan(x) тангенс

tanh(x) гиперболический тангенс
u(x) 1 если x > 0., иначе 0.

buf(x) 1  при x > .5, иначе 0
inv(x) 0 при x > .5, иначе 1

uramp(x) x если x > 0., иначе 0.
!(x) альтернативный синтаксис для inv(x)

int(x) преобразование x к целому числу
floor(x) целое число равное или меньше чем x
ceil(x) целое число равное или больше чем x

rand(x) случайное число между 0 и 1 в 
зависимости от целочисленного значения х

random(x) подобно rand(), но с гладкими 
переходами между значениями.

min(x,y) наименьшее из x и y
max(x,y) наибольшее из х или у

limit(x,y,z) эквивалентно min(max(x,y),z)
if(x,y,z) если x > .5, то y иначе z

table(x,a,b,c,d,...) интерполяция значений для x, основанная на про-
смотре таблицы, заданной как набор пар точек.

Для комплексных чисел функции atan2(,), sgn(), u(), buf(), inv() uramp(), 
int(),  floor(),  ceil(),  rand(),  min(,),  limit(,),  if(,,),  и  table(...) не  доступны. 
Функции  Re(x) и  Im(x) возвращают  вещественную  и  мнимую  часть 
комплексного числа.  Функции  Ph(x) и  Mag(x) возвращают фазу и ам-
плитуду комплексного числа.
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Истина в цифровой форме равна 1, и Ложь - 0. Преобразование к Бу-
левской переменной конвертирует значение к 1, если значение больше 
чем 0.5, иначе значение преобразуется в 0.

Для комплексных чисел доступны только +, -, *, /, **. Для комплекс-
ных чисел Булев оператор XOR (^), означает возведение в степень **.  

Имеются  следующие  встроенные  константы: 
e=2.7182818284590452354;    pi=3.141592653589793238464; 
k=1.3806503e-23;   q=1.602176462e-19.

C.  Конденсатор
Символьное имя: CAP, POLCAP

Синтаксис:
  Cnnn n1 n2 <capacitance> [ic=<value>]
         + [Rser=<value>] [Lser=<value>] [Rpar=<value>]
         + [Cpar=<value>] [m=<value>]  
         + [RLshunt=<value>]

Возможно задание последовательного эквивалентного сопротивления, 
последовательной  индуктивности,  параллельного  сопротивления  и  па-
раллельной внутренней емкости. Эквивалентная схема приведена ниже:

Установочные параметры емкости приведены ниже в таблице.
Таблица

Если требуется учитывать паразитные параметры емкости, то лучше 
их задать в виде параметров Rpar, Rser, RLshunt, Cpar и Lser, чем явно 
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имя параметр
Rser эквивалентное последовательное сопротивление
Lser эквивалентная последовательная индуктивность
Rpar эквивалентное параллельное сопротивление
Cpar эквивалентная параллельная емкость
RLshunt сопротивление шунта, параллельного Lser
m число параллельных модулей

ic
начальное напряжение
(используется,  только  если  uic помечен на  .tran за-
кладке)



вычерчивать их на схеме. LTspice применяет специальную технологию 
расчета емкости без использования внутренних узлов. Это делает матри-
цу моделирования меньшей, позволяет ее быстрее вычислить и снижает 
вероятность превращения ее в сингулярную матрицу при малых шагах 
времени.

Обратите внимание на то что, паразитные параметры могут быть ис-
пользованы для макромоделирования пьезокристаллов.

Нелинейный конденсатор можно определить через задание выражения 
для некоторой функции. LTspice компилирует это выражение и символи-
чески дифференцирует его относительно всех переменных, находя част-
ную производную, которая соответствует емкости:
Синтаксис:
  Cnnn n1 n2 Q=<Выражение> [ic=<величина>] [m=<величина>]

В выражении используется специальная переменная  x, которая соот-
ветствует напряжению на емкости. Поэтому, например, постоянная ем-
кость 100pF может быть описана так:
Cnnn n1 n2 Q=100p*x

Емкость со скачкообразным изменением от 100p до 300p при нулевом 
напряжении может быть описана так:
Cnnn n1 n2 Q=x*if(x<0,100p,300p)

Такая форма описания полезна, для быстрой оценки новых макромо-
делей нагрузки, например для транзисторов.

D. Диод
Символьные имена: DIODE, ZENER, SCHOTTKY, VARACTOR.

Синтаксис:
  Dnnn анод катод <модель> [area]
+        [off] [m=<val>] [temp=<value>]

Примеры:
D1 SW OUT MyIdealDiode
.model MyIdealDiode D(Ron=.1 Roff=1Meg Vfwd=.4)

D2 SW OUT dio2
.model dio2 D(Is=1e-10)

Параметры диода задаются в директиве .model. Допустимы две разно-
видности описания диода.

В первой используется кусочно-линейная модель проводимости диода, 
приводящая к минимальным вычислительным затратам. Эта модель име-
ет три основных участка: открытого состояния диода, закрытого и обрат-
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ного пробоя.  Область прямой проводимости и обратного пробоя ограни-
чиваются предельными токами Ilimit и revIlimit соответственно. Наклон 
вольтамперных характеристик участков прямой, обратной проводимости 
и обратного пробоя определяется сопротивлениями  Ron,  Roff и Rrev со-
ответственно. Переход к области прямой проводимости задается напря-
жением Vfwd, переход к области пробоя задается напряжением Vrev.  Па-
раметры  epsilon и  revepsilon определяют плавность перехода от одного 
участка к другому (для этого применяется квадратичная функция). Эти 
параметры задают ширину переходного участка в Вольтах.

Ниже  приводится  описание  параметров  кусочно-линейной  модели 
диода в формате:

 имя параметра - описание - [единица измерения] - значение по умол-
чанию.
Ron    -    сопротивление прямой проводимости  [Ом]      1,
Roff    -   сопротивление обратной проводимости  [Ом]    1/gmin,
Vfwd  -   напряжение перехода к прямой проводимости   [В]   0,
Vrev   -    напряжение пробоя   [В]   infin(бесконечность),
Rrev   -    сопротивление в области пробоя     [Ом]      Ron,    
Ilimit  - предельный ток области прямой проводимости    [А]    infin,
Revilimit  - предельный обратный ток     [А]    infin 
Epsilon  - ширина плавности перехода к прямой проводимости   [В]    0,
Revepsilon - ширина плавности перехода к пробою   [В]    0.

Во второй модели применяется стандартное описание диода, принятое 
в  SPICE-программах. Такие модели применяются при детальном анали-
зе  аварийных  режимов  и  вычислении  тока  рекомбинации.  Параметр 
[area] задает число параллельных диодных ветвей.

    Ниже приводится описание параметров SPICE-модели диода в фор-
мате:
имя параметра - описание - [единица измерения] - значение по умолчанию.
IS    - Ток насыщения перехода    [А]       1е-14,
RS    - Оммическое сопротивление     [Ом]      0,
N    - Коэффициент эмиссии     [ ]      1,
TT   - Время пролета неосновных носителей   [сек]      0,
CJO - Емкость перехода диода при нулевом смещении   [Ф]     0,
VJ   - Встроенный потенциал перехода    [В]   1,
M    -  Коэффициент качества перехода    [ ]  0.5,
EG - Энергетический барьер (ширина запрещенной зоны)- [эл/В] 
1.11(Si),   0.69 (Sbd),  0.67 (Ge)
XTI  - Температурный коэфф.IS   [ ]     3.0,
KF   - Коэфф.фликкер-шума         [ ]    0,
AF  - Показатель фликкер-шума     [ ]    1,
FC   - Коэфф. емкости прямосмещенного перехода    [ ]   0.5,
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BV   - Напряжение пробоя(обр.)    [В]   infin(бесконечность),
IBV- Ток насыщения при пробое диода обратн. напряжением  [А]   1e-10.

E. Источник напряжения управляемый напряжением (ИНУН)
Символьные имена: E, E2

Применяют три типа зависимых источника напряжения.

Синтаксис:  Exxx n+ n- nc+ nc- <коэффициент передачи>

Здесь напряжение между узлами n+ и n−  зависит от входного напря-
жения между узлами  nc+ и  nc−. Это − линейно-зависимый источник с 
постоянным коэффициентом передачи. 

Синтаксис : 
 Exxx n+ n- nc+ nc- table=(< пара значений>, < пара значений >, ...)

Здесь таблица используется, чтобы определить функциональный коэф-
фициент передачи. Таблица - список пар чисел. Второе значение пары - 
напряжение выхода, когда напряжение управления равно первому значе-
нию  этой  пары.  Выход  линейно  интерполируется,  когда  напряжение 
управления  попадает  между  указанными  точками.  Если  напряжение 
управления оказывается вне диапазона таблицы, выходное напряжение 
экстраполируется как постоянное напряжение крайней точки таблицы.

Синтаксис:
  Exxx n+ n−  nc+ nc− Laplace=<func(s)>
+ [window=<время>] [nfft=<число>] [mtol=<число>]

Передаточная функция этого элемента схемы определена преобразова-
нием Лапласа.  Преобразование Лапласа  должно быть функцией пере-
менной s. Оператор "^" распознается как возведение в степень "**" при 
использовании выражений с преобразованием Лапласа. При частотном 
анализе s заменяется на.   Поведение во временной области определяется 
импульсной передаточной функцией, найденной Фурье-преобразованием 
отклика в частотной области. LTspice автоматически определяет соответ-
ствующий  диапазон  частот  и  разрешающую способность.  Можно  эти 
значения откорректировать, явно устанавливая параметры nfft  и window. 
Обратная величина значения window  - разрешающая способность по ча-
стоте. Значение nfft – наибольшее значение частоты.    

Синтаксис:
  Exxx n+ n- value={<выражение>}
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Это  -  альтернативный  синтаксис  описания  источника  с  произвольной 
функцией изменения напряжения.

Синтаксис:
  Exxx n+ n- POLY(<N>) <(node1+,node1−) (node2+,node2−)
+  ... (nodeN+,nodeN−)> <c0 c1 c2 c3 c4 ...>

Это - архаичное средство описания источника с произвольной функцией, 
заданной полиномом. 

Обратите  внимание:  рекомендуется использовать  эквивалентный ис-
точник тока,  управляемый напряжением (ИТУН)  G,  шунтируемый со-
противлением вместо ИНУН. ИТУН с шунтируемым сопротивлением, 
требует меньше вычислительных затрат, чем ИНУН. Кроме того, выход-
ное сопротивление, отличное от нуля ближе к практическим схемам.

F.  Источник тока, управляемый током (ИТУТ)
Символьное имя: F

Синтаксис:
  Fxxx n+ n- <Vnam> <коэффициент передачи>

Этот элемент схемы  прикладывает ток к узлам  n+ и  n−. Прикладывае-
мый ток равен значению усиленного тока через источник напряжения, 
обозначенный как <Vnam>.

Синтаксис:
  Fxxx n+ n- value={<выражение>}

Это  -  альтернативный  синтаксис  описания  источника  с  произвольной 
функцией изменения коэффициента передачи.

Синтаксис:
  Fxxx n+ n− POLY(<N>) <V1 V2 ... VN> <c0 c1 c2 c3 c4 ...>

Это - архаичное средство описания источника с произвольной функцией, 
заданной полиномом.

G.  Источник тока, управляемый напряжением (ИТУН)
Символьные имена: G, G2

Применяют три типа ИНУТ.
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Синтаксис:
  Gxxx n+ n− nc+ nc− <коэффициент передачи>

Этот элемент задает ток между узлами n+ и n−, который зависит от вход-
ного напряжения между узлами nc+ и nc−. Этим способом описывается 
линейно-зависимый источник с постоянным коэффициентом передачи.

Синтаксис:
  Gxxx n+  n−  nc+  nc− table=(<два значения>, < два значения >, ...)

Здесь таблица используется для  функционального задания коэффициен-
та передачи. Таблица представляет собой список пар чисел. Второе зна-
чение пары – выходной ток при напряжении управления равном первому 
значению этой пары. Выход линейно интерполируется, когда напряжение 
управления  попадает  между  указанными  точками.  Если  напряжение 
управления оказывается вне диапазона таблицы, выходной ток экстрапо-
лируется как постоянный ток крайней точки таблицы.

Синтаксис:  
Gxxx n+ n− nc+ nc− Laplace=<func(s)>
+ [window=<время>] [nfft=<число>] [mtol=<число>]

Передаточная функция этого элемента схемы определена преобразовани-
ем Лапласа.  Преобразование Лапласа  должно быть функцией перемен-
ной s. При использовании выражений с преобразованием Лапласа опера-
тор "^" распознается как возведение в степень "**". При частотном ана-
лизе  s заменяется на.   Поведение во временной области определяется 
импульсной передаточной функцией, найденной Фурье-преобразованием 
отклика в частотной области. LTspice автоматически определяет соответ-
ствующий  диапазон  частот  и  разрешающую способность.  Можно  эти 
значения откорректировать, явно устанавливая параметры nfft  и window. 
Обратная величина значения window  - разрешающая способность по ча-
стоте. Значение nfft – наибольшее значение частоты.

Синтаксис:
  Gxxx n+ n- value={<expression>}

Это  -  альтернативный  синтаксис  описания  источника  с  произвольной 
функцией изменения коэффициента передачи.

Синтаксис:
  Gxxx n+ n- POLY(<N>) <(node1+,node1-) (node2+,node2-)

35



+  ... (nodeN+,nodeN-)> <c0 c1 c2 c3 c4 ...>

Это - архаичное средство описания источника с произвольной функцией, 
заданной полиномом.

H.  Источник напряжения, управляемый током (ИНУТ)
Символьное имя: H

Синтаксис:
  Hxxx n+ n− <Vnam> <коэффициент передачи>

Этот элемент прикладывает напряжение между узлами n + и n−. Прикла-
дываемое напряжение равно значению тока через источник напряжения 
с именем <Vnam>, умноженного на коэффициент передачи.

Синтаксис:
  Hxxx n+ n- value={<выражение>}
Это  -  альтернативный  синтаксис  описания  источника  с  произвольной 
функцией изменения коэффициента передачи.

Синтаксис:
  Hxxx n+ n- POLY(<N>) <V1 V2 ... V3> <c0 c1 c2 c3 c4 ...>

Это - архаичное средство описания источника с произвольной функцией, 
заданной полиномом.

I.  Источник тока

Символьное имя: CURRENT

Синтаксис:
  Ixxx n+ n− <current> [AC=<amplitude>] [load]

Это источник постоянного тока между узлами  n+ и  n−. Если источник 
помечен как  load,  то источник неидеальный,  то  есть  при уменьшении 
напряжения до нуля и переходе в отрицательную область, ток также па-
дает до нуля. Такой вариант предназначен для моделирования источника 
питания для тех случаев, когда его мощности не хватает для поддержа-
ния постоянства тока при режимах, близких к короткому замыканию.
Для частотного анализа AC, значение AC используется как амплитуда ис-
точника.

импульсный источник тока
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Синтаксис:
 Ixxx n+ n- PULSE (Ioff  Ion  Tdelay  Trise Tfall Ton Tperiod  Ncycles)

Параметры источника описаны в таблице.
имя параметр единица измерения
Ioff начальная величина А
Ion величина импульса А
Tdelay задержка с
Tr время нарастания с
Tf время спадания с
Ton время включения с
Tperiod период с
Ncycles число волновых циклов циклы −−

Зависимый от времени синусоидальный источник тока:
Синтаксис:
 Ixxx n+ n- SINE(Ioffset Iamp Freq Td Theta Phi Ncycles)
 Параметры описаны в таблице.    
имя параметр единица измерения
Ioffset смещение по пост току А
Iamp амплитуда А
Freq частота Гц
Td задержка с
Theta коэффициент затухания 1/с
Phi фаза градусы
Ncycles число циклов число

Для моментов времени меньших, чем Тd или  после завершения Ncy-
cles, ток вычисляется по формуле: 
Ioffset + Iamp∙ sin(π ∙ phi/180). 
Иначе ток определяется формулой
Ioffset + Iamp∙exp(−(time−Td)∙Theta)∙sin(2 ∙ π∙ Freq ∙ (time−Td) + π ∙ phi/180)

Зависимый от времени экспоненциальный источник тока:
Синтаксис:
  Ixxx n+ n- Ixxx n+ n- EXP(I1 I2 Td1 Tau1 Td2 Tau2)

Параметры описаны в таблице.
имя параметр единица измерения
I1 начальная величина А
I2 величина пульса А

37



Td1 время задержки нарастания с
Tau1 постоянная времени нарастания с
Td2 время задержки спада с
Tau2 постоянная времени спада с

Для моментов времени меньших, чем Td1, выходной ток есть I1.  В тече-
ние времени между Td1 и Td2 ток определяется формулой:
  I1 + (I2−I1) ∙ (1−exp(−(time−Td1)/Tau1)).

Для времени после Td2 ток определяется формулой:
I1 + (I2−I1)∙(1−exp(−(time−Td1)/Tau1)) + (I1−I2)∙(1−exp(−(time−Td2)/Tau2)).

Зависимый от времени  частотно-модулированный источник тока.
Синтаксис:
  Ixxx n+ n− SFFM(Ioff Iamp Fcar MDI Fsig)
Параметры описаны в таблице.

имя параметр единица измерения
Ioff смещение по постоянному току А
Iamp амплитуда А
Fcar несущая частота Гц
MDI коэффициент модуляции (нет)
Fsig частота сигнала Гц
Ток определяется выражением:

  Ioff + Iamp ∙ sin((2. ∙ π ∙ Fcar ∙ time) + MDI ∙ sin(2. ∙ π ∙ Fsig ∙ time)).
табличная функция напряжения
Синтаксис:
  Ixxx  n+ n−  tbl=(<напряжение, ток>, <напряжение, ток>, ...)

Ток может также быть определен как табличная функция напряжения 
между узлами. Этот способ может быть использован для моделирования 
характеристик нагрузки.
Специальная форма источника тока.
Синтаксис:
  Ixxx n+ n− <value> step(<value1>, [<value2>], [<value3>, ...]) [load]
  Ток определен  как  список  величин,  для  использования  при  анализе 
переходных процессов на том или ином шаге.  В этом режиме моделиро-
вание выполняется до устойчивого состояния при первом токе в списке, 
<value1>.  После чего ток меняется на следующее значение из списка, 
<value2>. Моделирование продолжается до устойчивого состояния, до-
стигаемого при этом токе. Далее ток принимает следующее значение и 
процесс повторяется, пока список не будет исчерпан.  Если команда .tran 
не определяет "step", то используется оригинал <value>.
резистивная нагрузка
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Синтаксис:
  Ixxx n+ n- R=<value>
Это - не источник тока, а резистор. Используется для моделирования ре-
зистивной нагрузки, представленной в списке соединения как источник 
тока.
Кусочно-линейное задание тока в функции времени
Синтаксис: Ixxx n+ n- PWL(t1 i1 t2 i2 t3 i3...)

До момента времени t1, ток источника равен i1. В моменты между t1 и 
t2, ток изменяется линейно от i1 до i2. Можно указать любое число мо-
ментов времени и соответствующих значений тока. Для моментов време-
ни за последней точкой ток сохраняет свое последнее значение.

Синтаксис:
 Ixxx n+ n- wavefile=<filename> [chan=<nnn>]

Этот способ позволяет использовать .wav файл для ввода данных в LT-
spice. <filename> может представлять или полный путь для .wav файла 
или относительный путь к каталогу, содержащему схему или список со-
единений. Для указания пути, содержащего пробелы, должны использо-
ваться двойные кавычки. .wav файл может содержать до 65536 каналов, 
нумерованных от 0 до 65535. Опция  chan определяет,  какой канал ис-
пользуется.  По  умолчанию для  первого  канала  используется  номер  0. 
.wav файл масштабируется в диапазоне от −1A до 1A. Этот источник 
применяется только при анализе переходных процессов.

J.  Полевой транзистор (JFET)
Символьные имена: NJF, PJF
Синтаксис:
  Jxxx Сток Затвор Исток  <model> [area] [off] [IC=Vds, Vgs]  [temp=T]

Примеры:
J1 0 in out MyJFETmodel
.model MyJFETmodel NJF(Lambda=.001)

J2 0 in out MyPJFETmodel
.model MyPJFETmodel PJF(Lambda=.001)

Параметры транзистора задаются в директиве .model. Ключевые слова 
NJF и PJF определяют полярность транзистора. Параметр [area] опреде-
ляет число параллельно соединенных транзисторов. 

Характеристики по постоянному току определены параметрами VTO и 
BETA, которые определяют зависимость тока стока от напряжения затво-
ра; параметром LAMBDA, который определяет выходную проводимость; 
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Is  - током насыщения перехода. Накопление заряда смоделировано нели-
нейными емкостями запирающего слоя для обоих переходов и определе-
но параметрами Cgs, Cgd и PB.

Ниже приводится описание некоторых параметров полевого транзи-
стора в формате:

 имя параметра - описание - [единица измерения] - значение по умол-
чанию.
VTO - Пороговое напряжение    [В]    -2.0
BETA - Проводимость передачи   [А/В]   1е-4 
LAMBDA – Коэффициент модуляции длины канала  [1/В]   0 
RD  - Сопротивление стока  [Ом]     0 
RS  - Сопротивление истока  [Ом]   0 
CGD - Емкость перехода затвор-сток при нулевом

напряжении на переходе  [Ф]  0
CGS - Емкость перехода затвор-исток при нулевом напряжении на пере-
ходе   [Ф]  0  
FC  - Коэффициент емкости прямосмещенного перехода   [ ]  0.5
PB  - Внутренний потенциал затвора   [В]   1.0 
IS   - Ток насыщения перехода затвор-исток(сток)  [А]  1е-14 
KF - Коэфф.фликкер-шума   [ ]     0  
AF - Показатель фликкер-шума  [ ]    1 

K.  Взаимная Индуктивность
Символьное имя: Отсутствует, размещается как текст на схеме.
Синтаксис: 
 Kxxx L1 L2 [L3 ...] <коэффициент связи>

L1 и L2 - имена катушек индуктивности в схеме. Взаимный коэффициент 
связи должен быть в диапазоне между −1 и 1. Коэффициент связи вычис-

ляется по формуле K= M
 L1 ⋅L2 

, где М – значение взаимной индуктивно-

сти, L1 – значение индуктивности катушки L1, L2 – значение индуктивно-
сти катушки L2.
Строка

K1  L1  L2  L3  L4   1.

аналогична шести строкам:
 K1 L1 L2 1.

K2 L2 L3 1.
K3 L3 L4 1.
K4 L1 L3 1.
K5 L2 L4 1.
K6 L1 L4 1.
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Рекомендуется  начинать  моделирование  при  взаимном  коэффициенте 
связи равном 1. При этом устраняется индуктивность рассеяния, которая 
может оказывать паразитное влияние на очень  высоких частотах при от-
сутствии затухания, что приводит к замедлению моделировании. Вместе 
с тем, взаимное значение индуктивности равное −1 или 1, так же может 
привести к трудностям моделирования, если присутствует uic директива 
в закладке .tran.

L.  Катушка индуктивности
Символьные имена: IND, IND2
Синтаксис:
 Lxxx  n+  n−  <inductance>  [ic=<value>]  [Rser=<value>]  [Rpar=<value>] 
+[Cpar=<value>] [m=<value>]

Для индуктивности можно определить эквивалентное последовательное 
сопротивление, последовательную индуктивность, параллельное сопро-
тивление  и  параллельную  емкость.  Эквивалентная  схема  приведена 
ниже:

                           
           Параметры Катушки индуктивности:
   Rser - эквивалентное последовательное сопротивление
   Rpar - эквивалентное параллельное сопротивление
   Cpar - эквивалентная параллельная емкость
   m  - число параллельных ветвей
    ic  - начальный ток (используется при директиве uic на закладке .tran)
    tc1 - линейный температурный коэффициент.
    tc2  - квадратичный температурный коэффициент индуктивности.
    temp - время

Если  включить  в  модель  катушки  индуктивности  паразитные  Rpar, 
Rser и Cpar, то LTspice будет использовать встроенную модель без вну-
тренних узлов.  Это уменьшит размер матрицы моделирования, снизит 
вероятность того, что эта матрица окажется сингулярной. В результате 
вычисления при любом временном шаге будут быстрее.
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По умолчанию,  LTspice  учитывает  последовательное  сопротивление 
катушки индуктивности, чтобы помочь SMPS анализу переходных про-
цессов.  Для SMPS это сопротивление не имеет никаких последствий и 
может  быть  при  желании  отключено.   Для этого надо дать команду 
"Tools=>Control Panel=>Hacks!" и снять отметку "Supply a min. inductor 
damping if no Rpar is given."  ("установить мин. демпфирование катушки 
индуктивности,  если не задан  Rpar").   Эта установка будет запомнена 
между запусками программы.  По умолчанию задается последовательное 
сопротивление 1 миллиОм для катушек индуктивности (не применяется 
для  взаимной  индуктивности).   Это  последовательное  сопротивление 
Rser позволяет SwitcherCAD III  моделировать индуктивность как Нор-
тон-эквивалентную схему вместо Тэвенин-эквивалентной для уменьше-
ния размера линеаризованной матрицы схемы.  Если Вы не хотите, что-
бы LTspice ввел это минимальное сопротивление, Вы должны явно уста-
новить Rser=0 для катушки индуктивности.  Это приведет к использова-
нию  более  громоздкого  Тевенин-эквивалента  катушки  индуктивности 
при анализе переходных процессов.

 В  LTspice применяется две формы для нелинейных катушек индук-
тивности.  Одна из них - функциональная индуктивность, задаваемая вы-
ражением для потока.  Ток катушки индуктивности обозначается в выра-
жении ключевым словом "x".  Ниже - пример из списка соединений.
L1 N001 0 Flux=1m*tanh(5*x)    ;Приведено выражение для потока.
I1 0 N001 PWL(0 0 1 1) ; Если была бы задана формула для нелинейной 
.tran 1  ;индуктивности, то она должна быть умножена на х
.end, 

В этом примере,  источник I1 линейно нарастает в функции времени. 
Тогда производная dI/dt равна единице, а напряжение  на узле N001 рав-
но значению индуктивности: UN001=L · dI/dt = L.

Второй способ задания нелинейной индуктивности в LTspice исполь-
зует  гистерезисную модель, первоначально предложенную Джоном Ча-
ном и др.  в IEEE Transactions On Computer-Aided Design, Vol. 10. No. 4, 
April 1991. Эта модель определяет гистерезис тремя параметрами:
    Hc  - Коэрцитивная сила   [A-витки/м];
    Br   - Остаточная индукция [Тесла];
    Bs  - Индукция насыщения [Тесла].

Верхними и нижними ветвями гистерезиса являются зависимости:

 
и
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Bup H =Bs⋅ H + Hc
∣HHc∣+ Hc⋅Bs/Br -1

+0⋅H

Bdn H= Bs⋅ H -Hc
∣H - Hc∣+ Hc⋅Bs /Br -1

+ 0⋅H



  Эти функции представлены ниже на графике.  Hc и Br являются пересе-
чениями главного цикла гистерезиса с Н-и B-осями.  Bs - пересечение B-
оси  асимптотической  линией,  Bsat(H)  =  Bs +  µ0·H,  получаемой  при 

устремлении H  в бесконечность.
Начальная  кривая  намагничивания 

определяется выражением
Bmag(H) = .5 · (Bup(H) + Bdn(H))
Младшие циклы получаются различными 
преобразованиями  вышеприведенных 
уравнений. Для примера на графике при-
веден асимметричный младший цикл для 
типичного  феррита  (Hc=16  A-витков/м, 
Bs=.44T, Br= .10T).

В дополнение к основным параметрам Hc, Br, и Bs, требуются: 
    Lm  -  Длина сердечника (искл. возд. за-
зор)  [м];
    Lg  - Длина воздушного зазора [м];
    A   - площадь поперечного сечения маг-
нитопровода [м2];
    N    - число витков . 

Следует  обратить  внимание  на  то,  что 
при  определении  ненулевого  зазора  для 
магнитного  поля,  H  не  пропорционально 
потоку  в  обмотках.  LTspice  рассчитывает 

магнитное поле в сердечнике и зазоре в предположении их однородно-
сти.

Ниже приводится пример, демонстрирующий задание индуктивности 
через поток для катушки L1, расположенной на сердечнике с зазором.
*
L1 N001 0 Hc=16. Bs=.44 Br=.10 A=0.0000251
+ Lm=0.0198 Lg=0.0006858 N=1000
I1 0 N001 PWL(0 0 1 1)
.tran .5
.options maxstep=10u
.end

M.  МОП-транзистор  с изолированным затвором (MOSFET)
Символьные имена:
  NMOS, NMOS3, PMOS, PMOS3
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В LTspice применяются два существенно различных типа MOSFETS: мо-
нолитный  MOSFETs и  VDMOS - мощный вертикальный МДП-транзи-
стор технологии двойной диффузии.

  Монолитные MOSFET:
  Синтаксис:  Mxxx Nd Ng Ns Nb <model> [m=<value>] [L=<len>]
           + [W=<width>] [AD=<area>] [AS=<area>]
           + [PD=<perim>] [PS=<perim>] [NRD=<value>]
           + [NRS=<value>] [off] [IC=<Vds, Vgs, Vbs>]
           + [temp=<T>]

Примеры:
  M1 Nd Ng Ns 0 MyMOSFET
  .model MyMOSFET NMOS(KP=.001)

  M1 Nd Ng Ns Nb MypMOSFET
  .model MypMOSFET PMOS(KP=.001)

 M1 14 2 13 0 PNOM  L=25U W=12U

 M2A 0 2 100 100 NW L=33U W=12U AD=288P AS=288P
       +   PD=60U PS=60U
       +    NRD=14  NRS=24
  
Вертикальный МДП-транзистор технологии двойной диффузии:
  Синтаксис:  Mxxx Nd Ng Ns <model> [L=<len>] [W=<width>]
           + [M=<area>] [m=<value>] [off]
           + [IC=<Vds, Vgs, Vbs>] [temp=<T>]

  Пример:
     M1 Nd Ng Ns Si4410DY
     .model Si4410DY VDMOS(Rd=3m Rs=3m Vto=2.6 Kp=60
     + Cgdmax=1.9n Cgdmin=50p Cgs=3.1n Cjo=1n
     + Is=5.5p Rb=5.7m) 

Монолитные МДП-транзисторы:
        ND,NG,NS -узлы подключения стока, затвора, истока
                  МОП - транзистора соответственно
        NB -узел подключения подложки
        имя модели -имя модели транзистора
        L -длина канала (может устанавливаться пользователем)
        W -ширина канала (может устанавливаться пользователем)
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        AD -площадь стока в м
        AS -площадь истока в м
        PD -периметр стока в м
        PS -периметр истока в м
        NRD -относительное сопротивление стока
        NRS -относительное сопротивление истока

Ниже приводится описание некоторых параметров МОП транзистора в 
формате:

 имя параметра - описание - [единица измерения] - значение по умолчанию.
LEVEL- Тип модели (1,2 или 3)      [ ]    1     
LD - Длина канала      [м]  0     
WD - Ширина канала(по диффузии)  [м]     0     
VTO - Напряжение порога при нулевом токе стока [В]  0            
KP - Проводимость передачи     [А/В2]    2.0е-5  
GAMMA-Коэфф.влияния подложки   sqrt [В]      0     
PHI - Объемный потенциал при   слабой инверсии  [В]    0.6 
LAMBDA- Коэфф.модуляции длины канала (для LEVEL 1 или 2)  [1/В] 
0                   
RD - Сопротивление стока  [Ом]     0     
RS - Сопротивление истока [Ом]     0     
IS - Ток насыщения переходов    [А]  1.е-14   
JS - Плотность тока насыщения [А/м]  0     
PB - Встречный потенц.подложки [В]  0     
CBD - Емкость перехода подл-сток при нулевом напр.на пере. [Ф]    0 
CBS - Емкость перех. подл-исток  при нулевом напр.на перех. [Ф]    0 
CJ - Емкость подл.-сток при нулевом смещении на ед.площ. [Ф/м2]   0 
CJSW - Удельная емкость боковой  поверх.перех.подл.-сток[Ф/м]   0 
MJ - Показатель качества перех. подл.-сток  [ ]    0.5 
MJSW - Показатель качества боковой поверх.перех.подл-сток  [ ] 
(level 2,3) 0.33 (level1) 0.5                  
FC - Коэфф.нелинейности прямосмещен.перех.подл-исток [] 0.5 
CGSO - Относительная емкость перекрытия затвор-исток (на едини-
цу ширины канала) [Ф/м]   0                     
CGDO - Относительная емкость перекрытия затвор-сток (на  единицу 
ширины канала) [Ф/м]  0                     
CGBO - Относительная емкость перекрытия затвор-подл.(на единицу 
ширины канала) [Ф/м]      0                    
NSUB - Уровень легирования подл.   [1/см3]       0     
NSS - Плотность поверхностных  состояний [1/см2]       0 
NFS - Плотность быстрых поверхностных состояний [1/см2]      0 
TOX - Толщина окисла   [м]     1e-7                    
TPG - Тип затвора: +1-противопол. м-лу подл.          [ ] 1         
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                       -1 – аналогичный подложке                   
                        0 - алюминий                            
XJ - Металлургическая глубина   перехода  [м]      0 
UO - Подвижность носителей  [см2 /В·c]        600.0  
UCRIT - Критическое  поле  для  ограничения  скорости  носителей  (для 
LEVEL=2) [В/см]    1.е4                    
UEXP - Показатель ограничения   скорости носителей  [ ] 0 
UTRA-Коэфф.поперечного поля ограничения подвижности носителей [ ]0 
VMAX-Скорость максимального дрейфа носителей   [м/сек]   0 
NEFF - Коэфф.заряда канала      [ ]        1.0   
XQC - Часть зарядов канала,притянутая стоком [ ] 0                             
DELTA-Коэфф.влияния  ширины  канала  на  пороговое  напряж.  (для 
LEVEL=2,3)  [] 0                  
THETA - Коэфф.модуляции подвижности (для LEVEL=3)    [1/В]   0 
ETA - Статическая обратная связь  (для LEVEL=3)  [ ]   0 
KAPPA - Коэфф.поля насыщения  (для LEVEL=3)    [ ]  0.2 
KF - Коэфф.фликкер-шума       []   0     
AF - Показатель фликкер-шума     [ ]   1.0   

O.  Линия передачи с потерями
Символьные имена: LTLIN
Синтаксис: 
 Oxxx L+ L- R+ R- <model>

Пример:
    O1 in 0 out 0 MyLossyTline
    .model MyLossyTline LTRA(len=1 R=10 L=1u C=10n)

Это - простой проводник линии с потерями.  L+ и L- являются входными 
узлами.  R+ и R- являются выходными узлами.  При моделировании ав-
томатически определяются электрические характеристики этого элемен-
та.
      Параметры для линии передачи с  потерями (Lossy Transmission 
Lines):
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имя параметр ед.изм/ти
п

по умолч.

R сопротивление/длина Ом/м 0.
L индуктивность/длина Гн/м 0.
G проводимость/длина mhos/м 0.
C емкость/длина Ф/м 0.
LEN длина линии - (none)
REL управление точкой прерывания - 1
ABS breakpoint control 1
NOSTEPLIMIT не  ограничивать  шаг  времени 

меньше, чем задержка линии
flag  not set

NOCONTROL не  делать  сложного  управления 
временным шагом

flag not set

LININTERP использовать линейную интерполя-
цию

flag not set

MIXEDINTERP использовать линейную интерполя-
цию,  когда  квадратичная  оказыва-
ется плохой

flag not set

COMPACTREL специальный  reltol для уплотнения 
хронологии

flag RELTOL

COMPACTABS специальный abstol для уплотнения 
хронологии

flag ABSTOL

TRUNCNR использовать  метод  Ньютона-Раф-
сона  для  управления  временным 
шагом

flag not set

TRUNCDONT-
CUT

не ограничивать шаг времени, что-
бы сохранить ошибки импульсной 
передаточной функции

flag not set
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Q.  Биполярный транзистор
Символьные имена:
 NPN, PNP, NPN2, PNP2

Синтаксис:
  Qxxx Коллектор База Эммитер [Узел подложки]
        + model [area] [off] [IC=<Vbe, Vce>] [temp=<T>]

Пример:
Q1 C B E MyNPNmodel
.model MyNPNmodel NPN(Bf=75)

Параметры транзистора задаются в директиве .model. Ключевые слова 
NPN и  PNP определяют полярность транзистора. Параметр [area] опре-
деляет число параллельно соединенных транзисторов. 

В основе применяемой модели транзистора использована модель Гум-
меля-Пуна.  Модель автоматически упрощается к модели Эберса-Молла 
при отсутствии некоторых параметров.

 
Ниже приводится описание некоторых параметров биполярного тран-

зистора в формате:
 имя параметра - описание - [единица измерения] - значение по умол-

чанию.
IS     -  Ток насыщения          [А]   1е-16 
EG   -  Энергетический барьер(ширина запрещенной зоны)  [эл/В]     1.11 
XTI  - Температур.коэфф.тока IS  []  3  
BF    - Прямой коэффициент усиле ния (максимальное значен.) [ ]     100 
NF    - Коэфф.эмиссии прямого тока  [ ]   1.0   
VAF - Напряжение Эрли         [В]     (бесконечность)             
IKF - Точка изгиба кривой зависимости IC=f(Uэб)при больших токах [А] 
(бесконечность)                 
ISE   - Ток утечки эмитт.перехода  [А]    0     
NE    - Коэфф.эмиссии тока ISE   [ ]    1.5   
BR   -  Обратный коэфф.усиления  [ ]   1.0   
NR    - Коэфф.эмиссии тока коллектора в инверсном вкл.  []     1     
VAR - Напряжение Эрли при инверсном включении   [В]  (бесконечность) 
IKR -Точка изгиба кривой зависимости IE=f(VCB) при больших токах [А] 
ISC   - Ток утечки коллек.перехода[А]           0 
NC    - Коэфф.эмиссии коллекторного перехода [ ]   2.0   
RB   -  Сопротивление базы      [ОМ]            0     
IRB  - Ток,при котором RB уменьшается в два раза [А]   (бесконечность) 
RBM   -  Минимальное значение RB   [Ом]           RB     
RE   - Сопротивление эмиттера   [ОМ]           0     
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RC   - Объемное сопротивление коллектора  [ОМ]                 
CJE - Емкость эмиттера при нулевом напряжении на переходе [Ф]     0 
MJE - Показатель качества перехода эмиттер-база [ ]    0.33  
VJE - Внутренний потенциал перехода эмиттер-база  [В]           0.75  
CJE  - Емкость коллектора при нулевом напряжении на переходе  [Ф]  0 
MJC - Показатель качества перехода коллектор-база [ ]   0.33  
VJC - Внутренний потенциал перехода коллектор-база [В]           0.75  
XCJC  - Коэфф.расщепления емкости коллектор-база  [ ]    1.0   
CJS - Емкость коллектор-подложка при нулевом напряжении [Ф]           0 
 MJS - Показатель качества перехода коллектор-подложка [ ]    0.   
VJS -  Внутренний  потенциал  перехода  коллектор-подложка   [В] 
0.75  
FC   - Коэфф.нелинейности прямосмещенного перехода [ ]    0.5     
TF   - Время переноса носителей через базу [сек]         0     
XTF   - Коэфф.зависимости времени TF от режима [ ]   0     
VTF - "Критическое" напряжение зависимости TF=f(VBC) [B] (бесконеч-
ность)               
ITF   - "Критический" ток для TF [А]           0     
PTF   - Избыточный фазовый сдвиг на частоте F=1/(TF*2π)  [град]         0 
TR - Время переноса носит. через базу в инверсном включении [сек]   0 
XTB   - Температурный коэффициент усиления по току [ ]    0     
KF    - Коэфф.фликкер-шума     [ ]    0     
AF    - Показатель фликкер-шума  [ ]     1  
   

R.  Резистор
Символьные имена: RES, RES2
Синтаксис:
  Rxxx n1 n2 <value> [tc=tc1, tc2, ...]

Резистор соответствует линейному сопротивлению между узлами n1 и 
n2. Температурная зависимость может быть определена для каждого ре-
зистора  параметром tc.  Сопротивление  R задается следующей форму-
лой:
R = R0 * (1. + dt * tc1  + dt**2 * tc2 + dt**3 * tc3 + ...)
где  R0 -  сопротивление при номинальной температуре,   dt -  разность 
между температурой резистора и номинальной температурой.

S.  Ключ, управляемый напряжением
символьное имя: SW
Синтаксис:
  Sxxx n1 n2 nc+ nc- <model> [on,off]
Пример:
S1 out 0 in 0 MySwitch
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.model MySwitch SW(Ron=.1 Roff=1Meg Vt=0 Vh=-.5 Lser=10n Vser=.6)
Напряжение между узлами nc+ и nc- управляет сопротивлением ключа 

между узлами n1 и n2.  В имени модели определяется поведение ключа. 
Пример схемы см. в файле .\examples\Educational\Vswitch.asc.

Параметры ключа, управляемого напряжением:
  Vt   -  пороговое напряжение [В], (по умолч. 0.);
  Vh  -  напряжение гистерезиса [В] , (по умолч. 0.);
  Ron    сопротивление замкнутого ключа [Ом] , (по умолч. 1.);
  Roff   сопротивление разомкнутого ключа [Ом] , (по умолч. 1/gmin);
  Lser   последовательная индуктивность   [Гн] , (по умолч. 0.);
  Vser   последовательное напряжение   [В], (по умолч. 0.);
  ilimit предельный ток [A] , (по умолч. infin);

Ключ имеет три разных режима управляющего напряжения, в зависи-
мости от значения напряжения гистерезиса Vh.  Если Vh является нуле-
вым,  ключ  срабатывает  в  зависимости  от  того,  является  ли  входное 
напряжение выше или ниже порогового напряжения Vt.  Если Vh поло-
жительно,  ключ  работает  как  триггер  Шмитта  с  точками  перехода  в 
Vt+Vh и  Vt-Vh.  То  есть  при  положительном  нарастании  напряжения 
управления ключ замкнется при  Vt+Vh и разомкнется при  Vt-Vh. Если 
Vh - отрицательно, ключ срабатывает с плавным переходом собственного 
сопротивления.  Переход  происходит между  напряжениями управления 
Vt+Vh и Vt-Vh.

T.  Линия передачи без потерь
Символьное имя: TLINE
Синтаксис: 
 Txxx L+ L- R+ R- Zo=<value> Td=<value>
L+ и L- входные узлы.  R+ and R- выходные узлы.  Zo – волновое сопро-
тивление (Ом). Td – задержка сигнала (с). 

U.  Однородная ёмкостно-резистивная линия
Символьное имя: URC
Синтаксис:
  Uxxx N1 N2 Ncom <model> L=<len> [N=<lumps>]

N1 и N2 – входной и выходной узлы,  Ncom – общий узел. Обязательно 
указываются имя модели <model> и длина линии <len> в метрах. Необя-
зательный параметр N задает число сегментов линии. 

В  модели  могут  быть  использованы  внутренние  сгенерированные 
узлы. RC сегменты располагаются в геометрической прогрессии, увели-
чивающейся к середине линии. Константа прогрессии К задается в моде-
ли как параметр.
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Если задается ненулевое значение параметра ISPERL, то линия представ-
ляет собой RC сегменты с обратно включенными диодами с эквивалент-
ными емкостными переходами, током насыщения ISPERL, и сопротивле-
нием  RSPERL. 
K   - константа прогрессии, по умолчанию равна  2.
FMAX  - максимальная частота, по умолчанию 1ГГц.
RPERL - сопротивление линии на единицу длины, по умолчанию 1000 
Ом/м.       CPERL- емкость линии на единицу длины, по умолчанию 1e-
15 Ф/м.
ISPERL - ток насыщения/длина модуля, по умолчанию 0 А/м.
RSPERL - диодное сопротивление/длина модуля, по умолчанию  0 Ом/м.

V.  Источник напряжения
Символьные имена: VOLTAGE, BATTERY
Источник постоянного напряжения.
Синтаксис:
  Vxxx n+ n- <число> [AC=<амплитуда>] [Rser=<число>] [Cpar=<число>]

Узлы соединения источника:  n+ и n-. Постоянное зна-
чение напряжения задается   числом  <число>.  Для ча-
стотного  анализа  задается  амплитуда  параметром  АС. 
Могут  быть  определены последовательное  сопротивле-
ние  Rser и  параллельная  емкость  Cpar.  Эквивалентная 
схема:

Исторически сложилось так, что источники напряжения 
дополнительно используются в SPICE-программах для измерения тока и 
как датчики тока для элементов, управляемых током.  Если задан пара-
метр  Rser,  то источник напряжения может использоваться как измери-
тель и не может использоваться для определения управляемых источни-
ков. 

Импульсный источник напряжения.
Синтаксис: 
Vxxx n+ n- PULSE(V1 V2 Tdelay Trise Tfall Ton Tperiod Ncycles )

Параметры:
  Voff,  [В]   - начальное значение,  
  Von ,   [В]   -  максимальное значение ,
  Tdelay, [с]   -  задержка, 
  Tr,  [с]    -    время нарастания ,
  Tf ,  [с]    -   время спада,
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  Ton,  [с]    -   длительность плоской части импульса, 
  Tperiod,  [с]  - период повторения, 
  Ncycles,  [-]  - число циклов.
Синусоидальный источник напряжения.
Синтасис:
 Vxxx n+ n- SINE(Voffset Vamp Freq Td Theta Phi Ncycles)
Параметры:
  Voffset,  [В]  -   смещение по постоянному току,
  Vamp,  [В]   -     амплитуда,
  Freq , [Гц]  -    частота,
  Td, [c]  -  задержка,
  Theta, [1/c]    -  коэффициент затухания,
  Phi, [градусы]  - фаза,
  Ncycles, [-]  - число циклов.

Для моментов времени меньших чем Td или  после завершения Ncy-
cles, напряжение имеет вид:
Voffset+Vamp*sin(pi*Phi/180),

Иначе напряжение определяется формулой:
Voffset+Vamp*exp(-(time-Td)*Theta)*sin(2*pi*Freq*(time-Td)+pi*Phi/180)

Коэффициент затухания,  Theta, является величиной, обратной постоян-
ной времени затухания  импульса.

Экспоненциальный источник напряжения.
Синтаксис:  
Vxxx n+ n- EXP(V1 V2 Td1 Tau1 Td2 Tau2)
Параметры:
   V1,  [В]  -  начальная величина, 
   V2,  [В] -   величина пульса ,             
   Td1, [c]  -  время задержки нарастания,          
   Tau1, [c] -  постоянная времени нарастания,       
   Td2, [c] -  время задержки спада,          
   Tau2, [c] -  постоянная времени спада.

Для моментов времени меньших, чем Td1, выходное напряжение рав-
но  V1.  В течение времени между  Td1 и  Td2 напряжение определяется 
формулой:
V1+(V2-V1)*(1-exp(-(time-Td1)/Tau1)).

Для времени после Td2 напряжение определяется формулой:
V1+(V2-V1)*(1-exp(-(time-Td1)/Tau1)) + (V1-V2)*(1-exp(-(time-Td2)/Tau2)).

Частотно-модулированный источник напряжения.  
Синтаксис:  
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Vxxx n+ n- SFFM(Voff Vamp Fcar MDI Fsig)

Параметры:
  Voff       смещение по постоянному току   Volts
  Vamp       амплитуда              Volts
  Fcar       несущая частота          Hz
  MDI        коэффициент модуляции         (none)
  Fsig       частота сигнала           Hz

Напряжение определяется выражением
   Voff+Vamp*sin((2.*pi*Fcar*time)+MDI*sin(2.*pi*Fsig*time)).

Кусочный линейный источник напряжения.
Синтаксис: 
  Vxxx n+ n- PWL(t1 v1 t2 v2 t3 v3...)

До момента времени, равного t1, напряжение равно -  v1. В моменты 
времени между t1 и t2, напряжение изменяется линейно от е1 до е2 и т.д. 
После  последней временной точки,  напряжение остается таким каким 
оно было задано для этой точки.

Источник, задаваемый внешним файлом.
Синтаксис: 
 Vxxx n+ n- wavefile=<имя файла> [chan=<nnn>]

В качестве внешнего файла используется  .wav файл. <имя файла> яв-
ляется или полным, абсолютным путем для .wav файла или относитель-
ным  путем,  определяемым  каталогом,  содержащим  схему  или  netlist. 
Чтобы определить путь,  содержащий пробелы должны использоваться 
двойные кавычки. 

.wav файл может содержать до 65536 каналов, нумерованных от 0 до 
65535. Параметр chan определяет номер используемого канала. По умол-
чанию используется первый канал с номером 0. 

.wav файл интерпретирует напряжение в  диапазоне от-1V до 1V.
Источник  может быть использован только  при расчете переходных 

процессов.

W.  Ключ, управляемый током независимого источника напряжения
Символьное имя:  CSW
Синтаксис: 
  Wxxx n1 n2 Vnam <model> [on,off]
Пример:
W1 out 0 Vsense MySwitch
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Vsense a b 0.
.model MySwitch CSW(Ron=.1 Roff=1Meg It=0 Ih=-.5)

Ток через источник напряжения с именем  Vnam управляет сопротив-
лением ключа. Обязательно указывается имя модели, которое определяет 
поведение ключа.
Параметры ключа, управляемого током:
  It   - пороговый ток   [А], (по умолч. 0.);
  Ih    - ток гистерезиса[А] , (по умолч. 0.);
  Ron  -  сопротивление замкнутого ключа [Ом] , (по умолч. 1.);
  Roff  - сопротивление разомкнутого ключа , (по умолч. 1/gmin);

Ключ имеет три разных режима управления током, в зависимости от 
значения тока гистерезиса, Ih.  Если Ih является нулевым, ключ срабаты-
вает в зависимости от того, является ли входной ток выше или ниже по-
рогового  тока  It.   Если  Ih положительно,  ключ работает  как  триггер 
Шмитта с точками перехода в It+Ih и It-Vh. То есть при положительном 
нарастании тока управления ключ замкнется при It+Ih и разомкнется при 
It-Ih.  Если  Ih -  отрицательно, ключ срабатывает с плавным переходом 
собственного сопротивления. Переход происходит между током управле-
ния It+Ih и It-Ih.

X.  Подсхема
Синтаксис: 
 Xxxx n1 n2 n3... <имя подсхемы> [<параметр>=<выражение>]
Ниже приводится  пример  описания  подсхемы делителя  напряжения  и 
вызова этой подсхемы из основной схемы.
* Пример вызова подсхемы
*
* Описание основной схемы
X1 in out 0 divider top=9K bot=1K
V1 in 0 pulse(0 1 0 .5m .5m 0 1m)
*описание подсхемы
.subckt divider A B C
R1 A B {top}
R2 B C {bot}
.ends divider
.tran 3m
.end
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Z.  Транзистор MESFET 
Символьное имя: 
 MESFET
Синтаксис:
  Zxxx Сток Затвор Исток model [area] [off] [IC=<Vds, Vgs>]

Параметры транзистора задаются в директиве .model. Ключевые слова 
NMF и PMF определяют полярность транзистора. Параметр [area] опре-
деляет число параллельно соединенных транзисторов.

Модель транзистора является модификацией модели арсенид-галиево-
го транзистора.

Ниже приводится описание некоторых параметров транзистора в фор-
мате:
 имя параметра - описание - [единица измерения] - значение по умолчанию.

VTO - Пороговое напряжение     [В]      -2.    
ALPHA - Параметр напряжения насыщения     [1/В]      2.0    
BETTA - Проводимость передачи(крутизна) [А/В2]      1e-4 
LAMBDA- Коэфф.модуляции длины канала   [1/B]       0 
RD - Сопротивление стока     [Ом]        0     
RS - Сопротивление истока    [Ом]        0     
CGD - Емкость перех. затвор-сток при
 нулевом напряж. на перех. [Ф]    0                                  
CGS - Емкость перех. затвор-исток при
 нулевом напряж. на перех.  [Ф]    0                                  
KF - Коэфф.фликкер-шума      [ ]      0     
AF - Показатель фликкер-шума    [ ]    1           
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Директивы моделирования.
Программа LTSpice позволяет проводить шесть видов анализа схем:

1. Расчет переходных процессов (включая Фурье-анализ)
2. Частотный анализ линеаризованных схем по малому сигналу. 
3. Многовариантный расчет по постоянному току
4. Режим по постоянному току в рабочей точке
5. Расчет малосигнальных передаточных функций в режиме по постоян-
ному току.
6. Анализ шумов

Если схема вводится в графическом редакторе, то директивы модели-
рования помещаются в схемное решение как текст, начинающийся с точ-
ки.

.AC - Частотный анализ линеаризованных схем по малому сигналу.
Синтаксис.
 .ac <oct, dec, lin> <Nsteps> <StartFreq> <EndFreq>

Директива задает частотный анализ в пределах начальной частоты, за-
даваемой параметром StartFreq и конечной частоты задаваемой парамет-
ром EndFreq. Ключевые слова oct или dec определяют логарифмический 
масштаб изменения частоты октавами или декадами соответственно. 
Если задано ключевое слово lin, то частота меняется линейно. Параметр 
Nsteps задает число точек по частоте:

ключевое слово            Значение параметра  Nsteps
---------------------------------------------------------------------------
 oct        Число точек на октаву
 dec        Число точек на декаду
 lin        Общее число точек между значениями StartFreq и EndFreq

Частотные  характеристики  рассчитываются  после  автоматического 
определения режима по постоянному току и линеаризации нелинейных 
компонентов.  Независимые источники тока и напряжения задаются ам-
плитудами и фазами.

.BACKANNO –  Соотнесение имен контактов подсхем и токов
Синтаксис: 
 .backanno

Эта  директива  автоматически  включается  в  список  соединений 
SwitcherCAD III, чтобы включить информацию в .raw файл, позволяю-
щей обратиться к токам порта по имени контакта штырька. Это дает воз-
можность строить графики тока через контакты через схемный редактор, 
с помощью нажатия на контакты мышкой.
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.DC – Расчет по постоянному току при вариации источников
Синтаксис:
  .dc <имя 1-й переменной> <начальное значение1> <конечное значени-
е1> +<приращение1>
+[<имя 2-й переменной> <начальное значение2> < конечное значение2>
+< приращение2>]

Этот режим удобно использовать для получения статических характе-
ристик различных устройств. В качестве переменных могут выступать 
имена независимых источников тока или напряжения. При указании вто-
рого источника формируется вложенный цикл.

* Пример
*
M1 2 1 0 0 nbsim
Vgs 1 0 3.5
Vds 2 0 3.5
.dc Vds 3.5 0 -0.05 Vgs 0 3.5 0.5
.model nbsim NMOS Level=8
.end

.END – Конец списка соединений
Все строки списка соединений после этой директивы игнорируются. 

Так как схемный редактор LTSpice автоматически вставляет эту директи-
ву в конец списка соединений, то ее вводить не надо.

.ENDS – Конец описания подсхемы
Этой  директивой  отмечается  конец  описания  макромодели 

(подсхемы). См. директиву .SUBCKT для более детальной информации.

.FOUR – Фурье-анализ сигналов переходных процессов
Синтаксис:
  .four <frequency> [Nharmonics] [Nperiods] <data trace1> [<data trace2> ...]

Пример:
 .four 1kHz V(out)

Фурье-анализ  выполняется  после  завершения  расчета  переходных 
процессов.  В  директиве  задается  частота  первой  гармоники  frequency. 
Если не задан параметр Nharmonics, то рассчитываются амплитуды посто-
янной составляющей и первых девяти гармоник. Если не задан параметр 
Nperiods,  то  спектральному  анализу  подвергается  участок  переходного 
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процесса равный одному периоду в конце интервала расчета. Длитель-
ность периода определяется как 1/frequency. Если Nperiods задан равным 
-1,  то  спектральный анализ  ведется  по  полному времени переходного 
процесса.

Эта директива введена для совместимости с  SPICE-программами. В 
большинстве случаев более удобным является применение Фурье-анали-
за, встроенного в редактор графиков LTSpice.

Если директива введена, то результат ее действий можно посмотреть в 
.log файле с помощью команды меню View=>Spice Error Log .

.FUNC – определение пользовательской функции
Синтаксис:
  .func <имя функции>([аргументы]) {<выражение>}
Пример: .func Pythag(x,y) {sqrt(x*x+y*y)}
 .func директива  позволяет  создавать  пользовательские  функции  для 
параметризации схем и функциональных источников. При описании под-
схем, в них будет содержаться только ссылка на функцию. Описание под-
схем оказывается независимым от содержания функции,  что дает воз-
можность включать подсхемы в библиотечные наборы. Наборы функций 
можно записывать в файлы и подключать их к заданию на моделирова-
ние директивой .inc.

Если  .func директива включена в описание подсхемы, то ее область 
действия ограничивается этой подсхемой.

Чтобы  заменить  тот  или  иной  номинал  на  функцию,  эта  функция 
должна быть заключена в фигурные скобки.
* Пример
.func myfunc(x,y) {sqrt(x*x+y*y)}
.param u=100 v=600
V1 a 0 pulse(0 1 0 1n 1n .5µ 1µ)
R1 a b {myfunc(u,v/3)}
C1 b 0 100p
.tran 3µ
.end

Вся вычисления параметров выполняются прежде, чем начинается мо-
делирование.

.GLOBAL – Объявление глобальных узлов
Синтаксис: 
 .global <node1> [node2 [node3] [...]]

Пример: 
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.global VDD VCC
Команда  .global позволяет  объявить  область  видимости  некоторых 

узлов, упомянутых в подсхемах, за пределами этих подсхем. Эти узлы 
автоматически соединяются в основной схеме и во всех подсхемах Сле-
дует иметь ввиду, что в общий узел с именем  "0" является глобальным и 
не требует упоминания в .global инструкции. Узлы, имена которых начи-
наются с "$G_ " также являются глобальными узлами, без упоминания в 
.global инструкции.

.IC – Установка начальных условий
Директива  .ic позволяет задать начальные условия для анализа пере-

ходных процессов. Могут быть определены напряжения узлов и токи ка-
тушек индуктивности. К указанным узлам и ветвям подключаются ис-
точники напряжения и тока,  и рассчитывается режим по постоянному 
току. После завершения расчета режима по постоянному току эти источ-
ники отключаются, и при наличии директивы .tran, выполняется расчет 
переходных процессов с заданными начальными условиями. При анали-
зе по постоянному току, начальные условия используются как ограниче-
ния. В LTspice катушки индуктивности при анализе по постоянному току 
интерпретируются как источники тока с бесконечным сопротивлением.

Синтаксис:
  .ic [V(<имя узла>)=<напряжение>] [I(<имя индуктивности>)=<ток>]

Пример:
  .ic V(in)=2 V(out)=5 V(vc)=1.8 I(L1)=300m

.INCLUDE – Включение произвольного файла
Синтаксис:
  .include <filename>

Эта директива включает названный файл так, как будто этот файл был 
напечатан в списке соединений вместо команды .include. Директива по-
лезна для включения библиотек моделей или подсхем.

Может быть введен абсолютный путь для имени файла. В противном 
случае LTspice смотрит сначала в каталоге <SwCADIII>\lib\sub и затем в 
каталоге,  который  содержит  запрос  на  список  соединений,  т.е. 
<SwCADIII> - каталог, содержащий программу scad3.exe, обычно уста-
навливаемую в C:\Program Files\LTC\SwCADIII.

Обязательно  надо  указывать  расширение  файла,  например,
 ".inc myfile.lib",  но не ".inc myfile" 

Можно определить Интернет-ссылку на имя файла:
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.inc http://www.company.com/models/library.lib
Файл "library.lib" будет передан в каталог, где находится схема и вклю-

чен в задание. При многократном моделировании, чтобы не заходить в 
Интернет каждый раз, . inc инструкцию можно отредактировать на:
.inc library.lib

Если  Интернет-ссылка  не  существует,  то  появятся  непредсказуемые 
сообщения об ошибках, так как LTspice  включит страницу ошибки html 
в задание на моделирование как допустимый синтаксис SPICE.

Если http – содержит ссылку на .pdf файл, моделирование прервется 
после загрузки. Следующий пример загрузит  .pdf файл:
*Фиктивное моделирование для загрузки файла справки.
*Моделирование прервется с ошибкой, но
*файл scad3.pdf будет размещен в
*тот же самый каталог, который содержит список соединений.
.inc http://ltspice.linear.com/software/scad3.pdf
.end

.LIB – Включение библиотеки
Синтаксис:
  .lib <filename>

Эта  директива  включает  модель  и  описание  подсхемы  названного 
файла, как будто тот файл был напечатан в списке соединений вместо ко-
манды .lib. 

Если в задании на моделирование имеется ссылка на модель из файла, 
указанного в директиве .lib,  то в ОЗУ загружается на весь файл, а только 
его часть, относящаяся к данной модели. В остальном директива  анало-
гична директиве .inc.

.LOADBIAS – Загрузка данных режима по постоянному току
Синтаксис:
  .loadbias <filename>

По этой команде производится считывание из файла узловых потенци-
алов по постоянному току. Для выполнения расчета переходных процес-
сов по директиве .tran  с заданными начальными условиями этот файл 
можно предварительно отредактировать и заменить директиву .nodeset 
на .ic. Для передачи содержания файла узловых потенциалов в выходной 
файл результатов (с расширением  out) необходимо в директиве .options 
указать параметр expand.

Команда .loadbias - дополнение к команде .savebias. Сначала необходи-
мо выполнить моделирование с командой .savebias. Затем надо заменить 
команду .savebias на  .loadbias .
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.MEASURE –  Определяемые пользователем вычисления
Есть два основных вида .MEASURE инструкций.  В одном случае об-

ращаются к точке по абсциссе (независимой переменной, например, ось 
времени в .tran анализе) и во втором случае  обращаются к диапазону по 
оси абсцисс.

В первом случае выводится значение данных или значение выражения 
в определенной точке и, возможно, при выполнении определенных усло-
вий. Используется следующий синтаксис:
Синтаксис:
  .MEAS[SURE] [AC|DC|OP|TRAN|TF|NOISE] <name>
         + [<FIND|DERIV|PARAM> <expr>]
         + [WHEN <expr> | AT=<expr>]]
         + [TD=<val1>] [<RISE|FALL|CROSS>=[<count1>|LAST]]

В .MEAS директивах можно произвольно задавать тип анализа. Это 
позволяет использовать инструкции только для некоторых типов анали-
за. Обязательно присутствие  имени <name>,  которое  может использо-
ваться в других  инструкциях.   Ниже приводятся примеры .MEAS ди-
ректив, которые обращаются к отдельной точке по абсциссе:

.MEAS TRAN res1 FIND V(out) AT=5m
Выводится значение V(out) в точке t=5ms помеченное как res1.

.MEAS TRAN res2 FIND V(out)*I(Vout) WHEN V(x)=3*V(y)
Выводится значение выражения V(out)*I(Vout) как только впервые вы-

полнится условие V(x)=3*V(y).  Результат помечен как res2.

.MEAS TRAN res3 FIND V(out) WHEN V(x)=3*V(y) cross=3
Выводится значение V(out), когда условие V (x) =3*V (y) выполнено в 

третий раз. Результат имеет метку res3.

.MEAS TRAN res4 FIND V(out) WHEN V(x)=3*V(y) rise=last
Выводится  значение  V(out) в  те  моменты  времени,  когда  условие 

V(x)=3*V(y) было выполнено при значениях V(x) больших, чем 3*V(y). 
Результат помечен res4.

.MEAS TRAN res5 FIND V(out) WHEN V(x)=3*V(y) cross=3 TD=1m
Выводится значение  V(out), когда условие  V(x)=3*V(y) выполнено в 

третий раз, но не ранее как через 1мс.  Результат имеет метку res5.

.MEAS TRAN res6 PARAM 3*res1/res2
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Выводится величина 3*res1/res2.  Эта форма полезна для того, чтобы 
выводить выражения других .meas операторных результатов.  Не преду-
сматривается присутствия в формуле, которая будет вычислена, выраже-
ний вида V(3) (выражений, основанных на прямых данных моделирова-
ния). Но если такие  данные все-таки приводятся, то берется значение 
для последней моделируемой точки. Результат данного примера помечен 
как res6.

 В приведенных примерах, при обращении к одной точке по абсциссе, 
требуемый результат основан на координатных данных (зависимых пере-
менных).  Если в  .MEAS операторе  никакая координатная информация 
не затребована, выводится точка по абсциссе, при выполнении заданного 
условия:
.MEAS TRAN res6 WHEN V(x)=3*V(y)
Выводится время наступления условия V(x)=3*V(y).  Результат помечен 
res6.
Второй вид .MEAS директивы обращается к диапазону по абсциссе. 

Синтаксис:
  .MEAS [AC|DC|OP|TRAN|TF|NOISE] <name>
         + [<AVG|MAX|MIN|PP|RMS|INTEG> <expr>]
         + [TRIG <lhs1> [[VAL]=]<rhs1>] [TD=<val1>]
         + [<RISE|FALL|CROSS>=<count1>]
         + [TARG <lhs2> [[VAL]=]<rhs2>] [TD=<val2>]
         + [<RISE|FALL|CROSS>=<count2>]

Диапазон  абсциссы  определен  точками,  задаваемыми  в  "TRIG"  и 
"TARG".  Если опущено TRIG значение, то по умолчанию происходит 
обращение к началу моделирования.  Точно так же TARG по умолчанию 
указывает значения до конца моделирования.  Если все три значения для 
TRIG, TARG и WHEN точек опущены, то директива работает по полно-
му диапазону данных оси абсцисс. Виды операций, которые могут быть 
выполнены на интервале:
AVG  - вычисление среднего числа <expr>
MAX  - поиск максимального значения <expr>
MIN  - поиск минимального значения <expr>
PP  - поиск удвоенной амплитуды <expr>
RMS  - вычисление среднеквадратичного значения <expr>
INTEG  - интегрирование <expr>
где <expr>  - выражение.
 Если никакая операция не определена, результат директивы - расстояние 
по абсциссе между TRIG и TARG точками.  Ниже приводятся примеры 
интервальных директив:
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 .MEAS TRAN res7 AVG V(NS01)
 + TRIG V(NS05) VAL=1.5 TD=1.1u FALL=1
 + TARG V(NS03) VAL=1.5 TD=1.1u FALL=1

Выводится среднее значение потенциала на узле V(NS01) от 1-ого па-
дения  V(NS05) к 1.5V после 1.1мкс и первого падения  V(NS03) к 1.5V 
после 1.1мкс.  Результат имеет метку res7.

Для частотного анализа, условные выражения с комплексными числа-
ми  переводятся  к  условиям  с  вещественными  числами,  выражения 
преобразуются к амплитудному значению.  Например:
 .MEAS AC rel8 when V(out)=1/sqrt(2)
Результат  rel8  -  частота,  при  которой  амплитуда  V(out) равна 
0.70710678118655.

Результаты, полученные в одной директиве, могут быть использованы 
в  другой  инструкции.  Далее  продемонстрировано  вычисление  полосы 
пропускания 3дБ:
 .MEAS AC tmp max mag(V(out))   ; поиск максимального значения и  

;пометка   результата именем "tmp"
 .MEAS AC BW trig mag(V(out))=tmp/sqrt(2) rise=1
 +           targ mag(V(out))=tmp/sqrt(2) fall=last

В результате будет выведена разница в частоте между двумя точками, 
отстоящими на 3дБ вниз от максимального значения.  Примечание: Дан-
ные при частотном анализе являются комплексными числами, как и ре-
зультаты директивы.  Однако, равенство в условиях относится только к 
вещественной  части  комплексного  числа,  то  есть "mag(V(out))  = 
tmp/sqrt(2)" эквивалентно  Re(mag(V(out))) = Re(tmp/sqrt(2)).

Операции AVG, RMS, и  INTEG различны для .NOISE анализа и дру-
гих типов анализа, так как шум уже интегрирован по частоте. Следова-
тельно,  AVG и RMS дает среднеквадратическое шумовое напряжение, а 
INTEG дает интегрированный полный шум.  Например, если добавляют-
ся директивы SPICE
 .MEAS NOISE out_totn INTEG V(onoise)
 .MEAS NOISE in_totn INTEG V(inoise)
к  .noise-анализу, то в .log файле будет напечатан интегрированный пол-
ный шум.

.MEAS директивы могут быть выполнены в графическом постпроцес-
соре, после того, как моделирование закончено. Это позволяет записы-
вать сценарий .MEAS инструкций и выполнять его на наборе выходных 
данных. Для этого надо сделать окно графического постпроцессора ак-
тивным, и выполнить команду меню File=>Execute .MEAS Script. 
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Есть одно последствие .MEAS директив, выполненных в графическом 
постпроцессоре. Точность .MEAS операторного вывода будет ограниче-
на точностью данных после сжатия.  Можно откорректировать парамет-
ры сжатия для более точного .MEAS операторного вывода.

 .MODEL – Определение  SPICE модели
Определение модели для диода, транзистора, ключа,  линии передачи 

с потерями и однородной емкостно-резистивной линии.
Некоторые элементы схемы, например, транзисторы, имеют много па-

раметров. Вместо того, чтобы определять каждый параметр транзистора 
для каждого типа транзистора, транзисторы сгруппированы по типовым 
именам и имеют общие параметры. Транзисторы той же самой модели 
могут иметь разные размеры, и электрическое поведение масштабирует-
ся к размеру образца.
Синтаксис:
  .model <modname> <type>[(<parameter list>)]

Имя модели <modname> должно быть уникально. То есть два различ-
ных типа элементов  схемы,  например,  диода и  транзистора,  не  могут 
одно и то же имя. Список параметров зависит от типа модели  <type>. 
Ниже  приведен список типовых имен моделей:
Тип     ассоциированный схемный элемент
SW       ключ, управляемый напряжением
CSW      ключ, управляемый током
URC      Однородная RC-линия
LTRA     линии передачи с потерями
D          диод
NPN      NPN биполярный транзистор
PNP      PNP биполярный транзистор 
NJF      N-канальный полевой транзистор (JFET)
PJF       P-канальный полевой транзистор (JFET)
NMOS     МОП-транзистор (MOSFET) с каналом N-типа  
PMOS     МОП-транзистор (MOSFET) с каналом P –типа
NMF      N-канальный MESFET (модификация Арсенид-Галиевого тран-
зистора)
PMF      P-кагальный MESFET
VDMOS  Мощный вертикальный МДП-транзистор технологии двойной 
диффузии

Список параметров приводится в описании соответствующего элемен-
та.

64



.NODESET – Установка приближенных значений для начального 
решения по постоянному току

Директива позволяет облегчить вычисление рабочей точки в статиче-
ском режиме. Если схема имеет несколько возможных состояний по по-
стоянному току как, например, для триггерных схем, итеративный про-
цесс при поиске решения по постоянному току может не сойтись. В этих 
случаях директива  может задать конкретное состояние схемы. К узлам, 
указанным в директиве, подключаются источники постоянного напряже-
ния, и рассчитывается одна итерация. Затем источники отключаются, и 
итерационный процесс продолжается.
Синтаксис:
  .NODESET V(узел1)=<напряжение> [V(узел2)=<vнапряжение [...]]

.NOISE –  Анализ шума
На каждой частоте рассчитывается спектральная плотность выходного 

напряжения, вызванная независимыми источниками внутреннего шума 
(резисторами, ключами и полупроводниковыми приборами)
Синтаксис:
  .noise V(<out>[,<ref>]) <src> <oct, dec, lin>
         + <Nsteps> <StartFreq> <EndFreq>
Выходное  напряжение  указывается  по  спецификации  V(<out>[,<ref>]). 
Если задана спецификация вида  V(n1,  n2), то вычисляется напряжение 
между узлами.  К входным узлам цепи подключается независимый ис-
точник напряжения или тока с именем <src> . Этот источник служит для 
обозначения входных зажимов. Выходной шум пересчитывается к вход-
ным зажимам цепи. Если к входу подключается источник напряжения, то 
на входе рассчитывается эквивалентная спектральная плотность напря-
жения шума Suвх(f) [В2/Гц], если источник тока, то рассчитывается экви-
валентная  спектральная  плотность  тока  Siвх(f)  [A2/Гц].  Уровень  шума 
пересчитывается с выхода на вход делением спектральной плотности вы-
ходного напряжения  Suвых  на квадрат модуля соответствующей переда-
точной функции. Внутреннее сопротивление генератора сигнала должно 
быть включено в описание схемы как отдельный резистор. На каждой 
частоте рассчитывается не только спектральная плотность суммарного 
шума, но и вклад в нее каждого шумового источника. Параметры <oct, 
dec, lin>, <Nsteps>, <StartFreq> и <EndFreq> аналогичны параметрам, за-
даваемым в директиве .ac .

В  качестве  выходной  переменной  используются:  V(onoise) –  корень 
квадратный из Suвых(f), V(inoise) - корень квадратный из Suвх(f). Если вход 
определен как источник тока, то в выходных данных используется inoise 
- корень квадратный из Siвх(f).  Может быть отображен шумовой вклад 
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каждого компонента. Эти вклады отнесены к выходу. Их можно отнести 
к входу, делением на коэффициент усиления ("gain").

По  результатам  расчета  спектральной  плотности  внутреннего  шума 
легко вычисляется дифференциальный коэффициент шума:

Кш(f)=Suвх(f)/Suг,  где  Suвх(f)  –  спектральная  плотность  напряжения 
шума, обусловленная шумом внутреннего сопротивления генератора  Rг 
и внутренним шумом схемы, пересчитанная на его вход.  Suвх(f)= V(in-
oise)2;  Suг =4k·T0·Rг –  спектральная  плотность  напряжения  шума вну-
треннего сопротивления генератора;  k=1,38·10-23 Дж/град. – постоянная 
Больцмана; Т0=300.15К – номинальная температура в градусах по Кель-
вину. 

Дифференциальный коэффициент шума может быть вычислен в деци-
белах как функция внутреннего сопротивле-
ния  генератора.  Для  этого  может  быть  ис-
пользована SPICE-директива .func:
.func NF(R) 
+10*log10(V(inoise)*V(inoise)/(4*k*300.15*R))

На рисунке приведен пример схемы, под-
готовленной для анализа шума (см.  файл 
<SwCADIII>\examples\Educational\NoiseFig-

ure.asc).

.OP –  Поиск рабочей точки по постоянному току
Расчет рабочей точки по постоянному току автоматически выполняет-

ся перед всеми видами анализа. Эта директива применяется только в тех 
случаях, когда требуется найти только рабочую точку. После моделиро-
вания по этой директиве, можно указать узел или ток – результат появит-
ся в строке состояния.

.OPTIONS – Установка опций моделирования
Ключевое слово  - [тип данных] (значение по умолч.) – Описание.
abstol  [число] (1pA) - Допустимая ошибка расчета тока в режиме TRAN
baudrate   [число] (нет)- Используется для графического постпроцессора
chgtol [число] (10fC)-Допустимая ошибка расчета заряда в режиме TRAN 
defad [число] (0.) -Диффузионная площадь стока МОП-транзистора(AD)
defas [число] 0.   - Диффузионная площадь истока МОП-транзистора(AS)
defl       [число] 100µm - Длина канала МОП-транзистора (L)
defw   [число] 100µm - Ширина канала МОП-транзистора (W)
delay    [число] (нет) - Сдвигает разрядные переходы в диаграмме.
flagloads [флаг] false- пометка внешних источников тока как загружаемых
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frain   [число] (нет) - Входной узел для многократного анализа 
fraout   [число] (нет) - Выходной узел для многократного анализа
frastop    [число] (нет) - верхняя частота для многократного анализа 
frastart   [число] (нет) - нижняя частота для многократного анализа
fraamp   [число] (нет) - fra func ampl. for freq.response analysis
fravref   [число] (нет) - additional DC offset of Vin  Freq. response analysis
Gmin    [число]  (1e-12)  -  Минимальная  проводимость  ветви(меньшая 
проводимость считается равной нулю)
itl1 [число] 100. -максимальное число итераций при анализе по пост.току
itl2     [число] 50.  - Максимальное число итераций при расчете переда-
точных функций по постоянному току при переходе к следующей точке.
itl4    [число] 10.  - Максимальное число итераций при переходе к следу-
ющему моменту времени в режиме TRAN
itl6  [число] 25.  - число шагов, используемых в продвижении источника 
(применяется при плохой сходимости по постоянному току при поиске 
рабочей точки)
srcsteps  [число] 25.  - альтернативное имя для itl6
maxclocks  [число] infin.- максимальное число циклов записи 
maxstep [число]  infin.- максимальный шаг при расчете переходных про-
цессов
measdgt [число] 6 -Число результатов, помечаемых в .measure-директивах
method  [строка] trap  - Численный метод интегрирования, используется 
также trapezoidal или Gear 
minclocks [число] 10   - минимальное число циклов записи
nomarch [флаг] false - не запускать графический постпроцессор.
noopiter  [флаг] false -Идти непосредственно к  gmin stepping. 
numdgt [число]   6   - Исторически "numdgt" используется для задания 
числа знаков в выходных данных. В LTspice, если "numdgt" устанавлива-
ется > 6, то используется двойная точность для представления перемен-
ных
oversample [число] (нет) - For Freq. response analysis
pivrel [число] 1e-3  - Относительная величина элемента строки матрицы, 
необходимая для его выделения в качестве ведущего элемента
pivtol [число] 1e-13 - Абсолютная величина элемента строки матрицы, 
необходимая для его выделения в качестве ведущего элемента (режим 
АС)
reltol [число] 0.001 - Допустимая относительная ошибка расчета напря-
жений и токов в режиме TRAN
startclocks [число]  5   -  number of clock cycles to wait before looking for 
steadystate  число тактовых циклов, необходимых для поиска установив-
шегося процесса
sstol [число] 0.001 -  относительная ошибка для обнаружения установив-
шегося режима 
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temp  [число] 27°C  - Заданная по умолчанию температура для типовых 
элементов схемы. 
 tnom  [число] 27°C  - Заданная по умолчанию температура для модель-
ных  элементов схемы.
topologycheck [число]  1   - Устанавливается ноль для игнорирования ви-
сячих узлов и контуров источников напряжения
trtol  [число] 1.0  - Set the transient error tolerance.  This parameter is an esti-
mate of the factor by which the actual truncation error is overestimated.
trytocompact [флаг] not set - Если установлен этот флаг, то производится 
уплотнение информации для входных напряжений и токов.
vntol   [число]  1µV  - Допустимая ошибка в расчетах напряжений в ре-
жиме TRAN
plotreltol  [число] .0025 - Установка относительной ошибки сжатия для 
графического постпроцессора
plotvntol  [число] 10µV  - Установка абсолютной ошибки сжатия напря-
жения для графического постпроцессора
plotabstol  [число] 1nA  - Установка абсолютной ошибки сжатия тока для 
графического постпроцессора
plotwinsize [число] 300  - Количество данных, сжимаемых в одном окне. 
Для отключения сжатия, указывается ноль.

.PARAM – Определяемые пользователем параметры
Директива создает определяемые пользователем переменные. Это поз-

воляет параметризовать подсхемы и сохранить их в библиотеках.  Если 
директива param включена в описании подсхемы, то ее область действия 
распространяется только на эту подсхему и на подсхемы, включенные в 
нее. Чтобы вызывать замену параметра и вычисление выражения, надо 
заключить выражение в изогнутые фигурные скобки.

Ниже приводится пример использования директивы  param для непо-
средственной передачи параметров в строке, ссылающейся на подсхему.
*
* Здесь описание схемы
.params x=y y=z z=1k*tan(pi/4+.1)
X1 a b 0 divider top=x bot=z
V1 a 0 pulse(0 1 0 .5µ .5µ 0 1µ)
* Здесь описание подсхемы
.subckt divider n1 n2 n3
r1 n1 n2 {top}
r2 n2 n3 {bot}
.ends
*
.tran 3µ
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.end
Вычисление параметра начинается после обнаружение фигурных ско-

бок, после этого вычисляются все доступные выражения.

.SAVE – Ограничения на количество записываемых данных
Ряд режимов моделирования, особенно расчет переходных процессов, 

может генерировать большое количество данных. Их число может быть 
ограничено,  использованием  save-директивы. В этом случае записыва-
ются только те напряжения и токи, которые представляют интерес.

Синтаксис:  
  .save V(out) [V(in) [I(L1) [I(S2)]]]  [dialogbox]

Директива .save I(Q2) сохранит токи базы, коллектора и эммитера би-
полярного транзистора Q2. Чтобы записать только ток коллектора, надо 
указать Ic(Q2).

В директиве могут использоваться групповые символы '*' и '?'.  Напри-
мер, ".save V(*) Id (*)" сохранит только все потенциалы и все токи стока.

Если определено ключевое слово "dialogbox", то отображается диало-
говое окно со списком всех доступных потенциалов и токов. Если моде-
лирование ведется с использованием схемного редактора LTspice, то вы-
вод на график нужного тока или потенциала может быть задан непосред-
ственно по схеме.

.SAVEBIAS – Сохранение данных режима по постоянному току
Синтаксис:
 .savebias <filename> [internal]
+ [time=<value> [repeat]] [temp=<value>] [step=<value>]
+ [DC1=<value>] [DC2=<value>] [DC3=<value>]

По этой команде  записывается текстовый файл с именем, указанным в 
<filename>, который впоследствии может быть загружен командой load-
bias  при последующем моделировании. 

Команды  savebias и loadbias применяются при расчете больших схем 
или схем, для которых по тем или иным причинам расчет режима по по-
стоянному току занимает большое время. В этом случае найденное один 
раз решение сохраняется на диске по директиве savebias и по директиве 
loadbias загружается перед выполнением этого или других видов анали-
за.

Можно добавить ключевое слово "internal", для сохранения потенциа-
лов внутренних узлов подсхем.  

Параметры [time=<value>  [repeat]]  определяют  моменты  времени,  в 
которые запоминаются узловые потенциалы схемы при расчете переход-
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ных процессов. Если параметр repeat не указан, то узловые потенциалы 
запоминаются в первый момент времени, равный указанному значению 
(с точностью до шага интегрирования) или превышающий его. При на-
личии параметра [repeat], параметр <value> равен интервалу времени, с 
которым узловые потенциалы запоминаются, при этом в файле сохраня-
ется только последняя запись.

Параметр  [temp=<value>] задает температуру, для которой сохраняют-
ся узловые потенциалы при вариации температуры, а параметр 
[step=<value>] задает интервал температур, через который обновляется 
запись в файл.

Параметры [DC1=<value>] [DC2=<value>] [DC3=<value>] задают зна-
чения параметров, варьируемых по директиве .DC, для которых произво-
дится запись в файл. Параметр [DC1=<value>] используется только при 
вариации одной переменной, а DC2, DC3 – при вариации двух перемен-
ных (соответственно первой и второй).

Образуемый на диске текстовый файл имеет следующий формат. Сна-
чала на одной или более строках в виде комментариев указываются имя 
схемы, заголовок, дата создания, затраты времени на расчет, тип анализа, 
температура и т.п.  Далее помещается единственная директива .NODE-
SET, содержащая полную информацию об узловых потенциалах схемы. 
При модификации схемы,  файл  может  быть  отредактирован  вручную, 
добавляя или исключая из директивы .NODESET узлы или корректируя 
их потенциалы.

.STEP – Вариация параметров
Эта команда позволяет выполнить многовариантный расчет при изме-

нении температуры, параметра модели, глобального параметра или неза-
висимого источника. Варьируемый параметр может задаваться в опреде-
ленном диапазоне с линейным или логарифмическим шагом прираще-
ния, или в виде списка значений. 
Примеры:
.step oct v1 1 20 5 

Здесь изменение напряжения независимого источника  v1 задается  в 
диапазоне от 1 до 20 Вольт в логарифмическом масштабе,  5 точек на 
октаву.

.step I1 10u 100u 10u 
Изменение тока независимого источника  I1 задается в диапазоне от 

10мкА до 100мкА при линейном приращении тока с шагом 10мкА.

.step param RLOAD LIST 5 10 15 
Моделирование  будет  выполнено  3  раза  с  глобальным  параметром 

Rload равным 5, 10 и 15
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.step NPN 2N2222(VAF) 50 100 25 
Параметр VAF в модели NPN-транзистора меняется от 50 до 100 с шагом 
25

.step temp -55 125 10 
Температура меняется от -55°C до 125°C с шагом 10 градусов. 10-degree 
step. Step sweeps may be nested up to three levels deep.

Возможно  изменение  сразу  нескольких  параметров,  но  не  больше 
трех. В этом случае формируются вложенные циклы. 

.SUBCKT – Описание подсхемы
Многократно повторяющиеся участки схемы могут быть определены 

как подсхема. В результате эти участки заменяются ссылками на описа-
ние этой подсхемы.  Перед моделированием список соединений схемы 
расширяется заменой каждого обращения к подсхеме ее элементами.

Окончание описания подсхемы обозначается директивой .ends.
Ниже приведен пример описания подсхемы:
*
* Описание схемы
X1 a b 0 divider
V1 a 0 pulse(0 1 0 .5µ .5µ 0 1µ)
* Описание подсхемы
.subckt divider n1 n2 n3
r1 n1 n2 1k
r2 n2 n3 1k
.ends
.tran 3µ 
.end
В результате непосредственно для моделирования будет сформирован 

следующий список соединений:

* Х1 разворачивается в цепь из 2-х транзисторов
r:х1:1  a  b  1k
r:х1:2  b  0  1k
*
v1  a  0  pulse(0 1 0 .5µ .5µ 0 1µ)
.tran  3µ
.end
Имена элементов подсхем и имя подсхемы образуют полное имя этих 

элементов.
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.TEMP – вариация температуры
Директива является архаичной формой для задания списка значений 

температуры при многовариантном расчете. 
Синтаксис:
  .TEMP <T1> <T2> ... 
 эквивалентно:  
  .STEP TEMP LIST <T1> <T2> ...

.TF – Расчет малосигнальных передаточных функций
По  этой  директиве  выполняется  расчет  по  постоянному  току  в 

окрестности рабочей точки и, после линеаризации схемы, рассчитывают-
ся передаточные функции при малых изменениях входного независимого 
источника. Если выходная переменная – ток, то для его определения ис-
пользуется измерительный источник напряжения с нулевым значением 
напряжения.
Синтаксис:
   .TF V(<узел>[, <2-й узел>]) <имя источника>
   .TF I(<имя независимого источника напряжения>) <имя источника>
Примеры:
          .TF V(out)   Vin
          .TF V(5,3)   Vin
          .TF I(Vload) Vin

.TRAN – Расчет переходных процессов
В LTspice могут применяться две формы директивы:

Синтаксис:
  .TRAN <Tstep> <Tstop> [Tstart [dTmax]] [modifiers]
  .TRAN <Tstop> [modifiers]

Первая форма - традиционная команда SPICE.  <Tstep> - приращение 
времени  для  построения  графиков,  также  используется  как  предвари-
тельное  задание  размера  расчетного  шага.  LTspice использует  сжатие 
данных при их графическом отображении, так что этот параметр мало-
значим и может быть опущен или установлен в нуль.  <Tstop> - продол-
жительность моделирования. Переходные процессы как правило, рассчи-
тываются  с  нулевого  момента  времени.  Однако,  если  задан  параметр 
Tstart,  то  результаты  между  нулевым  временем,  и  временем,  равным 
Tstart не сохраняются. Этот параметр может использоваться для регули-
рования размеров выходных файлов, позволяя проигнорировать процес-
сы при запуске схемы. Параметр dTmax, является максимальным шагом 
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интегрирования уравнений схемы. Если заданы  Tstart и  dTmax, то дол-
жен быть задан шаг  Tstep.

В директиве  tran может присутствовать несколько опций [modifiers]: 
UIC, steady, nodiscard, startup и step.

UIC (Use Initial Conditions – использовать начальные условия): Перед на-
чалом расчета переходных процессов всегда рассчитывается режим по 
постоянному току. Если установлена опция UIC, то расчет режима по по-
стоянному току отменяется. Начальные значения напряжений на емко-
стях и токов индуктивностей указываются в опциях IC=… при описании 
емкостей и индуктивностей, а все начальные значения узловых потенци-
алов указываются в директиве .IC. 

Опцию UIC следует применять с осторожностью. Пропуск расчета по 
постоянному току, в котором отыскивается рабочая точка, может приве-
сти к нефизическому начальному состоянию. Например, рассмотрим ис-
точник напряжения, соединенный параллельно с емкостью. При нулевых 
начальных условиях на емкости в первый шаг должен появиться беско-
нечный ток,  заряжающий емкость.  Алгоритм моделирования будет со-
кращать расчетный шаг, чтобы ток стал конечной величиной, что приве-
дет к сообщению об ошибке вида  "time step too small convergence fail" 
("шаг по времени слишком маленький").

steady:  Прервать моделирование при достижении установившегося со-
стояния.

Возможно полуавтоматическое определение установившегося состоя-
ния. Для этого после запуска моделирования надо воспользоваться ко-
мандами меню Simulate=>Efficiency Calculation=>Mark Start и
Simulate=>Efficiency Calculation=>Mark End.

Рекомендуется  использовать  .ic директиву  для  ускорения  выхода на 
установившийся режим. Амплитуда ошибки при поиске установившего-
ся состояния задается в опции sstol.

nodiscard: Не удалять часть переходного процесса до установившегося 
состояния.

startup: Рассчитать начальную рабочую точку с отключенными незави-
симыми источниками тока и напряжения. После этого запустить расчет 
переходных процессов и включить эти источники в первые 20мкс моде-
лирования.
 
step:  Вычислять пошаговый отклик схемы.

Эта опция работает с источниками тока, загружаемыми в виде списка 
с шагом по току. Процедура расчета следующая:
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1) вычисление установившегося состояния и удаление части переходного 
процесса, если не установлена опция nodiscard;
2) линейное нарастание следующего значения тока из списка со скоро-
стью нарастания 20 А/мкс;
3) вычисление установившегося состояния
4) загрузка следующего значения тока из списка или завершение расчета, 
если список исчерпан

При сложных схемах автоматический переход на новое значение из 
списка  может не  произойти.  В  этом случае  рекомендуется  применить 
при расчете переходных процессов кусочно-линейное задание источника 
тока, например:  

PWL(0 0.5 1m 0.5 1.01m 0.1  3m 0.1 3.01m 0.5)
что означает:
загрузка начального тока 0.5A в нулевой момент времени, 
фиксация 0.5A в течении 1мс,
переключение на 0.1A в момент 1.01мс, 
фиксация 0.1A в течение 3мс, 
переход к 0.5A к моменту 3.01мс и фиксация  0.5A.  

PWL может  иметь  почти  неограниченную  последовательность  пар 
(время, значение).

   
 .WAVE – Запись потенциалов в .Wav файл.

LTspice может записывать .wav аудио-файлы. Эти файлы можно про-
слушивать или использовать как входные данные для другого моделиро-
вания.

Синтаксис:
 .wave <filename.wav> <Nbits>  <SampleRate> V(out) [V(out2) ...]

Пример:
 .wave C:\output.wav 16 44.1K V(left) V(right)

<имя файла.wav> может включать или абсолютный путь к файлу или от-
носительный  путь,  содержащий  схему  или  список  соединений.  Если 
путь к файлу содержит пробелы, то он заключается в кавычки.
 <Nbits> - число битов на канал. Допустимый диапазон - от 1 до 32 би-
тов.
<SampleRate> число записей  выборок в моделируемую секунду. Допу-
стимый диапазон от 1 до 4294967295 выборок в секунду.
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Остальная часть синтаксиса перечисляет узлы, напряжения на кото-
рых требуется записать. Каждому узлу будет соответствовать независи-
мый канал в .wav файле. Число каналов может быть от одного до 65535. 
Так же как и узловое напряжение, можно записать ток, например, Ib(Q1). 
.wav-аналоговый файл преобразуется в цифровой сигнал в диапазоне от 
-1 до +1 Вольта  или Ампера.

Следует обратить внимание на то, что возможно записать .wav файлы, 
которые нельзя запустить в звуковой системе вашего компьютера из-за 
числа каналов, скорости выборки  или числа битов,  в связи с ограниче-
ниями кодер-декодера. Вместе с тем эти .wav файлы могут использовать-
ся в LTspice как входные данные для другого моделирования. При запус-
ке  .wav файла на звуковой плате вашего компьютера, следует иметь в 
виду, что обычно поддерживаемые файлы .wav форматы имеют 1 или 2 
канала;  8  или  16  битов/канал  и  скорость  выборки  составляет  11025, 
22050, или 44100 Гц.
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Выходные переменные
1. При расчете переходных процессов и расчете по постоянному току ис-
пользуются следующие обозначения для переменных [3]:
Общая форма Пример Пояснение
V(<узел>) V(2) Потенциал узла
V(<+узел>,<-узел>) V(2,4) Разность потенциалов узла

V(<имя>) V(R1) Разность потенциалов между выводами двух-
полюсного компонента

Vх(<имя>) VB(Q1) Потенциал вывода многополюсного компонен-
та

Vху(<имя>) VCE(Q3) Разность потенциалов между выводами много-
полюсного компонента

Vz(<имя>) VA(T2) Напряжение на входе или выходе линии пере-
дачи  (z=A - вход, z=B - выход)

I(<имя>) I(D5) Ток через двухполюсный компонент
Iх(<имя>) IB(Q1) Ток  через  указанный  вывод  многополюсного 

компонента
Iz(<имя>) IA(T3) Ток через входные или выходные зажимы ли-

нии передачи (z=A - вход, z=B - выход)
В  спецификации  переменных  V(<имя>),  I(<имя>)  параметр  <имя> 

указывает на один из двухполюсных компонентов, имена которых начи-
наются со следующих букв: С –  конденсатор; D – диод; Е – ИНУН; F – 
ИТУТ; G – ИТУН; Н –ИНУТ; I – независимый источник тока; L – индук-
тивность; R – резистор; S – ключ, управляемый напряжением; V – неза-
висимый источник напряжения; W – ключ, управляемый током.
В спецификациях переменных Vх(<имя>), Vху(<имя>) и Iх(<имя>) пара-
метр <имя> указывает имя трехполюсного или четырехполюсного 
компонента, а х и у – аббревиатуры их выводов (см. след. табл.).

Имена трех- и четырехполюсных компонентов
Первая буква Компонент Аббревиатура вывода
В Арсенид-галлиевый полевой 

транзистор
D (сток),G (затвор), S (исток)

J Полевой транзистор D (сток), G (затвор), S (исток)
М МОП-транзистор D (сток),G (затвор), S (исток) 

В (подложка)
Q Биполярный транзистор С (коллектор), В (база),

Е (эмиттер), S (подложка)
Т Линия передачи VA (входное напряжение)

IA (входной ток)
VB (выходное напряжение)
IB (выходной ток)

Z Статически индуцированный 
биполярный транзистор

С (коллектор), G (затвор),
 Е (эмиттер)
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Например,  напряжение коллектор – база  транзистора Q3 обозначается 
как VCB(Q3).

В спецификациях переменных Vz(<имя>),  Iz(<имя>) в качестве пара-
метра <имя> указывается имя линии передачи (начинается с буквы Т), а 
символ z принимает два значения: А – вход, В – выход линии передачи.

2. Режим расчета частотных характеристик. При выводе результатов 
расчета частотных характеристик к именам переменных, перечисленным 
выше, добавляются суффиксы, перечисленные  ниже в табл.

Суффиксы имен переменных при расчете частотных характеристик
Суффикс Пример Пояснение

V(2,3) Модуль
М VM(2) Модуль
DB VDB(R1) Модуль в децибелах
Р VCEP(Q3) Фаза в радианах
G IAG(T2) Групповое запаздывание
R IR(VIN) Действительная часть
I II(R13) Мнимая часть

В отличие от режимов DC и TRAN в режиме АС возможен вывод токов 
не всех компонентов, а только следующих: R — резисторы; С — конден-
саторы; I — независимые источники тока; L — индуктивности; Т — ли-
нии передачи; V — независимые источники напряжения. Для вывода то-
ков других устройств необходимо последовательно с ними включить не-
зависимый источник напряжения с нулевой ЭДС и затем указать специ-
фикацию тока этого источника.

3. Анализ уровня внутреннего шума. При расчете уровня внутреннего 
шума имена выходных переменных имеют стандартный вид:
INOISE — эквивалентный уровень шумового напряжения или тока на 
входе цепи, равный  Sвх  f 

ONOISE — уровень напряжения шума на выходе, равный  Suвых
 f 

DB(INOISE) — эквивалентный уровень шумового напряжения или тока 
на входе в децибелах;
DB(ONOISE) — уровень напряжения шума на выходе в децибелах.

В графическом постпроцессоре корень квадратный из  спектральной 
плотности  напряжения  и  тока  внутреннего  шума  выводится  в  виде 
V(INOISE), I(INOISE), V(ONOISE).
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Графический постпроцессор
Выбор графиков

Есть три основных способа выбора графиков.
  1.  Отображение графиков непосредственно из схемы;
  2.  В диалоговых окнах командами меню Plot Settings=>Visible Traces и 
Plot Settings=>Add Trace;
1. Отображение графиков непосредственно из схемы:

Курсором указать  провод  –  курсор  отобразится  в  виде  пробника,  и 
щелкнуть левой кнопкой мыши -  появится график потенциала на этом 
проводе относительно "земли". Если то же самое выполнить при нажа-
той клавише Alt, то курсор отобразится в виде токовых клещей (красная 
стрелка на клещах покажет направление тока) и при нажатии на левую 
кнопку мыши появится график тока через проводник. График тока отоб-
разится, если курсор навести на двухполюсник или на контакт многопо-
люсника. Если второй раз указать ток или напряжение, то отобразится 
только указанный график – все остальные будут стерты. Удалить график 
можно,  активизируя  панель  графиков  и  нажав  пиктограмму  удаления 
объектов. Курсор в виде ножниц надо навести на название удаляемого 
графика.  Для отображения напряжения между узлами, надо нажать на 
один узел и перетащить курсор на второй узел. Курсор в виде красного 
пробника сохранится на первом узле и в виде черного пробника на вто-
ром узле. Для отображения мгновенной мощности надо навести курсор 
на двухполюсник или на контакт многополюсника, и нажать на клавишу 
Alt.

Отображением графиков непосредственно из схемы можно воспользо-
ваться для схем любого уровня иерархии.
2. Команды меню Plot Settings=>Visible Traces и View=>Add Trace:
Эти команды доступны из главного меню при активной панели графи-
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Рис.18. Отображение графиков тока, напряжения и мгновенной мощно-
сти непосредственно из схемы.



ков. Такой же результат можно получить, если при активной панели гра-
фиков  нажать   правую  кнопку  мыши  и  выбрать  в  меню
 Visible Traces или Add Trace. 

В результате в первом случае появится диалог, позволяющий выбрать 
нужный график из полного списка графиков. При нажатой  Ctrl можно 
выбрать  графики в  произвольном порядке,  при нажатой  Alt оттягивая 
мышь,  можно  выбрать  некоторое  число  последовательно  следующих 
друг за другом графиков, при на жатой Alt и двойном клике мышью по-

явится окно для ввода алгебраического выражения.
Во втором случае отличия будут в следующем. Нельзя непосредствен-

но  удалить  уже  видимые  графики.  Преимущества:  можно  отобразить 
список графиков по шаблону и можно ввести выражение для отображае-
мого графика.

Размер экрана
LTspice автоматически  масшта-

бирует размер окна для построения 
графика.  Чтобы  изменить  размер 
окна на области, надо нажатой ле-
вой  кнопкой  мыши  оттянуть  пря-
моугольник нужных размеров. 
На панели имеются кнопки, позво-
ляющие  уменьшить  масштаб,  вы-
полнить панорамирование, автома-
тически выбрать масштаб или вер-
нуться к  исходному размеру окна. 
Есть  также  возможность  отката 
(отмена и восстановление) команд, 

если  в  главном  меню набрать  Plot 
Setting –Undo/Redo.
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Рис.19. Отображение графиков через диалоговые окна.

Рис.20.  Масштабирование  графи-
ков.



Математическая обработка графиков
Имеется три способа обработки графиков:

1.  Преобразование графиков по математическому выражению.
2.  Вычисление среднего и среднеквадратичного значения.
3.  Отображение результатов Фурье-преобразования графиков.
 

 Преобразование графиков по математическому выражению.

Перевести курсор на на-
звание графика и кликнуть 
правой  кнопкой  мыши.  В 
появившемся окне (рис.21) 
можно  ввести  требуемое 
выражение.  Разность  по-
тенциалов,  например, 
V(a)-V(b)  может  быть  за-
писана  в  эквивалентной 
форме V(a,b).

Рис.21. Ввод математического выражения при обработке графиков.

Приведенные в  таблице  операции сгруппированы в  обратном порядке 
старшинства вычисления:
& преобразование операнда к Булевской переменной и выполнение опера-

ции И

| преобразование операнда или выражения к Булевской переменной
и выполнение операции ИЛИ

^ преобразование операнда или выражения к Булевской переменной 
и выполнение операции исключающее ИЛИ

< истина,  если выражение слева -  меньше чем выражение справа,  иначе 
ложь

> истина, если выражение слева больше чем выражение справа, иначе ложь
<
=

истина, если выражение слева меньше чем или равно выражение справа, 
иначе ложь

>
=

истина, если выражение слева больше чем или равно выражение справа, 
иначе ложь

+ сложение с плавающей запятой
- вычитание с плавающей запятой 
* умножение с плавающей запятой 
/ деление с плавающей запятой 
*
* возведение в степень 

! преобразование выражения к Булевской переменной и инвертирование
@ оператор выбора шага
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Доступные математические функции приведены в следующей табли-
це.

abs(x) абсолютное значение
acos(x) арккосинус x
acosh(x) гиперболический арккосинус
asin(x) арксинус

asinh(x) гиперболический арксинус
atan(x) арктангенс

atan2(y, x) четырехквадрантный арктангенс у/х
atanh(x) гиперболический арктангенс
cos(x) косинус

cosh(x) гиперболический косинус
exp(x) экспонента
ln(x) натуральный логарифм
log(x) натуральный логарифм

log10(x) десятичный логарифм
sgn(x) знак
sin(x) синус

sinh(x) гиперболический синус
sqrt(x) квадратный корень
tan(x) тангенс
tanh(x) гиперболический тангенс

u(x) 1 если x > 0., иначе 0.
buf(x) 1  при x > .5, иначе 0
inv(x) 0 при x > .5, иначе 1

uramp(x) x если x > 0., иначе 0.
!(x) альтернативный синтаксис для inv(x)

int(x) преобразование x к целому числу
floor(x) целое число равное или меньше чем x
ceil(x) целое число равное или больше чем x

rand(x) случайное число между 0 и 1 в 
зависимости от целочисленного значения х

random(x) подобно rand(), но с гладкими 
переходами между значениями.

re(x) Вещественная часть комплексного числа
white(x) случайное число между-.5 и .5, еще более гладкие пере-

ходы по отношению к random 
min(x,y) наименьшее из x и y
max(x,y) наибольшее из х или у

limit(x,y,z) эквивалентно min(max(x,y),z)
if(x,y,z) если x > .5, то y иначе z

table(x,a,b,c,d,...) интерполяция значений для x, основанная на просмотре 
таблицы, заданной как набор пар точек.

Для комплексных чисел функции atan2(,), sgn(), u(), buf(), inv() uramp(), 
int(),  floor(),  ceil(),  rand(),  min(,),  limit(,),  if(,,),  и  table(...) не  доступны. 
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Функции  Re(x) и  Im(x) возвращают  вещественную  и  мнимую  часть 
комплексного числа.  Функции  Ph(x) и  Mag(x) возвращают фазу и ам-
плитуду комплексного числа.

Истина в цифровой форме равна 1, и Ложь - 0. Преобразование к Бу-
левской переменной конвертирует значение к 1, если значение больше 
чем 0.5, иначе значение преобразуется в 0.

Оператор выбора шага, '@' полезен при выполнении многовариантно-
го моделирования и применяется при заданных директивах .step, .temp, 
или .dc. Он позволяет выбирать данные, начиная с определенного выпол-
ненного шага. Например, оператор V(1)@3 определяет данные для гра-
фика, начиная с 3-го шага.

Для комплексных чисел доступны только +, -, *, /, **. Для комплекс-
ных чисел Булев оператор XOR (^), означает возведение в степень **.  

Имеются  следующие  встроенные  константы: 
e=2.7182818284590452354;    pi=3.141592653589793238464; 
k=1.3806503e-23;   q=1.602176462e-19.

При  построении  графиков  переходных  процессов  ключевое  слово 
"time" воспринимается как время. Точно так же "freq" и "omega" воспри-
нимаются как частота и угловая частота при выполнении частотного ана-
лиза. "w" может использоваться как синоним для "omega".

Вычисление среднего и среднеквадратичного значения.

Графический постпроцессор может проинтегрировать график для полу-
чения  среднего  (average)  и  среднеквадратичного  значения  (RMS)  по 

отображенной  области. 
Для  этого  по  оси  "х" 
надо  выбрать  интересу-
ющий  диапазон,  затем 
переместить мышь в на-
звание  графика  и  удер-
живая клавишу CTRL и 
щелкнуть  левой  кноп-
кой мыши.

Рис.22. Окно с результатами вычисления среднего и среднеквадратично-
го значения.
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Отображение результатов Фурье-преобразования графиков.

Быстрое  преобразование  Фурье  для  различных графиков  выполняется 
через  команду меню View=>FFT. Окно настройки приведено на рис.23.

 

Рис.23. Окно быстрого преобразования Фурье

Пользовательские функции
Команда меню Plot Settings=>Edit Plot Defs File позволяет вводить соб-

ственные  функции и параметры для  их использования  в  графическом 
постпроцессоре.  Эти функции сохраняются в файле  plot.defs в том же 
самом каталоге SwCADIII, где находится программа scad3.exe.

Синтаксис тот же самый как у инструкций .param и .func, используе-
мых для параметризации схем. Например, строка:
.func Pythag(x,y) {sqrt(x*x+y*y)} - определяет функцию Pythag() для вы-
числения квадратного корня от суммы двух параметров.
Аналогично, строка
.param twopi =  2*pi -  определяет  twopi как  число  6.28318530717959. 
Обратите внимание на использование встроенной константы pi .

Управление осями координат
Если  переместить  курсор  мыши  в  область  осей  координат,  курсор 

превращается в линейку. При левом клике появляется окно для ручного 

83



ввода диапазона оси и характера построения графика. Например, для ве-
щественных данных, можно изменить пределы отображения по оси "у" и 
задать логарифмический масштаб.

Для данных в комплексной форме, можно выбрать форматы представ-
ления Bode, Nyquist или Cartesian.

Дополнительные поля для графиков
Можно ввести дополнительные поля для графиков в том же окне (см. 

рис24). Для каждого поля можно независимо масштабировать ось орди-
нат. Можно перемещать 
графики из одного поля 
в  другое,  если  навести 
курсор на название гра-
фика и при нажатой ле-
вой кнопке мыши пере-
тащить это название на 
другое  поле.  Если  по-
сле перетаскивания на-
жать  клавишу  Ctrl и 
отпустить  мышь,  то 
график скопируется

Рис.24. Дополнительные поля для графиков.

Управление цветом
 Команда меню Tools=>Color Preferences позволяет устанавливать цвета. 

Наведя  курсор  на  объект  в  типовом 
графике,  и  используя  красные,  зеле-
ные и синие слайдеры, можно откор-
ректировать цвет этого объекта.

Рис.25. Управление цветом
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Добавление курсоров

 Можно использовать  один или два курсора. Вы можете прикрепить кур-
сор к следу левой мышью, нажимающей на метку следа. Один курсор 
прикрепляется к графику, если его навести на название графика и клик-
нуть левой кнопкой мыши. К этому же графику можно прикрепить вто-
рой курсор, если кликнуть правой кнопкой мыши на названии этого гра-
фика.

 Появится диалоговое окно, как на рис.26а, на развороте Attached Cursor 
надо выбрать  1st&2nd. Можно также прикрепить 1-ый или 2-ой курсор 
или оба курсора к любому графику, выбирая соответствующее значение 
на этом развороте.  Курсоры можно перемещать мышью или клавишами 
со стрелками. При активных курсорах появляется окно, показывающее 
месторасположение курсоров и их различия (рис.26б.).
 Приложенные курсоры могут также использоваться для определения, 

к какому шагу принадлежит 
график при отображении ре-
зультатов  многовариантного 
расчета. Для этого надо раз-
местить  курсор  на  верти-
кальной  линии  отсчета 
(должна  появиться  цифра  1 
или  2)  и  нажать  правую 
кнопку  мыши.  В результате 
появится окно с информаци-
ей  о  выполненном  шаге 
(рис.27).

Рис.27.  Окно  с  информацией  о  выполненном  шаге  многовариантного 
расчета.

85

Рис.26. Выбор курсоров и отображение результатов их  размещения.



Сохранение конфигурации
Команды меню  Plot Settings=>Save Plot Settings/Open Plot Settings files, 
позволяют читать и записывать параметры настройки графиков на диск. 
Файл  с  конфигурацией  графиков  это  текстовый  файл  с  расширением 
".plt". Такие файлы можно применять только к однотипным видам моде-
лирования.

Формат файла с быстрым доступом
При  моделировании  LTspice использует  сжатый  двоичный  формат 

файла  данных,  который  позволяет  добавлять  новые  данные  в  конец 
файла, не изменяя остальную его часть. После завершения моделирова-
ния, этот формат для обработки оказывается медленным при добавлении 
нового графика. 
Чтобы сократить время обработки данных, можно преобразовать файл к 
альтернативному  формату  с  быстрым  доступом.  Этот  формат  может 
быть получен после того, как моделирование закончено и когда не добав-
ляются новые данные. В формате с быстрым доступом время загрузки 
новых графиков сокращается. Например, если имеется 5GB файл с 2000 
графиками, то потребуется порядка 4min, чтобы добавить новый график. 
Но после конвертирования в формат  Fast Access, время загрузки с этих 
четырех минут уменьшается до одной секунды. 

Чтобы преобразовывать окно с графиками к формату Fast Access, надо 
это окно сделать активным и выполнить команду меню Files=>Convert to 
Fast Access. Преобразованный файл будет только на 11 байтов большим, 
чем первоначальный файл. Конверсионный процесс может занять долгое 
время и много физической памяти. Это время будет зависеть от состоя-
ния фрагментации жесткого диска и количества физической памяти. В 
ходе преобразования машина может не реагировать на мышь и клавиату-
ру.  Чтобы избежать этого,  можно конвертировать файлы в команде со 
следующим синтаксисом командной строки:
   scad3.exe  -FastAccess <file>,
где  <файл>  -  имя  .raw файла,  который  преобразуется  в  формат  Fast 
Access.

Формат Fast Access поддерживается только для вещественных данных.
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Панель управления.

Compression (Сжатие данных)

LTspice сжимает raw-файлы данных. Сжатый файл может быть в 50 раз 
меньшим чем несжатый. Сжатие выполняется с потерями. Эта закладка 
панели управления позволяет  управлять этими  потерями.

Window Size(No. of Points): Максимальное число точек, которое может 
расположиться между двумя точками после сжатия.
Relative Tolerance: относительная допустимая ошибка между сжатыми 
и несжатыми данными.
Absolute Voltage tolerance [V]: допустимая ошибка по напряжению.
Absolute Current tolerance[A]:  допустимая ошибка по току.

Установленные параметры сжатия не запоминаются между запусками 
программы, так как использование по умолчанию. Они доступны на па-
нели управления для диагностических целей. Допустимые ошибки и раз-
мер окна могут быть установлены опциями plotreltol, plotvntol, plotabstol 
и  plotwinsize  в  директивах .option, помещенных как SPICE-директивы в 
схемном редакторе.

Ниже  на  рис.  приведен  пример  отображения  сжатого  и  несжатого 
файлов:
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Operation (Операции)
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Строки, отмеченные  звездочкой [*] запоминаются между обращениями 
программы.
Marching Waveforms: Проверка результатов моделирования на предмет 
их отображения в ходе расчета.

Generate Expanded Listing: Размещение в списке соединений расши-
ренной информации из файла системного журнала -   SPICE Error Log 
file .

Open Demo circuits as regular schematics:  Открыть демонстрацион-
ные схемы в .\SwCADIII\lib\app\*.app. Все команды SPICE будут види-
мы.  Схемы  могут  быть  отредактированы  и  записаны  в  новом  файле. 
Строки,  отмеченные  двойными  точками  '..'  на  схеме  служат  для  де-
монстрации  применения  SPICE-директив.  Строки,  отмеченные  только 
одной точкой могут быть отредактированы.

Don't  warn when using preliminary models:  Выключить сообщение 
предупреждения для всех  SMPS-моделей (эти модели имеют правовую 
защиту).

Automatically delete  .raw files: Этот флажок позволяет удалить файлы 
данных  после завершения моделирования, что значительно уменьшает 
место  на диске, но требует дополнительного времени на формирование 
данных при повторном моделировании.

Automatically delete  .net files: удаление списка соединений после за-
вершения  моделирования.  Список  соединений  является  временным 
файлом, но может понадобиться при тестировании схемы или при записи 
в текстовый файл созданного в схемном редакторе описания схемы (под-
схемы).

Automatically delete .log files:  Эти файлы содержат различную стати-
стику моделирования – времени моделирования, предупреждений и со-
общений об ошибках и параметрах шага, используемых для исследова-
ний в директивах .step/.temp/.dc.

Save Defaults (Запись по умолчанию)
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Эта закладка используется, если явно не указано, какая информация 
должна быть записана при моделировании. Здесь можно отметить стро-
ки: "Записать токи ", "Записать узловые напряжения подсхем" и "Запи-
сать токи подсхем". 

Save Device Currents:  Отметка этой строки позволит отобразить пре-
дельные токи устройства и рассеиваемую мощность.

Save Subcircuit Node Voltages: Отметка этой строки позволит отобра-
зить на графиках напряжения в подсхемах.

Save Subcircuit Device Currents: Отметка этой строки позволит отоб-
разить на графиках напряжения в подсхемах.

Don’t save Ib(), Ie(), Is(), Ig(): Отметка в этой строке  позволяет сохра-
нить только токи коллектора (стока) транзисторов,  для экономии разме-
ров выходных файлов. Вместе с тем оказывается недоступным определе-
ние мощности потерь в транзисторах..

SPICE (настройка параметров моделирования)

Единственный параметр, который сохраняется при перезапуске системы 
- Trtol. Большинство SPICE программ устанавливают этот параметр рав-
ным 7. В LTspice он установлен равным 1 для того, чтобы при использо-
вании  макромоделей  SMPS отобразить  на  графиках  наиболее  полную 
информацию.  Trtol  влияет  на  расчетный  шаг,  что  существенно 
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сказывается на точности моделирования. Для моделирования  транзисто-
ров  уровней  больше  1  требуется  повышенная  точность  расчета.  Если 
увеличить  trtol,  то можно сократить время моделирования почти в два 
раза и одновременно с этим снизить точность расчета. Установленный 
параметр trtol будет сохранен при перезапусках системы.   Большинство 
традиционных параметров SPICE, таких как  gmin,  abstol,  reltol,  chgtol, 
vntol не запоминаются. Если возникает потребность в сохранении этих 
параметров,  то  их  надо  описать   .option-директиве  и  сохранить  в 
описании схемы или сохранить в отдельном файле, с тем, чтобы дирек-
тивой  .inc включить этот файл в описание схемы.

Следует обратить внимание на строку solver (метод решения). LTspice 
содержит две  версии SPICE. Одна версия является нормальной, другая - 
алтернативной. Альтернативный метод решения использует различные 
способы  упаковки  разреженных  матриц  для  уменьшения  расчетных 
ошибок. Обычно альтернативный метод приводит к замедлению расчета 
почти в два раза по сравнению с нормальным за счет повышения точно-
сти внутренних вычислений почти в тысячу раз. Это может оказаться по-
лезным  для  диагностических  целей.  Если  в  .option-директиве  не 
определено, какой  solver  используется, то на этой закладке необходимо 
сделать выбор прежде, чем будет сгенерирован список соединений, так 
как два метода решения используют принципиально различные подходы.

Если отмечена строка "Accept 3K4 as 3.4K" ("Принять 3K4 как 3.4K"), 
то  это  приведет  к  тому,  что  запись  вида  4K99  будет  воспринята  как 
4,99К. В большинстве SPICE-программ такая замена не применяется, но 
в LTSpice это принято из-за распространенности такого обозначения на 
практике.
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Netlist Options (опции списка соединений)

Convert 'µ' to 'u': Преобразование символа 'μ' к символу 'u' . Эта оп-
ция необходима, если Windows не поддерживает греческий шрифт. Сим-
вол 'u' воспринимается в числах как множитель 10-6.

Reverse comp. Order: Схемные элементы располагаются в списке со-
единений в том порядке, в каком они появились при вводе в схемном ре-
дакторе. Эта опция располагает элементы в обратном порядке.

Default Devices: Если в схемном редакторе LTSpice используется диод, 
то автоматически в список соединений вставляется инструкция ".model 
D D". Если не отметить эту опцию, то это включение не будет приме-
няться. То же относится и к транзисторам.

Default  Libraries:  Если  в  схемном  редакторе  LTSpice  используется 
диод, то по умолчанию используется стандартная библиотека dio, вклю-
чаемая по инструкции lib. Если не отметить эту опцию, то это включение 
не будет применяться. То же относится и к транзисторам.

Convergence Aids: зарезервировано для развития программы.

Hacks!
Эта закладка используется для развития программы и в настоящее время 
устарела. Рекомендуется применить Reset to Default Values.
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Drafting Options (опции схемного редактора) 

Allow direct component pin shorts:   Если не пометить эту опцию, то 
схемный редактор предотвратит замыкание контактов.  Таким образом, 
двухполюсники можно подключать к проводнику не размыкая его, а пря-
мо устанавливая на проводник.   Если не отметить эту опцию, то ко-
роткозамкнутая перемычка не будет автоматически удалена. 

Automatically scroll the view:  Отметка этой строки позволяет в схем-
ном редакторе осуществлять автоматический скроллинг при приближе-
нии элементов к границе чертежа.

Mark text Justification anchor points:  Вывести   маленький кружок 
слева от текстового блока для его выравнивания.

Mark unconnected  pins:   Вывести квадраты на  не подсоединенных 
узлах компонент . 

Show schematic grid points:  Отобразить  сетку.
Allow direct component pin shorts:   Если не пометить эту опцию, то 

схемный редактор предотвратит замыкание контактов.  Таким образом, 
двухполюсники можно подключать к проводнику не размыкая его, а пря-
мо устанавливая на проводник.   Если не отметить эту опцию, то ко-
роткозамкнутая перемычка не будет автоматически удалена. 
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Automatically scroll the view:  Отметка этой строки позволяет в схем-
ном редакторе осуществлять автоматический скроллинг при приближе-
нии элементов к границе чертежа.

Mark text Justification anchor points:  Вывести   маленький кружок 
слева от текстового блока для его выравнивания.

Mark unconnected pins:   Вывести квадраты на не подсоединенных 
узлах компонент . 

Show schematic grid points:  Отобразить  сетку.
Orthogonal snap wires: Проведение  проводников  только  под  пря-

мым углом. При нажатой клавише CTRL можно проводить под произ-
вольным углом в узлах сетки. Если не отмечать эту строку, тогда провод-
ники под любым углом можно проводить без нажатия на CTRL.

Cut angled wires during drags: Если отмечена эта строка, то двухпо-
люсники при перетаскивании смогут перемещаться только вдоль провод-
ников. 

Undo history size: Установить  размер буфера откат/восстановление .
Draft with thick lines: Увеличить толщину линий. Опия полезна при 

создании публикаций.
Show Title Block: Для внутреннего использования.

94



Приложения

Модель асинхронного двигателя с короткозамкнутым ротором

Система уравнений напряжений двигателя в матричной форме: 

xx
x

xxxx IG
dt
dILIRU ⋅⋅+⋅+⋅= ω  ,

где R – матрица сопротивлений, L – матрица индуктивностей, Gх – мат-
рица э.д.с. двигателя, ω – скорость двигателя в эл. радианах (ω=Zp·ωмех, 
Zp – число пар полюсов, ωмех - скорость двигателя в мех. радианах). 

Результаты автоматизированного формирования матриц для неподвиж-
ной системы координат,  в которой статорные обмотки представлены в 
трехфазных координатах, а роторные обмотки в двухфазных координа-
тах:

 

J⋅
d мех

d t
=Mdv−Mc

где G= ω ·  Gx ,  Ex = G·Ix – вектор э.д.с. двигателя, Mdv=Ixt·Gx·Ix – мо-
мент двигателя, Ix – вектор токов. J – момент инерции, ω – скорость ро-
тора в эл. радианах, ωмех – скорость ротора в механических радианах. ω 
=Zp·ωмех , Zp – число пар полюсов. Мс – момент сопротивления на валу 
двигателя. 

При выводе формул было учтено, что параметры фазы двухфазной 
машины в 1,5 раза больше параметров фазы эквивалентной по мощности 
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трехфазной машины, то есть: Lm=3/2·Lmf, Ls=3/2·Lf, Ls0=3·Lf, Rs=3/2·Rf, 
R0=3·Rf, где  Lmf – взаимная индуктивность между соответствующими 
фазами статора и ротора,  Lf  - индуктивность фазы статора трехфазной 
обмотки,  Rf –  активное  сопротивление  фазы  статора  трехфазной  об-
мотки. Ls0, R0 – индуктивность и сопротивление фазы нулевой последо-
вательности.

Создание модели в LTSpice.
1. Создать папку, в которой будет создаваться модель.
2. Создать изображение двигателя. Для этого:

Выбрать команду File-New  Symbol.  Ввести  кон-
такты с именами a,  b,  c,  m и w. Для ввода контактов 
можно нажать на клавишу ‘p’ и в появившемся окне 
напечатать соответствующее имя. Расположить кон-
такты, как показано на рисунке. Видимыми их мож-
но  не  делать  (отметить  радио-кнопку  Not Visible). 
Шаг сетки при создании компоненты соответствует 
шагу сетки схемного редактора. 

Нарисовать графическое изображение асинхронного двигателя. Основ-
ная команда: Draw=>Line, Circle и т.д. Чтобы точнее расположить лини в 
узлах  сетки  желательно  отобразить  точки  привязки  линий  командой 
View=>Anchor Points (или нажать 'O')

Командой Save-as записать файл (расширение asy) в созданную папку.
3. Создать схему замещения асинхронного двигателя. Для этого:
Выбрать команду File-New Schematic. Ввести компоненты схемы
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Компоненты схемы: В1, B2, B3 – управляемые источники напряжения 
bv.asy,  B4 – управляемый источник тока  bi.asy. Номиналы индуктивно-
стей и сопротивлений параметризованы. Вместо числа ставится иденти-
фикатор в фигурных скобках. Числовое значение идентификатору при-
сваивается в директиве .params. Взаимные индуктивности M в  SPICE - 
программах задаются коэффициентом связи: 

21 LL
Mk

⋅
= и вводятся как тек-

стовая строка. Например, взаимная индуктивность между фазой А стато-
ра и фазой α ротора соответствует строке k1 L1 L4 {k11}, где параметр 
k11 вычисляется в директиве .params.
4.Командой Save-as записать файл с тем же именем, какое было у создан-
ного ранее символа, но с расширением asс и в ту же папку.

Можно создать  схему замещения асинхронного двигателя в  текстовом 
редакторе  на  языке SPICE-программ.  Текст  надо сохранить  в  файле  с 
расширением sub или lib. При использовании текстовой модели в схеме 
верхнего уровня, надо указать место размещения этого файла.

* модель асинхронного двигателя
.subckt ADZIsPr a b c w m Isa Isb Pra Prb n
*.param Zp=2 Lm=28.7m Ls=29.4m Lr=29.7m Rs=0.067 Rr=0.032 J=0.62
.param q=sqrt(Ls*Lr2) Lr2=1.5*Lr Rr2=1.5*Rr sq3=sqrt(3)
+k11=Lm/q 
+k21=-Lm/2/q
+k22=sq3*Lm/q/2
+k31=-Lm/q/2
+k32=-sq3*Lm/q/2
R1 a N001 {Rs}
R2 b N003 {Rs}
R3 c N005 {Rs}
L1 N001 n {Ls}
L2 N003 n {Ls}
L3 N005 n {Ls}
L4 N002 N004 {Lr2}
L5 N006 N007 {Lr2}
k1 L1 L4 {k11}
k2 L2 L4 {k21}
k3 L2 L5 {k22}
k4 L3 L4 {k31}
k5 L3 L5 {k32}
R5 N004 0 {Rr2}
R6 N007 0 {Rr2}
B10 N002 0 V=-{Zp}*v(w)*({Lm}*sq3/2*(i(L2)-i(L3)) + {Lr2}*i(L5))
B11 N006 0 V={Zp}*v(w)*(3/2*{Lm}*i(L1) + {Lr2}*i(L4) )
B9 0 w I={Zp}*sq3/2*{Lm}*( (i(L2)-i(L3))*i(L4) - sq3*i(L1)*i(L5))
C2 w 0 {J}
B1 m 0 V=I(B9)
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B2 Isa 0 V=(2*I(L1) -I(L2) - I(L3))/3.
B3 Isb 0 V=(I(L2) - I(L3))/sq3
B4 Pra 0 V={Lr2}*I(L4)+1.5*{Lm}*v(Isa)
B5 Prb 0 V={Lr2}*I(L5)+1.5*{Lm}*v(Isb)
.end ADZIsPr

Вид символьного изображения приведен рядом с текстовым описани-
ем. В этой модели дополнительно включены управляемые источники В2-
В5. Потенциалы на этих источниках соответствуют: току статора по осям 
α и β и потокосцеплениям ротора по этим же осям. При создании сим-
вольного  изображения  для  такого описания,  вводятся  дополнительные 
контакты  с именами Isa, Isb, Pra, Prb.  Кроме начал фаз модель содержит 
вывод нейтрали статорной обмотки n.

Приведем еще две модели асинхронного двигателя:
* модель асинхронного двигателя с выводам концов фаз
.subckt AD a b c aa bb cc w m
*.param Zp=2 Lm=28.7m Ls=29.4m Lr=29.7m Rs=0.067 Rr=0.032 J=0.62
.param q=sqrt(Ls*Lr2) Lr2=1.5*Lr Rr2=1.5*Rr sq3=sqrt(3.)
+k11=Lm/q 
+k21=-Lm/2/q
+k22=sq3*Lm/q/2
+k31=-Lm/q/2
+k32=-sq3*Lm/q/2
R1 a N001 {Rs}
R2 b N003 {Rs}
R3 c N005 {Rs}
L1 N001 aa {Ls}
L2 N003 bb {Ls}
L3 N005 cc {Ls}
L4 N002 N004 {Lr2}
L5 N006 N007 {Lr2}
k1 L1 L4 {k11}
k2 L2 L4 {k21}
k3 L2 L5 {k22}
k4 L3 L4 {k31}
k5 L3 L5 {k32}
R5 N004 0 {Rr2}
R6 N007 0 {Rr2}
B10 N002 0 V=-{Zp}*v(w)*({Lm}*sq3/2*(i(L2)-i(L3)) + {Lr2}*i(L5))
B11 N006 0 V={Zp}*v(w)*(3/2*{Lm}*i(L1) + {Lr2}*i(L4) )
B9 0 w I={Zp}*sq3/2*{Lm}*( (i(L2)-i(L3))*i(L4) - sq3*i(L1)*i(L5))
B1 m 0 V=I(B9)
C2 w 0 {J}
.end AD
* модель асинхронного двигателя с выводом нейтрали статорной обмотки
.subckt ADZ a b c w m n
*.param Zp=2 Lm=28.7m Ls=29.4m Lr=29.7m Rs=0.067 Rr=0.032 J=0.62
.param q=sqrt(Ls*Lr2) Lr2=1.5*Lr Rr2=1.5*Rr sq3=sqrt(3.)
+k11=Lm/q 
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+k21=-Lm/2/q
+k22=sq3*Lm/q/2
+k31=-Lm/q/2
+k32=-sq3*Lm/q/2
R1 a N001 {Rs}
R2 b N003 {Rs}
R3 c N005 {Rs}
L1 N001 n {Ls}
L2 N003 n {Ls}
L3 N005 n {Ls}
L4 N002 N004 {Lr2}
L5 N006 N007 {Lr2}
k1 L1 L4 {k11}
k2 L2 L4 {k21}
k3 L2 L5 {k22}
k4 L3 L4 {k31}
k5 L3 L5 {k32}
R5 N004 0 {Rr2}
R6 N007 0 {Rr2}
B10 N002 0 V=-{Zp}*v(w)*({Lm}*sq3/2*(i(L2)-i(L3)) + {Lr2}*i(L5))
B11 N006 0 V={Zp}*v(w)*(3/2*{Lm}*i(L1) + {Lr2}*i(L4) )
B9 0 w I={Zp}*sq3/2*{Lm}*( (i(L2)-i(L3))*i(L4) - sq3*i(L1)*i(L5))
B1 m 0 V=I(B9)
C2 w 0 {J}
.end ADZ

Создание схемы для исследования прямого пуска асинхронного дви-
гателя.

 Для этого:
Выбрать команду File-New 
Schematic.  Ввести  компоненты 
схемы,  как  на  рисунке.  Незави-
симые источники напряжений – 
voltage.asy
При  задании  переходного  про-
цесса отметить строки:
Start  external  DC supply  voltages 
at 0V
Skip initial operating poin solution
При  наведении  мыши  на  асин-
хронный двигатель и нажатии на 
правую кнопку, в строке появившегося меню  PARAMS:  можно ввести 
параметр двигателя, отличный от того, который был введен при создании 
модели. Например, может быть указано другое значение момента инер-
ции: J=0.3. Для вывода на график момента и скорости, надо к контактам 
m и  w  двигателя подсоединить именованые проводники.
Командой Save-as записать файл под другим именем с расширением asс в 
ту же папку.
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Моделирование момента сопротивления на валу двигателя.
При исследованиях аинхронного двигателя к узлу w можно подсоеди-

нять электрические схемы замещения механических систем.
Вязкое трение 
Моделируется резистором, значение которого можно подсчитать по фор-
муле R=ωн/Мн. Резистор подсоединяется между выводом w и «землей».
 Постоянный момент сопротивления 
Моделируется источником тока,  подсоединяемым между выводом  w и 
«землей» (начало стрелки соединяется с  w). Пусть момент сопротивле-
ния равен 20 Н·м. Если источник тока будет иметь постоянное значение, 
равное 20А, то в начальный момент времени, когда момент, развиваемый 
двигателем мал, произойдет обратное вращение двигателя.

Чтобы избежать его, можно задать изменение источника тока в функ-
ции частоты. Например, в формате SPICE: 

I=if (v(w),20,0) , что означает: если скорость больше, чем 
0,5, то источник тока равен 20 А, иначе источник тока равен 
нулю.  Число 0,5, которое здесь фигурирует, задается систе-
мой LTSpice по умолчанию. Это число можно отмасштаби-
ровать, например, если в скобках записать 10*v(w), то вы-
полнение условия произойдет при 0,05В.
Момент сопротивления, пропорциональный квадрату скорости. 
Обозначим  коэффициент  пропорциональности  буквой 
k.  Условимся,  что при скорости 150рад/с момент дол-
жен  быть  равен  20  Н·м.  Вычисление  коэффициента 
можно выполнить непосредственно в строке  Spice-ди-
рективы param, как это показано на рис.

Момент  сопротивления,  зависящий  от  угла  поворота 
вала. 

Источник В4 (см.рис.) формирует ток, численно равный скорости дви-
гателя. Так как ток емкости i=C⋅ dU

dt , то U=1 
C∫ i⋅dt . Таким образом, 

напряжение на емкости числен-
но равно интегралу от скорости 
двигателя, то есть численно рав-
но углу поворота  вала  двигате-
ля. Если на валу имеется пони-
жающий  редуктор,  то  коэффи-
циент передачи этого редуктора 
должен быть равен емкости. То-
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.param k=20/(150**2)
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гда  потенциал  узла  fi численно  равен  углу  поворота  выходного  вала 
редуктора. 

На источнике  В5 формируется линейно нарастающий периодический 
сигнал амплитудой 2·π. Такой сигнал получается вычитанием из факти-
ческого значения угла его целой части (функция int – вычисление целой 
части числа) и умножением результата на 2π. 

Источник  В3 формирует зависимость тока от входного сигнала в та-
бличной форме. Первая точка таблицы имеет координаты (0,0),  вторая 
точка имеет координаты (π,0), третья (π+0.001,20). Таким образом, если 
угол  поворота  становится  равным  π+0.001,  то  момент  сопротивления 
подскакивает до 20 Н·м и остается таковым, пока угол не станет опять 
равным нулю.

Ниже на рисунке приведены результаты расчета скорости и момента 
двигателя при прямом пуске на холостой ход:

Частотный пуск асинхронного двигателя со скалярным 
управлением

Схема частотного пуска при линейном нарастании частоты и напряже-
ния приведена ниже.
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Параметры двигателя: Lm=164m, Ls=169m,  Lr=172m, Rs=1.32, 
Rr=0.922, Zp=2, J=0.0206.

На схеме используются следующие обозначения:
- в строке param задаются: fnes – несущая частота ШИМ в Гц, fkon – ко-
нечная значение частоты в Гц, trazg – время нарастания частоты в секун-
дах. Конкретные значения зависят от параметров двигателя и могут быть 
подобраны численным экспериментом. На управляемом источнике тока 
В7 и емкости С1 реализован интегратор, потенциал на v0 соответствует 
углу для задания синусоиды ШИМ. Амплитуда этой синусоиды меняется 
линейно от 0 до 1. Три таких синусоиды со сдвигом 120 эл. град. реали-
зованы  на  В1-В3.  На  элементах  В5-В7,В8  реализован  ШИМ  сигнал 
управления ключами.

Рассмотренное линейное изменение амплитуды напряжения и частоты 
применяется при скалярном частотном управлении асинхронным двига-
телем при постоянном моменте на валу. В соответствии с законом М.П.-
Костенко изменение напряжения на двигателе  в  функции частоты для 
сохранения постоянной перегрузочной способности двигателя:

U=
Uн

f н
⋅ Мнг

Мн
⋅f ,  где  Uн,  fн,  Мн – номинальное напряжение, частота и 

момент двигателя, Мнг – зависимость момента нагрузки от частоты, зная 
эту зависимость и подставляя ее в формулу, можно получить закон изме-
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нения напряжения в функции частоты. Например, если момент пропор-
ционален скорости вращения, причем при номинальной скорости он ока-
зывается равным номинальному моменту, то напряжение будет пропор-
ционально скорости в степени 3/2. В этом случае нагрузка моделируется 
резистором, а закон изменения синусоиды ШИМ для трех фаз будет вы-
глядеть так:

для фазы А: V=sqrt((v(u)/{w})**3)*sin(v(v0)),
фазы В: V=sqrt((v(u)/{w})**3)*sin(v(v0)-120/180*pi),
фазы С: V=sqrt((v(u)/{w})**3)*sin(v(v0)+120/180*pi).

Результаты моделирования:

На верхнем графике приведено изменение тока фазы 'а' двигателя, на 
нижнем графике приведено изменение скорости и потокосцепления ро-
тора (умноженное на 100).

Частотный пуск асинхронного двигателя с обратной связью по току 
(потокосцеплению) ротора.

Кроме рассмотренных в предыдущей схеме элементов, в этой схеме 
частотного пуска асинхронного двигателя с обратной связью по току (по-
токосцеплению) ротора  присутствуют:

А) задатчик частоты (элемент В12), реализующий следующую функ-
цию:

V=if(v(wr)-{w}/2, {w}+35, 2*v(wr)+35), 
где  v(wr) –  потенциал,  равный скорости двигателя,  w –  конечная ско-
рость разгона двигателя в рад/с; 35 – абсолютное скольжение в рад/с. Т.е 
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если скорость не достигла конечного значения, то задатчик определяет 
частоту питания как сумму скорости двигателя и частоты скольжения. 
При  достижении  заданной  скорости  частота  питания  устанавливается 
равной постоянному значению w+35 (вместо 35 можно взять другое чис-
ло).

Б) регулятор тока статора или потока ротора (элемент В11):
V=(1+(1-v(is)/{z})*{k}), 

где v(is) (или v(pr)) – фактическое значение тока (потока); {z} – задающее 
значение  тока  (потока);  {k} –  коэффициент  усиления  (можно  принять 
равным 1).  

В) задатчик синусоиды ШИМ для фазы А (элемент В1):
V=v(dp)*v(wz)/{w}*sin(v(v0)), 

где v(dp) – напряжение регулятора; v(wz) - напряжение задатчика часто-
ты; 

Результаты моделирования:
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На верхнем графике приведено изменение тока фазы 'а' двигателя,  на 
нижнем графике приведено изменение скорости и потокосцепления ро-
тора (умноженное на 100).
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АЛЬБОМ СХЕМ LTSPICE
 160.asc -  аналого-цифровая схема.
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 1563.asc - применение подсхемы с текстовым описанием.

107

.subckt TowTom2 1 2 3
C1 1 3 {C}
C3 N001 1 3p
C4 N002 N001 .3p
C7 2 N003 {C}
C6 2 3 .25p
R2 N001 1 10K
R3 N002 N001 10K
R5 N003 N002 {R}
R1 1 0 1.
C2 1 0 {Aol/GBW1/6.28318530717959}
G1 0 1 0 N005 {Aol}
R6 2 0 1.
C8 2 0 {Aol/GBW1/6.28318530717959}
G3 0 2 0 N007 {Aol}
R4 N002 0 1.
C5 N002 0 {Aol/GBW2/6.28318530717959}
G2 0 N002 0 N006 {Aol}
R10 N005 3 {RN1}
R11 N006 N001 {RN2}
R12 N007 N003 {RN3}
.params R=10K C=160p GBW1=10Meg GBW2=15Meg
.params Aol=100K
.param RN1=1 RN2=1 RN3=1
.ends TowTom2

Текст с описанием под-
схемы TowTom2.sub



Astable.asc - моделирование мультивибратора во времени.
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Audioamp.asc - многокаскадный транзисторный усилитель сигнала. 
Анализ переходных процессов и частотный анализ.
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BandGaps.asc - температурный анализ рабочей точки.
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Butter.asc - частотные характеристики при многовариантном 
анализе.
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Clapp.asc - временные осциллограммы транзисторного генератора. 
Применение опции для метода расчета
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Cohn.asc - частотные характеристики пассивного фильтра
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Colpits2.asc - временные осциллограммы транзисторного 
генератора. Применение опции для метода расчета
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Colpits.asc - временные осциллограммы транзисторного генератора. 
Применение опции для метода расчета
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Courvetrace.asc - статические характеристики транзистора.
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DcopPnt.asc - расчет рабочей точки многокаскадной транзисторной 
схемы

117

-- Operating Point ---
V(n001):  10  voltage
V(n006):  1.20832  voltage
V(n007):  0.56357  voltage
V(out):  -0.128575  voltage
V(n013):  -9.27379  voltage
V(n014):  -10  voltage
V(n012):  -0.777274  voltage
V(n008):  -0.117999  voltage
V(n002):  9.0597  voltage
V(n009):  -0.0727085  voltage
V(n011):  -0.766691  voltage
V(n010):  -0.0741923  voltage
V(n005):  9.14543  voltage
V(n004):  9.81485  voltage
V(n003):  9.13686  voltage
Ic(Q3):  -0.00184289  device_current
Ib(Q3):  -8.57331e-006  device_current
Ie(Q3):  0.00185146  device_current
Ic(Q6):  -0.00083961  device_current
Ib(Q6):  -3.87678e-006  device_current
Ie(Q6):  0.000843487  device_current
Ic(Q8):  0.0224993  device_current
Ib(Q8):  0.000113398  device_current
Ie(Q8):  -0.0226127  device_current
Ic(Q7):  0.00654354  device_current
Ib(Q7):  3.42112e-005  device_current
Ie(Q7):  -0.00657775  device_current
Ic(Q2):  0.00449493  device_current
Ib(Q2):  1.37508e-005  device_current
Ie(Q2):  -0.00450869  device_current

продолжение...
Ic(Q1):  0.00471008  device_current
Ib(Q1):  1.45417e-005  device_current
Ie(Q1):  -0.00472462  device_current
Ic(Q4):  0.00117751  device_current
Ib(Q4):  3.88491e-006  device_current
Ie(Q4):  -0.00118139  device_current
Ic(Q5):  0.000724134 device_current
Ib(Q5):  2.22241e-006  device_current
Ie(Q5):  -0.000726356  device_current
I(C3):  1.9856e-021  device_current
I(C1):  7.71598e-025  device_current
I(C2):  -7.93711e-022  device_current
I(R5):  8.57331e-006  device_current
I(R12):  0.000692145  device_current
I(R13):  0.000726212  device_current
I(R4):  8.57331e-006  device_current
I(R8):  0.00185146  device_current
I(R1):  -1.45417e-005  device_current
I(R7):  -1.08765e-006  device_current
I(R6):  -1.48385e-005  device_current
I(R3):  0.00923331  device_current
I(R2):  0.00470151  device_current
I(R10):  0.000659275  device_current
I(R9):  0.00066316 device_current
I(R14):  -0.0160718  device_current
I(R11):  0.00184455 device_current
I(V2):  0.0344168  device_current
I(V1):  -0.0183156  device_current



Dimmer.asc - применение транзисторных схем замещения динистора 
и тринистора
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FC.asc - применение текствого описания подсхемы
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.subckt capometer 1 2 3 4 5
B1 2 1 I={current}*cos(2*pi*{freq}*time)*min(time*2e5, 1.) Rpar=1G
R1 N001 0 1.
C2 N001 0 {C}
B2 0 N001 I=sin(2*pi*{freq}*time)*V(x)*min(time*2e5, 1.)
G1 0 N002 N001 0 1.
G2 0 im N002 0 1.
R4 N002 0 1.
C5 N002 0 {C}
R5 im 0 1.
C6 im 0 {C}
R2 N003 0 1.
C3 N003 0 {C}
B3 0 N003 I=cos(2*pi*{freq}*time)*V(x)*min(time*2e5, 1.)
G3 0 N004 N003 0 1.
G4 0 re N004 0 1.
R6 N004 0 1.
C7 N004 0 {C}
R7 re 0 1.
C8 re 0 {C}
R3 5 0 1.
C4 5 0 {C}
B4 0 5 I=if(time<10u, 0., 
max(0.,.5*V(im)*{current}/(2*pi*{freq})/(V(im)*V(im)+V(re)*V(re))))
R10 4 0 1.
C10 4 0 {C}
B6 0 4 I=if(time<10u, 0., 2./{current}*(V(re)+V(im)*V(im)/V(re)))
G5 0 x N005 2 1.
R8 x 0 1.
R9 3 0 1G
G6 N005 1 3 0 1.
R12 1 N005 1.
*C9 x 0 {1/(4*pi*freq/Q)}
*L1 0 x {1/(Q*pi*freq)}
.param current=10u freq=3Meg C=1µ Q=.25
.ends capometer



HalfSlope.asc - применение преобразования Лапласа при 
моделировании переходных процессов и при частотном анализе
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Hartly.asc - взаимные индуктивности в транзисторном генераторе 
синусоидального сигнала
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Howland.asc - параметрический анализ мгновенных процессов 
схемы на операционном усилителе
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IdealTransformer.asc - макромодель «идеального трансформатора»
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LM78XX.asc (LM308.asc, LM741.asc) - сложные транзисторные 
схемы усилителей
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Logamp.asc - логарифмическая функция на электронных 
компонентах
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LoopGain2.asc - частотные характеристики разомкнутого и 
замкнутого контуров.
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LoopGain.asc -  частотные характеристики разомкнутого и 
замкнутого контуров
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MC1648.asc - транзисторный генератор синусоидального 
напряжения
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MeasureBW.asc - измерение полосы пропускания транзисторного 
усилителя

129

Circuit: * C:\Program Files\LTC\SwCADIII\examples\Educational\MeasureBW.asc

Direct Newton iteration for .op point succeeded.

tmp: MAX(mag(v(out)))=(43.2762dB,0°) FROM 1 TO 1e+007
bw=81949.4 FROM 73.2928 TO 82022.7

Date: Wed Mar 12 14:00:44 2008
Total elapsed time: 0.094 seconds.

tnom = 27
temp = 27
method = trap
totiter = 9
traniter = 0
tranpoints = 0
accept = 0
rejected = 0
trancuriters = 9
matrix size = 10
fillins = 0
solver = Normal



MonteCarlo.asc - частотные характеристики при разбросе 
параметров по случайному закону
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NE555.asc - транзисторный генератор импульсов
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Noise.asc - анализ шума электронной схемы
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NoiseFigure.asc - анализ шума электронной схемы
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Notch.asc - многовариантный анализ частотных характеристик.
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Opamp.asc - частотные характеристики схемы на операционных 
усилителях
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P2.asc - получение осциллограмм работы сложной транзисторной 
схемы
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Passive.asc - частотные характеристики пассивного фильтра
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PhaseShift2.asc - транзисторная генераторная схема
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PhaseShift.asc - транзисторная генераторная схема.
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Phono.asc - частотный и временной анализ схемы на опреационном 
усилителе
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Pierce.asc - транзисторный генератор переменного сигнала
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PLL2.asc - применение функциональных звеньев и звеньев, 
представленных преобразованиями Лапласа
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PLL.asc - применение функциональных звеньев и звеньев, 
представленных преобразованиями Лапласа
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Relax.asc - генератор пилообразного сигнала на операционном 
усилителе
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Royer.asc - генератор сигнала
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SampleAndHold.asc - функциональная модель квантователя

146



S-param.asc - многовариантный анализ частотных характеристик 
пассивного фильтра
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StepAC.asc - многовариантный частотный анализ с пошаговым 
изменением одного параметра семы
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StepModelParam.asc - статические характеристики транзистора с 
применением пошагового изменения параметра
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StepNoise.asc - анализ шума при пошаговом изменении параметра
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StepTemp.asc - анализ рабочей точки усилительной схемы при 
пошаговом изменении температуры
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Transformer2.asc - анализ переходных процессов в схеме с 
взаимными индуктивностями
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Transformer.asc - схема с трансформатором
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TransmissionLineInverter.asc - модель длинной линии
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TwoTau.asc - применение звеньев представленных преобразованием 
Лапласа.
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UniversalOpamp2.asc — частотные характеристики операционных 
усилителей различного уровня
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Varactor2.asc - многовариантный анализ частотных характеристик 
схемы с варактором
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Varactor.asc -  многовариантный анализ частотных характеристик 
схемы с варактором
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Varistor.asc - временной анализ схемы с варистором
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Vswitch.asc - применение модели ключа, управляемого 
напряжением.
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WaveIn.asc — ввод в схему сигнала из wav-файла
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WaveOut.asc - вывод в wav-файл сигнала.
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Wein.asc - схема генератора синусоидального напряжения
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Конструирование, изготовление и наладка источников питания имеет свои специфические 

особенности. Например, авария источника и выход из строя его элементов происходит за тысячные и 
миллионные доли секунды, что практически не даёт шанса рассмотреть её причины и последовательность. В 
этом случае многих проблем можно избежать, если предварительно моделировать работу схемы источника. 
Моделирование позволяет проверять работу элементов источника питания в критических режимах, 
производить замеры, которые обычно проблематичны или даже не возможны на реальном устройстве. 
Моделирование позволяет уточнять и оптимизировать результаты предварительных расчётов, а порой 
экспериментально подбирать параметры элементов и режимы работы схемы. Все выше перечисленные и не 
перечисленные соображение делают моделирование кровно необходимым этапом конструирования 
источников питания. 
В настоящее время любителю и профессионалу доступно большое количество программ для персонального 
компьютера, позволяющих производить моделирование работы электронных схем. Зачастую эти программы  
используют различные базовые математические алгоритмы,  что даёт им определённые преимущества при 
моделировании определённого типа электронных устройств. Наибольшей популярностью пользуются 
программы, использующие SPICE (Simulation Program with Integrated Circuit Emphasis) алгоритм 
моделирования процессов протекающих в  электронных схемах. Алгоритм SPICE, разработанный в конце 
70-х годов в университете Беркли (Калифорния), де-факто стал стандартом для разрабатываемых и уже 
эксплуатируемых в настоящее время коммерческих систем схемотехнического моделирования для 
персонального компьютера. К таким системам относятся:  

• HSPICE (фирма “MetaSoftware”); 
• PSpice (“Microsim”); 
• MicroCap V (“Spectrum Software”): 
• Circuit Maker (“The Virtual Elektronics Lab”); 
• Dr. Spice; 
• ViewSpice (“Deutsch Research”) и другие.  
Учитывая тот факт, что не для всех представляется возможным приобретение коммерческой системы 

схемотехнического моделирования, остановим свой выбор на прекрасном и к тому же бесплатном 
симуляторе LTspice от корпорации Linear Technology.  SwCad можно бесплатно скачать с сайта корпорации 
Linear Technology[7]. Программа может работать под управлением ОС: 

• Windows 98;  
• Windows 2000; 
• Windows NT4.0; 
• Windows Me; 
• Windows XP; 
• Linux RedHat 8.0 с WINE версии 20030219.  
Несмотря на свою бесплатность программа является настоящим и полноценным SPICE-симулятором, 

позволяет моделировать аналогово-цифровые схемы, имеет дружественный интерфейс и обеспечивает 
вполне приличную скорость моделирования. Кроме этого имеется отличный (правда англоязычный) 
встроенный Help[9], который является прекрасным и лучшим руководством. В интернете существует 
достаточно много ресурсов, где обсуждается и поддерживается эта прекрасная программа[4, 5]. 

Данный раздел написан в виде пошаговой инструкции, которая поможет начинающим достаточно 
быстро освоить эту прекрасную и полезную программу. Разумеется, при этом не затрагиваются некоторые 
важные моменты, которые можно будет позже разобрать самостоятельно, исследую примеры и встроенную 
помощь. Так же существует большое количество различной литературы, посвящённой SPICE-
симуляторам[1, 2, 6], которая в большей мере будет справедлива и для программы LTspice. 

Программа заточена для анализа процессов, происходящих в импульсных источниках питания. 
Однако, благодаря своим особенностям, программа снискала большую популярность и среди аудиофилов. 
При наличие подключения к Интернету программа регулярно обновляется. 

Программа достаточно универсальна и позволяет создавать новые библиотечные элементы, 
редактировать схемные решения, производить моделирование и просматривать его результаты. В программе 
имеется встроенная библиотека моделей большинства микросхем DC-DC преобразователей, выпускаемых 
корпорацией Linear Technology. Однако библиотека моделей может пополняться самостоятельно 
собственными моделями и моделями от производителей электронных компонентов. Во многом эта работа 
уже проделана фанатами LTspice. Например, основной набор моделей можно найти на домашней страничке 
Андрея Кадатч [3], где надо скачать архив EXTRA. В архиве находятся библиотека моделей транзисторов, 
диодов, тиристоров, симисторов и т.д. от ведущих мировых производителей. Там же находится подробная 
инструкция по установке этой библиотеки.   

 



1. Установка и запуск программы LTspice 
Как уже говорилось ранее, программа LTspice IV работает на персональном компьютере под 

управлением операционной системы Windows 98, 2000, NT 4.0, ME или XP. Так как программа генерирует 
много данных, то желательно, чтобы на жёстком диске было свободное пространство размером не менее 
200 Мб, а размер оперативной памяти был более 128 Мб.  

Установочный файл LTspice IV можно бесплатно скачать с сайта корпорации Linear Technology [8. 
После того как вы скачали самораспаковывающийся архив LTspiceIV.exe, запустите его и следуйте 
инструкциям. Процесс установки обычно не вызывает проблем, просто надо соглашаться со всеми 
предложенными настройками. 

 
 
Рис. 1. Меню запуска программы LTspice в 

классическом представлении меню Пуск Windows XP. 
После установки программы на рабочем столе 

появится иконка , а в верхней части меню Пуск 
появится строчка LTspice IV (рис. 1). Программу можно 
запустить как с помощью иконки на рабочем столе, так 
и через меню Пуск. В результате откроется стартовое 
окно программы (рис. 2), которое имеет: 

• строку заголовка; 
• панель команд; 
• панель инструментов; 
• рабочее поле; 
• строку подсказки.  
В левой части строки заголовка прописано 

название программы. В правой части этой строки 
сгруппированы стандартные кнопки управления 
размером окна и завершения программы. Цвет строки 
заголовка отражает активность окна, и если он синий, то 
окно активно, а если серый, то пассивно. На панели 
команд расположены стандартные меню, набор которых 
может меняться в зависимости от активного 
приложения, расположенного в рабочем поле 
программы. На панель инструментов вынесены иконки 
часто используемых команд и настроек. В рабочем поле 
располагаются подокна рабочих приложений, которыми 
являются редактор схем, плоттер, редактор символов и 

окно текстовых сообщений. В строке подсказки отображается текущее состояние программы и актуальные 
настройки симулятора. В рассматриваемый момент там отображается надпись Ready, которая говорит, что 
программа загружена и ждёт дальнейших действий пользователя. 

 

 
Рис. 2. Стартовое окно программы LTspice. 
 
2. Быстро осваиваем LTspice 
Данный раздел написан в виде пошаговой инструкции, которая поможет начинающим пользователям 

достаточно быстро освоить эту прекрасную и полезную программу. Разумеется, при этом не затрагиваются 
некоторые важные моменты, которые будут рассмотрены в последующих главах.  



Для загрузки схемы в программу LTspice требуется специальный текстовый файл списка соединений 
(netlist). Этот файл имеет расширение cir и содержит перечень схемных компонентов, узлов, с которыми эти 
компоненты связаны, определения моделей и различные SPICE директивы. Для загрузки текстового файла 
списка соединений достаточно выполнить команду меню File (Файл) => Open (Открыть), т. е. 
активизировать подпункт Open в меню File, расположенном на панели команд. При этом из всех 
предложенных типов файлов нужно выбрать cir.  

Списки соединений генерируются многими программами. Например, подобный файл генерируется 
программой проектирования фильтров FilterCAD производства той же корпорации Linear Technology. Кроме 
этого, текстовый файл списка соединений может быть создан вручную, при помощи любого текстового 
редактора. Именно таким образом описывались схемы в ранних SPICE симуляторах. Однако данный способ 
описания схем нельзя назвать очень удобным и поэтому многие современные SPICE симуляторы имеют в 
своём составе редактор схем. 

LTspice также содержит редактор схем, который сохраняет введённую схему в специальном файле с 
расширением asc. Перед началом симуляции, из ASC-файла извлекается описание схемы и автоматически 
генерируется cir-файл, который в дальнейшем используется симулятором.  

Чтобы преждевременно не забивать себе голову ненужной информацией о внутреннем 
функционировании программы LTspice, перейдём к более практическим вопросам. Известно, что лучшим 
способом изучения программы является попытка что-либо в ней сделать. Для начала нарисуем схему 
простейшего мультивибратора и промоделируем его работу. Чтобы начать рисовать новую схему, нужно 

щёлкнуть левой кнопкой мышки по иконке , расположенной на панели инструментов, или выполнить 
команду File (Файл) => New Schematic (Новая схема). Чтобы редактировать ранее созданную схему, следует 

щёлкнуть левой кнопкой мышки по иконке , расположенной на панели инструментов, или выполнить 
команду File (Файл) => Open (Открыть), а затем выбрать входной файл с расширением asc. 

Следствием указанных действий будет активизация редактора схем. Активность редактора схем 
подтверждается символом синего транзистора в левой части панели команд. Если создаётся новая схема, то 
LTspice сам присваивает ей имя Draft<порядковый номер>.asc. Например, в данном случае схеме присвоено 
имя Draft1.asc (рис. 3). Если название не пришлось вам по вкусу, то его можно изменить, сохранив схему 
под другим именем с помощью команды File (Файл) => Save As (Сохранить как).  

Нельзя не заметить, что, в отличие от стартового окна, на панели команд окна редактора схем 
появились дополнительные меню:Edit, Hierarchy, Simulate и Window, а также стали активными значки на 
панели инструментов. Рабочее поле редактора схем окрасилось в светло-серый цвет, установленный по 
умолчанию. При необходимости, с помощью комбинации клавиш <Ctrl>+<G>, можно нанести сетку на 
рабочее поле редактора схем. Аналогичный результат можно получить с помощью команды 
View (Вид) => Show Grid (Показать сетку).  

 

 
Рис. 3.  Окно схемного редактора LTspice 
 
Немного забегая вперёд, отметим, что в правой части строки подсказки отображается алгоритм работы 

вычислителя SPICE симулятора. Пользователю доступны два алгоритма работы вычислителя: 
• Normal; 
• Alternate.  
По умолчанию устанавливается алгоритм Normal, который несколько быстрее алгоритма Alternate. 

Однако алгоритм Alternate обеспечивает большую внутреннюю точность и устойчивость процесса 
вычислений. Благодаря этому, для многих схем, алгоритм Alternate способен обеспечить и большую 
скорость моделирования. Так что если симулятор надолго "задумывается", то первое, что стоит сделать, — 

это изменить алгоритм работы вычислителя. Для этого надо щёлкнуть левой кнопкой мышки по иконке  
на панели инструментов или выполнить команду Simulate (Моделирование) => Control Panel (Панель 
управления). В возникшем после этого окне Control Panel надо выбрать вкладку SPICE и в строке Solver(*) 
установить требуемый алгоритм. 



Для выбора часто используемых компонентов, таких как резисторы, конденсаторы, индуктивности и 

диоды можно воспользоваться соответствующими иконками    , расположенными на 
панели инструментов.  

Применительно к мультивибратору получится примерно следующая картина (рис. 4). 
 

 
Рис. 4. Размещение компонентов в окне редактора схем LTspice. 
Для выбора остальных компонентов необходимо выполнить команду 

Edit (Редактировать) => Component (Компонент), которая вызывает диалоговое окно Select Component 
Symbol (рис. 5). Аналогичное действие производит нажатие функциональной клавиши <F2>, а также 

щелчок левой кнопкой мышки по иконке , расположенной на панели инструментов. Выбрав требуемый 
компонент, нужно щёлкнуть левой кнопкой мышки по кнопке OK, после чего компонент переносится на 
рабочее поле в окне редактора схем. 

 
Рис. 5. Выбор компонентов из диалогового окна Select Component Symbol 



Необходимое пространственное положение компонента можно обеспечить, вращая его комбинацией 

клавиш <Ctrl>+<R>. Также на панели инструментов есть специальные иконки , предназначенные 
для вращения и зеркального отображения выбранного компонента. Кроме этого, на панели инструментов 

присутствуют иконки, позволяющие осуществлять 
стандартные операции редактирования: 

 или <F5> — удалить один либо группу 
схемных элементов; 

 или <F6> — копировать один либо группу 
схемных элементов; 

 — вставить схемные элементы, 
скопированные в другом документе (например, из 
другого ASC-файла);  

 — найти компонент в большой схеме. 
Найденный компонент подсвечивается жёлтым цветом;  

 или <F7> — переместить один либо группу 
схемных элементов; 

 или <F8> — перетащить один,либо группу 
схемных элементов. Отличается от перемещения тем, 
что позволяет перетаскивать компоненты без разрыва 
электрических связей. Таким образом, например, можно 
проводить линии под углом, отличным от прямого; 

 или <F9> — вернуться к предыдущему 
состоянию; 

 или <Shift>+<F9> — вернуться к 
последующему состоянию; 

Все перечисленные здесь, а также 
дополнительные действия можно производить через 
меню Edit (Редактировать) на панели команд (рис. 6). 

 
Рис. 6. Вид меню Edit на панели команд. 
После размещения всех компонентов получим картинку, изображённую на рис. 7. 

 
Рис. 7. Размещение компонентов в окне редактора схем LTspice. 



На схеме, в обязательном порядке, должен присутствовать компонент "Земля" , с которым должны 
быть связаны все остальные компоненты. "Подвешенные цепи", т. е. фрагменты схемы гальванически не 
связанные с компонентом "Земля" недопустимы. Данное требование по началу кажется чрезмерным, но 
реально не вызывает ни каких особых проблем. 

Для рисования связей между компонентами необходимо активизировать иконку карандаша  на 
панели инструментов или в меню Edit (Редактировать) на панели управления (рис. 6). 

 

Рис. 8. Соединение компонентов. 
Теперь, когда схема нарисована (рис. 8), необходимо определить числовые параметры и типы 

компонентов. Для этого подводим курсор к редактируемому компоненту. При совмещении курсора с 
позицией компонента, курсор меняет своё начертание и из крестика превращается в указательный палец 

. Теперь, после щелчка правой кнопкой мышки, появляется соответствующее окно, в котором можно 
определить числовые параметры компонента.  

Рис. 9. Меню настройки резистора. 
Для резистора (рис. 9) можно определить:  

• Resistance (сопротивление в омах);  
• Tolerance (разброс значения в процентах);  
• Power Rating (допустимая рассеиваемая мощность в 

ваттах).  
Нажав на кнопку Select Resistor (выбор резистора), 

можно получить доступ к заранее подготовленной базе 
параметров резисторов.  

Устанавливаем следующие номиналы резисторов: 
1 4 2R R= =  кОм, 2 101R =  кОм, 3 100R =  кОм. 

Небольшая разница номиналов 2R  и 3R  необходима для 
устойчивого запуска мультивибратора.  

 
Рис. 10. Эквивалентная схема конденсатора. 
В отличие от модели резистора, модель 

конденсатора в LTspice имеет достаточно сложную 
структуру (рис. 10). Кроме ёмкости (Capacitance), модель 
учитывает массу паразитных параметров: 

• Rpar (Parallel Resistance) - сопротивление потерь 
между выводами конденсатора; 

• Rser (Series Resistance) - последовательное 
сопротивление; 



• Lser (Series Inductance) - последовательная индуктивность; 
• Cpar (Parallel Capacitance) - параллельная ёмкость.  

 
Рис. 11. Меню настройки конденсатора. 
 
Настроить основные и паразитные параметры 

модели можно в окне настройки (рис. 11), которое 
вызывается щелчком правой кнопки мышки по 
конденсатору C1 (или C2). Здесь ёмкость измеряется в 
фарадах, индуктивность в генри, а сопротивление в 
омах. В LTspice имеется заранее подготовленная 
библиотека моделей конденсаторов, куда можно 
попасть, щёлкнув левой кнопкой мышки по кнопке 
Select Capacitor (выбор конденсатора). 

Числовые значения параметров компонентов 
могут масштабироваться при помощи суффиксов. 
Масштабные коэффициенты указаны в табл. 1. Также 
допустима экспоненциальная форма записи.   

В табл. 2 приведено соответствие между 
обозначениями единиц измерения электрических 
величин, принятых у нас (ГОСТ 8.417-2002), и 
используемых в LTspice. 

Устанавливаем следующие номиналы 
конденсаторов С1, C2: 1 2 0.01C C= =  мкФ. 

Примечание: 
LTspice воспринимает как масштабный 

коэффициент только первый символ после числового 
параметра и поэтому запись 0.01u эквивалентна 

записи 0.01uF.  
 
Таблица 1. Масштабные коэффициенты. 
суффикс масштабный коэффициент Наименование 

f 1e-15 Фемто 
p 1e-12 Пико 
n 1e-9 Нано 

u(или µ) 1e-6 Микро 
m 1e-3 Милли 
k 1e3 Кило 

meg 1e6 Мега 
g 1e9 Гига 
t 1e12 Тера 

 
Таблица 2. Соответствие обозначений единиц измерения электрических величин 

Наименование величины Единица измерения Обозначение единицы измерения 
ГОСТ 8.417-
2002 

LTspice 

Электрическое напряжение вольт В V 
Сила электрического тока ампер A A 
Энергия джоуль Дж J 
Мощность ватт Вт W 
Частота герц Гц Hz 
Магнитная индукция тесла Тл T 
Электрическая емкость фарад Ф F 
Электрическое сопротивление ом Ом Ω 
Индуктивность генри Гн H 
Время секунда с s 

 
Для транзисторов, щёлкнув левой кнопкой мышки по кнопке Pick New Transistor (Выбрать новый 

транзистор), показанной на рис. 12, выбираем меню Select Bipolar Transistor (Выбрать биполярный 
транзистор), в котором выбираем транзистор 2N3904, производства Philips.  



Установим напряжение питания мультивибратора равным 12 В. Для этого щелчком правой кнопки 
мышки по символу источника напряжения V1 вызываем его меню настройки (рис. 13). В строке DC value 
пропишем требуемое значение напряжения и закроем окно Voltage Source, щёлкнув левой кнопкой мышки 
по кнопке ОК.  

Рис. 12. Выбор модели биполярного транзистора из библиотеки LTspice. 
 

 
Рис. 13. Меню настройки источника постоянного напряжения. 
Схема нарисована, и в ней определены все компоненты (рис. 14). 

 
Рис. 14. Результирующая схема мультивибратора. 
Теперь можно приступить к имитационному моделированию работы мультивибратора. Программа 

LTspice позволяет разнообразные исследования электронных схем: 



1. Transient — выполняется анализ переходных процессов. Исследуется поведение схемы после 
подачи питания; 

2. AC Analysis — расчёт частотных характеристик; 
3. DC sweep — выполняется анализ режима по постоянному току при изменении постоянного 

напряжения или тока;  
4. Noise — Расчёт уровня внутреннего шума; 
5. DC Transfer — определяется переходная функция по постоянному току; 
6. DC op pnt — Определяется режим схемы по постоянному току (рабочая точка).  
В данном случае нас интересуют поведение схемы мультивибратора после подачи питания. 

 
Рис. 15. Запуск процесса моделирования 

(симуляции). 
Для проведения анализа переходных процессов 

воспользуемся командой 
Simulate (Моделирование) => Run (рис. 15), или щёлкнем 

левой кнопкой мышки по иконке Run  на панели 
инструментов. После этого активизируется окно 
Edit Simulation Command (Редактирование команды 
моделирования), в котором, по умолчанию, выбрана 
вкладка Transient (рис. 16). На этой вкладке, как 
минимум, нужно определить время остановки анализа 
переходного процесса (Stop Time). Это необходимо 
сделать только при первом запуске моделирования. Все 
последующие запуски производятся согласно 
установленным значениям. При необходимости 
редактирования, окно Edit Simulation Command можно 

вызвать командой Simulate (Моделирование) => Edit Simulation Cmd (Редактирование команды 
моделирования) или щёлкнув правой кнопкой мышки по директиве .tran в рабочем поле редактора схем. 
Кроме времени окончания анализа переходного процесса (Stop Time), в окне Edit Simulation Command, 
выбрав вкладку Transient, можно определить: 

• Time to Start Saving Data - время начала записи результатов моделирования; 
• Maximum Timestep - максимальный шаг интегрирования.  
Если шаг интегрирования не указан, то программа сама выбирает для него максимально возможное 

значение.  

 
Рис. 16. Окно команд моделирования. 
В окне Edit Simulation Command присутствуют дополнительно опции, позволяющие более тонкую 

настройку процесса моделирования, но нас они пока не интересуют.  



Установим время остановки равным 60 мс. В строке Syntax появилась директива для симулятора — 
.tran 60m. После щелчка левой кнопкой мышки по кнопке ОК, директива .tran 60m будет скопирована в 
окно редактора схем, где ее надо разместить в любом выбранном месте. После этого автоматически 
начнется анализ переходного процесса, окно со схемой Draft1.asv сожмётся, а на освободившееся место 
будет вставлено окно плоттера Draft1.raw, которое пока выглядит как пустой прямоугольник (рис. 17). 

Рис. 17. Вид окна программы LTspice после завершения моделирования. 
Щелчок левой кнопкой мышки в области окна делает это окно активным. В зависимости от того, какое 

окно активно, меняется содержание панели команд. Если активно окно схемы Draft1.asc, то на панели 
присутствуют меню:  

• File;  
• Edit;  
• Hierarchy;  
• View;  
• Simulate и т. д.  
Если активно окно плоттера Draft1.raw, то на панели команд присутствуют меню:  

• File;  
• View; 
• Plot Setting; 
• Simulation и т. д. 

Неактивный вид иконки Run  говорит о том, что идёт процесс моделирования. При этом в строке 
подсказки отображается текущее время и процент выполнения моделирования.  

Наблюдать диаграммы сигналов в различных точках схемы можно как в процессе моделирования, так 
и после его завершения. В первом случае процесс моделирования несколько растягивается, т. к. процессор 
компьютера загружается дополнительными операциями вывода изображения.  

Моделирование будет автоматически завершено после достижения времени остановки. При 
необходимости, процесс можно остановить и раньше комбинацией клавиш <Ctrl>+<H> или щёлкнув левой 

кнопкой мышки по иконке  на панели инструментов.  
Поместить диаграмму в окно плоттера можно тремя способами. 
Непосредственно зондируя схему.  
Через меню команд Plot Settings (Установки плоттера) => Visible Traces (Показать диаграммы).  
Через меню команд Plot Settings (Установки плоттера) => Add Trace (Добавить диаграмму). 
Воспользуемся пока самым простым способом, т. е. непосредственным зондированием схемы.  
Чтобы посмотреть форму напряжения на произвольном узле (проводнике) схемы, надо приблизить к 

нему курсор мышки. Оказавшись в районе проводника, курсор трансформируется в щуп красного цвета. 
Одновременно в строке подсказки, в левой нижней части окна, отображается приглашение щёлкнуть левой 



кнопкой мышки для вывода диаграммы напряжения на плоттер — Click to plot V(N002). После щелчка, в 
окне плоттера будет построена соответствующая временная диаграмма напряжения узла N002, которой 
будет присвоено название в виде выражения V(N002).  

Сама диаграмма и её название окрашены в одинаковый цвет, который выбирается автоматически, но 
может быть изменён вручную в окне Expression Editor (редактирование выражения). Это окно можно 
вызвать, щелкнув правой кнопкой мышки по названию диаграммы. 

Рис. 18. Диаграмма напряжения на коллекторе транзистора Q1. 
В данном случае (рис. 18) отображается напряжение на коллекторе транзистора Q1. 
При удалении курсора от выбранного узла, он превратится в крестик и, соответственно, вновь 

трансформируется в щуп при приближении к любому узлу схемы мультивибратора. По умолчанию плоттер  

Рис. 19. Диаграмма напряжения между коллекторами транзисторов Q1 и Q2. 



 

Показывает  напряжение на выбранном узле, относительно "земли" . Чтобы увидеть напряжение между 
узлами, следует щёлкнуть левой кнопкой мышки по первому узлу и, не отпуская кнопки мышки, 
переместить курсор ко второму узлу. По мере перемещения, щуп сначала окрасится в серый цвет, а затем, в 
районе второго узла, в чёрный цвет. После этого отпускаем левую кнопку мыши. Для примера, на рис. 19 
показана диаграмма напряжения между коллекторами транзисторов Q1 и Q2.  
 

 
Рис. 20. Диаграмма тока в резисторе R1. 
 

 
Рис. 21. Диаграмма мощности выделяемой на транзисторе Q1. 
 
Чтобы увидеть токи в компонентах схемы, достаточно навести курсор на компонент или подвести к 

одному из выводов компонента, имеющего более двух выводов. Курсор трансформируется в токовые клещи 



. Причём красная стрелочка будет показывать условно положительное направление тока. Теперь, 
чтобы посмотреть диаграмму тока, достаточно щёлкнуть левой кнопкой мышки. Для примера посмотрим 
ток в резисторе R1 (рис. 20). 

Аналогично току, можно посмотреть диаграмму мгновенной мощности, выделяемой на компоненте. 
Для этого нужно нажать клавишу <Alt> и, удерживая её, щёлкнуть левой кнопкой мышки по компоненту 

или по выводу компонента. Теперь курсор будет похож не на токовые клещи, а на градусник . На рис. 21 
показана диаграмма мгновенной мощности, выделяемой на транзисторе Q1. 

Вычислить среднее значение мощности, а также средние и действующие значения напряжений и 
токов можно только после окончания моделирования. Усреднение производится за весь период времени, 
отображаемый в окне плоттера. Чтобы воспользоваться функцией усреднения, достаточно нажать клавишу 
<Ctrl> и, удерживая её, щёлкнуть левой кнопкой мышки по интересующему выражению. Для напряжений и 
токов рассчитываются среднее (Average) и действующее (RMS) значения (рис. 22). Для мощности (рис. 23) 
рассчитывается средняя (Average) мощность и энергия (Integral) за отображаемый период времени. 

 
Рис. 22. Среднее и действующее значения параметра за 

отображаемый период времени. 
 
Рис. 23. Средняя мощность и энергия за отображаемый 

период времени. 
 
Для настройки 

временного интервала 
можно щёлкнуть левой 

кнопкой мышки в области окна плоттера, после чего курсор 
превратится в лупу. Затем, не отпуская левую кнопку мышки, 
выделить требуемый фрагмент диаграммы.  

В качестве альтернативы можно навести курсор на 
временную ось, после чего он трансформируется в линейку. 
Теперь, щёлкнув левой кнопкой мышки, можно вызвать окно настройки горизонтальной оси — Horizontal 
Axis (рис. 24). В этом окне можно выставить левую (Left) и правую (Right) временные границы, а также 
цену деления (tick). Аналогичным образом можно настраивать верхнюю (Top) и нижнюю (Bottom) границы 
для вертикальной оси (рис. 25).  

 

 
Рис. 24. Меню настройки горизонтальной оси плоттера. 
 

Рис. 25. Меню настройки вертикальной оси 
плоттера. 

В настройках горизонтальной оси, в отличие от 
оси вертикальной, есть дополнительная строка 
Quantity Plotted (Величина развертки). В эту строчку 
записывается базовая переменная величина, которая 
формирует горизонтальную развёртку в окне плоттера. 
По умолчанию такой переменной величиной является 
время, но в качестве неё можно использовать любое 
другое значение, вычисляемое при моделировании 
схемы. Описанная возможность далее пригодится при 

визуализации различных функциональных зависимостей, характерных для анализируемой схемы. 
Например, чтобы увидеть траекторию движения рабочей точки транзистора Q1, нужно отложить по 
горизонтали напряжение на коллекторе этого транзистора — ( 002)V N . А по вертикали — ток коллектора 
транзистора Q1, ( 1)Ic Q . То, что получилось, можно увидеть на рис. 26. 



 
Рис. 26. Траектория рабочей точки транзистора VT1. 
На этот раз, немного разобравшись с интерфейсом программы LTspice, займёмся источниками 

питания. Рассмотрим работу простейшего низковольтного источника постоянного тока, работающего от 
сети 220 В переменного тока частотой 50 Гц. Источник должен обеспечивает на выходе 12 В при токе 
нагрузки 0.1 А. Источник состоит из понижающего трансформатора и простейшего однополупериодного 
выпрямителя с конденсаторным фильтром (рис. 27). 

 
Рис. 27. Низковольтный источник постоянного тока. 
Первым делом настроим источник напряжения V1, который имитирует питающую сеть. Щелчком 

правой кнопки мышки по символу источника вызовем его меню настройки.  
 

 
Рис. 28. Меню настройки независимого источника напряжения. 
По умолчанию считается, что источник напряжения генерирует постоянное напряжения. Чтобы 

заставить его генерировать переменное напряжение, перейдём в продвинутый режим настройки, щёлкнув 



левой кнопкой мышки по кнопке Advanced (Расширенные настройки). После этого появляется меню 
настройки независимого источника напряжения (Independent Voltage Source) (рис. 28), в котором источнику 
напряжения назначается функция генератора импульсов (PULSE), синусоиды (SINE), экспоненты (EXP), 
частотно модулированного синусоидального сигнала (SFFM) или генератора сигнала произвольной формы 
(PWL). В последнем случае пользователь может задать любую форму сигнала путём кусочно-линейной 
аппроксимации. Выбираем функцию генератора синусоиды. Далее назначаем постоянную составляющую 
(DC offset) — 0 В, амплитуду (Amplitude) — 310 В и частоту переменного синусоидального напряжения 
(Freq) — 50 Гц. Возможно, в этих настройках определённое неудобство вызывает необходимость указывать 
амплитудное, а не действующее значение переменного напряжения. Для вычисления амплитудного 
значения Uamp  из известного действующего Urms , можно воспользоваться формулой 

2 1.414 220 310Uamp Urms= ⋅ = ⋅ ≈  В. 
Сетевое напряжение получили, теперь требуется понизить его до 10.5 В. Предполагается, что в 

последствии, за счёт разницы между действующей и амплитудной составляющих синусоиды, напряжение на 
конденсаторе С1 (рис. 38) поднимется до уровня 12 В. Попытаемся средствами LTspice изготовить 
трансформатор. Для этого берём две индуктивности L1 и L2, которые будут имитировать индуктивность 
первичной и вторичной обмоток трансформатора. Но этого недостаточно, надо ещё имитировать связь 
между обмотками трансформатора. В SPICE принята модель, согласно которой связь между обмотками 
определяется фиктивным схемным компонентом, который называется коэффициентом связи К (рис. 29). 
При этом коэффициент связи двух обмоток определяется выражением 12 1 2K M L L= ⋅ , где 1L , 2L  — 
индуктивности обмоток, а 12M  — их взаимная индуктивность. На рис. 29 также присутствуют 
индуктивности Ls1 и Ls2, которые обычно называются индуктивностями рассеяния и символизируют 
несвязанные между собой части первичной и вторичной обмоток трансформатора.  

 

 
Рис. 29. Моделирование взаимной индуктивности двух обмоток через их коэффициент связи. 
Допустимо изменение коэффициента связи в диапазоне –1 … 1. Если 0K = , то связь между 

обмотками отсутствует, а если 1K = , то связь полная. Минус перед коэффициентом связи позволяет 
поменять местами начало и конец вторичной обмотки трансформатора. Из-за индуктивности рассеяния 
коэффициент связи реальных трансформаторов меньше единицы и обычно находится в диапазоне 
0.9 … 0.999.  

Коэффициент связи K размещается непосредственно на схеме в виде SPICE директивы. Для его 

размещения щёлкнем левой кнопкой мышки по иконке SPICE Directive (Директива симулятора)  на 
панели инструментов. В результате появится окно ввода текста (рис. 30). Вводим следующую строку: 
K1 L1 L2 0.999, которая означает, что индуктивности L1, L2 связаны между собой, а их коэффициент 
связи равен 0.999.  

 
Рис. 30. Создания связи между индуктивностями. 



 
Далее, щёлкнув левой кнопкой мышки по кнопке ОК, переносим введённую строчку в окно редактора 

схем (рис. 31).  

 
Рис. 31. Размещение директивы связи в окне редактора схем. 
 
Теперь осталось настроить коэффициент трансформации трK  трансформатора. Известно, что 

индуктивность обмотки пропорциональна квадрату витков этой обмотки. Примем индуктивность первичной 

обмотки 1 700L =  Гн. Следовательно, если 
1 1 220 21
2 2 10.5тр

W UK
W U

= = = ≈ , то 2 2
1 7002 1.59

21тр

LL
K

= = =  Гн.  

Описанным способом можно создавать не только двух-, но и многообмоточные трансформаторы. 
Например, директива K1 L1 L2 L3 L4 1.0 создаёт четырехобмоточный трансформатор. Многократные 
объявления коэффициента связи внутри одного трансформатора недопустимы. В этом случае LTspice 
потребует использования одной директивы коэффициента связи. 

Модель индуктивности в LTspice имеет вид, представленный на рис. 32. Здесь, кроме индуктивности 
(Inductance), учитывается масса паразитных параметров: 

• Rser  (Series Resistance) - последовательное сопротивление обмотки; 
• Rpar  (Parallel Resistance) - сопротивление потерь между выводами обмотки;  
• Cpar  (Parallel Capacitance) - межвитковая ёмкость.   
Настроить основные и паразитные параметры модели можно в окне настройки (рис. 33), которое 

вызывается щелчком правой кнопки мышки по индуктивности L1 (или L2). Здесь индуктивность измеряется 
в генри, ёмкость — в фарадах, а сопротивление — в омах. Опцией Show Phase Dot (Отметить точкой начало 
обмотки) можно делать видимой и скрывать индикацию начала обмотки.  

 
Рис. 32. Модель индуктивности, используемая в программе 

LTspice. 
 
Указание паразитных параметров компонентов позволяет 

получить более реалистичную картину моделирования. Некоторые 
паразитные параметры LTspice определяет сам, если пользователь не 
указывает их конкретную величину. Например, по умолчанию, 
LTspice считает, что 0.001Rser =  Ом. 

Устанавливаем 
индуктивность 1 700L =  Гн и 
последовательное 
сопротивление 

100Rser =  Ом (рис. 33). Для 
L2 соответственно 2 1.59L =  Гн и 1Rser =  Ом. 

Выберем конденсатор С1 и установим значение ёмкости 
470 мкФ. Обычно в подобных устройствах устанавливают 
электролитические конденсаторы, которые имеют достаточно 
высокое внутреннее сопротивление, поэтому устанавливаем 
последовательное сопротивление 1Rser =  Ом.  

 
Рис. 33 Меню настройки индуктивности. 

 
 



Так как источник должен обеспечивать 12 В при токе нагрузки 0.1 А, то 
121 120
0.1

R = =  Ом.  

Для диода оставляем идеальную модель, выбранную по умолчанию. При желании можно выбрать 
модель реального диода из встроенной библиотеки LTspice. Для этого щелчком правой кнопки мышки по 
символу диода вызываем его окно настройки. Затем вызываем список доступных моделей, щёлкнув левой 
кнопкой мышки по кнопке Pick New Diode (Выбрать новый диод).  

Полностью настроенная схема изображена на рис. 34. 

 
Рис. 34. Схема модели маломощного источника постоянного тока. 

Щёлкнув левой кнопкой мышки по символу Run  на панели инструментов, попадаем в окно Edit 
Simulation Command. где устанавливаем  время окончания анализа переходного процесса Stop Time 
равным 5 с и время начала записи результатов моделирования Time to Start Saving Data — 4.96 с. В этом 
случае в окно плоттера будут выведены последние два периода работы схемы, а предшествующий им 
переходной процесс останется вне поля зрения. На рис. 35 изображено состояние после окончания 
моделирования. В окно плоттера выведены диаграммы: ( 002)V n  — напряжение на вторичной обмотке 
трансформатора, ( 003)V n  — напряжение на резисторе R1, ( 1) * 21I L  — ток первичной обмотки, 
приведённый ко вторичной обмотке (умножен на коэффициент трансформации), ( 2)I L−  — ток вторичной 
обмотки (символ минус "–" использован для изменения полярности отображаемого тока). Видно, что, в 
момент, когда напряжение на вторичной обмотке трансформатора превышает напряжение нагрузки, во 
вторичной обмотке возникают короткие импульсы тока амплитудой до 900 мА. Ток в первичной обмотке 
трансформатора отличается от тока вторичной. Видно, что в паузах между импульсами, он меняет свою 
полярность. Такое поведение тока первичной обмотки трансформатора характерно для случая 
использования однополупериодного выпрямления. Постоянный ток нагрузки, протекает через вторичную 
обмотку трансформатора, а трансформатор, как известно, не может трансформировать постоянный ток. В 
результате, в первичной обмотке возникает размагничивающий ток отрицательной полярности, который 
компенсирует постоянную составляющую входного тока. 

В данном примере мы использовали идеализированную линейную модель трансформатора. К 
сожалению, идеализированная модель не всегда уместна, т. к. не учитывает насыщение и гистерезис, 
которые присущи магнитным сердечникам реальных трансформаторов. Например, в рассмотренной 
ситуации, диаграмма тока в первичной обмотке реального трансформатора, скорей всего, будет сильно 
отличатся от диаграммы, полученной для идеализированной модели.  

В LTspice предусмотрено два способа задания нелинейности индуктивности: 
• первый способ позволяет аналитически задавать зависимости потока магнитной индукции от тока в 

обмотке катушки индуктивности; 
• второй способ позволяет использовать упрощённую гистерезисную модель магнитного сердечника, 

которую впервые предложил Джон Чан.  
Модель использует только основные параметры петли гистерезиса, перечисленные в таблице 3 и 

показанные на рис. 36.  
Таблица  3. Параметры петли гистерезиса ферромагнитного материала  

Параметр Описание Единицы измерения
Hc  Коэрцитивная сила А/м 
Br  Остаточная индукция Тл 
Bs  Индукция насыщения Тл 



 
Рис. 35. Состояние после окончания моделирования источника постоянного тока. 

 
Рис. 36. Параметры петли гистерезиса магнитного материала.  
Наряду с параметрами петли гистерезиса, при описании нелинейной индуктивности, учитываются 

линейные размеры сердечника, а также количество витков катушки (табл. 4). 
Таблица 4. Конструктивные параметры нелинейной индуктивности    

Параметр Описание Единицы измерения
Lm  Средняя длина магнитной линии (исключая немагнитный зазор)м 
Lg  Длина немагнитного зазора м 
A  Сечение сердечника м2 
N  Количество витков — 

Согласитесь со мной, что второй способ задания нелинейной индуктивности более привлекателен, т. к. 
он использует минимальное количество справочных данных, а также понятные и легко контролируемые 
параметры самого сердечника и катушки. 



На частоте 50 Гц в трансформаторах обычно применяется электротехническая сталь с толщиной листа 
0.27—0.5 мм. Для холоднокатаной электротехнической стали типов 3411—3413 (Э310—Э330) можно 
использовать следующие параметры петли гистерезиса: 95Hc =  A/м, 1.2Br =  Тл, 1.75Bs =  Тл. 

Примем следующие конструктивные параметры нелинейной индуктивности, предназначенной для 
моделирования параметров трансформатора источника постоянного тока: 0.1Lm =  м, 0Lg =  м, 

41.1 10A −= ⋅  м2, 6000N =  витков.  
В основе модели нелинейного трансформатора (на рис. 37 обведен пунктирной линией) лежит всё тот 

же идеальный трансформатор L1, L2. Здесь он служит для имитации гальванической развязки и 
коэффициента трансформации. Нелинейная индуктивность L3, подключена параллельно первичной (или 
вторичной) обмотке идеального трансформатора. Чтобы не возникала ошибка моделирования (запрет на 
параллельное включение индуктивностей), нужно последовательно с индуктивностью L3 включить 
низкоомное сопротивление R2 (или указать последовательное сопротивление в меню настройки 
индуктивности).  

Так как обмотки идеального трансформатора теперь полностью связаны, то последовательно с 
первичной и вторичной обмотками надо включить индуктивности рассеяния L4 и L5, которые имитируют 
поля рассеяния реального трансформатора. Индуктивности L1, L2, L4, L5 — линейные и настраиваются 
описанным ранее способом, согласно табл. 5. 

Таблица 5. Значения параметров индуктивностей в модели трансформатора 
Поз. 
обозначение 

Inductance[H] 
(Индуктивность[Гн]) 

Series Resistance[Ω] (Последовательное 
сопротивление[Ом]) 

L1 700 — 
L2 1.59 — 
L4 350m 100 
L5 0.8m 1 

Теперь, щёлкнув правой кнопкой мышки по символу L3, вызовем меню настройки и впишем 
определённый ранее перечень параметров в строку Inductance (Индуктивность): 95Hc = , 1.2Br = , 

1.75Bs = , 0.1Lm = , 0Lg = , 0.00011A = , 6000N = .  

После ввода всех параметров, при помощи иконки  на панели инструментов, раздвинем 
позиционные обозначения и строки параметров таким образом, чтобы они друг друга не заслоняли и хорошо 
читались (рис. 37). 

 
Рис. 37. Схема модели маломощного источника постоянного тока с нелинейным трансформатором. 
На рис. 38 изображено состояние после окончания моделирования. В окно плоттера выведены 

диаграммы:  
• ( 004)V n  — напряжение на вторичной обмотке трансформатора;  
• ( 005)V n  — напряжение на резисторе R1;  
• ( 4) * 21I L  — ток первичной обмотки, приведённый ко вторичной обмотке (умножен на 

коэффициент трансформации);  
• ( 5)I L  — ток вторичной обмотки. 

 
 
 
 



 
Рис. 38. Состояние после окончания моделирования источника постоянного тока с нелинейным 

трансформатором. 
На диаграмме тока первичной обмотки ( 4) * 21I L , кроме небольшой составляющей намагничивания, 

виден отрицательный импульс тока, который отсутствовал в случае использования линейного 
трансформатора. Этот импульс не связан с током нагрузки (в это время ток во вторичной обмотке 
отсутствует) и, следовательно, вызван односторонним насыщением сердечника трансформатора. 
Насыщение происходит в конце отрицательного полупериода сетевого напряжения, когда индукция в 
сердечнике достигает своего максимального значения.  

К сожалению, в LTspice нет встроенной функции, позволяющей отобразить траекторию 
перемагничивания магнитного сердечника. Но данную проблему можно решить, добавив простейший 
тестовый узел в модель источника питания (рис. 39). 

 
Рис. 39. Тестовый узел, позволяющий наблюдать траекторию перемагничивания магнитного 

сердечника. 
Тестовый узел построен на двух источниках тока, G1 и G2, управляемых напряжением, которые 

используются для измерения и нормирования отображаемых параметров.  
Известно, что скорость изменения индукции в сердечнике прямо пропорциональна приложенному 

напряжению U  и обратно пропорциональна площади сечения A  и виткам обмотки N .  
dB U
dt A N

=
⋅

 



Следовательно, подав напряжение U  на вход интегратора, на его выходе мы получим сигнал, 
пропорциональный индукции в сердечнике. В нашем случае роль интегратора возложена на узел, состоящий 
из источника G1 и конденсатора С2. Коэффициент передачи управляемого источника тока G1, 
обеспечивающий выходное напряжение интегратора, равное индукции, можно вычислить по формуле: 

6
6

1 6
2 1 10 1.515 10

110 10 6000G
CK

A N

−
−

−
⋅

= = = ⋅
⋅ ⋅ ⋅

 

Вычисленное значение коэффициента передачи необходимо записать в строке Value меню настройки 
управляемого источника тока G1. 

Коэффициент передачи управляемого источника тока G2, обеспечивающий выходной ток, равный 
напряжённости в сердечнике нелинейного трансформатора, можно вычислить по формуле: 

5
2

6000 6 10
2 0.1 0.1G
NK

R Lm
= = = ⋅

⋅ ⋅
 

Вычисленное значение коэффициента передачи необходимо записать в строке Value меню настройки 
управляемого источника тока G2.  

Для устранения дрейфа показаний интегратора G1, C2 необходимо установить параметр вычисления 
переходного процесса Maximum Timestep 10 мс или меньше. В настройках горизонтальной оси, в строчке 
Quantity Plotted (Величина развертки), вместо time впишем "I(G2)". По вертикали выводим напряжение на 
выходе интегратора, щёлкнув левой кнопкой мышки по верхнему выводу конденсатора С2 (рис. 40).  

 

 
Рис. 40. Траектория перемагничивания сердечника нелинейного трансформатора. 
Из диаграммы перемагничивания (рис. 40) видно, что сердечник подвержен сильному одностороннему 

насыщению. В направлении насыщения напряженность магнитного поля достигает 3500 А/м. Очевидно, 
одностороннее насыщение вызвано постоянной составляющей выходного тока источника, который 
протекает через вторичную обмотку трансформатора. Чтобы убедиться в справедливости наших 
подозрений, заменим однополупериодный выпрямитель на двухполупериодный (рис. 41). 

 



 
Рис. 41. Траектория перемагничивания сердечника трансформатора в источнике постоянного тока с 

двухполупериодным выпрямителем.  
На рис. 40 изображено состояние после окончания моделирования источника постоянного тока с 

двухполупериодным выпрямителем. В данном случае цикл перемагничивания сердечника симметричен и не 
выходит в область насыщения. Отсюда можно сделать вывод, что использование однополупериодного 
выпрямителя на выходе трансформатора недопустимо, т. к. вызывает одностороннее насыщение его 
сердечника.  
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МОП-транзистор

Имена компонента: NMOS, NMOS3, PMOS,

PMOS3, VDMOS.

В LTSpice есть две существенно отличаю-

щиеся модели МОП-транзисторов: модель

интегрального МОП-транзистора и новая мо-

дель силового вертикального МОП-транзи-

стора с двойной диффузией.

Интегральный МОП-транзистор

Синтаксис: Mxxx <порт стока> <порт за-

твора> <порт истока> <порт подложки>

<имя модели> [m=<значение>] [L=<значе-

ние>] [W=<значение>] [AD=<значение>]

[AS=<значение>] [PD=<значение>] [PS=<зна-

чение>] [NRD=<значение>] [NRS=<значе-

ние>] [off] [Iс=<Vds, Vgs, Vbs>] [temp=<тем-

пература>].

Например:

M1 Nd Ng Ns 0 MyMOSFET 

.model MyMOSFET NMOS(KP=.001)

M1 Nd Ng Ns Nb MypMOSFET 

.model MypMOSFET PMOS(KP=.001)

Мощный вертикальный 

МОП-транзистор с двойной диффузией

Синтаксис: Mxxx <порт стока> <порт затво-

ра> <порт истока> <имя модели> [L=<значе-

ние>] [W=<значение>] [m=<значение>] [off]

[IC=<Vds, Vgs, Vbs>] [temp=<температура>].

Например:

M1 Nd Ng Ns Si4410DY

.model Si4410DY VDMOS(Rd=3m Rs=3m Vto=2.6 Kp=60

Cgdmax=1.9n Cgdmin=50p Cgs=3.1n Cjo=1n Is=5.5p Rb=5.7m)

Описание модели МОП-транзистора опре-

деляет рассматриваемый тип транзистора.

Ключевые слова модели NMOS и PMOS оп-

ределяют интегральный n- или p-канальный

МОП-транзистор. Ключевое слово модели

VDMOS определяет мощный вертикальный

МОП-транзистор с двойной диффузией.

Интегральные МОП-транзисторы — уст-

ройства с четырьмя выводами Nd, Ng, NS

и Nb, соответственно, это выводы стока, за-

твора, истока и подложки. L и W — длина

и ширина канала в метрах. AD и AS — пло-

щади диффузионных областей стока и исто-

ка в квадратных метрах. Отметим, что суф-

фикс u определяет мкм, а p — мкм2. Если ка-

кой-либо из параметров L, W, AD или AS не

определен, используется значение по умол-

чанию. По умолчанию PD и PS равны нулю,

а NRD и NRS равны единице. Ключевое сло-

во off указывает на наличие начальных усло-

вий при DC.-анализе. Начальные условия

Iс = VDS, VGS, VBS предназначены для .TRAN-

анализа с модификатором UIC, когда анализ

переходного процесса желательно начать в от-

личной от статической рабочей точке. Допол-

нительная величина TEMP задает рабочую

температуру конкретного устройства и анну-

лирует для него задание температуры в уп-

равляющей строке .OPTION. Указать темпе-

ратуру можно только для МОП-транзисто-

ров уровней 1, 2, 3 и 6, но не для устройств

BSIM уровней 4, 5 или 8.

Физические параметры МОП-транзисто-

ров перечислены в таблице 28.

LTSpice поддерживает семь различных мо-

делей интегральных МОП-транзисторов и од-

ну модель мощного вертикального с двой-

ной диффузией МОП-транзистора. Для ин-

тегральных МОП-транзисторов параметр

модели LEVEL указывает на используемую

модель. По умолчанию этот параметр равен

единице.

Характеристики постоянного тока МОП-

транзисторов уровней с 1-го по 3-й опреде-

лены параметрами VTO, KP, LAMBDA, PHI

и GAMMA. Эти параметры рассчитываются

по известным параметрам процесса (NSUB,

TOX, ѕ), при этом пользовательские значе-

ния всегда аннулируются. VTO положитель-

но (отрицательно) для обогащенных и от-

рицательно (положительно) для обеднен-

ных n-канальных (p-канальных) приборов.

Накопление заряда моделируется тремя по-

стоянными емкостями CGSO, CGDO и CGBO,

которые представляют собой емкости пере-

крытия, тонкопленочные нелинейные кон-

денсаторы, распределенные над затвором, ис-

током, стоком, и нелинейные емкости обед-

ненного слоя обоих переходов с подложкой.

Они, в свою очередь, подразделяются на ос-

новные и периферические, которые изменя-

ются с приложенным к переходам напряже-

нием с коэффициентами MJ и MJSW соответ-

ственно и определены параметрами CBD,

CBS, CJ, CJSW, MJ, MJSW и PB. Эффект на-

копления заряда описывается моделью емко-

сти, линейно зависящей от напряжения, пред-

ложенной Мейером. Эффекты накопления за-

ряда в тонком окисле отличаются для модели

Level = 1. Эти зависящие от напряжения ем-

кости подключаются, только если задана Tox.

Параметры, описывающие переходы, не-

сколько перекрываются, например, обратный

ток может быть специфицирован либо через

Is (A) либо через Js (А/м2). Поскольку пер-

вое — абсолютная величина второго, умно-

женного на AD и AS, то имеем обратные то-

ки переходов стока и истока соответственно.

Это относится и к емкостям переходов при

нулевом смещении CBD и CBS (Ф) в одном

варианте и CJ (Ф/м2) в другом. Паразитные

последовательные сопротивления стока и ис-

тока могут быть выражены как RD и RS (Ом)

или RSH (Ом/кв.), последнее умножается на

количество квадратов NRD и NRS, приходя-

щихся на длину элемента прибора.

Параметры моделей МОП-транзисторов

уровней 1, 2 и 3 перечислены в таблице 29.

Дискретный вертикальный МОП-транзи-

стор с двойной диффузией (ДМОП), обычно

используемый в ИИП, ведет себя качествен-

но по-другому, чем вышеупомянутые моде-

ли интегральных МОП-транзисторов. В ча-

стности, встроенный диод ДМОП-транзисто-

ра подключен к внешним выводам иначе, чем

диод подложки интегрального МОП-транзи-

стора, а нелинейная емкость затвор–сток (Cgd)

не может быть смоделирована простым мас-

штабированием емкостей моделей интеграль-

ных МОП-транзисторов. В ДМОП-транзис-

торе Cgd резко изменяется в окрестности ну-

левого напряжения затвор–исток (Vgd). Когда

напряжение Vgd отрицательно, Cgd физиче-

В данной части статьи — продолжение описания моделей компонентов

на языке LTSpice.

Программа схемотехнического 

моделирования SwitcherCAD III

Окончание. Начало в № 11 `2008

Таблица 28. Физические параметры МОП"транзистора

–

–

м

м

м2

м2

м

Удельное поверхностное 
сопротивление истока

Удельное поверхностное 
сопротивление стока

Периметр диффузионной области истока

Периметр диффузионной области стока

Площадь диффузионной области истока

Площадь диффузионной области стока

Ширина канала

NRS

NRD

PS

PD

AS

AD

W

мДлина каналаL

Единица 
измерения

Параметр
Обозна)

чение
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ски базируется на конденсаторе с затвором в качестве первого элект-

рода и стока, а в конечном итоге — подложки, в качестве второго эле-

ктрода. Эта емкость весьма мала вследствие большой толщины не-

проводящей подложки. Когда же Vgd положительно, подложка в про-

водящем состоянии, и Cgd физически основана на конденсаторе

с толщиной затворного окисла.

Традиционно для имитации поведения мощных МОП-транзисто-

ров используются сложные макромодели. Новое встроенное SPICE-

устройство было создано с целью ускорения расчетов, надежности

преобразования и упрощения записи моделей. Эквивалентная схе-

ма устройства представлена на рис. 55.

Модель для постоянного тока аналогична модели уровня 1 инте-

грального МОП-транзистора, за исключением того, что длина и ши-

рина канала опускаются, а крутизна задается непосредственно,

без вычислений. Модель для переменного тока следующая. Емкость

затвор–исток принята постоянной. Как установлено опытным пу-

тем, это хорошее приближение для мощного МОП-транзистора,

если напряжение затвор–исток не становится отрицательным. Емкость

затвор–сток определяется эмпирической зависимостью, изображен-

ной на рис. 56.

Емкость затвор–сток Cgd изменяется как гиперболический тан-

генс напряжения затвор-сток Vgd для положительного напряжения

и как арктангенс для отрицательного напряжения. Параметры мо-

дели Cgdmax и Cgdmax определяют емкость затвор–сток. Емкость

исток–сток представлена емкостью встроенного диода, подключен-

ного непосредственно к электродам истока и стока для исключения

влияния сопротивлений истока и стока.

Параметры модели вертикального ДМОП-транзистора в таблице 30.

www.kit)e.ru

Таблица 29. Параметры модели интегрального МОП"транзистора

1

1

5×104

0,3

700

0,1

1×104

1×10–7

50

0,1

10

1

1

0,65

0,87

4×1015

1×10–10

1×10–10

5

0,5

0,8

0,02

3×10–6

1×10–26

0,5

1×10–8

1×10–15

0,37

1

1

1

2×10–4

4×10–11

4×10–11

2×10–10

20

20

0

0

0

0

600

0

1×104

1

1×10–7

27

0

0

0

0

0,6

0,8

0

0

0

1

1

0,33 уровни 2, 3

0,50 уровень 1

0,5

0

0

2×10–5

0

0,2

0

1×10–14

0

0,5

0

0

0

0

0

0

0

0

0

мкм

В

м/с

–

см2/В·с

–

В/см

–

м

°С

–

Ом

Ом

Ом

В

В

1/см3

1/см2

1/см2

–

–

–

–

мкм

1/В

А/В2

–

–

А/м2

А

В1/2

–

–

–

пФ/м

Ф/м2

Ф/м

Ф/м

Ф/м

фФ

фФ

Глубина металлургического перехода

Пороговое напряжение

Максимальная скорость дрейфа носителей 
(только уровни 2 и 3)

Коэффициент поперечного поля (только уровень 2)

Подвижность носителей в поверхностном слое

Эмпирическая константа подвижности носителей
(только уровень 2)

Критическая напряженность поля (только уровень 2)

0 (алюминиевый затвор)

–1 (примесью противоположного типа)

+1 (примесью того же типа, как и подложки)

Тип легирования затвора:

Толщина окисла

Рабочая температура

Коэффициент модуляции подвижности 
(только уровень 3)

Сопротивление диффузионных областей стока и истока

Объемное сопротивление истока

Объемное сопротивление стока

Поверхностный потенциал инверсии

Потенциал инверсии приповерхностного слоя
подложки

Уровень легирования подложки

Плотность медленных поверхностных состояний

Плотность быстрых поверхностных состояний

Коэффициент коррекции концентрации примеси
в канале (только уровень 2)

Коэффициент неидеальности перехода сток–подложка

Коэффициент наклона боковой поверхности 
переходов сток (исток) – подложка

Коэффициент плавности переходов 
сток (исток) – подложка

Боковая диффузия

Параметр модуляции длины канала 
(только для уровней 1 и 2)

Крутизна

Коэффициент фликкер"шума

Параметр модуляции длины канала напряжением
сток–исток (только уровень 3)

Плотность тока насыщения переходов 
сток (исток) – подложка

Ток насыщения переходов сток (исток) – подложка

Коэффициент влияния потенциала подложки
на пороговое напряжение

Коэффициент нелинейности барьерной емкости
прямосмещенного перехода

Коэффициент влияния напряжения сток–исток
на пороговое напряжение (только уровень 3)

Коэффициент влияния ширины канала на пороговое
напряжение (уровни 2 и 3)

Удельная емкость боковой поверхности переходов
сток (исток) – подложка при нулевом смещении

Удельная емкость переходов сток (исток) – подложка

Удельная емкость перекрытия затвор–исток

Удельная емкость перекрытия затвор–сток

Удельная емкость перекрытия затвор–подложка

Емкость перехода исток–подложка 
при нулевом смещении

Емкость перехода сток–подложка 
при нулевом смещении

Xj

Vto

Vmax

Utra

Uo

Uexp

Ucrit

TPG

Tox

Tnom

Theta

Rsh

Rs

Rd

Phi

Pb

Nsub

Nss

Nfs

Neff

N

Mjsw

Mj

Ld

Lambda

Kp

Kf

Kappa

Js

Is

Gamma

Fc

Eta

Delta

Cjsw

Cj

Cgso

Cgdo

Cgbo

Cbs

Cbd

1,21–Показатель степени фликкер"шумаAf

Пример
Значение 

по умолчанию
Единица 

измерения
Параметр

Обозна)
чение

Рис. 56. Зависимость емкости затвор–сток

Таблица 30. Параметры модели ДМОП"транзистора

1

0,8

10

50

1

2

10

1

0,5

–

0,65

0,5

0,02

0,5

1×10–15

1

500

300

1000

1

3

0

1

0

27

0

0

∞

0

0

(false)

0,6

(true)

1

0,5

0

1

1

0

1×10–14

0,5

1×10–11

0

0

0

0

1

–

–

В

В

нс

°С

Ом

Ом

МОм

Ом

Ом

–

В

–

–

–

1/В

–

А/В2

–

А

–

эВ

нФ

пФ

пФ

пФ

–

Коэффициент для ширины канала

Температурный коэффициент тока насыщения 
диода подложки

Пороговое напряжение

Пороговый потенциал диода подложки

Время переноса заряда для диода подложки

Температура

Омическое сопротивление истока

Омическое сопротивление затвора

Сопротивление утечки сток–исток

Омическое сопротивление стока

Омическое сопротивление диода подложки

p"канальный вертикальный ДМОП

Поверхностный потенциал инверсии

n"канальный вертикальный ДМОП

Коэффициент эмиссии диода подложки

Коэффициент плавности перехода диода подложки

Параметр модуляции длины канала

Коэффициент для длины канала

Параметр крутизны

Коэффициент фликкер"шума

Ток насыщения диода подложки

Коэффициент нелинейности барьерной емкости
прямосмещенного диода подложки

Ширина запрещенной зоны для диода подложки

Емкость перехода диода подложки 
при нулевом смещении

Емкость затвор–исток

Минимум нелинейной емкости затвор–сток

Максимум нелинейной емкости затвор–сток

Показатель степени фликкер"шума

W

Xti

Vto

Vj

tt

Tnom

Rs

Rg

Rds

Rd

Rb

pchan[*]

Phi

nchan[*]

N

M

Lambda

L

Kp

Kf

Is
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Eg

Cjo

Cgs

Cgdmin

Cgdmax

Af

0,51–Параметр нелинейности емкости затвор–стокA
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Рис. 55. Эквивалентная схема мощного МОП"транзистора
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Имя модели VDMOS используется как для n-канальных, так и для

p-канальных транзисторов. По умолчанию устанавливается n-про-

водимость. Для того чтобы определить p-канал, следует дополнить

модель ключевым словом pchan, например, “.model xyz VDMOS(Kp=3

pchan)” определяет p-канальный транзистор.

Линия передачи с потерями

Имя символа: LTLIN.

Синтаксис: Oxxx <узел порта L+> <узел порта L–> <узел порта R+>

<узел порта R–> <имя модели>.

Например: 

O1 in 0 out 0 MyLossyTline

.model MyLossyTline LTRA(len=1 R=10 L=1u C=10n)

Это однопроводная линия передачи с потерями. L+ и L– — узлы од-

ного порта. R+ и R– — узлы другого порта. Электрические характе-

ристики определяются строкой .MODEL. 

Параметры модели линии передачи с потерями приведены в таб-

лице 31.

Биполярный транзистор

Имя символа: NPN, PNP, NPN2, PNP2.

Синтаксис: Qxxx <узел коллектора> <узел базы> <узел эмиттера>

[узел подложки] <имя модели> [коэффициент кратности] [прово-

димость] [IC=<Vbe, Vce>] [temp=<T>].

Например:

Q1 C B E MyNPNmodel 

.model MyNPNmodel NPN(Bf=75)

Чтобы задать характеристики биполярных транзисторов, исполь-

зуется описание модели. Ключевые слова в строке модели NPN и PNP

указывают на проводимость транзистора. Множитель area опреде-

ляет количество эквивалентных устройств соответствующей моде-

ли, включенных параллельно.

Модель биполярного транзистора — это адаптированная модель

Гуммеля-Пуна. Модификация расширила модель, чтобы учесть не-

которые эффекты при больших уровнях смещения, в режиме квази-

насыщения, и проводимость подложки. Модель автоматически уп-

рощается до модели Эберса-Молла, когда опущены некоторые пара-

метры. На постоянном токе модель задана параметрами Is, Bf, Nf, Ise,

Ikf, Ne, определяющими характеристики в прямом включении, Is,

Br, Nr, Isc, Ikr, Nc, определяющими характеристики в обратном вклю-

чении, и Vaf, Var, определяющими выходную проводимость для пря-

мого и обратного включения. Модель включает в себя три омичес-

ких сопротивления Rb, Rc и Re, при этом Rb может зависеть от ве-

личины протекающего тока. Накопление заряда в базе моделируется

временами переноса заряда в прямом и обратном включении (Tf

и Tr), причем Tf можно сделать зависящим от уровня смещения, и не-

линейными емкостями обедненного слоя, заданными параметрами

Cje, Vje, Mje для перехода база–эмиттер, Cjc, Vjc, Mjc для перехода ба-

за–коллектор и Cjs, Vjs, Mjs для перехода коллектор–подложка. Тем-

пературная зависимость тока насыщения Is определяется шириной

запрещенной зоны полупроводника Eg и экспоненциальным темпе-

ратурным коэффициентом Xti. Температурная зависимость коэф-

фициента передачи в новой модели моделируется экспоненциаль-

ным температурным коэффициентом Xtb. Значение температуры

Tnom может быть задано директивой .OPTIONS или отвергнуто при-

оритетной записью в строке .MODEL.

Параметры биполярного транзистора, использованные в модифи-

цированной модели Гуммеля-Пуна, приведены в таблице 32.

Таблица 31. Параметры линии передачи с потерями

Таблица 32. Параметры модифицированой модели Гуммеля"Пуна биполярного транзистора
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Ом

–

К

–
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–
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–

–

А

А

А

А

А

А

А

А

–

эВ

0,52 PNP

0,87 NPN

2,2 PNP

2,42 NPN

Ф

Ф

Ф

В

–

–

Экспоненциальный температурный коэффициент для Is

Коэффициент, описывающий зависимость Tf 
от напряжения база–коллектор

Температурный коэффициент Bf и Br

Коэффициент расщепления емкости база–коллектор

Коэффициент, описывающий зависимость Tf 
от напряжения коллектор–база

Напряжение, определяющее перегиб зависимости тока
эпитаксиальной области

Контактная разность потенциалов перехода коллектор–подложка

Контактная разность потенциалов перехода база–эмиттер

Контактная разность потенциалов перехода база–коллектор

Напряжение ширины запрещенной зоны, 
экстраполированное для 0 К

Напряжение Эрли в инверсном режиме

Напряжение Эрли в нормальном режиме

Квадратичный температурный коэффициент пробивного
напряжения перехода коллектор–база

Линейный температурный коэффициент 
пробивного напряжения перехода коллектор–база

Квадратичный температурный коэффициент Rmb

Линейный температурный коэффициент Rmb

Квадратичный температурный коэффициент Re

Линейный температурный коэффициент Re

Квадратичный температурный коэффициент Rc

Линейный температурный коэффициент Rc

Квадратичный температурный коэффициент Rb

Линейный температурный коэффициент Rb

Идеальное время переноса в инверсном режиме

Температура измерений

Идеальное время переноса в нормальном режиме

Объемное сопротивление эмиттера

Сопротивление эпитаксиальной области

Объемное сопротивление коллектора

Сопротивление базы при больших токах

Объемное сопротивление базы при нулевом смещении

Флаг квазинасыщения температурной зависимости

Множитель, определяющий заряд в эпитаксиальной области

Фазовый сдвиг на граничной частоте f = 1/(Tf×2×PI)

Коэффициент неидеальности перехода коллектор–подложка

Коэффициент неидеальности в инверсном режиме

Коэффициент неидеальности в нормальном режиме

Коэффициент неидеальности перехода база–эмиттер

Коффициент неидеальности перехода база–коллектор

Коэффициент неидеальности в режиме пробоя перехода
база–коллектор

Коэффициент плавности перехода коллектор–подложка

Коэффициент плавности перехода база–эмиттер

Коэффициент плавности перехода база–коллектор

Коэффициент спектральной плотности фликкер"шума

Параметр, определяющий зависимость Tf при больших токах

Обратный ток перехода коллектор–подложка

Обратный ток перехода база–эмиттер

Обратный ток перехода база–коллектор

Ток насыщения

Ток базы, при котором сопротивление базы уменьшается
на величину, равную половине разности между максимальным

и минимальным значениями

Ток начала спада коэффициента передачи в инверсном режиме

Ток начала спада коэффициента передачи в нормальном режиме

Коэффициент легирования эпитаксиальной области

Коэффициент нелинейности барьерных емкостей 
при прямом смещении

Ширина запрещенной зоны

Температурный коэффициент квазинасыщения скорости
рассасывания неосновных носителей

Температурный коэффициент квазинасыщения подвижности
неосновных носителей

Емкость перехода коллектор–подложка при нулевом смещении

Емкость перехода база–эмиттер при нулевом смещении

Емкость перехода база–коллектор при нулевом смещении

Пробивное напряжение перехода база–коллектор

Идеальный максимальный коэффициент передачи 
в инверсном режиме

Идеальный максимальный коэффициент передачи 
в нормальном режиме
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Установив параметр модели Level = 9,

в LTSpice можно воспользоваться другой

моделью биполярного транзистора, VBIC,

являющейся расширенной модификацией

стандарной модели Гуммеля-Пуна, ориенти-

рованной на интегральные биполярные тран-

зисторы современных полупроводниковых

технологий.

Дополнительные возможности, которые

дает модель VBIC в сравнении со стандарт-

ной моделью Гуммеля-Пуна: 
•• интегрированный паразитный транзистор

подложки для интегральных схем;
•• модель лавинного пробоя база–эмиттер;
•• улучшенное моделирование эффекта Эрли;
•• физическое разделение Ic и Ib;
•• улучшенная модель барьерной емкости;
•• улучшенное температурное моделирование;
•• моделирование саморазогрева (в LTSpice

отсутствует).

Резистор

Имя символа: RES, RES2.

Синтаксис: Rxxx <узел 1> <узел 2> <сопро-

тивление> [tc=линейный температурный ко-

эффициент, квадратичный температурный

коэффициент, ѕ] [temp=<значение>].

Резистор представляется простым линей-

ным сопротивлением между узлами n1 и n2.

Температурная зависимость может быть оп-

ределена для каждого резистора встроенным

параметром tc. Сопротивление R равно:

R=R0�
�(1+dt�tc1+dt�2�tc2+dt�3�tc3+ѕ),

где R0 — сопротивление при номинальной

температуре, а dt — разница между темпера-

турой резистора и номинальной температу-

рой.

Ключ, 

управляемый напряжением

Имя символа: SW. 

Синтаксис: Sxxx <узел 1> <узел 2> <управ-

ляющий узел+> <управляющий узел–> <имя

модели> [on,off].

Например:

S1 out 0 in 0 MySwitch 

.model MySwitch SW(Ron=.1 Roff=1Meg Vt=0 Vh=-.5 Lser=10n

Vser=.6)

Напряжение между узлами <управляющий

узел+> <управляющий узел–> управляет

полным сопротивлением ключа между узла-

ми <узел 1> и <узел 2>. Требуется опреде-

лить поведение ключа в директиве .MODEL.

В файле .\examples\Educational\Vswitch.asc

показан пример с размещением директивы

.MODEL непосредственно в схеме.

Параметры модели ключа, управляемого

напряжением, приведены в таблице 33.

Ключ имеет три различных способа управ-

ления напряжением, в зависимости от вели-

чины напряжения гистерезиза Vh. Если Vh

равно нулю, ключ всегда полностью замкнут

или разомкнут в зависимости от того, выше

или ниже порога входное напряжение. Если

Vh положительно, ключ имеет гистерезис, как

будто он управляется триггером Шмитта

с точками переключения Vt–Vh и Vt+Vh.

Vh равно половине напряжения между точка-

ми переключения, и в этом отличие от других

известных моделей. Если Vh отрицательно,

ключ плавно переключается между замкну-

тым и разомкнутым состояниями. Переклю-

чение происходит между управляющими на-

пряжениями Vt–Vh и Vt+Vh.

Есть модель ключа, управляемого напря-

жением, уровня 2, являющаяся более совер-

шенной версией ключа уровня 1 с отрица-

тельным гистерезисом. Ключ уровня 2 ни-

когда полностью ни замкнут, ни разомкнут.

Проводимость в функции управляющего на-

пряжения Vc:

g(Vc) = exp(A�atn((Vc–Vt)/Vh)+B),

где A = pi�(log(1/Ron)–log(1/Roff));

B = (log(1/Ron)+log(1/Roff)).

Переключение ключа уровня 2 до ограни-

чения тока плавное, а не внезапное. При фик-

сированном управляющем напряжении вольт-

амперная характеристика описывается урав-

нением:

I(V) = Ilimit�tanh(g(Vc)�V).

Ключ уровня 2 поддерживает режим про-

водимости только в одном направлении, ес-

ли установлен флаг oneway или задано паде-

ние напряжения параметром Vser. Плавность

переключения из проводящего состояния

в запертое может быть задана установкой па-

раметра epsilon не равным нулю.

На рис. 57 показаны результаты моделиро-

вания различных вариантов ключа.

Линия передачи без потерь

Имя символа: TLINE.

Синтаксис: Txxx <узел порта L+> <узел

порта L–> <узел порта R+> <узел порта R–>

Zo=<значение> Td=<значение>. L+ и L– —

узлы одного порта. R+ и R– — узлы другого

порта. Zo — полное характеристическое со-

противление. Длина линии определяется вре-

менем задержки сигнала Td.

Распределенная RC-цепь

Имя символа: URC.

Синтаксис: Uxx <узел 1> <узел 2> <узел об-

щий> <имя модели> L=<len> [N=<lumps>].

N1 и N2 — два узла подключения к RC-цепи,

Ncom — узел, в которым связаны емкости.

LEN — длина RC-цепи в метрах. Lumps, если

задано, — количество RC-сегментов, исполь-

зуемых в моделировании RC-цепи. Если

www.kit)e.ru

Таблица 33. Параметры модели ключа, 

управляемого напряжением
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Рис. 57. Результаты моделирования ключа, управляемого напряжением
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количество сегментов не задано, подбирает-

ся их подходящее количество.

Модель выполнена в макровиде. Сегмен-

ты RC находятся в геометрической пропор-

ции, с возрастающим отношением к середи-

не цепи с коэффициентом пропорциональ-

ности K.

Цепь URC создается из сегментов, состоя-

щих из резистора и конденсатора, если же за-

дана не нулевая величина параметра ISPERL,

конденсаторы заменяются обратносмещен-

ными диодами с эквивалентной емкостью,

током насыщения ISPERL и дополнительным

последовательным эквивалентным сопротив-

лением RSPERL.

Параметры распределенной RC-цепи при-

ведены в таблице 34.

Источник напряжения

Имя символа: VOLTAGE, BATTERY.

Синтаксис: Vxxx <узел+> <узел–> <напря-

жение> [AC=<амплитуда>] [Rser=<значе-

ние>] [Cpar=<значение>]. Это источник по-

стоянного напряжения между узлами узел+

и узел–. Для AC-анализа как амплитуда ис-

точника на частоте анализа используется зна-

чение AC. Могут быть заданы последователь-

ное сопротивление Rser и параллельная ем-

кость Cpar.

Эквивалентная схема источника напряже-

ния показана на рис. 58.

Источники напряжения исторически ис-

пользуются в SPICE для измерения тока

в цепи и как датчики тока для управляемых

током элементов, для чего в ветвь электри-

ческой цепи намеренно включается источник

напряжения с нулевым значением напряже-

ния. Если задано последовательное сопротив-

ление, источник напряжения не может быть

использован как датчик тока для F, H или W

элементов. Тем не менее, ток любого элемен-

та ветви цепи, включая источник напряже-

ния, можно отобразить.

Синтаксис: Vxxx <узел+> <узел–>

PULSE(V1 V2 Tdelay Trise Tfall Ton Tperiod

Ncycles). Так описывается источник импульс-

ного напряжения, параметры модели кото-

рого приведены в таблице 35.

Синтаксис: Vxxx <узел+> <узел->

SINE(Voffset Vamp Freq Td Theta Phi Ncycles).

Это форма записи источника синусоидаль-

ного напряжения, параметры его модели при-

ведены в таблице 36.

В течение времени, меньшего Td, или вре-

мени после завершения Ncycles выходное на-

пряжение равно:

Voffset+Vamp�sin (pi�phi/180).

В иное время напряжение равно:

Voffset+Vamp�exp(–(time–Td)�Theta)�
�sin(2�pi�Freq�(time–Td)+pi�phi/180).

Коэффициент демпфирования, Theta, яв-

ляется аналогом постоянной времени спада.

Синтаксис: Vxxx <узел+> <узел–> EXP(V1

V2 Td1 Tau1 Td2 Tau2). Это — источник экс-

поненциального напряжения с параметрами

модели, приведенными в таблице 37.

В течение времени, меньшего Td1, выход-

ное напряжение — V1. Для времени между

Td1 и Td2 напряжение равно:

V1+(V2–V1)�
�(1–exp(–(time–Td1)/Tau1)).

В течение времени после Td2 напряжение

равно:

V1+(V2–V1)�
�(1–exp(–(time–Td1)/Tau1))+(I1–I2)�

�(1–exp(–(time–Td2)/Tau2)).

Синтаксис: Vxxx n+ n– SFFM(Voff Vamp

Fcar MDI Fsig). Так описывается источник си-

нусоидального напряжения с частотной мо-

дуляцией с параметрами модели, приведен-

ными в таблице 38.

Напряжение равно:

Voff+Vamp*sin((2.�pi�Fcar�time)+
+MDI�sin(2.�pi�Fsig�time)).

Синтаксис: Vxxx n+ n– PWL(t1 v1 t2 v2 t3

v3ѕ). Это источник напряжения с кусочно-

линейным сигналом, задаваемым координа-

тами точек излома (ti, vi).

В течение времени до t1 напряжение равно

v1. В течение времени между t1 и t2 напряже-

ние изменяется линейно от v1 до v2. Допус-

кается любое количество точек время–напря-

жение. Для времени после последнего значе-

ния напряжение равно последнему значению.

Синтаксис: Vxxx n+ n– wavefile=<имя фай-

ла> [chan=<nnn>]. Такая модель позволяет

использовать файл .wav в качестве входного

для LTSpice. <Имя файла> — это либо пол-

ный, абсолютный путь к файлу .wav, либо от-

носительный путь, определяемый каталогом,

содержащим моделируемую схему или спи-

сок соединений. Двойные кавычки могут ис-

пользоваться для определения пути. Файл

.wav может содержать до 65 536 каналов, про-

нумерованных от 0 до 65 535. Следует опре-

делить используемый канал. По умолчанию

используется первый канал под номером 0.

Файл .wav интерпретируется как имеющий

полную шкалу от –1 до 1 В. Этот источник

имеет применение только в .TRAN-анализе.

Рис. 58. Эквивалентная схема источника напряжения

Таблица 34. Параметры модели распределенной 

RC"цепи
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Таблица 35. Параметры модели источника

импульсного напряжения

Таблица 36. Параметры модели источника

синусоидального напряжения

число

с

с

с

с

с

В

Количество циклов 
(опускается для источника

с неограниченным количеством импульсов)

Период следования импульсов

Длительность импульса

Время спада

Время нарастания

Задержка

Значение напряжения в импульсе
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Tf

Tr

Tdelay

Von

ВНачальное значение напряженияVof

Единица 
измерения

Параметр
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Таблица 37. Параметры модели источника

экспоненциального напряжения
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Таблица 38. Параметры модели источника

синусоидального напряжения с частотной модуляцией

Амплитуда напряженияVamp

ГцЧастота сигналаFsig

–Индекс модуляцииMDI

ГцНесущая частота

Постоянное смещениеVoff

Fcar
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°
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Ключ, управляемый током

Имя символа: CSW. Синтаксис: Wxxx

<узел 1> <узел 2> <имя управляющего ис-

точника напряжения> <имя модели> [on,off].

Например:

W1 out 0 Vsense MySwitch

Vsense a b 0.

.model MySwitch CSW(Ron=.1 Roff=1Meg It=0 Ih=–.5)

Ток через источник напряжения Vsense уп-

равляет сопротивлением ключа. Требуется оп-

ределить поведение ключа в строке .MODEL. 

Параметры модели ключа, управляемого

током, приведены в таблице 39.

Ключ имеет три различных способа управ-

ления, в зависимости от величины тока гис-

терезиса Ih. Если Ih равен нулю, ключ всегда

полностью замкнут или разомкнут, в зави-

симости от того, выше или ниже порога уп-

равляющий ток. Если Ih положителен, ключ

имеет гистерезис с точками переключения

It–Ih и It+Ih. Если Ih отрицателен, ключ плав-

но переключается между замкнутым и разо-

мкнутым состояниями. Переключение про-

исходит между управляющими токами It–Ih

и It+Ih.

Макромодель

Синтаксис: Xxxx <узел 1> <узел 2> <узел 3>

ѕ <имя макромодели> [<parameter>=<вы-

ражение>].

Макромодели позволяют определить и со-

хранить схему в библиотеке для позднейше-

го поиска по имени. Пример описания в ви-

де макромодели делителя:

* calling a subcircuit

*

* This is the circuit

X1 in out 0 divider top=9K bot=1K

V1 in 0 pulse(0 1 0 .5m .5m 0 1m)

* This is the subcircuit

.subckt divider A B C

R1 A B {top}

R2 B C {bot}

.ends divider

.tran 3m

.end

Полевой транзистор 

с затвором Шоттки (MESFET)

Имя символа: MESFET. Синтаксис: Zxxx

<узел стока> <узел затвора> <узел истока>

<имя модели> [area] [проводимость]

[IC=<Vds, Vgs>] [temp=<значение>].

Для MESFET-транзистора необходима стро-

ка модели, определяющая характеристики.

Ключевые слова NMF и PMF в строке моде-

ли определяют проводимость транзистора.

Параметры модели полевого транзистора

с затвором Шоттки приведены в таблице 40.

Стоит отметить, что часть моделей компо-

нентов отличается по обозначению и описа-

нию от широко используемых моделей

в формате PSpice. При необходимости ис-

пользования таких моделей в LTSpice следу-

ет внимательно проанализировать текст мо-

дели и внести необходимые изменения. Это

весьма непростая задача, требующая соответ-

ствующей подготовки.

Этим материалом заканчивается цикл, по-

священный программе схемотехнического

моделирования Switcher CAD. Автор про-

граммы Майкл Энгельгарт (Mike Engelhardt)

создал замечательный продукт, за который

ему благодарны специалисты, работающие

в различных областях электроники. ■

www.kit)e.ru

Таблица 39. Параметры модели ключа, 

управляемого током
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Введение

Специалистам известны коммерческие про-

граммы автоматизированного проектирова-

ния в электронике, включающие в себя и воз-

можности моделирования, такие как OrCAD,

Proteus, Micro-Cap, Multisim (Electronics

Workbench). Их возможности, приемы рабо-

ты в них описаны в литературе, в том числе

и русскоязычной. К сожалению, легальные

версии этих программ недоступны для мно-

гих предприятий, не говоря уже об отдель-

ных пользователях. Фирма Linear Technology

свободно распространяет программу моде-

лирования LTSpice/SwitcherCAD III, имею-

щую более скромные, но вполне достаточ-

ные для большинства известных видов ана-

лиза возможности.

Программа включает в себя самую полную

и регулярно обновляемую библиотеку ком-

понентов фирмы Linear Technology, имею-

щих Spice-модели, в том числе импульсных

регуляторов и контроллеров, и незаменима

для разработчиков, предпочитающих про-

дукцию Linear Technology. Кстати сказать, мо-

дели импульсных регуляторов и контролле-

ров практически отсутствуют в других про-

граммах.

К счастью, для пользователей программы

ее возможности не исчерпываются модели-

рованием схем с применением только изде-

лий фирмы-разработчика, и ее с успехом

применяют те, кто специализируется на ана-

логовой схемотехнике.

SwitcherCAD III — это третье поколение

программы моделирования импульсных ре-

гуляторов компании Linear Technology. Про-

грамма состоит из эффективного Spice-симу-

лятора смешанного моделирования, включа-

ющего Spice-устройства с новыми свойствами

для макромоделирования импульсных источ-

ников питания (ИИП) на основе контролле-

ров и регуляторов. Программа рисования ие-

рархических схем позволяет пользователю

редактировать встроенные примеры схем или

создавать новые схемы. В окне графиков ото-

бражаются результаты моделирования с воз-

можностью дальнейшего анализа получен-

ных данных. Имеется встроенная база инте-

гральных схем Linear Technology и многих

пассивных компонентов. В одной програм-

ме объединены база компонентов, редакти-

рование схем, управление моделированием

и анализ графиков.

На рис. 1 показан экран программы.

Установка программы

SwitcherCAD III и руководство пользова-

теля [1] можно загрузить с сайта Linear Tech-

nology. Прямая ссылка на файл установки —

http://ltspice.linear.com/software/swcadiii.exe.

Файл swcadiii.exe — это самораспаковываю-

щийся архив для установки SwitcherCAD III.

Программа часто обновляется. После пер-

воначальной установки SwitcherCAD III мож-

но использовать команду Tools>Sync Release

встроенного меню, которая изменит про-

грамму до текущей версии, если есть доступ

в Интернет. Процесс обновления сначала за-

грузит мастер-файл с сайта LTC, содержащий

размер и контрольную сумму каждого фай-

ла. Если какой-то файл отсутствует или от-

личается по размеру либо контрольной сум-

ме, содержащейся в мастер-файле, он будет

автоматически обновлен. Компоненты базы

данных в процессе модернизации будут до-

бавлены так, как будто вы добавили собст-

венные устройства, то есть дополнения не бу-

дут потеряны, как будто утилита автомати-

ческого обновления и не использовалась.

Файл changelog.txt в каталоге с установлен-

ной программой содержит информацию

о всех модернизациях программы.

Режимы работы

Краткий обзор

Для SwitcherCAD III возможны два основ-

ных режима использования симулятора:

1. Использование программы как универсаль-

ной программы рисования схем с интегри-

рованным симулятором. Команда меню

File>New и File>Open (файлы типа asc.).

2. Загрузка в симулятор списка соединений

(netlist), созданного вручную, или списка

соединений, сгенерированного различны-

ми инструментами создания схем. Коман-

да меню File>Open (файлы типа cir.).

В статье описаны возможности бесплатной программы схемотехническо$

го моделирования SwitcherCAD III и приемы работы в ней.

Программа схемотехнического 

моделирования SwitcherCAD III

Рис. 1. Экран программы
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LTSpice/SwitcherCAD III предназначен для

использования в качестве универсальной про-

граммы рисования схем с интегрированным

Spice-симулятором. Вы рисуете свою ориги-

нальную схему (или открываете имеющую-

ся схему из примеров) и наблюдаете ее рабо-

ту в симуляторе. В процессе разработки вно-

сите изменения, пока при моделировании не

будет достигнуто желаемое поведение схемы.

Более ранние версии LTSpice/SwitcherCAD III

включали в себя синтезатор, пытавшийся со-

здавать совершенный проект ИИП по специ-

фикации пользователя, но теперь такой ре-

жим работы исключен.

В результате схема преобразуется в тексто-

вый список соединений, который запускается

в симулятор. Если обычно список соединений

извлекается из графической схемы, выполнен-

ной в LTSpice/SwitcherCAD III, импортирован-

ный список соединений может быть исполь-

зован непосредственно, без схемы. Несколько

примеров такого использования: 
•• Программа синтеза фильтров от Linear

Technology's FilterCAD может синтезиро-

вать список соединений для LTSpice, что-

бы моделировать фильтр в частотной или

временной области.
•• Осуществляется более простое эталонное

тестирование LTSpice в сравнении с други-

ми Spice-программами.
•• Профессионалы уже знакомы со Spice-си-

муляторами, работающими непосредствен-

но с текстовым списком соединений, по-

скольку в старых системах рисование схемы

не было объединено со Spice-симулятором.

Примеры схем

Есть несколько ресурсов с примерами схем

для LTSpice/SwitcherCAD III, поставляемых

с программой. Как правило, они установле-

ны в каталоге C:\Program Files\LTC\SwCADIII\

examples\Educational, содержащем множест-

во примеров Spice-моделирования для неком-

мерческого использования, они демонстри-

руют различные виды анализа, методы и воз-

можности программы. В каталоге C:\Program

Files\LTC\SwCADIII\examples\jigs есть пример

моделирования для каждого устройства Linear

Technology, имеющего макромодель в LTSpice/

SwitcherCAD III.

По адресу http://www.kit-e.ru/assets/My_

Examples.zip размещена папка со схемами уст-

ройств, на примере которых демонстрируют-

ся некоторые возможности программы, и биб-

лиотеками входящих в них компонентов.

Внешне сгенерированные 

списки соединений

Используя программу, можно открыть

списки соединений, созданные вручную или

другими программами рисования схем. Эти

файлы обычно имеют в названии известные

расширения .cir, .but, .net или .sp. Ранее пе-

речислены примеры использования импор-

тированных (внешне сгенерированных)

списков соединений. ASCII-редактор, ис-

пользуемый для файлов списка соединений,

поддерживает неограниченный размер фай-

ла и неограниченное количество команд

Undo/Redo. Для изменения цветов, исполь-

зуемых в ASCII-редакторе, применяется ко-

манда меню Tool>Color Preferences.

Отчет о потерях

По результатам TRAN-анализа (анализа пе-

реходного процесса) с модификатором steady

можно получить отчет о потерях в преобра-

зователе. По окончании моделирования от-

чет о потерях может быть отображен на схе-

ме в виде блока текста комментария, как по-

казано на рис. 2.

Эффективность преобразователя определя-

ется следующим образом. Чтобы идентифи-

цировать вход и выход, требуется хотя бы по

одному источнику напряжения и источнику

тока. По умолчанию источник напряжения

является входным источником питания, а ис-

точник тока — выходной нагрузкой. Для ис-

пользования в качестве нагрузки программа

имеет два специфических компонента — ис-

точника тока, точнее, потребителя тока: load

и load2. Можно использовать в качестве на-

грузки резистор, обозначив его Rload. Схему

запускают до тех пор, пока при моделирова-

нии не будет обнаружен установившийся ре-

жим работы. Для этого необходимо, чтобы ма-

кромодели ИИП содержали информацию

о том, как обнаруживать установившийся ре-

жим. Макромодели импульсных регуляторов

LTC имеют такую информацию. Обычно ус-

тановившийся режим можно обнаружить, ког-

да отмечено, что ток усилителя ошибки, ус-

редненный по циклу переключения, умень-

шается до малой величины в нескольких

циклах. Тогда энергия в каждой реактивнос-

ти на фронте импульса вычисляется и запо-

минается, а моделирование продолжают еще

до десяти тактов, интегрируя потери в каждом

устройстве. На фронте последнего импульса

энергия, сохраненная в каждой реактивности,

снова запоминается и моделирование останав-

ливается. Информация о потерях представля-

www.kit$e.ru

Рис. 2. Окно схемы с отчетом о потерях

Таблица 1. Ключи командной строки

Ускорение работы WINE (Linux)

Эквивалент команды меню Tools>Sync Release

Выполнение процесса деинсталляции

Позволяет иметь в макромодели МОП-транзистора до 7 узлов

Старт моделирования схемы из командной строки без нажатия кнопки Run

Сохранение пользовательских установок, MRU и т. д. в регистре вместо файла %WINDIR%\scad3.ini 

Преобразование схемы в формат PCBnetlist 

Предотвращение использования работы WINE (Linux) 

Преобразование схемы в список соединений

Синоним для – big

Преобразование бинарного .raw файла в формат  Fast Access

Шифрование библиотеки моделей. При желании можно сделать так, чтобы пользователи третьей стороны 
не видели деталей библиотеки. Не используется в моделях  Linear Technology Corporation

Старт в максимальном окне

Управление пакетным режимом. Например “scad3.exe – b deck.cir” сохранит данные в файле deck.raw

$wine

$web update

$uninstall

$SOI

$Run  

$registry

$PCBnetlist

$nowine

$netlist

$max

$FastAccess

$encrypt

$big

$b

Использование ASCII .raw файлов. Серьезно ухудшается работа программы$ascii

ОписаниеФлаг
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ется как отношение выходной мощности в на-

грузке к мощности входного источника на-

пряжения после коррекции по изменению

в энергии, сохраненной в реактивностях. Так

как потери в каждом устройстве также изве-

стны, можно определить, насколько контроль-

ная сумма энергии близка к нулю.

Можно рассчитать эффективность спроек-

тированной схемы ИИП, используя команду

Stop simulating if steady state is detected («Оста-

новка моделирования по обнаружению уста-

новившегося режима») в диалоговом окне Edit

Simulation Command. После моделирования

используется команда меню View>Efficiency

Report для вывода сообщения о потерях.

Автоматическое обнаружение установив-

шегося режима работает не всегда. Иногда

критерии для обнаружения установившего-

ся режима слишком строги, а порой и слиш-

ком расплывчаты. Тогда следует подобрать

параметр выбора sstol или просто в интерак-

тивном режиме установить пределы для рас-

чета потерь.

Ключи командной строки

В таблице 1 перечислены ключи команд-

ной строки, понятные и исполняемые LTSpice

(scad3.exe).

Рисование схемы

Основы редактирования схемы

Чтобы создать новые схемы или изменить

предоставленные примеры схем, использует-

ся программа рисования. Размер схемы и глу-

бина иерархии ограничены только ресурса-

ми компьютера. Создание новой схемы начи-

нается с команды меню File->New Schematic,

а ранее созданная схема или встроенный при-

мер открываются командой File->Open.

На рис. 3 показан открытый файл проекта

с меню редактирования Edit.

Программа включает в себя около 800 ком-

понентов. Это большинство интегральных

схем для источников питания, операционных

усилителей, компараторов компании LTC

и много устройств общего назначения. Мож-

но создать и собственные символы компо-

нентов для устройств, которые вам нужно

импортировать в программу.

В отличие от многих программ рисования

схем, эта была написана специально для уп-

равления Spice-моделированием. При нажа-

тии на объект по умолчанию отображается

график напряжения в цепи или тока через

компонент без выбора объекта для редакти-

рования или какого-либо редактирования по-

ведения, отменяющего только что выполнен-

ное моделирование. Для перемещения, зер-

кального отражения, вращения, рисования

или удаления объектов сначала следует вы-

брать соответствующую команду. После это-

го можно выбрать объект нажатием на него.

Можно выбрать несколько объектов, обведя

их рамкой. Программа останется в режиме

перемещения, рисования или удаления, по-

ка не нажаты правая кнопка мыши или кноп-

ка Esc. При редактировании вся схема может

быть удалена или перерисована. Команды ме-

ню Edit перечислены в таблице 2.

Команды меню Edit, за исключением ко-

манд Place BUS tap и Draw, дублированы

кнопками на панели инструментов.

Графические объекты (линии, прямоуголь-

ники, окружности и дуги) не имеют электри-

ческих свойств и используются на схеме для

ввода дополнительной информации. По умол-

чанию графические объекты в схеме привяза-

ны к той же сетке, что используется для элек-

трического контакта с проводниками и выво-

Рис. 3. Окно схемы и меню Edit

Таблица 2. Команды меню Edit (редактирование)

Изменение стиля линий графических объектов

Рисование дуги на схеме

Рисование окружности

Рисование прямоугольника

Рисование линии

Нажмите на объект или начертите рамку вокруг объектов, которые следует перетянуть. 
После этого можно переместить объекты и присоединенные проводники без их разрыва в новое местоположение

Размещение объектов в  окне новой схемы, когда они уже были выбраны командой Duplicate

Перемещение объекта нажатием на него или вычерчиванием рамки вокруг объектов, которые необходимо переместить.
После этого можно переместить объекты в новое местоположение

Копирование объектов нажатием на них или вычерчиванием рамки вокруг них. Можно скопировать объект 
из одной схемы в другую, если они обе открыты в LTSpice/SwitcherCAD III. 

Начните команду копирования в окне первой схемы. Далее сделайте вторую схему активным окном и выполните Ctrl$V

Удаление объектов нажатием на них или вычерчиванием рамки вокруг них

Размещение указателя подключения к шине (линии групповой связи)

Размещение символа GROUND. Это узел “0”, обычно глобальный для схемы

Определение имени узла, предотвращающее его произвольное наименование при генерации списка соединений

Нажатием левой кнопкой мыши начинается рисование проводника. Каждое нажатие определяет новый сегмент
проводника. Нажатие на существующем сегменте проводника присоединяет новый проводник или продолжает
существующий. Нажатие правой кнопки отменяет рисование проводника. Следующее нажатие правой кнопки 

отменяет команду рисования. Можно тянуть проводники через компоненты типа резисторов. 
Автоматически будет выполнен разрыв проводника так, чтобы резистор включился в цепь последовательно

Зеркальное отражение редактируемого объекта. Соответствующая кнопка имеет серый цвет, 
когда не выбран никакой объект

Вращение редактируемого объекта на 90° по часовой стрелке. Соответствующая кнопка имеет серый цвет, 
когда не выбран никакой объект

Размещение компонента на схеме. Команда открывает диалоговое окно с базой данных компонентов. 
Это более общая форма по сравнению с командами Resistor, Capacitor, Inductor и Diode

Размещение диода

Размещение индуктивности

Размещение конденсатора

Размещение резистора

Ввод и редактирование команд моделирования

Размещение текста на схеме, который будет включен в список соединений. Это позволяет объединить схему со списком
соединений Spice. Таким путем устанавливаются режимы моделирования, подключаются файлы, содержащие модели,
определяются новые модели или используются любые другие существующие Spice-команды. Можно даже запускать

макромодель, не имеющую символа управлять макромоделью, не имея ее компонента для установки, к примеру,
строкой модели (Spice-команда начинается c “X”) в схеме, включая определение

Размещение текста на схеме. Это просто информация о схеме. Этот текст не имеет электрического воздействия на схему

Отменить удаление объекта (откат вперед)

Draw>Line Style

Draw>Arc

Draw>Circle

Draw>Rectangle

Draw>Line

Drag (F8)

Paste

Move (F7)

Duplicate (F6)

Delete (F5)

Place BUS tap

Place GND (G)

Label Net (F4)

Draw Wire (F3)

Mirror (Ctrl+E)

Rotate (Ctrl+R)

Component (F2)

Diode (D)

Inductor (L)

Capacitor (C)

Resistor (R)

SPICE Analysis

SPICE Directive (S)

Text (T)

Redo (Shift+F9)

Восстановить удаленный объект (откат назад)Undo (F9)

Выполняемая функция
Команда

(горячие клавиши)
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дами. Привязка к сетке отключается, если при

рисовании удерживать нажатой клавишу Ctrl.

Присвоение имени узлу

Каждый узел в схеме должен иметь уни-

кальное имя. Во избежание произвольно-

го именования узла в списке соединений

можно присвоить ему определенное имя.

Узел «0» — «общая земля» схемы и изобра-

жается специальным символом без имени «0».

Есть также графический символ, опреде-

ленный для узла «COM», но этот узел не име-

ет никакого специального значения. Таким

образом, это не Spice глобальное подключе-

ние и даже не глобальный узел. Просто ино-

гда удобно иметь графический символ, свя-

занный с узлом, отличающимся от «земли».

Если присвоить узлу имя, начинающееся

с символов «$G_», как, например, «$G_VDD»,

тогда этот узел является глобальным незави-

симо от иерархии схемы.

Присвоение имени узлу и определение типа

порта выполняется в диалоговом окне (рис. 4),

вызываемом по команде меню Edit>Label Net.

Можно указать, что узел — порт типа

«вход», «выход» или «двунаправленный». Эти

типы портов имеют различные изображения,

но это не имеет никакого значения для фор-

мирования списка соединений. Указание ти-

па порта делает схему более «удобочитаемой».

Глобальные узлы также изображаются с рам-

кой вокруг имени. Возможные типы портов

изображены на рис. 5.

Цвета в схеме

Команда меню Tools>Color Preferences,

вызывающая диалоговое окно регулировки

цвета (рис. 6), позволяет установить предпо-

чтительные цвета для отображения схемы.

Нажав на объект на рисунке схемы в окне или

выбрав требуемый объект из списка в про-

кручивающемся меню, можно отрегулиро-

вать цвета по своему предпочтению, пользу-

ясь «ползунками» red (красный), green (зеле-

ный) и blue (синий).

Неэлектрические графические объекты на

схеме, типа линий и окружностей, будут изо-

бражены в цвете компонентов.

Размещение новых компонентов

Некоторые часто используемые компонен-

ты типа резисторов, конденсаторов и кату-

шек индуктивности могут быть выбраны для

размещения на схеме кнопкой на панели ин-

струментов. Для большинства компонентов

используется команда меню Edit>Component

с открытием диалогового окна поиска требу-

емого устройства, показанного на рис. 7.

Программирование «горячих» клавиш

Команда меню Tools>Control Panel>Drafting

Options>Hot Keys, вызывающая диалоговое

окно (рис. 8), позволяет программировать

«горячие» клавиши для большинства команд.

Просто нажмите мышью на команду, а затем

нажмите клавишу или комбинацию клавиш,

которой требуется сопоставить команду. Что-

бы удалить «горячую» клавишу, сначала на-

жмите команду и затем клавишу Delete.

Извлечение списка соединений 

для программ проектирования 

печатных плат

По команде меню схемы Tools>Export

Netlist генерируется ASCII список соединений

для программы создания печатной платы.

Может потребоваться создание ряда компо-

нентов с соответствующим порядком сле-

дования имен выводов. Например, при им-

порте списка соединений из схемы LTSpice

в ExpressPCB нужно создать компоненты ли-

бо для LTSpice, либо для ExpressPCB, с оди-

наковым порядком следования выводов

в списках соединений. Иначе диоды в списке

соединений могут оказаться перевернутыми

или выводы транзисторов перепутанными.

Доступны следующие форматы: Accel,

Algorex, Allegro, Applicon Bravo, Applicon Leap,

Cadnetix, Calay, Calay90, CBDS, Computervi-

sion, EE Designer, ExpressPCB, Intergraph,

Mentor, Multiwire, PADS, Scicards, Tango,

Telesis, Vectron и Wire List.

Редактирование компонентов

Компоненты могут быть отредактирова-

ны двумя или тремя различными способами,

в зависимости от типа компонента.

Редактирование видимых атрибутов

Видимые непосредственно на поле схемы

атрибуты можно отредактировать указани-

ем на них мышью с последующим нажатием

ее правой кнопки. Курсор мыши превратит-

www.kit$e.ru

Рис. 4. Присвоение имени узлу

Рис. 5. Типы портов

Рис. 6. Редактирование цвета

Рис. 7. Выбор символа компонента

Рис. 8. Программирование «горячих» клавиш

Рис. 9. Редактирование видимых атрибутов



134 проектирование

КОМПОНЕНТЫ И ТЕХНОЛОГИИ • № 11 '2008

ся в окно вставки текста, показанное на рис. 9.

Это удобный способ изменения значения па-

раметра компонента.

Специальные редакторы компонентов

Многие типы компонентов, такие как ре-

зисторы, конденсаторы, катушки индуктив-

ности, диоды, биполярные транзисторы,

МОП-транзисторы, полевые транзисторы,

независимые источники напряжения, неза-

висимые источники тока и иерархические

схемные блоки, имеют специальные редак-

торы. Эти редакторы позволяют получить

доступ к соответствующей базе данных уст-

ройств. Для использования этих редакторов

правой кнопкой мыши нажимают на тело

компонента. Диалоговое окно редактора па-

раметров индуктивности показано на рис. 10.

Полное редактирование атрибутов

Иногда желательно получить прямой до-

ступ ко всем имеющимся атрибутам компо-

нента, чтобы редактировать их содержание

и видимость. Редактор, позволяющий делать

это, можно вызвать, если поместить курсор

на компонент, нажать сначала клавишу Ctrl

и затем — правую кнопку мыши. Появится

диалоговое окно (рис. 11), в котором показа-

ны все имеющиеся атрибуты компонента.

В каждой строке есть ячейка с индикатором

видимости признака на схеме. При рисова-

нии схемы полезно сделать видимыми пара-

зитные характеристики компонентов, такие

как, например, эквивалентное последователь-

ное сопротивление конденсатора.

Первый символ имени компонента опре-

деляет его тип. Специфический символ атри-

бута Prefix приписывается в первую позицию,

если он отличается от первого символа име-

ни, определяющего тип компонента. Атрибу-

ты Prefix и InstName в таком случае будут

разделены символом «§». Например, для ат-

рибута Prefix «M» и атрибута InstName «Q1»

имя в списке соединений будет M§Q1. Допу-

скается использовать атрибут InstName, от-

личающийся от используемого Spice для

идентификации типа устройства. Заменив

в схеме атрибут InstName для биполярного

транзистора на привычный «VT1», получим

имя компонента в списке соединений Q§VT1.

Есть три исключения из этого правила:

1. Специальный символ, джампер (jumper),

который не считается элементом схемы,

но указывает генератору списка соедине-

ний, что две цепи с разными именами эле-

ктрически связаны.

2. Символ, имеющий префикс «X», и оба оп-

ределенных атрибута — Value и Value2.

Такой компонент представлен в списке со-

единений двумя строками:

.lib <SpiceModel>

<имя> <узел1> <узел2> [...] <Value2>

Так к соответствующему символу автома-

тически подключается библиотека, содержа-

щая описание макромодели компонента.

Компилятор списка соединений удаляет дуб-

лирующиеся ссылки к библиотекам. Такие

компоненты нельзя отредактировать в листе

схемы.

3. Символ с префиксом «X», имеющий атри-

бут ModelFile. Такой компонент представ-

лен в списке соединений двумя строками:

.lib <ModelFile>

<имя> <узел1> <узел2> [...] <SpiceModel> <Value> <Value2>

<SpiceLine> <SpiceLine2>

Примечание. Здесь и далее по тексту обя-

зательный по правилам переноса строк в Spice-

выражениях знак «+», предваряющий каждую

последующую строку, сознательно опущен.

При работе с программой нарушение этого

правила недопустимо.

Этот метод используется, когда желательно

автоматически подключить файл библиотеки

и иметь возможность редактирования симво-

ла. Если атрибут символа SpiceModel сущест-

вует и имя макромодели определено в файле

<ModelFile>, тогда раскрывающийся список

имен всех макромоделей будет доступен для

редактирования символа в листе схемы.

Создание новых символов

Символы могут представлять примитив-

ное устройство типа резистора или конден-

сатора, либо макромодели с библиотекой

в отдельном файле или на странице схемы.

Для создания нового символа используется

команда меню File>New Symbol.

Графика символа компонента

Графически символ компонента изобра-

жается рядом линий, прямоугольников, ок-

ружностей и дуг. Эти объекты не имеют эле-

ктрического влияния на схему. С помощью

команды Draw>Text можно поместить в сим-

вол компонента текст, также не влияющий

на схему. Точки привязки объектов отмечены

маленькими красными кружками, показыва-

ющими, что их следует захватить для переме-

щения. Красные маркеры можно отключить

командой меню View>Mark Object Anchors.

Рис. 10. Редактор компонентов

Рис. 11. Редактор атрибутов компонентов

Рис. 12. Окно схемы в режиме рисования символа
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Окно схемы в режиме создания нового сим-

вола показано на рис. 12.

Добавление выводов

Электрическое подключение компонента

в схеме обеспечивается через выводы симво-

лов. Чтобы добавить новый вывод, исполь-

зуется команда меню Edit>Add Pin/Port,

по которой вызывается диалоговое окно ре-

дактирования свойств выводов (портов), по-

казанное на рис. 13.

Хотя Pin Label Position должна определять,

как будет показано имя вывода, в действи-

тельности TOP (сверху), BOTTOM (снизу),

LEFT (слева) и RIGHT (справа) определяют по-

ложение вывода относительно текста его име-

ни. Например, если положение вывода опре-

делено как TOP, вывод будет выше имени. Ес-

ли символ представляет собой Spice-примитив

или макромодель с библиотекой, тогда имя вы-

вода не упоминается в списке соединений и,

следовательно, не оказывает прямого электри-

ческого воздействия на схему. Однако если

символ представляет схему низшего уровня

иерархической схемы, имя вывода служит име-

нем цепи схемы более низкого уровня.

Netlist Order определяет порядок следова-

ния выводов в списке соединений для Spice.

Добавление атрибутов

Можно изменить атрибуты символа, уста-

новленные по умолчанию, используя коман-

ду меню Edit>Attributes>Edit Attributes, по ко-

торой вызывается диалоговое окно, показан-

ное на рис. 14. Наиболее важный атрибут —

Prefix. Он в основном определяет тип симво-

ла. Если символ представляет Spice-прими-

тив, он должен иметь соответствующий пре-

фикс: R для резистора, C для конденсатора, М

для МОП-транзистора и т. д. Для символа,

представленного макромоделью с определе-

нием в библиотеке, префикс должен быть X.

Атрибуты символа могут отвергаться, если

символ представляет компонент с собствен-

ной схемой. Например, для символа МОП-

транзистора атрибут Prefix «M», однако, если

конкретный транзистор представлен в виде

макромодели, то он будет иметь префикс X.

Специальная комбинация атрибутов за-

ставляет подключить необходимую библио-

теку автоматически в каждую схему, в кото-

рой используется компонент с префиксом X:
•• SpiceModel: <имя файла подключаемой

Spice-модели>;
•• Value: <значение, отображаемое на листе

схемы>;
•• Value2: <значение, отображаемое в списке

соединений>.

Value2 должно совпадать с именем макро-

модели, определенном в файле подключае-

мой модели, и может содержать дополнитель-

ные параметры макромодели. Когда символ

определен в такой манере, невозможно ре-

дактировать различные атрибуты компонен-

та в листе схемы.

Если необходимо, чтобы символ представ-

лял следующую страницу в иерархической

схеме, все атрибуты нужно оставить пусты-

ми, а тип компонента Symbol Type должен

быть изменен с Cell на Block. Не должны быть

установлены значения никаких атрибутов.

Есть атрибут символа, ModelFile, который

может быть указан. При этом используется

имя файла, включаемого в список соедине-

ний как библиотека. Пример использования

этого атрибута в файле .LTC\SwCADIII\lib\

Misc\ neobulb. Если атрибут Prefix — «X» и оп-

ределен атрибут символа SpiceModel, указы-

вающий на макромодель с файлом модели,

будет доступен ниспадающий список всех

имен макромоделей на случай редактирова-

ния символа в схеме.

Видимость атрибута

Можно редактировать видимость атри-

бутов в диалоговом окне (рис. 15), исполь-

зуя команду меню Edit>Attributes>Attribute

Window. После того, как выбран соответст-

вующий атрибут в диалоговом окне, можно

переместить его относительно символа так,

как в данный момент необходимо.

Можно изменить ориентацию текста и со-

держание атрибутов, которые уже сделаны

видимыми, в диалоговом окне (рис. 16), оно

появляется при нажатии правой кнопки мы-

ши на текст атрибута.

Иерархия

Иерархическое построение схем имеет

большие преимущества. Достаточно боль-

шие схемы могут быть нарисованы на одном

листе с ясностью изображения, характерной

для небольших схем. Просто изобразить по-

вторяющиеся узлы. Блоки схемы могут быть

включены в библиотеку для последующего

использования в другом проекте.

Правила иерархии

Для использования какой-либо схемы в ка-

честве блока в схеме высшего уровня необ-

ходимо создать символ с тем же самым име-

нем, что и у схемы блока, а затем поместить

этот символ в схему высшего уровня. Напри-

мер, есть схема высшего уровня, названная

TL431_test_pulse.asc, и есть файл другой схе-

мы с именем TL431_test.asc, которую жела-

тельно поместить в схему TL431_test_pulse.asc.

Создадим символ, названный TL431_test.asy,

и поместим его в схему TL431_test_pulse.asc.

Этот иерархический проект показан на рис. 17.

Электрические соединения между схемами

можно установить путем подсоединения про-

водников схемы более высокого уровня к вы-

водам символа блока более низкого уровня,

которые соответствуют именам узлов в схеме

низшего уровня. Как имена символов, исполь-

зованных в качестве блоков схемы, так и име-

на схем соответствующих блоков должны со-

стоять из разрешенных символов. Недопус-

тимо использование пробелов.

www.kit$e.ru

Рис. 13. Редактирование выводов

Рис. 14. Редактирование атрибутов символа

Рис. 15. Редактирование видимости атрибутов символа

Рис. 16. Коррекция положения атрибута символа
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LTSpice ищет в каталоге схемы высшего

уровня схемы символов и блоков, чтобы

скомплектовать схему высшего уровня.

Для символа, создаваемого как блок схемы

низшего уровня, не должны быть определе-

ны никакие атрибуты.

Навигация в иерархии

Любой файл, открытый командой File>Open,

рассматривается как схема высшего уровня.

Можно добавить Spice-директивы к блоку

и начать моделирование, используя схему лю-

бого уровня.

Чтобы открыть схему блока, входящего

в схему более высокого уровня, сначала от-

кройте схему более высокого уровня, а затем

переместите курсор на символ вызываемого

блока. При нажатии правой кнопкой мыши

на выбранном символе отобразится диало-

говое окно (рис. 18), позволяющее открыть

схему и символ. Диалоговое окно позволяет

вводить параметры блока при их наличии.

Когда схема будет открыта, можно иссле-

довать узловые напряжения и токи в блоке.

Отметим, что необходимо включить режи-

мы Save Subcircuit Node Voltages и Save

Subcircuit Device Currents в окне Save Defaults

в Control Panel. Если подсветить цепь на схе-

ме более высокого уровня, она так же подсве-

тится в блоке нижнего уровня.

В следующей части статьи будет рассказа-

но, как отображаются результаты моделиро-

вания и какие операции можно выполнить

над ними. ■
Продолжение следует

Рис. 17. Окно программы в режиме иерархического проекта

Рис. 18. Редактирование в иерархическом проекте
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Михаил ПУШКАРЕВ

Окно графиков

SwitcherCAD III включает в себя интегри-

рованное окно графиков, обеспечивающее

полное управление отображением данных

моделирования. Окно графиков открывает-

ся одновременно с запуском процесса моде-

лирования по команде Simulate->Run.

Выбор графика

Есть три основных средства выбора ото-

бражаемых графиков.

1. Использование пробника в схеме. Это са-

мый простой метод. Выбираете цепь и щел-

каете по проводнику, чтобы построить гра-

фик напряжения на этом проводнике.

Для отображения графика тока через лю-

бой компонент с двумя выводами (резис-

тор, конденсатор или катушка индуктив-

ности) нужно нажать на изображение ком-

понента. Способ работает на любом уровне

иерархии схемы. Чтобы вывести график

тока через соответствующий вывод ком-

понента, имеющего более двух выводов,

следует щелкнуть по нужному выводу ком-

понента. Двойной щелчок стирает все пре-

дыдущие графики, отобразится один гра-

фик, вызванный двумя щелчками. Можно

удалить отдельные графики, нажав на имя

графика и выбрав команду удаления.

Как отобразить ток в цепи, показано на рис. 17.

Курсор мыши превращается в изображение,

похожее на зажим амперметра, когда он ука-

зывает на ток, который будет отображен.

По принятому условию втекающий ток счи-

тается положительным.

Можно также указать мышью на разность

напряжений. Нажмите на проводник и тяни-

те курсор к другому проводнику. Увидите

красный пробник напряжения на первом

проводнике и черный пробник на втором.

Это позволяет отобразить разность напряже-

ний, как показано на рис. 19.

Еще один схемный пробник позволяет ото-

бразить график мощности, рассеиваемой

в компоненте. Для этого нажмите на компо-

нент, удерживая клавишу Alt. Отобразится

график мгновенной мощности как произве-

дение напряжений и токов. Он будет изобра-

жен со своей шкалой в ваттах. Курсор мыши

превращается в изображение, похожее на тер-

мометр (рис. 20), когда он указывает на поте-

ри, которые будут отображены. Можно най-

ти средние потери, для этого нужно щелкнуть

на имени графика при нажатой клавише Ctrl.

2. Команда меню Plot Settings->Visible Traces.

Эта команда показывает диалоговое окно

(рис. 21) для начала отображения данных,

полученных при моделировании. Окно

В данной части статьи речь пойдет об отображении результатов модели


рования и возможных операциях с этими результатами.

Программа схемотехнического 

моделирования SwitcherCAD III

Продолжение. Начало в № 11 `2008

Рис. 19. Выбор отображаемой разности напряжений потенциальными пробниками

Рис. 20. Пробник мощности Рис. 21. Выбор отображаемых графиков



116 проектирование

КОМПОНЕНТЫ И ТЕХНОЛОГИИ • № 12 '2008

позволяет выбрать графики перед отобра-

жением. Оно также дает произвольный до-

ступ к полному списку отображаемых гра-

фиков. Удерживая нажатой клавишу Ctrl,

можно добавлять графики к списку одно-

временно отображаемых графиков. Двой-

ной щелчок при нажатой клавише Alt от-

крывает диалоговое окно для ввода мате-

матического выражения.

3. Команда Plot Settings->Add Trace подобна ко-

манде Plot Settings->Visible Traces. Однако при

ее использовании не удаляются графики, ото-

браженные ранее. Имеются две полезных

возможности. Введите в ячейку редактиро-

вания вверху диалогового окна часть имени

графика. В диалоговом окне будут показаны

имена только тех графиков, которые соответ-

ствуют образцу. Это очень полезно при по-

иске нужного графика, когда известна толь-

ко часть его имени. Кроме того, несколько

легче составлять выражения из данных гра-

фиков, потому что можно нажимать на имя

графика в списке вместо его вписывания.

Команды Undo и Redo позволяют просма-

тривать разные графики независимо от ис-

пользованного способа выбора.

Изменение масштаба изображения

LTspice/SwitcherCAD III автоматически из-

меняет масштаб изображения всякий раз, ког-

да появляются новые данные для отображе-

ния. Чтобы изменить масштаб изображения

области, просто начертите рамку вокруг об-

ласти (рис. 22), которую следует увеличить.

Есть кнопки на панели инструментов и ко-

манды меню для изменения масштаба изоб-

ражения и возврата к автоматически установ-

ленному масштабу. Команды Undo и Redo

при просмотре графиков тоже действуют.

Математические операции с графиками

С данными графиков могут быть выпол-

нены три типа математических операций.

1. Отображение преобразованных графиков.

Обе команды, Plot Settings>Visible Traces

и Plot Settings>Add Trace, позволяют вводить

выражения для преобразования данных.

При другом методе вывода графиков преоб-

разованных данных моделирования нужно

поместить курсор на имя графика в верхней

части окна графиков и щелкнуть правой

кнопкой мыши. Диалоговое окно редактиро-

вания выражений (рис. 23) позволяет также

установить цвет графика и подключить кур-

сор к кривой. LTspice проанализирует размер-

ность выражения и разметит вертикальную

ось в соответствующих единицах измерений.

Все графики отобразятся в тех же единицах,

что указаны на соответствующей оси.

Разность двух напряжений, например,

V (a) – V (b), может быть эквивалентно запи-

сана как V (a, b).

Для данных в действительных величинах до-

ступны функции, перечисленные в таблице 3.

Для данных в комплексных числах функции

ATAN2(,), SGN(), U(), BUF(), INV() URAMP(),

INT(), FLOOR(), CEIL(), RAND(), MIN(,),

LIMIT(,), IF(,,) и TABLE(...) недоступны.

Операции, доступные для действительных

чисел, приведены в таблице 4.

Рис. 22. Изменение масштаба

Рис. 23. Редактор математических выражений

Таблица 3. Математические функции

для преобразования графиков

Случайные числа между –0,5 и 0,5 
с плавными переходами между значениями, 

даже более плавными, чем в random()

Функция ограничения: 
uramp(x)=x, если x> 0; uramp(x)=0, если x≤0

Ступенчатая функция: 
u(x)=1, если x> 0; u(x)=0, если x≤0

Гиперболический тангенс x

Тангенс x

Табличная зависимость функции от x. Координаты
точек (x, y) в виде таблицы, в промежутках
между точками линейная аппроксимация

Квадратный корень из x

Гиперболический синус x

Синус x

Знак числа x

Ближайшее целое к x

Действительная часть комплексного аргумента

Функция, подобная rand(x), но с более плавными
переходами между значениями

Случайные числа между 0 и 1 
в зависимости от значения x

sgn(x) *abs(x) ** y

abs(x) ** y

x ** y

Действительная часть, 
равная фазе комплексного аргумента

Минимальное из x или y

Максимальное из x или y

Действительная часть, равная амплитуде
комплексного аргумента

Десятичный логарифм x

Альтернативный синтаксис для ln(x)

Натуральный логарифм x

x, если y<x<z; y, если x<y; z, если x>y

inv(x)=0, если x>0,5; inv(x)=1, если x≤0,5

Округление x до целого числа

Мнимая часть комплексного аргумента

y, если x истинно, иначе z

sqrt(x ** 2 + y ** 2)

Целое число, равное или меньшее, чем x

Экспонента числа x

Производная dx/dt

Гиперболический косинус x

Косинус x

Комплексная функция, сопряженная х

Целое число, равное или большее, чем x

buf(x)=1, если x>0,5; buf(x)=0, если x≤0,5

Гиперболический тангенс x

Арктангенс y/x

Синоним для atan(x)

Арктангенс x

Гиперболический синус x

Синоним для asin(x)

Арксинус x

Гиперболический косинус x

Синоним для acos(x)

Арккосинус x

WHITE(x)

URAMP(x)

U(x)

TANH(x)

TAN(x)

TABLE
(x,a,b,c,d,...)

SQRT(x)

SINH(x)

SIN(x)

SGN(x)

ROUND(x)  

RE(x)

RANDOM(x)

RAND(x)

PWRS(x, y)

PWR(x, y)

POW(x, y)

PH(x)

MIN(x,y)

MAX(x,y)

MAG(x)

LOG10(x)

LOG(x)

LN(x)

LIMIT(x,y,z)

INV(x)

INT(x)

IM(x)

IF(x, y, z)

HUPOT(x,y)

FLOOR(x)

EXP(x)

D(x)

COSH(x)

COS(x)

CONJ(x)

CEIL(x)

BUF(x)

ATANH(x)

ATAN2(y, x)

ARCTAN(x)

ATAN(x)

ASINH(x)

ARCSIN(x)

ASIN(x)

ACOSH(x)

ARCOS(x)

ACOS(x)

Абсолютное значение xABS(x)

ОпределениеФункция
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ИСТИНА (TRUE) в цифровой форме равна

1, а ЛОЖЬ (FALSE) — 0. В булевом преобразо-

вании значение преобразуется в 1, если оно

больше 0,5, иначе преобразованное значение 0.

Оператор выбора шага @ используется, ког-

да возможны многократные проходы моде-

лирования как в .STEP, .TEMP или .DC ана-

лизе. Так выбираются данные из определен-

ного прохода. Например, V(1)@3 отобразил

бы данные от 3-го прохода независимо от то-

го, какие шаги выбраны для отображения.

Для комплексных чисел доступны только

операции +, –, *, /, ** и @. Также для ком-

плексных чисел булев оператор XOR, ^, по-

нимается как возведение в степень, **.

Встроенные в программу константы пере-

числены в таблице 5.

Ключевое слово time подразумевается при

подготовке к отображению результатов ана-

лиза переходных процессов. Точно так же freq

и omega подразумеваются при подготовке

отображения данных анализа по переменно-

му току. Знак w может использоваться как

синоним для омеги.

2. Вычисление среднего или среднеквадра-

тичного значения для графика.

В окне графиков можно интегрировать гра-

фики, чтобы получить среднее или среднеква-

дратичное значения в указанном диапазоне.

Увеличьте масштаб изображения кривой до

интересующего участка, затем переместите

курсор на имя графика и, удерживая нажатой

клавишу Ctrl, щелкните левой кнопкой мыши.

В табличке (рис. 24) показаны результаты.

3. Показ Фурье-преобразования графика.

Используйте команду View->FFT для вызо-

ва диалогового окна выбора графиков (рис. 25),

чтобы выполнить быстрое преобразование Фу-

рье над данными различных графиков.

Функции, определяемые пользователем

Команда меню Plot Settings->Edit Plot Defs

File позволяет вводить собственные опреде-

ления функций и параметров для использо-

вания в окне графиков. Эти функции сохра-

няются в файле plot.defs в том же каталоге,

что и исполняемый файл SwCADIII, scad3.exe.

Синтаксис тот же самый, что и в дирек-

тивах .PARAM и .FUNC, которые будут рас-

смотрены далее. Например, строка .func

Pythag(x,y) {sqrt (x*x+y*y)} определяет функ-

цию Pythag () как квадратный корень из сум-

мы двух ее аргументов. Точно так же строка

.param twopi = 2*pi определяет twopi равным

6.28318530717959. При этом используется

встроенная константа π.

Управление осями

Если переместить курсор мыши за преде-

лы области данных, он превращается в ли-

нейку. Это показывает возможность изме-

нения атрибутов соответствующей оси.

Щелчком левой кнопки мыши открывается

диалоговое окно ручного ввода данных для

масштабирования оси графика. Например,

для данных в действительных числах, если

переместить курсор мыши в низ экрана

и щелкнуть левой кнопкой, можно войти

в диалог для изменения масштаба горизон-

тальной оси. Это позволяет изменить пара-

метры изображения.

Для данных в комплексных числах можно

отобразить любую фазу, групповую задерж-

ку или что-то иное с правой вертикальной

осью. Можно изменить представление ком-

плексных данных от диаграмм Боде к годо-

графу Найквиста или декартовым координа-

там, переместив мышь к левой вертикальной

оси комплексных данных и нажав левую

кнопку мыши.

Панели отображения графиков

Несколько панелей графиков могут быть

размещены в одном окне по команде Plot

Setting->Add Plot Pane. Это обеспечивает луч-

шее разделение между графиками и незави-

симое масштабирование разных графиков

(рис. 26). Графики можно перемещать между

панелями путем перетягивания метки. Копия

графика может быть сделана в другой панели.

Рис. 24. Окно результатов вычисления средних

значений

Рис. 25. Выбор графиков 

для быстрого преобразования ФурьеТаблица 5. Встроенные константы

1,602176462eN19

1,3806503eN23

3,14159265358979323846

Заряд электрона

Постоянная Больцмана

π

Q

K

Pi

2,7182818284590452354eE

ВеличинаОписаниеСимвол

Рис. 26. Отображение графиков на нескольких панелях

Таблица 4. Математические операции

для преобразования графиков

Оператор выбора шага

Преобразование, эквивалентное логической инверсии

Возведение в степень

Деление

Умножение

Вычитание

Сложение

ИСТИНА (TRUE), если выражение слева меньше
или равно выражению справа, иначе ЛОЖЬ (FALSE)

ИСТИНА (TRUE), если выражение слева больше
или равно выражению справа, иначе ЛОЖЬ (FALSE)

ИСТИНА (TRUE), если выражение слева  меньше
выражения справа, иначе ЛОЖЬ (FALSE)

ИСТИНА (TRUE), если выражение слева больше
выражения справа, иначе ЛОЖЬ (FALSE)

Преобразование, эквивалентное логическому
исключающему ИЛИ (XOR)

Преобразование, эквивалентное логическому ИЛИ (OR)

@

!

**

/

*

–

+

<=

>=

<

>

^

|

Преобразование, эквивалентное логическому И (AND)&

Назначение
Символ

операции
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Если в меню Plot Setting пометить ячейку

Grid, панель отображения графиков будет до-

полнена сеткой.

Управление цветом

Команда меню Tools->Color Preferences

позволяет установить цвета, используемые

для отображения данных (рис. 27). Нажмите

на объект и, используя красный, зеленый

и синий ползунки, изменяйте цвета по ваше-

му желанию.

Подключаемые курсоры

Два курсора доступны для подключения.

Подключить курсор к графику можно щелч-

ком левой кнопки мыши на имени графика.

Можно подключить оба курсора к одному

графику, нажав правую кнопку мыши на

имени графика и выбрав 1st & 2nd в ячейке

Attached Cursor всплывающего меню. Мож-

но также подключить 1-й или 2-й курсор или

оба курсора к любому графику по выбору

(рис. 28). Подключенные курсоры могут пе-

ремещаться перетягиванием мышью или при

помощи курсорной клавиатуры.

С подключением курсоров появляется ок-

но, в котором показаны координаты и раз-

ность координат курсоров.

Возможно также считывание позиции кур-

сора мыши, независимое от вышеупомяну-

того считывания подключенным курсором

(рис. 29). При перемещении курсора мыши

по окну графиков, положение мыши отобра-

жается в управляющей строке. Если переме-

щать мышь, как при изменении масштаба

изображения, в строке управления отобра-

жается размер рамки. Это позволяет быстро

проводить различные измерения с помощью

курсора мыши. Если координата горизон-

тальной оси — время, то разность координат

преобразуется в частоту.

Таким способом можно измерить разность

координат, не изменяя масштаба изображе-

ния, если нажать клавишу Esc или правую

кнопку мыши, перед тем как отпустить ле-

вую кнопку мыши.

Подключенные курсоры можно использо-

вать для считывания сведений о графике со-

ответствующей ступени в семействе графи-

ков, полученных .step/.dc/.temp моделирова-

нием (рис. 30). Курсор можно перемещать от

графика одной ступени к графику другой сту-

пени клавишами вверх/вниз курсорной кла-

виатуры и, нажав затем на курсор правой

кнопкой мыши, увидеть информацию о со-

ответствующем графике.

Сохранение конфигурации 

отображения графиков

Команды меню Plot Settings->Save Plot

Settings/Open Plot Settings File позволяют про-

читать и записать конфигурацию отображе-

ния на диск. Файлы настройки отображения

графиков — ASCII файлы с расширением .plt.

По умолчанию имя файла совпадает с име-

нем файла данных с заменой расширения .raw

файла данных на .plt. Если файл с таким име-

нем существует, то, когда открывается файл

данных, считывается и соответствующий

файл конфигурации отображения.

Каждый тип анализа — .TRAN, .AC, .NOISE

и пр. — имеет собственный файл настроек

отображения. Это не дает возможности за-

гружать параметры настройки от одного ви-

да анализа к другому. Но можно использо-

вать файл параметров настройки отображе-

ния от другого моделирования такого же вида

анализа.

Формат файла быстрого доступа 

Fast Access

В процессе моделирования программа

LTspice обычно использует формат сжатого

бинарного файла, позволяющий присоеди-

нить дополнительные данные моделирова-

ния без изменения остальной части файла.

Но когда моделирование закончено, может

оказаться, что этот формат файла слишком

медленный для доступа с целью добавления

единственного нового графика в файл.

Чтобы сократить время, можно преобразо-

вать файл в альтернативный формат Fast

Access. Это может быть сделано только после

того, как моделирование закончено, то есть

никакие новые данные не будут добавлены

к файлу. Как только файл преобразован в этот

формат, время загрузки новых графиков бу-

дет уменьшено пропорционально количест-

ву графиков, сохраненных в файле. Напри-

мер, для файла объемом 5 Гбайт с данными

на 2000 графиков может потребоваться 4 мин,

чтобы добавить новый график. После преоб-

разования этого файла в формат Fast Access,

время загрузки с четырех минут уменьшится

до секунды. Это облегчает многократный ана-

лиз больших схем с огромными файлами дан-

ных моделирования. Время, требуемое для

того, чтобы загрузить файл графика в фор-

мате Fast Access, в большей степени зависит

от количества имеющейся памяти и скорости

жесткого диска.

Чтобы преобразовать графики в формат

Fast Access, нужно сделать окно графиков ак-

тивным и выполнить команду меню File->

Convert to Fast Access. Процесс преобразова-

ния потребует свободного дискового прост-

ранства, равного размеру преобразуемого

файла, но преобразованный файл будет толь-

ко на 11 байт больше оригинального.

Процесс преобразования может занять

много времени и использовать до одной чет-

верти оперативной памяти. Фактически для

преобразования файла в формат Fast Access

может потребоваться больше времени, чем

было необходимо для первоначального мо-

делирования. Точное время преобразования

будет зависеть от фрагментации жесткого

диска и количества имеющейся оперативной

памяти. В течение преобразования можно за-

метить, что компьютер неохотно откликает-

ся на действия мыши и клавиатуры. Возмож-

но преобразование файлов командой из ко-

мандной строки со следующим синтаксисом:

scad3.exe -FastAccess <file>

Здесь <file> — название .raw файла, кото-

рый преобразуется в формат Fast Access. Этот

формат поддерживается только для действи-

тельных данных, а не комплексных данных,

получаемых при .AC анализе.

Далее будет рассмотрен синтаксис и дирек-

тивы моделирования языка LTSpice. ■
Продолжение следует

Рис. 27. Управление цветами графиков

Рис. 28. Подключение курсоров

Рис. 29. Координаты курсоров

Рис. 30. Окно информации о графике



Михаил ПУШКАРЕВ

92 проектирование

КОМПОНЕНТЫ И ТЕХНОЛОГИИ • № 2 '2009

Кратко о LTspice

LTspice — инструмент моделирования схем

в SwitcherCAD III. Это программа моделиро-

вания схем с поддержкой рисования. LTspice-

симулятор первоначально базировался на

Berkeley SPICE 3F4/5. Симулятор претерпел

полную переработку с целью улучшения ра-

боты, обнаружения ошибок и доведен до со-

стояния промышленного стандарта в полу-

проводниковых и поведенческих моделях.

Наряду с расширением возможностей анало-

гового SPICE-моделирования добавлена воз-

можность цифрового моделирования, чтобы

сделать LTspice симулятором аналогового

и смешанного моделирования промышлен-

ного уровня для большого класса схем им-

пульсных регуляторов и фильтров на пере-

ключаемых конденсаторах.

Многие продукты Linear Technology смо-

делированы с использованием составляющих

собственность блоков и (или) составляющих

собственность языка, которые объединяют

реалистичное поведение с традиционными

макромоделями. Это дает возможность быс-

тро смоделировать систему питания и изго-

товить прототип.

LTspice может использоваться как SPICE-

симулятор схем общего назначения. Новые

схемы можно создать с использованием под-

ключенной программы рисования. Команды

моделирования и параметры помещаются на

схему как текст с использованием синтакси-

са SPICE. Щелчком мыши на цепи схемы

в процессе моделирования или после моде-

лирования на экран выводятся графики на-

пряжений и токов.

LTspice — зарегистрированная торговая

марка Linear Technology Corporation.

Описание схемы

Схемы описываются текстом списка соеди-

нений (netlist). Список соединений состоит

из списка элементов схемы и их узлов, опре-

делений моделей и других SPICE-команд.

Обычно список соединений формируется

при графическом вводе схемы. Чтобы начать

новую схему, выберите в меню File>Open.

Появится окно файлового браузера. Выбери-

те любую имеющуюся схему и сохраните ее

под новым именем или создайте новый чис-

тый файл схемы под новым именем. LTspice

использует различные типы файлов и доку-

ментов. Описание схемы сохраняется в фай-

ле с расширением .asc. Команды рисования

схемы находятся в меню Edit. Клавиши бы-

строго вызова показаны в списке команд ре-

дактора схем.

Когда схема моделируется, информация

для списка соединений извлекается из графи-

ческой информации для создания файла

с именем схемы, но с расширением .net.

LTspice читает его как netlist.

Можно также открывать, моделировать

и редактировать текстовый список соедине-

ний, созданный вручную или сгенерирован-

ный извне. Файлы с расширениями .net, .cir

и .sp распознаются LTspice как список соеди-

нений.

Общая структура и соглашения

Анализируемая схема описывается текс-

товым файлом, называемым списком со-

единений. Первая строка в списке соедине-

ний игнорируется, так как по предположе-

нию является комментарием. Последняя

строка списка соединений обычно просто

строка .END, но она может быть опущена.

Любые строки после строки .END игнори-

руются.

Порядок строк между комментарием и кон-

цом не регламентирован. Строки могут быть

комментариями, параметрами элементов схе-

мы или директивами моделирования. Нач-

нем с примера:

* Первая строка игнорируется

* Схема представляет собой резистивно-емкостной фильтр

* с входным сигналом прямоугольной формы 1 МГц

R1 n1 n2 1К; резистор 1 кОм между узлами n1 и n2

C1 n2 0 100p; конденсатор 100 пФ между узлами n2 и «землей»

V1 n1 0 PULSE(0 1 0 0 0 .5μ 1μ); прямоугольный сигнал 1 МГц

.tran 3μ; анализ переходного процесса продолжительностью 3 мкс

.end

Первые две строки — комментарии. Любая

строка, начинающаяся с «*», является ком-

ментарием и игнорируется. Строка, начина-

ющаяся с «R1», объявляет, что есть резистор

сопротивлением 1 кОм, включенный между

узлами n1 и n2. Отметим, что при этом мо-

жет использоваться точка с запятой «;», что-

бы начать комментарий в середине строки.

Строка, начинающаяся с «C1», объявляет, что

есть конденсатор емкостью 100 пФ между уз-

лом n2 и «землей». Узел «0» — глобальная

«земля» схемы.

Случайные знаки, пробелы и табуляции

игнорируются.

Первый отличный от пробела знак в стро-

ке (табл. 6) определяет тип элемента схемы.

Числа могут быть выражены не только в на-

учном написании, например, 1e12, но и с ис-

В этой части статьи рассмотрены синтаксис языка LTspice и директивы

моделирования.

Программа схемотехнического 

моделирования SwitcherCAD III

Продолжение. Начало в № 11 `2008

Таблица 6. Первый символ в строке

Таблица 7. Масштабные коэффициенты

Продолжение предыдущей строки. 
«+» не учитывается и продолжение строки считают

частью предшествующей строки

Директива моделирования, например: 
.options reltol=1e/4

Полевой транзистор с затвором Шоттки (MESFET)

Макромодель

Ключ, управляемый током

Независимый источник напряжения

Распределенная RC/цепь

Линия передачи без потерь

Ключ, управляемый напряжением

Резистор

Биполярный транзистор

Линия передачи с потерями

МОП/транзистор (MOS)

Индуктивность

Взаимная индуктивность

Полевой транзистор 
с управляющим p�n/переходом (JFET)

Независимый источник тока

Источник напряжения, управляемый током

Источник тока, управляемый напряжением

Источник тока, управляемый током

Источник напряжения, управляемый напряжением

Диод

Конденсатор

Источник с произвольным поведением

Устройство со специальными функциями

+

.

Z

X

W

V

U

T

S

R

Q

O

М

L

K

J

I

H

G

F

E

D

C

B

A

Комментарий*

Тип строки
Символ, 

начинающий 
строку

1×10–15

1×10–12

1×10–9

1×10–6

1×10–3

25,4×10–6

1×103

1×106

1×109

f

p

n

u (или μ)

M

Mil

K

Meg

G

1×1012T

Масштабный коэффициентСуффикс
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пользованием инженерных множителей.

Таким образом, 1000 или 1e3 может также

быть записано как 1 К. В таблице 7 перечис-

лены масштабные коэффициенты.

Не специфицированные буквы, следую-

щие после числа или инженерного множи-

теля, игнорируются. Следовательно, 10, 10 V,

10 Volts и 10 Hz представляют одно и то же

число, и М, MA, МSec и MMhos представ-

ляют один и тот же масштабный коэффи-

циент (0,001). Распространенная ошибка

состоит в изображении резистора со значе-

нием сопротивления 1M, подразумевая ре-

зистор в один мегаом, однако, 1M интер-

претируется как резистор с сопротивлени-

ем один миллиом. Этим обеспечивается

совместимость со стандартными SPICE-пра-

вилами.

LTspice воспринимает числа, написанные

в форме 6K34, как 6,34 K. Это справедливо

для любого из перечисленных множителей.

Эта возможность может быть выключена сле-

дующим путем Tools>Control Panel>SPICE

с отключением Accept 3K4 as 3.4K.

Имена узлов могут быть произвольным

набором символов. Узел глобальной «земли»

схемы — «0», хотя есть и «GND» — специаль-

ный синоним. Поскольку узлы обозначают-

ся строкой символов, то «0» и «00» — разные

цепи.

Во всех последующих разделах угловые

скобки, помещенные вокруг полей данных,

должны быть заполнены соответствующей

информацией, например, <srcname> будет

именем некоего определенного источника.

Квадратные скобки указывают, что вложен-

ные в поле данные являются дополнитель-

ными и необязательными.

Синтаксис компонента

Компоненты, поддерживаемые в LTSpice,

и их синтаксис приведены в таблице 8.

Директивы моделирования. 
Команды с точкой

Для начала моделирования необходимо оп-

ределить не только схему, но и вид анализа,

который будет выполнен. Есть шесть различ-

ных типов анализа: линеаризованный анализ

на переменном токе в режиме малого сигна-

ла (linearized small signal AC), анализ на по-

стоянном токе со ступенчатым изменением

параметра (DC sweep), анализ шумов (noise),

расчет рабочей точки на постоянном токе

(DC operating point), нахождение передаточ-

ной функции на постоянном токе в режиме

малого сигнала (small signal DC transfer func-

tion) и анализ переходного процесса (tran-

sient analysis). Один из этих типов анализа

должен быть правильно описан.

Схема обычно изображается графически,

а команды помещаются в схему как текст. Все

такие команды начинаются с точки и поэто-

му названы «команды с точкой».

.AC — анализ на переменном токе

в режиме малого сигнала,

линеаризованный в окрестности

рабочей точки по постоянному току

(расчет частотных характеристик)

Для малых приращений сигнала (линей-

ных) на переменном токе LTspice вычисляет

комплексные значения узловых напряжений

и токов ветвей в функции частоты. Сначала

определяется рабочая точка схемы по посто-

янному току. Затем находятся линеаризован-

ные для малого сигнала модели всех нели-

нейных компонентов схемы в этой рабочей

точке. И, наконец, при использовании неза-

висимых источников напряжения и тока как

управляющие сигналы результирующая ли-

неаризованная схема обсчитывается в задан-

ном диапазоне частот.

Этот метод применяется при анализе филь-

тров и цепей, устойчивости и шумов.

Синтаксис:

.ac <oct, dec, lin> <количество точек> <начальная частота> <ко-

нечная частота>

Частота изменяется от <начальной часто-

ты> до <конечной частоты>. Ключевые сло-

ва oct, dec устанавливают логарифмический

характер изменения частоты октавами и де-

кадами соответственно, lin — линейное из-

менение частоты. Ключевое слово <количе-

ство точек> определяет количество точек на

октаву, декаду или весь диапазон частот.

Директива .AC вносится в лист схемы по ко-

манде Edit>SPICE Analysis с последующим вы-

бором в диалоговом окне пункта AC Analysis

и заполнением ячеек соответственно заданию.

Диалоговое окно показано на рис. 31.

Один из примеров анализа на переменном

токе содержится в файле …LTC\SwCADIII\ex-

amples\Educational\phono.asc.

.BACKANNO — связь имен выводов

макромодели с токами портов

Синтаксис:

.backanno

Эта директива автоматически включается

в каждый список соединений, генерируемый

SwitcherCAD III из схемы. Она заставляет

LTspice включить в .raw файл информацию

о связи токов портов с именами выводов. Это

www.kit5e.ru

Таблица 8. Синтаксис компонентов

Zxx <узел стока> <узел затвора> <узел истока> <имя модели> 
[коэффициент кратности area] [проводимость]  [IC=<Vds,Vgs>]

Xxx n1 n2 n3… <имя макромодели>

Wxx <узел1> <узел2> <имя управляющей ветви> <модель> 
[сопротивление замкнутого ключа, сопротивление разомкнутого ключа]

Vxx <+узел> <–узел> <значение напряжения>

Uxx <узел1> <узел2> <узел общий>  <имя модели>  L=< длина, м> 
[N=<количество сегментов>]

Txx <+узел порта L><–узел порта L>
<+узел порта R><–узел порта R>
ZO=<значение> TD=<значение>

Sxx <узел1> <узел2> <+управляющий узел>  <–управляющий узел> <имя модели>
[сопротивление замкнутого ключа, сопротивление разомкнутого ключа]

Rxx <узел1> <узел2> <сопротивление> [дополнительные параметры]

Qxx <узел коллектора> <узел базы> <узел эмиттера>  [узел подложки] 
<имя модели>  [коэффициент кратности area]  [проводимость]

[IC=Vbe,Vce][temp=<температура>]

Oxx <+узел порта L> <–узел порта L> <+узел порта R> <–узел порта R> <имя модели>

Mxx <узел стока> <узел затвора> <узел истока> <узел подложки> <имя модели>
[L=<длина канала>]  [W=<ширина канала>] [AD=<площадь стока>]  

[AS=<площадь истока>] [PD=<периметр стока>]  [PS=<периметр истока>] [NRD=<значение>]
[NRS=<значение>] [проводимость]  [IC=<Vds, Vgs, Vbs>]  [temp=<температура>]

Lxx <+узел> <–узел> <индуктивность> [ic=<начальный ток>] [Rser=<значение>]
[Rpar=<значение>]  [Cpar=<значение>] [m=<значение>] [дополнительные параметры]

Kxx L1 L2 L3… <коэффициент связи>

Jxx <узел стока> <узел затвора> <узел истока> <имя модели> 
[коэффициент кратности area] [проводимость] [IC=<Vds,Vgs>] [temp=<температура>]

Ixx <+узел> <–узел> <значение тока>

Hxx <+узел> <–узел> <имя управляющего источника напряжения> <коэффициент передачи>

Gxx <+узел> <–узел> <+управляющий узел>  
<–управляющий узел> <коэффициент передачи>

Fxx <+узел> <–узел> <имя управляющего источника напряжения> <коэффициент передачи>

Exx <+узел> <–узел> <+управляющий узел>  
</управляющий узел> <коэффициент передачи>

Dxx <узел анода> <узел катода <имя модели> [коэффициент кратности area]

Cxx <+узел> <–узел> <емкость> [ic=<начальное напряжение>] [Rser=<значение>]
[Lser=<значение>] [Rpar=<значение>] [Cpar=<значение>]

[m=<значение>] [дополнительные параметры]

Bxx <+узел> <–узел> <V=… или I=…>

Полевой транзистор 
с затвором Шоттки (MESFET)

Макромодель

Ключ, управляемый током

Независимый источник напряжения

Однородная RC/линия 
с распределеными параметрами

Линия передачи без потерь

Ключ, управляемый напряжением

Резистор

Биполярный транзистор

Линия передачи с потерями

МОП/транзистор (MOSFET)

Индуктивность

Взаимная индуктивность

Полевой транзистор 
с управляющим p�n/переходом (JFET)

Независимый источник тока

Источник напряжения, управляемый током

Источник тока, управляемый напряжением

Источник тока, управляемый током

Источник напряжения, 
управляемый напряжением

Диод

Конденсатор

Источник с произвольным поведением

Axx <узел 1> <узел 2> <узел 3> <узел 4> <узел 5> <узел 6> <узел 7> <узел 8> 
<имя модели> [дополнительные параметры]

Устройство со специальными функциями

Рис. 31. Задание параметров .AC/анализа
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позволяет отображать ток через вывод ком-

понента щелчком мыши на выводе компо-

нента.

.DC — анализ режима 

по постоянному току 

с вариацией параметров источников

По этой директиве выполняется анализ по

постоянному току со ступенчатым изменени-

ем параметра источника постоянного напря-

жения или тока. Одновременно может быть

использовано до трех источников. Директи-

ва, в частности, применяется для вычисления

передаточной функции усилителя по посто-

янному току или отображения характерис-

тик для проверки модели транзистора.

Синтаксис:

.dc < имя 1-го источника> < начальное значение> <конечное зна-

чение> < приращение> [<имя 2-го источника> < начальное зна-

чение> <конечное значение> < приращение>]

<Имя источника> — имя независимого ис-

точника напряжения или тока, выходной сиг-

нал которого задается ступенями <прираще-

ние> от <начального значения> до <конеч-

ного значения>.

Это не документировано разработчиком,

но возможно в качестве одного из источни-

ков указывать температуру. При вариации

температуры в качестве имени источника ука-

зывается ключевое слово TEMP.

Параметры моделирования задаются с ис-

пользованием диалогового окна, вызывае-

мого по команде меню Edit>SPICE Analysis

с выбором пункта DC sweep, показанного

на рис. 32.

Для каждого от одного до трех независи-

мых источников необходимо указать его имя,

характер изменения его выходного сигнала

(линейный, логарифмический на октаву или

декаду, задаваемый в виде списка значений),

начальное и конечное значения, шаг измене-

ния или количество точек.

В качестве выходного сигнала выступают

разность узловых потенциалов или ток через

ветвь с включенным в нее резистором.

В файле …LTC\SwCADIII\examples\Educa-

tional\ stepmodelparam.asc показан пример ис-

пользования .DC-директивы для демонстра-

ции выходных характеристик биполярного

транзистора.

.END — конец списка соединений

Эта директива отмечает конец текстово-

го списка соединений. Все строки после нее

игнорируются. Не нужно помещать дирек-

тиву как текст на схеме, поскольку экстрак-

тор списка соединений делает это самосто-

ятельно.

.ENDS — конец описания макромодели

Синтаксис:

.ends [имя макромодели]

Эта директива отмечает конец описания

макромодели. (См. .SUBCKT для дополни-

тельной информации.) Необязательный па-

раметр [имя макромодели] используется

для удобства чтения и анализа текстового

файла.

.FOUR — вычисление 

Фурье-компонентов 

после .TRAN-анализа

Синтаксис:

.four <частота первой гармоники> [количество гармоник] [коли-

чество периодов] <выходные данные 1> [<выходные данные 2> ...]

Например: 

.four 1kHz V(out)

Эта команда выполняется после анализа

переходного процесса. Результат выполне-

ния команды печатается в файл .log. Для про-

смотра результата используется команда ме-

ню View>Spice Error Log. В большинстве слу-

чаев для быстрого преобразования Фурье

лучше воспользоваться возможностями ок-

на графиков по команде меню View>FFT.

Задается частота первой гармоники и ко-

личество анализируемых гармоник. По умол-

чанию рассчитываются первые 9 гармоник.

Фурье-анализ выполняется на отрезке вре-

мени, отстоящем от конечного времени, Tend,

более чем на период, по меньшей мере, на один

период, если после количества гармоник ука-

зано количество периодов. Если количество

периодов задано равным –1, Фурье-анализ вы-

полняется по всему временному отрезку.

Пример использования директивы .FOUR

приведен в файле …LTC\SwCADIII\exam-

ples\Educational\audioamp.asc.

.FUNC — функции, 

определяемые пользователем

Синтаксис:

.func <имя>([аргументы]) {<выражение>}

Например: 

.func Pythag(x,y) {sqrt(x*x+y*y)}

Директива .FUNC позволяет создание поль-

зовательских функций для использования

в собственных параметризованных схемах

и поведенческих источниках. Этим обеспе-

чивается понятная ассоциативная связь име-

ни с функцией и параметризованной макро-

моделью, чтобы абстрактные схемы можно

было сохранить в библиотеках.

Директива .FUNC может быть включена

в описание макромодели, чтобы ограничить

использование функции этой макромоделью

и макромоделями, входящими в нее.

Чтобы вводить параметр и оценивать вы-

ражение пользовательской функции, выра-

жение заключается в фигурные скобки. Вло-

женное выражение будет заменено числом

с плавающей точкой.

Пример использования директив .FUNC

и .PARAM:

* Example deck using a .func statement

.func myfunc(x,y) {sqrt(x*x+y*y)}

.param u=100 v=600

V1 a 0 pulse(0 1 0 1n 1n .5μ 1μ)

R1 a b {myfunc(u,v/3)}

C1 b 0 100p

.tran 3μ

.end

Подстановка параметров делается до нача-

ла моделирования.

.FERRET — загрузка файла данных 

с использованием URL

Эта команда позволяет загружать файлы

пакетным способом, указывая URL. Это удоб-

но, когда не хочется указывать пути к каждо-

му файлу через интернет-браузер. Загружен-

ный файл будет в том же каталоге, что и ис-

ходная схема или список соединений. Эта

команда не имеет никакого воздействия на

моделирование:

* example deck

.ferret http://ltspice.linear.com/software/scad3.pdf

.end

.GLOBAL — 

назначение глобальных узлов

Синтаксис:

.global <узел1> [узел2 [узел3] [...]]

Например: 

.global VDD VCC

Команда .GLOBAL позволяет объявить, что

определенные узлы, упомянутые в макромо-

делях, не локальные для макромодели узлы,

а абсолютно глобальные узлы.

Рис. 32. Задание параметров .DC/анализа
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Общим глобальным для схемы является

узел «0», для этого не требуется использовать

директиву .GLOBAL. Узлы с именами в фор-

ме «$G_» также являются глобальными без

упоминания в директиве .GLOBAL.

.IC — задание начальных условий

Директива .IC задает начальные условия

для анализа переходных процессов. Могут

быть заданы узловые напряжения и токи че-

рез катушки индуктивности. Решение для по-

стоянного тока выполняется с использовани-

ем начальных условий как ограничений. Ес-

ли катушки индуктивности в решении для

постоянного тока в других SPICE-програм-

мах обычно рассматриваются коротко замк-

нутыми, в LTspice, если начальный ток опре-

делен, они рассматриваются как источники

тока бесконечного импеданса.

Синтаксис:

.ic [V(<узел>)=<напряжение>] [I(<катушка>)=<ток>]

Например: 

.ic V(in)=2 V(out)=5 V(vc)=1.8 I(L1)=300m

.INCLUDE — 

подключение текстовых файлов

Синтаксис:

.include <имя файла>

Эта директива подключает названный

файл, как будто этот файл напечатан в спи-

ске соединений вместо команды .INCLUDE.

Она используется для подключения библио-

тек моделей или макромоделей.

В имени файла должен быть указан пол-

ный путь к нему. Иначе LTspice смотрит сна-

чала в каталоге <SwCADIII>\lib\sub, а затем

в каталоге, который содержит запрашивае-

мый список соединений, где <SwCADIII> —

каталог, содержащий исполняемый scad3.exe,

типично устанавливается как C:\Program

Files\LTC\SwCADIII.

Недопустимо игнорировать расширение

имени файла. Следует использовать .inc my-

file.lib, а не .inc myfile, если файл называет-

ся myfile.lib.

Можно определить url как имя файла сле-

дующим образом:

.inc http://www.company.com/models/library.lib

Файл library.lib будет передан в каталог схемы

и подключен. Во избежание повторной загруз-

ки файла при следующем сеансе моделирова-

ния можно отредактировать директиву .INC.

.inc library.lib

Отметим, что если запрашиваемый url не

существует, большинство серверов сети не

показывают ошибку, но показывают html

web-страницу в вашем web-браузере, кото-

рая объясняет ошибку. LTspice может не все-

гда воспринимать эти страницы как указание

на ошибку, таким образом, можно получить

некое загадочное сообщение об ошибке, ког-

да идет процесс моделирования с включени-

ем html web-страницы как директивы SPICE.

Если полученный документ представляет

собой .pdf-файл, моделирование прервется

после загрузки. Например, после загрузки

файла .pdf будет получен следующий ком-

ментарий:

* Dummy simulation to download the help file.

* The simulation will abort with an error, but

* you'll be left with the file scad3.pdf in the

* same directory containing the netlist.

.inc http://ltspice.linear.com/software/scad3.pdf

.end

Директива .INCLUDE использована в при-

мере …LTC\SwCADIII\examples\Educational\

logamp.asc для подключения макромодели

компонента opamp, в атрибутах которого нет

указания на имя макромодели или файл, ее

содержащий.

.LIB — подключение библиотеки

Синтаксис:

.lib <имя файла>

Эта директива подключает модель и опи-

сание макромодели в названном файле, как

будто этот файл напечатан в списке соедине-

ний вместо команды .lib. Если модель (моде-

ли) компонентов в подключаемом файле

имеет альтернативные описания в библиоте-

ке LTSpice, то последние игнорируются.

В имени файла должен быть указан пол-

ный путь к нему. Иначе LTspice смотрит сна-

чала в каталоге <SwCADIII>\lib\sub, а затем

в каталоге, который содержит запрашивае-

мый список соединений, где <SwCADIII> —

каталог, содержащий исполняемый scad3.exe,

типично устанавливается как C:\Program Files\

LTC\SwCADIII.

Недопустимо игнорировать расширение име-

ни файла. Необходимо указать .lib myfile.lib,

а не .lib myfile, если файл называется myfile.lib

Можно определить url как имя файла сле-

дующим образом:

.lib http://www.company.com/models/library.mod

Файл library.mod будет передан в каталог схе-

мы и подключен. Во избежание повторной за-

грузки файла при следующем сеансе модели-

рования можно отредактировать указание .lib:

.lib library.mod

Зашифрованные библиотеки

LTspice может генерировать и читать библио-

теки, зашифрованные в специальной форме.

Это позволяет одному пользователю готовить

библиотеку для другого пользователя, кото-

рую можно использовать в моделировании,

не показывая ее содержимое. Резонно попы-

таться сделать зашифрованную библиотеку,

которую исключительно сложно расшифро-

вывать, но такое решение нельзя считать аб-

солютным, если только не решить проблему

непосредственно в программном обеспечении.

Чтобы подготовить зашифрованную биб-

лиотеку, нужно вызвать LTspice из команд-

ной строки с выбором опции «-encrypt». Сна-

чала следует сделать копию библиотеки, по-

скольку она будет заменена зашифрованной

версией. Нет никакой возможности преобра-

зовать зашифрованную библиотеку обратно

в текстовый формат. Уточним эти два шага:

1. Сделайте резервные копии библиотеки.

Версия, которая кодируется, будет удалена.

2. В командной строке напечатайте:

scad3.exe -encrypt <filename>

Файл <filename> будет заменен зашифро-

ванной версией. Процесс шифрования зай-

мет несколько минут.

По окончании этого процесса вы будете

иметь зашифрованный ASCII-файл. Можно

добавить уведомление об авторском праве вы-

ше строки «*Begin:», но первые 9 строк файла

должны остаться неизменными, и каждая стро-

ка уведомления об авторском праве, добавлен-

ная вами, должна начинаться символом «*».

Итак, приведем пример зашифрованного

файла, созданный LTspice:

* LTspice Encrypted File

*

* This encrypted file has been supplied by a 3rd

* party vendor that does not wish to publicize

* the technology used to implement this library.

*

* Permission is granted to use this file for

* simulations but not to reverse engineer its

* contents.

*

* Begin:

50 3E 46 0F FA 6E 67 FF B8 4D D9 62 14 32 60 24

36 71 35 0B 66 4F AD 52 B8 F5 9E 22 9F C0 18 8B

FB FE 1D...

Можете изменить файл следующим образом:

* LTspice Encrypted File
*
* This encrypted file has been supplied by a 3rd
* party vendor that does not wish to publicize
* the technology used to implement this library.
*
* Permission is granted to use this file for
* simulations but not to reverse engineer its
* contents.
*
* Copyright © 2005 Acme SPICE Modeling
* For additional information, see
* www.acmespicemodels.com
*
* Begin:
50 3E 46 0F FA 6E 67 FF B8 4D D9 62 14 32 60 24
36 71 35 0B 66 4F AD 52 B8 F5 9E 22 9F C0 18 8B
FB FE 1D...

www.kit5e.ru
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.LOADBIAS — загрузка 

предварительно выполненного расчета

по постоянному току

Синтаксис:

.loadbias <имя файла>

Команда LOADBIAS — дополнение к коман-

де .SAVEBIAS. Сначала выполните моделиро-

вание по команде .SAVEBIAS. Затем измените

команду .SAVEBIAS на команду .LOADBIAS.

.MEASURE — измерение заданных 

пользователем электрических величин

Есть два различных варианта директив

.MEASURE. В первом случае обращаются

к точке на оси абсцисс (независимая перемен-

ная, откладываемая по горизонтальной оси,

ось времени для .TRAN-анализа), во втором

случае обращаются к диапазону по оси абсцисс.

Первый вариант используется, чтобы найти

значение данных или выражения в заданной

точке на оси абсцисс, или когда выполняет-

ся необходимое условие. Используется сле-

дующий синтаксис:

.meas[sure] [AC|DC|OP|TRAN|TF|NOISE] <имя результата>
[<FIND|DERIV|PARAM> <выражение>] [WHEN <выражение> |
AT=<выражение>]] [TD = <значение1>] [<RISE|FALL|CROSS> =
[<отсчет1> |LAST]]

Здесь [AC|DC|OP|TRAN|TF|NOISE] — вид

анализа, к которому применяется директива;

FIND (найти); DERIV (производная); PARAM

(использование результатов предшествую-

щих измерений); WHEN (условие); AT (ко-

ордината точки измерения на оси абсцисс);

TD (задержка в единицах измерения по оси

абсцисс относительно момента выполнения

условия); RISE (увеличение); FALL (умень-

шение); CROSS (пересечение); LAST (послед-

ний случай).

В первой позиции можно указать вид ана-

лиза, к которому применяется директива

.MEAS. Это позволяет использовать соответ-

ствующие директивы .MEAS только в опре-

деленных видах анализа. Обязательно следу-

ет присваивать имя результату, который мо-

жет быть использован в качестве параметра

в других директивах .MEAS. Далее — приме-

ры директивы .MEAS с обращением к одной

точке на оси абсцисс:

.MEAS TRAN res1 FIND V(out) AT=5m

Результат — значение V(out) для t = 5 мс,

именованный как res1.

.MEAS TRAN res2 FIND V(out)*I(Vout) WHEN V(x)=3*V(y)

Результат — значение выражения

V(out)*I(Vout), когда условие V(x)=3*V(y)

встречается в первый раз. Он будет именован

как res2.

.MEAS TRAN res3 FIND V(out) WHEN V(x)=3*V(y) cross=3

Результат — значение V(out), когда усло-

вие V(x)=3*V(y) встречается в третий раз.

Он будет именован как res3.

.MEAS TRAN res4 FIND V(out) WHEN V(x)=3*V(y) rise=last

Результат — значение V(out), для которо-

го условие V(x)=3*V(y) встречается в послед-

ний раз, либо когда V(x) максимально близ-

ко к 3*V (y). Он будет именован как res4.

.MEAS TRAN res5 FIND V(out) WHEN V(x)=3*V(y) cross=3 TD=1m

Результат — значение V(out) через 1 мс по-

сле того, как условие V(x)=3*V(y) встречает-

ся в третий раз. Он будет именован как res5.

.MEAS TRAN res6 PARAM 3*res1/res2

Результат — значение 3*res1/res2. Такая

форма используется, чтобы определить зна-

чение выражения, составленного из резуль-

татов других .MEAS-утверждений. Не пред-

полагается, что в оцениваемом выражении

присутствуют непосредственные результаты

моделирования, например, V(3), если только

это не данные из последней точки моделиро-

вания. Результат именован как res6.

В приведенных примерах обращения к од-

ной точке на оси абсцисс результат соответ-

ствует данным ординаты (зависимые пере-

менные). Если информация об ординате не

требуется, результатом .MEAS-утверждения

будет точка на оси абсцисс, в которой выпол-

няется условие измерений:

.MEAS TRAN res6 WHEN V(x)=3*V(y)

Результат — это момент времени, когда

условие V(x)=3*V(y) встречается впервые.

Он именован как res6.

Второй вариант директивы .MEAS обраща-

ется к диапазону по абсциссе. Используется

следующий синтаксис:

.meas [AC|DC|OP|TRAN|TF|NOISE] <имя результата>

[<AVG|MAX|MIN|PP|RMS|INTEG> <выражение>] [TRIG <lhs1>

[[VAL] =] <rhs1>] [TD = <значение1>] [<RISE|FALL|CROSS> =

<отсчет1>] [TARG <lhs2> [[VAL] =] <rhs2>] [TD = <значение2>]

[<RISE|FALL|CROSS> = <отсчет2>]

Диапазон по абсциссе ограничен точками,

определенными как «TRIG» и «TARG».

По умолчанию точка TRIG устанавливает на-

чало моделирования и может быть опущена.

Точно так же точка TARG по умолчанию со-

ответствует данным в конце моделирования.

Если все три из TRIG, TARG и WHEN точки

опущены, то утверждение .MEAS действует

на весь диапазон данных. Типы измерений,

которые могут быть выполнены в интерва-

ле, перечислены в таблице 9.

Если никакое измерение не задано, резуль-

тат директивы .MEAS — расстояние по абс-

циссе между точками TRIG и TARG. Далее —

пример директивы .MEAS по диапазону:

.MEAS TRAN res7 AVG V(NS01) TRIG V(NS05) VAL=1.5 TD=1.1u

FALL=1 TARG V(NS03) VAL=1.5 TD=1.1u FALL=1

Результат — среднее значение напряжения

V(NS01) на отрезке времени от 1-го умень-

шения V(NS05) до 1,5 В с задержкой 1,1 мкс

и до 1-го уменьшения V (NS03) до 1,5 В с за-

держкой 1,1 мкс. Результат именован как res7.

Для .AC-анализа условные выражения

в комплексных данных упрощаются до ве-

щественной части с преобразованием в вы-

ражение для амплитуды. Например:

.MEAS AC res8 when V(out)=1/sqrt(2)

Результат res8 — частота, на которой вели-

чина V(out) равна 0.7071067811865475.

Кроме того, результат директивы .MEAS

может использоваться в другой директиве

.MEAS. В следующем примере рассчитана по-

лоса пропускания на уровне 3 дБ:

.MEAS AC tmp max mag(V(out)); найдем амплитуду и запомним

как tmp

.MEAS AC BW trig mag(V(out))=tmp/sqrt(2) rise=1 targ

mag(V(out))=tmp/sqrt(2) fall=last

Результат — разность частот между двумя

точками, лежащими на 3 дБ ниже максималь-

ного значения сигнала. Отметим, что данные,

получаемые в .AC-анализе, комплексные, и та-

ковы же результаты по директиве .MEASURE.

Тем не менее, равенство оперирует только

с реальной частью комплексного числа, то есть

выражение mag(V(out))=tmp/sqrt(2) эквива-

лентно Re(mag(V(out)))=Re(tmp/sqrt(2)).

Операции AVG, RMS и INTEG в .NOISE-

анализе несколько иные, чем в анализах дру-

гих типов, так как .NOISE связан с квадратом

частоты. Таким образом, и AVG, и RMS да-

ют среднеквадратичное напряжение шумов,

а INTEG дает интегрированный полный

шум. Следовательно, если вы добавляете

SPICE-директивы:

.MEAS NOISE out_totn INTEG V(onoise)

.MEAS NOISE in_totn INTEG V(inoise)

Таблица 9. Вычислительные операции,

выполняемые по диапазону данных

Интегрирование <выражение>

Вычисление среднеквадратичного значения 
<выражение>

Нахождение размаха от пика до пика <выражение>

Нахождение минимального значения <выражение>

Нахождение максимального значения <выражение>

INTEG

RMS

PP

MIN

MAX

Вычисление среднего значения <выражение>AVG

Выполняемая по диапазону операция
Ключевое

слово
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к .NOISE-анализу, в .log-файле будут напеча-

таны значения полных интегрированных

среднеквадратичных шумов, приведенных

к выходу и входу.

Директива .MEAS выполняется после окон-

чания моделирования. Это позволяет запи-

сывать сценарии директив .MEAS и выпол-

нять их над набором данных. Для этого сде-

лайте окно графиков активным и выполните

команду меню File>Execute .MEAS Script.

Другое последствие .MEAS-директив, выпол-

няемых после моделирования, — то, что точ-

ность вычислений ограничена точностью

данных графика после сжатия. Можно изме-

нить параметры настройки сжатия для полу-

чения более точных результатов по .MEAS-

директиве.

Не следует задавать условие в виде равен-

ства, типа «when <cond1> = <cond2>». Это

объясняется тем, что равенство чисел в фор-

ме с плавающей запятой никогда не должно

требоваться из-за конечной точности, исполь-

зуемой при хранении чисел.

Пример использования директивы .MEASURE

приведен в файле …LTC\SwCADIII\examples\

Educational\MeasureBW.asc.

.MODEL — определение SPICE-модели

Директива определяет модель для диода,

транзистора, ключа, линии передачи с поте-

рями или однородной RC-линии.

Некоторые элементы схемы, например,

транзисторы, имеют много параметров. Вме-

сто того чтобы определять каждый параметр

для каждого транзистора, транзисторы объ-

единены именем модели и имеют общие па-

раметры. Транзисторы одной модели могут

иметь различные размеры, и электрическое

поведение масштабируется в соответствии

с размером.

Синтаксис:

.model <имя модели> <имя типа модели> [(<список параметров>)]

Например: 

.model DIODE D (Is=1E-10)

Имя модели должно быть уникальным.

Таким образом, два различных типа элемен-

тов схемы, типа диода и транзистора, не мо-

гут иметь одного имени модели. Список па-

раметров зависит от ее типа. В таблице 10

приведен перечень типов моделей.

.NET — расчет параметров цепей 

в .AC-анализе

Эта директива используется при .AC-ана-

лизе в режиме малого сигнала, чтобы вычис-

лить входной и выходной адмиттанс, импе-

данс, Y-, Z-, H- и S-параметры четырехполюс-

ника. Эту методику можно также использовать

для вычисления входного адмиттанса и импе-

данса двухполюсника. Директива должна ис-

пользоваться с директивой .AC, определяю-

щей девиацию частоты при анализе цепи.

Синтаксис:

.net [V(out[,ref])|I(Rout)] <Vin|Iin> [Rin=<значение>]

[Rout=<значение>]

Входной порт цепи определяется либо не-

зависимым источником напряжения, <Vin>,

либо независимым источником тока, <Iin>.

Соответственно, выходной порт определяет-

ся либо как узел, V(out), либо как резистор,

I(Rout). К портам подключаются резисторы

Rin и Rout. Если не указано определенно, под-

ключаемые импедансы по умолчанию 1 Ом,

кроме случаев источника напряжения с оп-

ределенным Rser или выходного порта, оп-

ределенного как резистор. В этих двух случа-

ях подключаемые резисторы по умолчанию

являются импедансами устройства. Импедан-

сы подключаемых по директиве .NET уст-

ройств действительны только для вычисле-

ний по этой директиве, но не для узловых на-

пряжений и токов обычного .AC-анализа.

То есть директива .NET не навязывает под-

ключаемые к цепи импедансы при расчете

напряжений и токов в процессе .AC-анализа.

Файл примера — …\LTC\SwCADIII\examples\

Educational\S-param. Рекомендуется исполь-

зовать источник напряжения, V4, с установ-

кой требуемого импеданса источника Rser,

и резистор, Rout, подключенный к выходу,

с простой формой записи директивы .net

I(Rout) V4. При этом нет необходимости за-

давать значения Rin или Rout в директиве

.NET, достаточно задать характеристики уст-

ройств, подключенных к входу и выходу.

Доступ к графикам зависимостей малосиг-

нальных параметров по команде Plot Settings>

Visible Traces или View>Add Trace.

.NODESET — задание начального 

режима по постоянному току

Директива .NODESET устанавливает на-

чальные значения узловых потенциалов в ра-

бочей точке по постоянному току. Если схе-

ма имеет множество возможных состояний

по постоянному току, например, триггер,

процесс итерации решения по постоянному

току может никогда не сойтись. Директиву

.NODESET можно использовать, чтобы уста-

новить схему в то или иное состояние. В ос-

новном, после того как выполнен проход ре-

шения с напряжением, определенным в ди-

рективе .NODESET, ограничение удаляется

в последующих итерациях.

Синтаксис:

.nodeset V(узел1)=<напряжение> [V(узел2)=<напряжение [...]]

.NOISE — расчет 

спектральной плотности шумов

Синтаксис:

.noise V(<узел1>[,<узел2>]) <имя источника> <oct, dec, lin> <ко-

личество точек> <начальная частота> <конечная частота>

Это — анализ в частотной области, в кото-

ром вычисляются джонсоновский тепловой

шум, дробовый и фликкер-шумы. Выходные

данные — значения квадратного корня из

спектральной плотности шумов.

V(<узел1>[,<узел2>]) — участок цепи,

для которого вычисляется полный выходной

шум. Это может быть выражено как V (n1, n2),

чтобы представить напряжение между дву-

мя узлами. <Имя источника> — имя незави-

симого источника напряжения или тока,

к входу которого пересчитывается шум. Это

фиктивный не шумящий источник сигнала.

Параметры <oct, dec, lin>, <количество то-

чек>, <начальная частота> и <конечная час-

тота> определяют интересующий частотный

диапазон и разрешение таким же образом,

как и при использовании в директиве .AC.

Параметры анализа вводятся с помощью ди-

алогового окна (рис. 33), вызываемого по ко-

манде меню Edit>Spice Analysis, с выбором

пункта Noise.

График выходных данных V(onoise) — спе-

ктральная плотность шумового напряжения

в узле (узлах), определенных как выход в вы-

шеупомянутом синтаксисе. Если источник

входного сигнала — источник напряжения,

то график V(inoise) — приведенная к входу

плотность напряжения шумов. Если источ-

ник входного сигнала — источник тока,

то график inoise — шум, приведенный к то-

ку источника входного сигнала. Может быть

www.kit5e.ru

Таблица 10. Имена типов моделей компонентов

Мощный вертикальный МОП/транзистор 
по технологии двойной диффузии

Однородная RC/линия с распределенными параметрами

Ключ, управляемый напряжением

Биполярный p�n�p/транзистор

МОП/транзистор с каналом p/типа

MESFET с каналом p/типа

Полевой транзистор с каналом p/типа

Биполярный n�p�n/транзистор

МОП/транзистор с каналом n/типа

MESFET с каналом n/типа

Полевой транзистор с каналом n/типа

Линия передачи с потерями

Диод

VDMOS

URC

SW

PNP

PMOS

PMF

PJF

NPN

NMOS

NMF

NJF

LTRA

D

Ключ, управляемый токомCSW

Тип компонента
Имя типа 
модели

Рис. 33. Задание параметров .NOISE/анализа
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отображен шумовой вклад каждого компо-

нента. Эти вклады пересчитываются к выхо-

ду. Можно пересчитать их к входу, поделив

данные графика на усиление.

В окне графиков можно суммировать шу-

мы в полосе пропускания, нажав на имя со-

ответствующего графика правой кнопкой

мыши при нажатой клавише Ctrl.

Пример использования директивы .NOISE

приведен в файле …LTC\SwCADIII\examples\

Educational\noise.asc.

.OP — определение режима 

по постоянному току в рабочей точке

Выполняется решение для постоянного

тока с отключенными емкостями и корот-

ко замкнутыми индуктивностями. Обычно

решение для постоянного тока выполняет-

ся как часть другого анализа, чтобы найти

рабочую точку схемы. Используйте дирек-

тиву .OP, если нужно только найти рабо-

чую точку. Результаты появятся в диалого-

вом окне. Решение по постоянному току

появится в управляющей строке, если ука-

зать на узел или цепь с током после .OP-мо-

делирования.

В файле …\LTC\SwCADIII\examples\Educa-

tional\DcopPnt.asc приведен пример исполь-

зования директивы .OP.

.OPTIONS — установка 

параметров моделирования

Все доступные параметры моделирования

приведены в таблице 11.

.PARAM — параметры, 

определяемые пользователем

Директива .PARAM позволяет создавать

определяемые пользователем переменные.

Она обеспечивает понятную ассоциативную

связь имени с параметризованной макромо-

делью, чтобы абстрактные схемы можно бы-

ло сохранить в библиотеках.

Директива .PARAM может быть включена

в описание макромодели, чтобы ограничить

действие значения параметра этой макромо-

делью и макромоделями, включенными в эту

макромодель.

Для подстановки параметра в оцениваемое

выражение заключите выражение в фигур-

ные скобки. Вложенное выражение будет за-

менено величиной с плавающей точкой.

Далее приведен пример использования как

собственно директивы .PARAM, так и непо-

средственного ввода параметров в строке вы-

зываемой макромодели:

*

* This is the circuit definition

.params x=y y=z z=1k*tan(pi/4+.1)

X1 a b 0 divider top=x bot=z

V1 a 0 pulse(0 1 0 .5μ .5μ 0 1μ)

* this is the definition of the subcircuit

.subckt divider n1 n2 n3

r1 n1 n2 {top}

r2 n2 n3 {bot}

.ends

*

.tran 3μ

.end

Доступные математические функции и опе-

рации собраны в таблицах 12, 13.

В файле …\LTC\SwCADIII\examples\Educa-

tional\Cohn.asc приведен пример использо-

вания директивы .PARAM.

.SAVE — ограничение количества 

сохраняемых данных

В процессе некоторых видов анализа, осо-

бенно при моделировании во временной об-

ласти, может быть сгенерирован большой

объем данных. Объем выходных данных мо-

жет быть ограничен при использовании ди-

рективы .SAVE, чтобы сохранить только оп-

ределенные интересующие узловые напря-

жения и токи в устройстве.

Синтаксис:

.save V(out) [V(in) [I(L1) [I(S2)]]] [dialogbox]

Директива .save I(Q2) сохраняет токи базы,

коллектора и эмиттера биполярного транзи-

стора Q2. Чтобы сохранить ток через один

вывод транзистора, следует указать Ic(Q2).

Чтобы сохранить данные графиков, соот-

ветствующих образцу, можно использовать

символы группировки «*» и «?». Например,

«.save V(*) Id(*)» позволит сохранить каждое

значение напряжения и каждое значение тока.

Если присутствует ключевое слово dialogbox,

то появляется диалоговое окно со списком

всех доступных по умолчанию узловых на-

пряжений и токов, позволяющее пользова-

Таблица 11. Параметры моделирования

Абсолютная погрешность при расчете напряжений

Представление в компактной форме информации о токах и напряжениях 
в длинных линиях с потерями

Установка погрешности анализа переходного процесса. 
Этот параметр — коэффициент, определяющий фактическую ошибку округления

Устанавливается в нуль, чтобы отменить проверку плавающих узлов, 
контуров источников напряжения и топологии витков трансформаторов

Номинальное значение температуры

По умолчанию температура элементов схемы, 
для которых не задано определенное значение температуры 

Количество тактов ожидания перед поиском установившегося режима

Относительная погрешность детектирования установившегося режима

Альтернативное имя для itl6

Алгоритм ступенчатого изменения параметра источника 

Относительная погрешность при расчете напряжений и токов

Количество точек данных в одном окне после сжатия. 
Устанавливается в нуль, чтобы отменить сжатие

Установка абсолютной погрешности по напряжению при сжатии графиков

Установка относительной погрешности при сжатии графиков

Установка абсолютной погрешности по току при сжатии графиков

Абсолютная величина элемента строки матрицы, необходимая для его выделения 
в качестве ведущего элемента

Относительная величина элемента строки матрицы, необходимая для его выделения
в качестве ведущего элемента

Исторически “numdgt” использовался для установки разрядности выходных данных.
В LTspice, если “numdgt” больше 6, для зависимых переменных данных используется

двойная точность

Переход к непосредственному управлению шагом gmin

Отключение вывода графиков в процессе моделирования

Установка ограничения для завершения подбора gmin

Минимальное сохраняемое количество тактов

Выбор метода численного интегрирования

Разрядность выходных данных для директивы  .MEASURE.

Формат комплексных чисел для результатов директивы .MEASURE. 
Один из возможных: “polar”, “cartesian” или “bode”

Максимальный шаг при анализе переходного процесса

Максимальное сохраняемое количество тактов

Устанавливается в нуль, чтобы предотвратить ступенчатое изменение параметра источника
при начальном решении по постоянному току

Максимальное количество итераций при переходе к следующему моменту времени
при анализе  переходного процесса 

Максимальное количество итераций при расчете передаточной функции по постоянному току

Максимальное количество итераций в расчете по постоянному току

Дополнительная проводимость, добавляемая к каждому узлу относительно «земли»

Устанавливается в нуль, чтобы предотвратить перебор параметра при начальном решении
по постоянному току

Проводимость, добавленная к каждому p�n/переходу для облегчения преобразований

Включение внешних источников тока в режим нагрузки

Преобразование в формат файла fastaccess  в конце моделирования

Используется при просмотре графиков. Перемещает позиции битов в графике

Ширина канала МОП/транзистора по умолчанию

Длина канала МОП/транзистора по умолчанию

Площадь истока МОП/транзистора по умолчанию

Площадь стока МОП/транзистора по умолчанию

Дополнительная емкость, 
добавляемая к каждому внутреннему узлу устройства относительно «земли»

Дополнительная емкость, добавляемая к каждому узлу относительно «земли»

Абсолютная погрешность расчета заряда

Используется при просмотре графиков. Задает режим сглаживания битовых переходов

1 мкВ

1

1

1

27 °С

27 °С

5

0,001

25

0

0,001

300

10 мкВ

0,0025

1 нА

1.00E/13

1.00E/03

6

false

false

1.00E/04

10

trap

6

bode

бескон.

бескон.

25

10

50

100

0

25

1.00E/12

false

false

0

100 мкм

100 мкм

0

0

cshunt

0

10 фК

нет

число

число

число

число

число

число

число

число

число

число

число

число

число

число

число

число

число

число

флаг

флаг

число

число

слово

число

слово

число

число

число

число

число

число

число

число

число

флаг

флаг

число

число

число

число

число

число

число

число

число

VNTOL

TRYTOCOMPACT

TRTOL

TOPOLOGYCHECK

TNOM

TEMP

STARTCLOCKS

SSTOL

SRCSTEPS

SRCSTEPMETHOD

RELTOL

PLOTWINSIZE

PLOTVNTOL

PLOTRELTOL

PLOTABSTOL

PIVTOL

PIVREL

NUMDGT

NOOPITER

NOMARCH

MINDELTAGMIN

MINCLOCKS

METHOD

MEASDGT

MEASCPLXFMT

MAXSTEP

MAXCLOCKS

ITL6

ITL4

ITL2

ITL1

GSHUNT

GMINSTEPS

GMIN

FLSGLOADS

FASTACCESS

DELAY

DEFW

DEFL

DEFAS

DEFAD

CSHUNTINTERN

CSHUNT

CHGTOL

BAUTRATE

Абсолютная погрешность расчета токов1 пАчислоABSTOL

Наименование
Значение 

по умолчанию
Тип 

данных
Параметр
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телю составить список сохраняемых данных.

Если список соединений был сгенерирован

из схемы, то, указав на выбранные ранее уз-

лы и устройства и нажав кнопку мыши, мож-

но отобразить графики в окне.

Если указать для сохранения только один

график, то после запуска процесса модели-

рования он будет отображаться в окне гра-

фиков по ходу процесса, если только не дез-

активирована ячейка Marching Waveforms

в окне Operation панели управления.

.SAVEBIAS — 

сохранение рабочей точки на диске

Синтаксис:

.savebias <имя файла> [internal] [temp=<значение>] [time=< зна-

чение > [repeat]] [step=< значение >] [DC1=< значение >] [DC2=<

значение >] [DC3=< значение >]

Это команда записи на диск текстового

файла, который при последующем модели-

ровании загружается командой .LOADBIAS.

Для схемы, имеющей сложный расчет режи-

ма по постоянному току в рабочей точке,

можно сохранить решение на диске, чтобы

сэкономить время на расчете режима по по-

стоянному току при последующих анализах.

Ключевое слово INTERNAL добавляется,

чтобы указать, что внутренние узловые по-

тенциалы некоторых устройств также долж-

ны быть сохранены с сохранением более пол-

ного решения по постоянному току.

Чтобы сохранить определенную рабочую

точку по постоянному току при расчете пе-

реходных процессов .TRAN, необходимо ука-

зать момент времени. Первое решение для

момента времени, следующего за указанным,

будет сохранено. Модификатор REPEAT за-

ставляет записывать решение по постоянно-

му току через каждый период после указан-

ного момента времени. В файл записывает-

ся только последнее решение по постоянному

току. Можно указать DC1, DC2 и DC3, что-

бы извлечь единственную рабочую точку из

.DC-анализа с вариацией параметров.

По директиве .SAVEBIAS записывается текс-

товый файл в формате директивы .NODESET.

Отметим, что директивы .NODESET — только

рекомендации для решения. Таким образом, вы-

числитель начнет повторять решение с узловы-

ми напряжениями, заданными в директиве

.NODESET, но продолжит повторять вычисле-

ния, пока не будет найдено правильное реше-

ние. Если нужно повторно запустить .TRAN-ре-

шение из рабочей точки по постоянному току,

можно изменить файл .NODESET на .IC, чтобы

принудить вычислитель начать решение с этой

рабочей точки по постоянному току.

Поскольку суммарное состояние всех реак-

тивностей схемы не сохраняется в .SAVEBIAS

файле, успешное решение в этой технике до-

стижимо не всегда.

.STEP — ступенчатое 

изменение параметра

Эта команда заставляет неоднократно вы-

полнять анализ, ступенчато изменяя темпера-

туру, параметр модели, глобальный параметр

или параметр независимого источника. Ступе-

ни могут быть линейными, логарифмически-

ми или определенными как список значений.

Например: 

.step oct v1 1 20 5

Ступенчатое изменение напряжения незави-

симого источника напряжения V1 от 1 до 20 В

с логарифмическим изменением ступеней

с 5 точками на октаву.

Например: 

.step I1 10u 100u 10u

Изменение тока независимого источника

тока I1 от 10 до 100 мкА с шагом 10 мкА.

Например: 

.step param RLOAD LIST 5 10 15

Трехкратное выполнение моделирования

с глобальным параметром Rload, равным 5,

10 и 15.

Например:

.step NPN 2N2222(VAF) 50 100 25

Ступенчатое изменение параметра VAF мо-

дели NPN от 50 до 100 с шагом 25.

Например: 

.step temp -55 125 10

Изменение температуры от –55 до 125 °C

с шагом 10 °C.

Вариации шага могут быть вложениями

глубиной до трех уровней.

Например: 

.step I1 10u 100u 10u temp list 25 100

Изменение тока независимого источника

тока I1 от 10 до 100 мкА с шагом 10 мкА при

двух значениях температуры: 25 и 100 °C.

.SUBCKT — описание макромодели

Для упрощения описания повторяющие-

ся схемы могут быть оформлены в виде ма-

кромоделей со своим описанием и использо-

www.kit5e.ru

Таблица 12. Математические функции Таблица 13. Математические операции

Случайные числа между –0,5 и 0,5 
с плавными переходами между значениями, 

даже более плавными, чем в random()

Функция ограничения: uramp(x)=x, 
если x> 0; uramp(x)=0, если x≤0 

Ступенчатая функция: u(x)=1, 
если x> 0; u(x)=0, если x≤0 

Гиперболический тангенс x

Тангенс x

Табличная зависимость функции от x.
Координаты точек (x, y) в виде таблицы,
в промежутках между точками линейная

аппроксимация

Действительная часть квадратного корня x,
например, sqrt(–1) возвращает 0, не 0,707107i

Гиперболический синус x

Синус x

Знак x

Ближайшее целое число к x

Функция, подобная rand(x), но с более
плавными переходами между значениями

Случайные числа между 0 и 1 
в зависимости от значения x

sgn(x)*abs(x)**y

abs(x)**y

Действительная часть x**y, например,
pow(–0.5,1.5) возвращает 0, а не 0,353553i

Минимальное из x или y 

Случайное число между x * (1+y) и x * (1–y)
с нормальным распределением

Максимальное из x или y 

Десятичный логарифм x

Альтернатива ln(x)

Натуральный логарифм x

x, если y<x<z; y, если x<y; z, если x>y

inv(x)=0, если x>0,5; inv(x)=1, если x≤0,5 

Округление x до целого числа

y, если x истинно, иначе z

Интеграл ∫x(t)

sqrt(x**2 + y**2)

Случайное число с распределением Гаусса
с сигмой x

Целое число, равное или меньше x

Случайное число между –x и x 
с нормальным распределением

То же самое, что и abs(x)

Экспоненциальная функция x

Задержка сигнала x на время y

Первая производная dx/dt

Гиперболический косинус x

Косинус x

Целое число, равное или большее x

Кубический корень из x

buf(x)=1, если x>0,5; buf(x)=0, если x≤0,5

Гиперболический арктангенс

Арктангенс (x/y)

Синоним для atan(x)

Арктангенс x

Гиперболический арксинус

Синоним для asin(x)

Действительная часть арксинуса x, 
например, asin(–5) возвращает –1.57080, 

а не –1.57080+2.29243i

Действительная часть acosh(x), например,
acosh(.5) возвращает 0, а не 1.0472i

Синоним для acos(x)

Действительная часть arcos(x), 
например, acos(–5) возвращает 3.14159, 

а не 3.14159+2.29243i

WHITE(x)

URAMP(x)

U(x)

TANH(x)

TAN(x)

TABLE(x,a,b,c,d,...)

SQRT(x)

SINH(x)

SIN(x)

SGN(x)

ROUND(x)  

RANDOM(x)

RAND(x)

PWRS(x, y)

PWR(x, y)

POW(x, y)

MIN(x,y)

MC(x,y)

MAX(x,y)

LOG10(x)

LOG(x)

LN(x)

LIMIT(x,y,z)

INV(x)

INT(x)

IF(x, y, z)

IDT(x)

HUPOT(x,y)

GAUSS(x)

FLOOR(x)

FLAT(x)

FABS(x)

EXP(x)

DELAY(x,y)

DDT(x)

COSH(x)

COS(x)

CEIL(x)

CBRT(x)

BUF(x)

ATANH(x)

ATAN2(y, x)

ARCTAN(x)

ATAN(x)

ASINH(x)

ARCSIN(x)

ASIN(x)

ACOSH(x)

ARCOS(x)

ACOS(x)

Абсолютное значение xABS(x)

ОпределениеФункция

Оператор выбора шага

Преобразование, эквивалентное логической инверсии

Возведение в степень, возвращается только действитель/
ная часть, например, –2**1,5 возвращает 0, а не 2,82843i

Деление с плавающей точкой

Умножение с плавающей точкой

Вычитание с плавающей точкой

Сложение с плавающей точкой

ИСТИНА (TRUE), если выражение слева меньше 
или равно выражению справа, иначе ЛОЖЬ (FALSE)

ИСТИНА (TRUE), если выражение слева больше 
или равно выражению справа, иначе ЛОЖЬ (FALSE)

ИСТИНА (TRUE), если выражение слева
меньше выражения справа, иначе ЛОЖЬ (FALSE)

ИСТИНА (TRUE), если выражение слева 
больше выражения справа, иначе ЛОЖЬ (FALSE)

Преобразование, эквивалентное логическому
исключающему ИЛИ (XOR)

Преобразование, эквивалентное логическому ИЛИ (OR)

@

!

**

/

*

–

+

<=

>=

<

>

^

|

Преобразование, эквивалентное логическому И (AND)&

Назначение
Символ 

операции
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ваться в одной схеме многократно. Прежде

чем начнется моделирование, список соеди-

нений схемы будет расширен с заменой каж-

дого обращения к макромодели элементами

схемы из описания макромодели. Нет ника-

ких ограничений по размеру или сложности

макромоделей.

Описание макромодели должно заканчивать-

ся директивой .ENDS. Для удобства работы

с текстовым файлом в дальнейшем целесооб-

разно строку дополнить именем макромодели.

Пример использования макромодели:

*

* Описание схемы

X1 a b 0 divider

V1 a 0 pulse(0 1 0 .5μ .5μ 0 1μ)

* Описание макромодели

.subckt divider n1 n2 n3

r1 n1 n2 1k

r2 n2 n3 1k

.ends

.tran 3μ

.end

Расширение после запуска моделирования:

* Расширение X1 до набора из двух резисторов

r:1:1 a b 1k

r:1:2 b 0 1k

*

v1 a 0 pulse(0 1 0 .5μ .5μ 0 1μ)

.tran 3μ

.end

Отметим, что для элементов схемы, обра-

зованных расширением макромодели, созда-

ны уникальные имена, основанные на име-

ни макромодели и именах элементов описа-

ния макромодели.

.TEMP — температурный анализ

Это устаревшая форма для команды сту-

пенчатого изменения температуры. Все ви-

ды анализа выполняются для каждой указан-

ной температуры.

Синтаксис:

.TEMP <температура1> <температура2> ...

Что эквивалентно:

.STEP TEMP LIST <температура1> <температура2> ...

.TF — определение 

малосигнальной передаточной функции

по постоянному току

В этом режиме определяется малосигналь-

ная передаточная функция по постоянному

току для узлового напряжения или тока вет-

ви при малых изменениях параметра незави-

симого источника. Параметры моделирова-

ния можно задать через диалоговое окно, по-

казанное на рис. 34.

Синтаксис:

.TF V(<узел>[, <опорный узел>]) <независимый источник>

.TF I(<источник напряжения>) <независимый источник>

Например:

.TF V(out) Vin

.TF V(5,3) Vin

.TF I(Vload) Vin

.TRAN — анализ переходных процессов

По этой директиве выполняется анализ пе-

реходного процесса. Это наиболее информа-

тивное моделирование схемы. В процессе ана-

лиза вычисляется, что происходит в схеме по-

сле подачи питания. В качестве испытательных

сигналов часто применяются независимые ис-

точники.

Синтаксис:

.TRAN <Tstep> <Tstop> [Tstart [dTmax]] [modifiers]

.TRAN <Tstop> [modifiers]

.TRAN <шаг вывода данных> <конечное время> [начальный момент

времени вывода данных [максимальный шаг]] [модификаторы]

.TRAN <конечное время> [модификаторы]

Первая запись представляет собой традици-

онную форму для SPICE команды .TRAN.

Tstep — шаг вывода графиков. LTspice исполь-

зует сжатие графиков, так что этот параметр

не имеет большого значения и может быть опу-

щен или установлен в ноль. Tstop — продол-

жительность моделирования. Анализ переход-

ного процесса всегда начинается с момента вре-

мени, равного нулю. Однако, если определено

Tstart, данные для графика между нулем и Tstart

не сохраняются. Это — средство управления

размером файлов графиков, позволяющее иг-

норировать переходные процессы при вклю-

чении. Последний параметр dTmax является

максимальным шагом интегрирования. Если

заданы Tstart или dTmax, то должен быть за-

дан и Tstep. Параметры моделирования легко

задаются с использованием диалогового окна,

изображенного на рис. 35.

В строку .TRAN могут быть помещены не-

сколько модификаторов из перечисленных

далее.

UIC

Использование начальных условий. Обыч-

но расчет рабочей точки по постоянному то-

ку выполняется перед началом анализа пере-

ходного процесса. Директива подавляет эту

инициализацию. Начальные условия для не-

которых элементов схемы могут быть опре-

делены случайным образом. UIC — не осо-

бенно рекомендуемая возможность SPICE.

Пропуск расчета рабочей точки по постоян-

ному току пункта ведет к нереализуемому фи-

зически начальному условию. Рассмотрим,

например, подключение емкости к источни-

ку напряжения. Узловое напряжение равно

нулю, если не задано иное. Тогда в первый мо-

мент бесконечный ток обязан заряжать кон-

денсатор. Симулятор не может найти доста-

точно короткий шаг времени и выдает сооб-

щение time step too small convergence fail.

STARTUP

Модификатор подобен оригинальному

SPICE UIC. Он означает, что независимые ис-

точники должны отключаться на первые

20 мс моделирования. Однако анализ рабо-

чей точки по постоянному току выполнен

с использованием ограничений, заданных ди-

рективой .IC.

STEADY

Останавливает моделирование по достиже-

нию установившегося режима. Это требуется

для создания отчета о расчете эффективности.

Обнаружение установившегося режима запи-

сано в макромоделях ВИП. Обычное реше-

ние — обнаружение нулевого значения в вы-

ходном токе усилителя ошибки, усредненном

по периоду тактовой частоты. Алгоритм пред-

полагает анализ выходного сигнала усилителя

ошибки. Доля импульсного тока, считающая-

ся нулевым током, задается параметром SSTOL.

Автоматическое обнаружение установив-

шегося режима может быть неудачным

вследствие неоптимального критерия его де-

тектирования. Можно в интерактивном ре-

жиме определить установившийся режим

следующим образом: как только моделиро-

вание начинается, выполните команду меню

Simulate>Efficiency Calculation>Mark Start.

При выполнении этой команды в первый раз

вы указываете LTspice, что собираетесь вруч-

ную определять пределы интегрирования.

После того как схема достигла установивше-

гося режима, выполните эту команду снова.

Это очистит историю и перезапустит расчет

Рис. 34. Задание параметров .TF/анализа

Рис. 35. Задание параметров .TRAN/анализа
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потерь. Затем, по меньшей мере через 10 так-

товых импульсов выполните команду Simulate>

Efficiency Calculation>Mark End. Каждый раз

при выполнении команды Simulate>Efficiency

Calculation>Mark Start повторно начинается

расчет потерь и очищается история графи-

ков. Это хороший метод воспрепятствовать

чрезмерному увеличению файла и замедле-

нию рисования. Рекомендуется периодичес-

ки выполнять Simulate>Efficiency Calculation>

Mark Start всякий раз, когда ясно, что накопле-

но существенное количество данных, которые

нецелесообразно включать в расчет потерь.

Используйте директиву .IC для определе-

ния узловых напряжений и токов через катуш-

ки индуктивности, чтобы уменьшить длитель-

ность анализа переходного процесса, предше-

ствующего установившемуся режиму.

NODICARD

Не удалять часть моделирования переход-

ного процесса, прежде чем будет достигнут

установившийся режим.

STEP

Расчет отклика схемы на ступенчатое воз-

действие. Эта функция работает с использо-

ванием в качестве нагрузки источника тока

со ступенчатым изменением тока. Процеду-

ра включает в себя следующие этапы:

1. Определяется установившийся режим

и очищается история, если не использует-

ся NODISCARD.

2. Нагрузка ступенчато изменяется к следу-

ющему значению из списка со скоростью

20 A/мкс.

3. Определяется установившийся режим.

4. Нагрузка ступенчато изменяется к следу-

ющему значению из списка или отключа-

ется, если его нет.

В сложной схеме автоматически изменение

тока нагрузки можно и не обнаружить. В по-

добном случае лучше использовать команду

.TRAN для запуска моделирования переход-

ного процесса и наблюдать начало и конец

периода желаемого отклика на скачок нагруз-

ки. Используйте команду PWL, чтобы про-

граммировать выходной ток нагрузки и пе-

реключать его на различные уровни в жела-

емые моменты времени. Например:

PWL(0 0.5 1m 0.5 1.01m 0.1 3m 0.1 3.01m 0.5)

Ток нагрузки начинается с 0,5 A в момент времени 0,

пребывает равным 0,5 A в течение 1 мс,

переключается на 0,1 A в момент времени 1,01 мс,

пребывает равным 0,1 A до 3 мс,

переключается на 0,5A в 3,01 мс и остается равным 0,5 A.

PWL может иметь почти неограниченную

последовательность пар (время, значение).

.WAVE —

запись выбранных узлов в .wav-файл

LTspice может записывать звуковые фай-

лы .wav. Эти файлы можно слушать или ис-

пользовать в качестве входных для другого

моделирования.

Синтаксис:

.wave <имя файла .wav> <Nbits> <SampleRate> V(out) [V(out2)

...]

Например: 

.wave C:\output.wav 16 44.1K V(left) V(right)

Здесь <имя файла .wav> — полный путь

к .wav-файлу или относительный путь, оп-

ределяемый из каталога, содержащего симу-

лируемую схему или список соединений.

<Nbits> — число битов в выборке. Допус-

тимый диапазон — от 1 до 32 битов.

<SampleRate> — количество выборок в се-

кунду. Допустимый диапазон — от 1 до

4 294 967 295 выборок в секунду. Далее в син-

таксисе — перечисление узловых напряже-

ний, значения которых нужно сохранить.

Каждый узел будет независимым каналом

в .wav-файле. Число каналов может быть от

одного до 65 535. Можно записать ток в уст-

ройстве, например, Ib(Q1), или узловое на-

пряжение. .wav-аналог цифрового преобра-

зователя имеет полномасштабный диапазон

от –1 до +1 вольта или ампера.

В файле …\LTC\SwCADIII\examples\Educa-

tional\wavein.asc приведен пример использо-

вания директивы .WAVE.

В следующей статье — примеры моделиро-

вания схем с использованием программы.   ■

www.kit5e.ru
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Примеры работы
в LTspice/SwitcherCAD III

В папке My_Examples, хранящейся по адре-

су http://www.kit-e.ru/assets/My_Examples.zip,

содержатся файлы для демонстрации воз-

можностей LTspice/SwitcherCAD III.

Папка My_Project включает в себя файлы:
•• TL431.asc — схема макромодели TL431;
•• TL431_test_pulse.asc — схема тестирова-

ния TL431 в режиме компаратора;
•• TL431_test_freq.asc — схема тестирования

TL431 в режиме усилителя переменного

тока;
•• TL431_test_temp.asc — схема для темпера-

турного анализа TL431;
•• Regulator_dc.asc — схема стабилизатора

напряжения для анализа на постоянном

токе;
•• Regulator_tr.asc — схема стабилизатора на-

пряжения для расчета передаточной функ-

ции на постоянном токе;
•• Regulator_ac.asc — схема стабилизатора

напряжения для анализа устойчивости;
•• Regulator_ac1.asc — то же самое, но для по-

строения годографа Найквиста;
•• Regulator_tran.asc — схема стабилизатора

напряжения для анализа качества регули-

рования.

Файл My_Lib.lib содержит описание мак-

ромодели микросхемы TL431.

В папке My_Sym описания символов ком-

понента TL431:
•• TL431.asy — символ с атрибутом «тип ком-

понента» Cell;
•• TL431_test.asy — символ с атрибутом «тип

компонента» Block.

Чтобы воспользоваться предлагаемыми

примерами, необходимо поместить файл

My_Lib.lib в папку sub, папку My_Sym в пап-

ку sum, а папку My_Project в папку SwCADIII

установленной программы.

Модель микросхемы TL431

Файл TL431.asc — это схема макромодели

регулируемого стабилитрона TL431, создан-

ная на основе принципиальной схемы, пред-

ставленной в [2]. Эта модель, в отличие от из-

вестных SPICE-моделей микросхемы TL431,

обеспечивает удовлетворительные результа-

ты моделирования во всех вариантах приме-

нения, предлагаемых производителем мик-

росхемы. Приведем текст модели, содержа-

щийся в файле My_Lib.lib:

.subckt TL431 A C R

*TL431 Reference

*Model for LTSpiceSwCADIII, Orcad, Micro-Cap

* Designed by M.Pushkarev, Uljanovsk, Russia, 10/07/2008

Q1 N011 N011 A QN

Q2 C R N005 QN

Q3 N003 N003 R QN

Q4 N012 N011 N014 QN 2

Q5 N004 N004 N001 QP

Q6 N004 N005 N008 QN

Q7 N010 N012 A QN

Q8 N003 N004 N002 QP

Q9 N003 N013 A QN

Q10 C N003 N006 QN

Q11 C N007 A QN 3

R1 N009 N011 2.4k TC=2E-3, -2E-5

R2 N005 N009 3.28k TC=2E-3, -2E-5

R3 N009 N012 7.2k TC=2E-3, -2E-5

R4 N014 A 800 TC=1.8E-3

R5 C N001 800 TC=1.8E-3

R6 N008 N010 4k TC=2E-3, -2E-5

R7 N013 N011 1k

R8 C N002 800 TC=1.8E-3

R9 N007 N006 150

R10 N007 A 10k

D1 A N003 QD

D2 A C QD

C1 N010 N012 20p

C2 C N003 20p

.model QD D (is=10e-15)

.model QN NPN(is=5e-15 BF=120 Cje=.5p Cjc=.5p Rb=500)

.model QP LPNP(is=5e-15 BF=50Cje=.3p Cjc=1.5p Rb=250)

.backanno

.ends TL431

Описание макромодели начинается стро-

кой, включающей в себя директиву .SUBCKT,

имя макромодели и имена выводов, распо-

ложенных в порядке, аналогичном поряд-

ку размещения их в символе компонента.

Следующие три строки — комментарий,

не оказывающий влияния на моделирование.

Далее несколько строк, определяющих под-

ключение транзисторов Q1–Q11. Транзисто-

ры записаны подряд и в порядке возраста-

ния позиционных обозначений исключи-

тельно только для удобства чтения файла.

Порядок следования элементов схемы мак-

ромодели на анализ влияния не оказывает.

Для транзисторов Q4 и Q11 показано коли-

чество параллельно включенных структур,

2 и 3 соответственно. Для большинства ре-

зисторов наряду с номинальным значением

сопротивления указаны температурные ко-

эффициенты сопротивления, которыми

в основном определяется температурная за-

висимость опорного напряжения. Модели

диода и транзисторов из множества параме-

тров содержат только существенно необхо-

димые. Описание заканчивается строками

с директивами .BACKANNO и .ENDS.

В папке My_Sym есть два файла — TL431_

test.asy и TL431.asy — с описаниями симво-

лов TL431_test и TL431. Символ TL431_test,

имеющий атрибут Symbol Type — Block, ис-

пользован в проектах TL431_test_pulse.asc

и TL431_test_freq.asc, позволяющих проде-

монстрировать иерархические проекты с те-

стированием микросхемы TL431, включен-

ной в качестве компаратора и в качестве уси-

лителя.

Первый из проектов с результатами ана-

лиза показан на рис. 17 (см. КиТ № 11 `2008,

стр. 136). В левом верхнем углу рисунка —

схема тестирования регулируемого стабилитро-

на в режиме компаратора TL431_test_pulse.asc.

В правом нижнем углу собственно схема ми-

кросхемы TL431 — TL431_test.asc. В правом

верхнем углу — результаты моделирования,

где показаны графики входного напряжения

V(in) и тока коллектора транзистора Q11 ми-

кросхемы Ic(x1:Q11).

Анализ температурного дрейфа 

модели микросхемы TL431

Файл TL431_test_temp.asc после открытия

демонстрирует схему проверки поведения

компонента TL431 при изменении темпера-

туры. В этом проекте используется символ

TL431.asy, не допускающий редактирования

в составе схемы. Схема и результат модели-

рования изображены на рис. 36.

Анализ схемы стабилизатора 

напряжения на постоянном токе

Файл Regulator_dc.asc — несложная схема

стабилизатора напряжения с выходным на-

пряжением 12 В и током нагрузки до 300 мА.

Допустимый диапазон изменения входного

напряжения — 13–30 В. Схема и результат

моделирования изображены на рис. 37.

Схема стабилизатора включает в себя тран-

зисторы, модели которых отсутствуют в биб-

лиотеке standard.bjt. Один из возможных спо-

собов использования сторонних библиотек,

который и применен в данном примере, по-

местить модели компонентов на листе схемы.

Достоинство такого решения: проект запус-

кается на любом компьютере, вне зависимо-

В этой части статьи рассматриваются примеры работы в симуляторе и воз%

можные настройки программы.

Программа схемотехнического 

моделирования SwitcherCAD III

Продолжение. Начало в № 11 `2008
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сти от места установки программы и нали-

чия соответствующих библиотек.

На листе схемы помещены четыре дирек-

тивы моделирования:

.dc Vin 15 30 1

.step param I list 100m 200m

.meas V(in) trig V(out)=12.022 targ V(out)=12.0225

.save V(out)

Они предусматривают анализ поведения

схемы на постоянном токе при изменении

входного напряжения в диапазоне 15–30 В

с шагом 1 В и двух значениях тока нагруз-

ки (100 и 200 мА), с измерением входного

напряжения при двух значениях выходно-

го напряжения (12,022 и 12,0225 В) и вы-

водом графика выходного напряжения

V(out) непосредственно в процессе моде-

лирования.

В окне графиков подключены два курсо-

ра: первый курсор к синему графику, соот-

ветствующему току нагрузки 100 мА, вто-

рой — к красному графику, соответствую-

щему току нагрузки 200 мА. По данным

таблички Cursor Step Information видно, что

курсор 2 подключен к графику, соответству-

ющему ступени тока 200 мА, и полученно-

му за второй проход моделирования из двух

проходов. В диалоговом окне показаны ко-

ординаты и разности координат курсоров.

На рис. 38 приведен фрагмент .log-файла,
Рис. 36. Анализ температурного дрейфа модели микросхемы TL431

Рис. 37. Анализ схемы стабилизатора напряжения на постоянном токе
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открытого по команде View>SPICE Error Log,

с результатами измерений по директиве

.MEAS.

На рис. 39 показан результат моделирова-

ния передаточной характеристики стабили-

затора по постоянному току (файл проекта

Regulator_tr.asc) по директиве:

.tr V(out) Vin.

Отчет представляет результаты вычисле-

ний коэффициента передачи, входного и вы-

ходного сопротивлений.

Анализ устойчивости 

стабилизатора напряжения

Файл Regulator_ac.asc — это схема стаби-

лизатора напряжения, подготовленная для

.AC-анализа с целью проверки устойчивос-

ти. Методика такого анализа изложена в [3, 4].

Схема и результат моделирования показаны

на рис. 40. Роль источника возмущения в це-

пи отрицательной обратной связи играет

независимый источник напряжения Vtest.

Директивами моделирования

.ac dec 100 1 10MEG

.step param C list 1p 4.7n

задан анализ с логарифмическим декадным

изменением частоты и со 100 отображаемы-

ми точками в каждой декаде в полосе частот

от 1 Гц до 10 МГц, при двух значениях кор-

ректирующей емкости С1: 1 пФ и 4,7 нФ.

Директива 

.options gmin=1E-9

обеспечивает нормальное завершение процес-

са моделирования. При значении gmin = 1E-12,

установленном по умолчанию, попытка ана-

лиза схемы при C1 = 1 пФ заканчивается со-

общением об ошибке Analysis Failed: Iteration

Limit reached.

В окне графиков изображен график –V(out)/

V(test). Результаты моделирования представ-

ляют собой логарифмические амплитудно-

частотную (ЛАЧХ) и фазочастотную (ЛФЧХ)

характеристики разомкнутой системы. Знак

«–» приводит график ЛФЧХ к виду, приня-

тому при анализе систем автоматического ре-

гулирования [5]. Запас по фазе составляет

около –22° и 41° для значений корректирую-

щей емкости 1 пФ и 4,7 нФ соответственно.

При значении корректирующей емкости, рав-

ном 1 пФ, схема неустойчива. На практике

для гарантии устойчивости рекомендуется

иметь запас по фазе не менее 30°. На рис. 41

представлен результат моделирования этой

схемы (файл проекта Regulator_ac1.asc) в ди-

апазоне частот 10 кГц – 10 МГц в виде годо-

графа Найквиста. Характеристика, соответ-

ствующая значению корректирующей емко-

сти 1 пФ, охватывает точку с координатами

(–1, j0), что свидетельствует о неустойчиво-

сти схемы.

Анализ переходного процесса 

в стабилизаторе напряжения

Качество регулирования в стабилизаторе на-

пряжения можно оценить по реакции на ска-

чок тока нагрузки. Файл Regulator_tran.asc —

это проект для анализа стабилизатора напря-

жения при скачкообразном изменении тока

нагрузки от 0 до 300 мА и обратно. Директи-

вами моделирования

.tran 0.8m

.step param C list 1n 4.7n

задан анализ переходного процесса на вре-

менном отрезке 0–1,5 мс при двух значениях

корректирующей емкости: 1 и 4,7 нФ.

Судя по графикам на рис. 42, величина кор-

ректирующей емкости сказывается не толь-

Рис. 38. Фрагмент .log)файла 

Рис. 39. Параметры передаточной характеристики по постоянному току
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ко на устойчивости схемы, но и на реакции

на скачок нагрузки. Увеличение корректиру-

ющей емкости ведет к росту амплитуды вы-

бросов, увеличивает время переходного про-

цесса и его колебательность, что ухудшает ка-

чество регулирования.

Панель настройки

Вызов панели настройки

Чтобы вызвать панель настройки, исполь-

зуется команда меню Tools>Control Panel,

в которой конфигурируются режимы рабо-

ты LTspice/SwitcherCAD III.

Сжатие (Compression)

LTspice сжимает .raw-файлы данных в про-

цессе их генерации. Сжатый файл может быть

в 50 раз меньше, чем несжатый. Сжатие вы-

полняется с потерями. Окно панели настрой-

ки (рис. 43) позволяет управлять потерями

при сжатии:
•• ASCII файлы данных (ASCII data fieles).
•• Сжатие только при анализе переходных

процессов (Only compress transient analyses).
•• Включение сжатия первого порядка (Enable

1st Order Compression).
•• Включение сжатия второго порядка (Enable

2nd Order Compression).
•• Удалив метки в обеих ячейках, можно пол-

ностью отключить сжатие данных.

Рис. 40. Анализ устойчивости по ЛАЧХ и ЛФЧХ

Рис. 41. Анализ устойчивости по годографу Найквиста
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•• Размер окна (Window Size (No. of Points)):

максимальное количество точек, которые

будут сжаты до двух граничных точек.
•• Относительная погрешность (Relative

Tolerance): относительная погрешность,

допустимая между сжатыми и несжатыми

данными.
•• Абсолютная погрешность по напряжению,

В (Absolute Voltage tolerance[V]): погреш-

ность по напряжению, обеспечиваемая ал-

горитмом сжатия.

•• Абсолютная погрешность по току, А (Abso-

lute Current tolerance[A]): погрешность по

току, обеспечиваемая алгоритмом сжатия.

Эти параметры настройки сжатия не запо-

минаются. При перезагрузке программы бу-

дут применены установки по умолчанию.

Они доступны на панели управления в диагно-

стических целях. Погрешность и размер окна

могут быть определены установкой парамет-

ров PROTELTOL, PLOTVNTOL, PLOTABSTOL

и PLOTWINSIZE в .OPTION-директивах, раз-

мещаемых как SPICE-директивы на схеме.

Операция (Operation)

Окно Operation изображено на рис. 44.

Параметры настройки, отмеченные звездоч-

кой [*], сохраняются при перезапусках про-

граммы:
•• Размещение окон по умолчанию (Default

Window Tile Pattern): размещение окон

в многооконном режиме по умолчанию

можно сделать вертикальным.
•• Вывод графиков (Marching Waveforms): ес-

ли ячейка помечена, обеспечивается отобра-

жение графиков непосредственно в процес-

се анализа по мере готовности результатов.
•• Генерация расширенного листинга (Generate

Expanded Listing): в файл SPICE Error Log

добавляется расширенный список соедине-

ний, включающий в себя список соедине-

ний использованных в схеме макромоде-

лей. Для макромоделей, описываемых би-

нарными файлами, правило не действует.
•• Открытие демонстрационных схем (Open

Demo circuits as regular schematics): с исполь-

зованием команды File>Open открываются

демонстрационные схемы .\SwCADIII\

lib\app\*.app. Видимы все SPICE-команды.

Схема может быть отредактирована и со-

хранена в новом файле. Команды с двой-

ными точками «..» показывают возможные

режимы анализа. Исполняются после ре-

дактирования SPICE-директив команды

с одной точкой.

Примечание. Каталога .\SwCADIII\lib\app

в текущей версии программы нет, возмож-

но, он присутствовал в первых версиях про-

граммы.
•• Не давать предупреждения при использо-

вании предварительных моделей (Don't

warn when using preliminary models): от-

ключение предупреждающего сообщения

для всех предварительных моделей.
•• Автоматическое удаление .raw-файлов

(Automatically delete .raw files): файлы дан-

ных графиков автоматически удаляются

после закрытия моделируемой схемы.

Это существенно уменьшает объем диско-

вого пространства, используемого LTspice,

но требует повторного запуска моделиро-

вания в следующем сеансе моделирования

данной схемы.

Рис. 42. Анализ переходного процесса

Рис. 43. Окно настройки Compression
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•• Автоматическое удаление .net-файлов

(Automatically delete .net files): после закры-

тия моделируемой схемы автоматически

удаляются .net-файлы со списком соедине-

ний. Это небольшие временные файлы, их

удаление делает папку с результатами ана-

лиза более аккуратной. Они определяют

электрические связи в схеме для симулято-

ра LTspice. Некоторые пользователи пред-

почитают не удалять эти файлы, исполь-

зуя их в дальнейшей работе.
•• Автоматическое удаление .log-файлов

(Automatically delete .log files): после за-

крытия моделируемой схемы автоматиче-

ски удаляются .log-файлы. Эти файлы со-

держат различные статистические данные

процесса моделирования, типа времени, за-

траченного на моделирование, предупреж-

дения и сообщения об ошибках, парамет-

ры шага, используемого в .STEP/.TEMP/.DC

анализах.
•• Папка для временных файлов (Directory

for Temporary Files): в ячейке показан путь

к папке для временного хранения графи-

ков и файлов обновления.

Сохранение по умолчанию (Save Defaults)

Эти настройки используются, когда не ука-

зывается, состояние каких конкретных узлов

должно быть сохранено при моделировании.

Используются настройки Save Device Currents,

Save Subcircuit Node Voltages и Save Subcircuit

Device Currents. Настройка Save Internal

Device Voltages используется только для вну-

трифирменного развития программы. Окно

Save Defauls изображено на рис. 45:
•• Сохранить токи устройств (Save Device

Currents): пометьте, чтобы отобразить то-

ки приборов и через порты. Это потребу-

ется для отображения графиков рассеива-

емой мощности.
•• Сохранить узловые потенциалы макромо-

делей (Save Subcircuit Node Voltages): от-

метьте, чтобы отобразить напряжения в ие-

рархических проектах.

•• Сохранить токи в приборах макромодели

(Save Subcircuit Device Currents): отметь-

те, чтобы отобразить токи в иерархичес-

ких проектах.
•• Не сохранять Ib(), Ie(), Is(), Ig() (Don't save

Ib(), Ie(), Is(), Ig()): при этом сохраняются

только токи коллектора (стока) транзисто-

ров для сокращения размера выходного

.data-файла. Полезно в проектах интеграль-

ных схем, но означает отсутствие множе-

ства данных, необходимых для расчета

мощности, рассеиваемой транзисторами.

Окно настройки SPICE

Это окно (рис. 46) позволяет изменять на-

стройки по умолчанию для LTspice. Эти на-

стройки могут быть отменены для конкрет-

ного проекта при задании в нем режимов.

Обычно эти настройки оставляются такими,

как есть. При частом обновлении програм-

мы можно нажать Reset to Default Values, что-

бы перезагрузиться к текущим рекомендо-

ванным настройкам.

Есть один параметр, который рекомен-

дуется изменять: TRTOL. В коммерческих

SPICE-программах он по умолчанию равен 7.

В LTspice параметр по умолчанию равен 1,

для того, чтобы при моделировании с исполь-

зованием макромоделей ИИП уменьшить ве-

роятность появления артефактов в графиках.

TRTOL в большей степени затрагивает стра-

тегию timestep, чем непосредственно влияет

на точность моделирования. Для моделиро-

вания на уровне транзисторов значение

больше 1 — обычно лучшее решение. Мож-

но заметить, что скорость удваивается, если

увеличивать TRTOL, что неблагоприятно

воздействует на точность моделирования.

Установленное значение TRTOL сохраняется

при перезапуске программы. Большинство

традиционных SPICE-параметров, определя-

ющих точность, (GMIN, ABSTOL, RELTOL,

CHGTOL, VNTOL) не сохраняется при пере-

запуске программы. Если желательно исполь-

зовать настройки, отличные от установлен-

ных по умолчанию, необходимо написать ди-

рективу .OPTION, задающую необходимые

значения, и поместить ее в схему, либо запи-

сать настройки в файле .INC.

Важно и то, какое вычислительное ядро ис-

пользовано. LTspice содержит две полных вер-

сии SPICE. Одна называется нормальной, дру-

гая — альтернативной. Альтернативное вы-

числительное ядро применяет отличающуюся

свертку разреженной матрицы с уменьшенной

ошибкой округления. Как правило, скорость

моделирования с альтернативным вычисли-

тельным ядром в два раза ниже, но в тысячу

раз лучше точность. Это полезно иметь для

диагностики. Если нет директивы .OPTION,

однозначно указывающей на используемое

ядро, следует сделать выбор прежде, чем будет

считан список соединений, поскольку два

ядра используют различные анализаторы.

Пометив ячейку “Accept 3K4 as 3.4K”, мож-

но заставить LTspice понимать число, напи-

санное в виде 4K99, как 4.99K. Обычная прак-

тика SPICE этого не позволяет, но это доступ-

но в LTspice по запросу.

Варианты списка соединений 

(Netlist Options)

Окно Netlist Options показано на рис. 47:
•• Преобразование «μ» в «u» (Convert 'μ' to 'u'):

везде «μ» заменяется на «u». Используется,

если установленная MS Windows не может

показать греческую μ (как, например, не-

которые китайские выпуски Windows по

умолчанию не имеют шрифтов), а также

для генерации списка соединений для

SPICE-симуляторов, которые не понима-

ют «μ» как метрический множитель 1e-6.
•• Изменение порядка записи компонентов

(Reverse comp. Order): обычно элементы

схемы перечисляются в списке соединений

в порядке, в котором они были добавлены

в схему. Активизация этой ячейки меняет

порядок записи на обратный.
•• Приборы по умолчанию (Default Devices):

всякий раз, когда, к примеру, в схеме LTspice

Рис. 44. Окно настройки Operation Рис. 45. Окно настройки Save Defaults Рис. 46. Окно настройки SPICE
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применяется диод, по умолчанию в список це-

пей добавляется строка модели “.model D D”,

чтобы подавить сообщения об использо-

вании модели по умолчанию. Непомечен-

ная ячейка подавляет включение аналогич-

ных строк моделей биполярных, МОП

и полевых транзисторов.
•• Библиотеки по умолчанию (Default Libraries):

всякий раз, когда, к примеру, в схеме LTspice

применяется диод, по умолчанию директи-

вой .lib в моделирование включается библи-

отека standard.dio. Непомеченная ячейка по-

давляет включение этой библиотеки, а так-

же аналогичных ссылок на библиотеки

биполярных, МОП и полевых транзисторов.
•• Проблемы конвергенции (Convergence

Aids): используется только для развития

программы.

Компилятор (Hacks)

Это окно использовалось для развития про-

граммы, но в настоящее время практически

устарело.

Обычно можно оставить имеющиеся на-

стройки. При частом обновлении програм-

мы желательно нажать Reset to Default Values

для перезагрузки с текущими рекомендован-

ными настройками.

Режимы рисования (Drafting Options)

Окно Drafting Options изображено на рис. 48:
•• Разрешение замыкать выводы компонен-

тов (Allow direct component pin shorts):

обычно можно тянуть связь прямо через

компонент, отрезок связи, закорачиваю-

щий выводы компонента, будет удален.

Если пометить ячейку, то этот отрезок не

будет автоматически удален.
•• Автоматический скроллинг при просмот-

ре (Automatically scroll the view): актива-

ция этой ячейки позволяет при просмот-

ре изменять масштаб схемы, используя ко-

лесо прокрутки мыши.
•• Разрешение показывать точки привязки

текста (Mark text Justification anchor points):

отображается маленькая окружность, ука-

зывающая точку привязки блока текста.
•• Маркировка неподключенных выводов

(Mark unconnected pins): рисуется малень-

кий квадрат на каждом неподключенном

выводе для указания на отсутствие связи.
•• Отображение на схеме точек сетки (Show

schematic grid points): делает видимой сетку.
•• Ортогональная разводка связей (Orthogonal

snap wires): обеспечивает рисование сег-

ментов электрических связей только по

вертикали или по горизонтали. Если ячей-

ка дезактивирована, связь может быть на-

рисована под любым углом между узлами

сетки. Нажатая клавиша Ctrl на время от-

меняет эту установку.
•• Ортогональный режим перемещения (Orto

drag mode): при выполнении команды Drag

компонент перемещается только вдоль ли-

нии связи, в которую он включен.
•• Добавление изломов в линии связи (Cut

angled wires during drags): при выполне-

нии команды Drag неортогональная связь

преобразуется в два сегмента, если нажать

на середину линии связи.
•• Глубина отката (Undo history size): уста-

новка размера буфера команд undo/redo.
•• Рисование толстыми линиями (Draft with

thick lines): увеличивает толщину всех ли-

ний. Полезно для подготовки изображе-

ний для публикации.
•• Отображение штампа (Show Title Block):

режим для внутреннего использования.

Работа в Интернете (Internet Options)

Это окно панели настроек (рис. 49) ис-

пользуется для обновления через Интернет.

LTspice часто обновляется с новыми возмож-

ностями и моделями. Для обновления до те-

кущей версии используется команда меню

Tools>Sync Release. Если в течение пары ме-

сяцев не производилось обновление, LTspice

начинает спрашивать, не желаете ли вы про-

верить обновления. LTspice никогда не полу-

чит доступ к сети, не спрашивая разрешения.

LTspice не содержит никаких закладок для пе-

редачи данных любого типа при получении

файлов, нуждающихся в обновлении.
•• Не делать кэш-файлов (Don't cache files):

при обновлении не делать кэш исполняе-

мых файлов.
•• Не проверять контрольные суммы (Don't

verify checksums): по соображениям безо-

пасности LTspice использует собственный

конфиденциальный 128-битовый алгоритм

контрольной суммы для подтверждения под-

линности файлов, получаемых из сети для

обновления. Эта аутентификация может не

состояться в случае, если в алгоритме есть

ошибка. Однако ни о каких проблемах с этим

никогда не сообщалось, так что не рекомен-

дуется пренебрегать этой основой безопас-

ности. Для доступа в Интернет LTspice ис-

пользует только обращение к операционной

системе высокого уровня. Нет необходимо-

сти в изменении параметров настройки, кро-

ме редких случаев, когда требуется опреде-

лить прокси-сервер и пароль, поскольку

не LTspice управляет доступом в Интернет,

а ваш компьютер и операционная система.

Параметры настройки этого окна не сохра-

няются при перезапуске программы.

Далее будут рассмотрены описания моде-

лей компонентов. ■
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Модели компонентов

Компоненты 

со специальными функциями

Имена символов: AND (И с комплементар-

ными выходами), BUF (буфер с комплемен-

тарными выходами), BUF1 (буфер), DFLOP

(D-триггер), DIFFSCHMITT (триггер Шмит-

та с комплементарными выходами и диффе-

ренциальными входами), DIFFSCHMTBUF

(триггер Шмитта с буфером и дифференци-

альными входами), DIFFSCHMTINV (инвер-

тирующий триггер Шмитта с дифференци-

альными входами), INV (инвертор), OR (ИЛИ

с комплементарными выходами), PHIDET

(фазо-частотный детектор), SCHMITT (триг-

гер Шмитта с комплементарными выхода-

ми), SCHMTBUF (триггер Шмитта с буфе-

ром), SCHMTINV (инвертирующий триггер

Шмитта), SRFLOP (RS-триггер), XOR (исклю-

чающее ИЛИ), MODULATE и MODULATE2

(модуляторы), SAMPLE (устройство выбор-

ки-хранения) и VARISTOR (варистор).

Синтаксис: Annn n001 n002 n003 n004 n005

n006 n007 n008 <имя модели> [конкретные

параметры].

Примечание. Здесь и далее в угловые скобки

заключены обязательные параметры, а в квад-

ратные скобки — необязательные параметры.

Это устройства со специальными функци-

ями и смешанным режимом моделирования

разработки Linear Technology Corporation's. 

INV, BUF, AND, OR и XOR — распростра-

ненные логические элементы с идеализиро-

ванным поведением. Все элементы имеют по

восемь выводов. Им не нужны внешние ис-

точники питания. Ток вытекает или втекает

через комплементарные выходы, выводы 6

и 7 и общий для устройства вывод 8. Выво-

ды с 1 по 5 — входы. Неиспользуемые вхо-

ды и выходы должны быть подключены

к выводу 8, это условие выполняется авто-

матически, если оставить вывод неподклю-

ченным. Компилятор цифровых устройств

таким образом определяет, что вывод не ис-

пользован, и исключает его из моделирова-

ния. Это лучше потенциально возможной

ситуации, когда вход элемента AND зазем-

лен или подключен к точке с нулевым потен-

циалом. Если «земля» для элементов общая,

заземление входа не будет логической ошиб-

кой, но он не исключается из моделирова-

ния. Резонность подобного использования

элементов в том, что они работают как 2-, 3-,

4- и 5-входовые устройства с прямым, ин-

вертирующим или комплементарным выхо-

дом, и при этом не тратится время на моде-

лирование неиспользуемых портов. Таким

образом, устройство AND заменяет 12 раз-

личных типов элементов AND. Характерис-

тики устанавливаются параметрами, пере-

численными в таблице 14.

Не все параметры могут быть определены

одновременно, например, выход может ха-

рактеризоваться либо временем нарастания,

либо постоянной времени, но не обоими па-

раметрами сразу.

Исключающее ИЛИ (XOR) имеет нестан-

дартное поведение при использовании более

двух входов.

Пороговые точки триггеров Шмитта опре-

делены параметрами Vt и Vh. Нижняя поро-

говая точка — это Vt – Vh, верхняя порого-

вая точка — это Vt +Vh.

По умолчанию цифровые компоненты не

дают никакой информации о шаге модели-

рования для управления моделированием.

То есть они не дают предупреждений о пред-

стоящем изменении текущего состояния.

Для изменения максимального шага модели-

рования, установленного уставками симуля-

тора, можно задать значение встроенного па-

раметра tripdt.

Примечание. Библиотека цифровых уст-

ройств не содержит ни одной модели конкрет-

ной цифровой микросхемы.

Устройство MODULATE является генерато-

ром, управляемым напряжением. Пример схе-

мы — в файле .\examples\Educational\PLL.asc.

Текущая частота генерации устанавлива-

ется напряжением на входе FM. Преобра-

зование напряжения в частоту линейное

и устанавливается двумя встроенными па-

раметрами, mark и space. Mark — частота

при напряжении на входе FM, равном 1 В,

а space — частота, для которой напряжение

на входе FM равно 0 В. Амплитуда устанав-

ливается напряжением на входе AM и по

умолчанию равна 1 В, если этот вход не ис-

пользован (подключен к общему выводу

MODULATE).

VARISTOR — это управляемый напряже-

нием варистор. Напряжение ограничения ус-

танавливается напряжением между вывода-

ми 1 и 2. Сопротивление в режиме ограниче-

ния определяется встроенным параметром

rclamp. Пример схемы — в файле .\examples\

Educational\varistor.asc.

Пример схемы с устройством выборки-хра-

нения SAMPLE содержится в файле .\examples\

Educational\SampleAndHold.asc.

В LTspice список цепей с этими устройст-

вами создается специальным образом. Все не-

подключенные выводы автоматически под-

ключаются к выводу 8. Если вывод 8 не под-

ключен, то и он подключается к узлу 0. 

Источники сигнала 

с произвольным поведением

Имена символов: BV, BI.

Синтаксис модели источника напряжения

с произвольным поведением: Bnnn <+узел>

<–узел> V=<выражение> [ic=<значение>]

[tripdv=<значение>] [tripdt=<значение>]

[laplace=<выражение> [window=<время>]

[nfft=<количество>] [mtol=<количество>].

Синтаксис модели источника тока с про-

извольным поведением: Bnnn <+узел>

<–узел> I=<выражение> [ic=<значение>]

[tripdv=<значение>] [tripdt=<значение>]

[Rpar=<значение>] [laplace=<выражение>

[window=<время>] [nfft=<количество>]

[mtol=<количество>].

Выражения могут содержать следующее:
•• Узловой потенциал, например V(n001).
•• Разность узловых потенциалов, например

V(n001, n002).

В данной части статьи дается описание моделей компонентов на языке

LTspice.

Программа схемотехнического 

моделирования SwitcherCAD III

Продолжение. Начало в № 11 `2008

Таблица 14. Параметры моделей цифровых устройств
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•• Токи через элементы схемы, например,

I(S1) — ток через ключ S1, или Ib(Q1) —

ток базы транзистора Q1. Считается, что

ток через элемент схемы изменяется квази-

статически, то есть нет немедленной обрат-

ной связи между током через управляющее

устройство и выходным сигналом источ-

ника. Аналогично, любой компонент пере-

менного тока, текущего через устройство,

при .AC-анализе принимается равным нулю. 
•• Ключевое слово time, означающее текущее

время при моделировании. 

•• Ключевое слово pi, означающее

3.14159265358979323846.
•• Функции, перечисленные в таблице 15.
•• Математические операции, перечисленные

в таблице 16.

Параметр ic устанавливает начальные ус-

ловия, напряжение или ток источника в мо-

мент начала моделирования.

Параметры tripdv и tripdt управляют ша-

гом моделирования. Если скорость измене-

ния напряжения источника больше, чем

tripdv/tripdt [В/с], то шаг моделирования

timestep отвергается.

Для источника тока параметром Rpar за-

дается подключенное параллельно сопротив-

ление.

Истина численно эквивалентна 1, а ложь — 0.

В булевом преобразовании величина, бóль-

шая 0,5, преобразуется в 1, в противном слу-

чае величина преобразуется в 0.

В LTspice символ ^ используется в логи-

ческой операции исключающее ИЛИ (XOR),

а символ ** — для возведения в степень. Так-

же в LTspice различаются возведение в сте-

пень, x**y и функция pwr(x,y). При возве-

дении в степень отрицательного числа

LTspice возвращает действительную часть

результата возведения в степень. Например,

–2**1.5 оценивается нулем, который являет-

ся действительной частью правильного от-

вета 2.82842712474619i. При импорте моде-

ли третьей стороны, предназначенной для

другого симулятора, возможно, придется из-

менить синтаксис, например, x^y на x**y

или даже pwr(x,y). 

Если определен дополнительный атрибут

LAPLACE, источник с произвольным пове-

дением будет описываться с использованием

преобразования Лапласа. Преобразование

Лапласа обязательно должно быть функци-

ей от s. Логический оператор XOR, ^, когда

он использован в выражении Лапласа, пони-

мается как возведение в степень, **. При рас-

чете частотных характеристик в .AC-анализе

переменная s заменяется на sqrt(–1)*2*pi*f.

Выходной ток (напряжение) сигнала отыски-

вается путем свертки импульсной характери-

стики с входным током (напряжением).

В LTspice реакция на импульсное воздейст-

вие представляет собой набор результатов

БПФ в дискретных точках частотной облас-

ти. В процессе преобразования возможны та-

кие специфические проявления БПФ, как

прореживание спектра, и выбросы, присущие

дискретному БПФ. В LTspice используется

собственный алгоритм, дающий точное ана-

литическое выражение в частотной области,

выбирающий точки и интервал таким обра-

зом, что артефакты практически отсутству-

ют. LTspice должен определить подходящие

частотный диапазон и разрешение. Рекомен-

дуется сначала позволить программе сделать

приближенный расчет. Длина интервала и ко-

личество использованных в FFT точек дан-

ных будут приведены в .log-файле. В даль-

нейшем можно подстроить выбранный ал-

горитм, устанавливая параметр nfft и длину

интервала. Величина, обратная длине времен-

ного интервала, является частотным разре-

шением. Значение времени nfft определяет

максимальную рассматриваемую частоту.

Конденсатор

Имя компонента: CAP, POLCAP. Синтак-

сис: Cnnn <+узел> <–узел> <емкость>

[ic=<начальное напряжение>] [Rser=<значе-

ние>] [Lser=<значение>] [Rpar=<значение>]

[Cpar=<значение>] [m=<значение>] [RLshunt=

<значение>] [tc=<температурный коэффи-

циент емкости>] [temp=<температура>].

При необходимости можно задать эквива-

лентное последовательное сопротивление,

последовательную индуктивность, параллель-

ное сопротивление и параллельную шунти-

рующую емкость. Эквивалентная схема кон-

денсатора показана на рис. 50.

Параметры модели конденсатора приведе-

ны в таблице 17.

Для вычислений лучше включить паразит-

ные Rpar, Rser, RLshunt, Cpar и Lser в состав

конденсатора, чем изображать их в явном ви-

де. В LTspice используется собственная тех-

нология для имитации физического конден-

сатора моделью без внутренних узлов. Это

www.kit+e.ru

Таблица 15. Математические функции в источниках

с произвольным поведением

Таблица 16. Математические операции для источников

с произвольным поведением

Преобразование, эквивалентное логической инверсии

Возведение первого числа в степень второго.
Возвращается только действительная часть, 

например, –1**1.5 дает нуль, а не i

Деление с плавающей точкой

Умножение с плавающей точкой

Вычитание с плавающей точкой

Сложение с плавающей точкой

ИСТИНА (TRUE), если выражение слева меньше
или равно выражению справа, иначе ЛОЖЬ (FALSE)

ИСТИНА (TRUE), если выражение слева больше
или равно выражению справа, иначе ЛОЖЬ (FALSE)

ИСТИНА (TRUE), если выражение слева меньше
выражения справа, иначе ЛОЖЬ (FALSE)

ИСТИНА (TRUE), если выражение слева больше
выражения справа, иначе ЛОЖЬ (FALSE)

Преобразование, эквивалентное логическому
исключающему ИЛИ (XOR)

Преобразование, эквивалентное логическому ИЛИ (OR)

!

**

/

*

–

+

<=

>=

<

>

^

|

Преобразование, эквивалентное логическому И (AND)&

Назначение
Символ 

операции

Рис. 50. Эквивалентная схема конденсатора

Альтернативная форма для INV(x)

Альтернативная форма для INV(x)

Случайные числа между –0,5 и 0,5 
с плавными переходами между значениями,

даже более плавными, чем в random()

Функция ограничения: uramp(x) = x, 
если x> 0; uramp(x) = 0, если x≤0

Ступенчатая функция: u(x) = 1, 
если x> 0; u(x) = 0, если x≤0

Гиперболический тангенс x

Тангенс x

Табличная зависимость функции от x.
Координаты точек (x, y) в виде таблицы,
в промежутках между точками линейная

аппроксимация

Квадратный корень из x

Гиперболический синус x

Синус x

Альтернативная форма для IDT(x[,ic[,a]])

Ближайшее целое к x

Функция, подобная rand(x), но с плавными
переходами между значениями

Случайные числа между 0 и 1 
в зависимости от значения x

sgn(x) *abs(x) ** y

abs(x) ** y

Действительная часть от x ** y

Минимальное из x или y

Максимальное из x или y

Десятичный логарифм x

Альтернативный синтаксис для ln(x)

Натуральный логарифм x

x, если y<x<z; y, если x<y; z, если x>y

inv(x) = 0, если x>0,5; inv(x) = 1, если x≤0,5

Округление x до целого числа

y, если x истинно, иначе z

Интегрирование x, при необходимости
с начальными условием ic, со сбросом интегZ
ратора по достижении сигналом  по модулю

значения m, со сдвигом сигнала на значение o. 

Интегрирование x, при необходимости
с начальными условием ic, со сбросом интегZ
ратора по достижении сигналом значения a. 

sqrt(x ** 2 + y ** 2)

Целое число, равное или меньшее x

Экспонента числа x

Производная dx/dt

То же, что и ABSDELAY(x,t[tmax])

Производная dx/dt

Гиперболический косинус x

Косинус x

Целое число, равное или большее x

buf(x) = 1, если x>0,5; buf(x) = 0, если x≤0,5

Гиперболический тангенс x

Арктангенс y/x

Синоним для atan(x)

Арктангенс x

Гиперболический синус x

Синоним для asin(x)

Действительная часть арксинуса от x

Действительная часть гиперболического
арккосинуса от x

Синоним для acos(x)

Действительная часть арккосинуса от x

Задержка сигнала x на время t. Как вариант,
уведомление о максимальной задержке tmax

~(x)

!(x)

WHITE(x)

URAMP(x)

U(x)

TANH(x)

TAN(x)

TABLE(x,a,b,c,d,...)

SQRT(x)

SINH(x)

SIN(x)

SDT(x[,ic[,a]])

ROUND(x) 

RANDOM(x)

RAND(x)

PWRS(x, y)

PWR(x, y)

POW(x, y)

MIN(x,y)

MAX(x,y)

LOG10(x)

LOG(x)

LN(x)

LIMIT(x,y,z)

INV(x)

INT(x)

IF(x, y, z)

IDTMOD(x[,ic[,m[,o]]])

IDT(x[,ic[,a]])

HUPOT(x,y)

FLOOR(x)

EXP(x)

D(x)

DELAY(x,t[tmax])

DDT(x)

COSH(x)

COS(x)

CEIL(x)

BUF(x)

ATANH(x)

ATAN2(y, x)

ARCTAN(x)

ATAN(x)

ASINH(x)

ARCSIN(x)

ASIN(x)

ACOSH(x)

ARCOS(x)

ACOS(x)

ABSDELAY(x,t[tmax])

Абсолютное значение xABS(x)

ОпределениеФункция
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делает имитационную матрицу меньше, бы-

стрее решаемой, с меньшей вероятностью,

что она окажется сингулярной при малом

временном шаге.

Похожую эквивалентную схему имеет

и макромодель пьезоэлектрического резона-

тора. 

Можно моделировать и нелинейный кон-

денсатор, при этом вместо указания емкости

записывается выражение для заряда. 

LTspice компилирует это выражение, диф-

ференцирует его в символьном виде относи-

тельно всех переменных с нахождением ча-

стных производных, соответствующих ем-

костям.

Синтаксис: Cnnn <+узел> <–узел> Q=<вы-

ражение> [ic=<значение>] [m=<значение>].

Специальная переменная x обозначает на-

пряжение на устройстве. Таким образом, по-

стоянная емкость 100 пФ может быть запи-

сана как: Cnnn <+узел> <–узел> Q=100p*x.

Емкость со ступенчатым изменением ве-

личины от 100 до 300 пФ, когда напряжение

становится равным нулю, описывается как:

Cnnn <+узел> <–узел> Q=x*if(x<0,100p,300p).

Емкость, управляемая напряжением в узле

N01 и имеющая значение 1000 пФ при напря-

жении 1 В, описывается как: Cnnn <+узел>

<–узел> Q=1000p*x*V(N01).

Диод

Имя компонента: DIODE, ZENER, SCHOTTKY,

VARACTOR. Синтаксис: Dnnn <анод> <ка-

тод> <имя модели> [off] [m=<значение>]

[n=<значение>] [temp=<значение>].

Например:

D1 SW OUT MyIdealDiode

.model MyIdealDiode D(Ron=.1 Roff=1Meg Vfwd=.4)

D2 SW OUT dio2

.model dio2 D(Is=1e–10)

Ключевое слово off исключает диод из схе-

мы при первой итерации расчета по постоян-

ному току. Параметр m устанавливает коли-

чество параллельно включенных устройств,

а параметр n — количество последовательно

включенных устройств. Эти параметры име-

ют аналогичное значение и в моделях неко-

торых других компонентов.

Характеристики диода задаются в строке

.MODEL. Есть два способа описания модели

диода. Один представлен линейной моделью

простого для расчетов идеализированного

диода. Модель имеет три линейных участ-

ка электропроводности: прямое включение,

обратное включение и пробой при обрат-

ном включении. Характеристика на участ-

ках прямой проводимости и обратного про-

боя может определяться нелинейно с огра-

ничением токов через Ilimit (revIlimit).

Переход к ограничению тока на участке пря-

мой проводимости формируется с использо-

ванием функции tanh(). Стоит отметить, что

поведение модели с использованием параме-

тров Ilimit, revIlimit не соответствует привыч-

ному поведению полупроводникового диода.

Параметры epsilon и revepsilon определяют

плавность переключения между запертым

и проводящим состояниями. Участок харак-

теристики между проводящим и запертым

состояниями описывается квадратичной

функцией таким образом, что вольт-ампер-

ная характеристика диода сохраняется непре-

рывной и гладкой. В проводящем состоянии

переход обеспечивается при напряжении, оп-

ределяемом значением epsilon, а переход меж-

ду непроводящим состоянием и пробоем при

обратном напряжении определяется revepsilon.

Идеализированная модель используется,

если любое из Ron, Roff, Vfwd, Vrev или Rrev

определено в модели.

Параметры идеализированной модели ди-

ода приведены в таблице 18.

Другая модель является стандартной SPICE-

моделью полупроводникового диода, но рас-

ширенной так, чтобы более подробно описы-

вать поведение при пробое и токи рекомбина-

ции. Множитель Area определяет количество

аналогичных параллельно включенных уст-

ройств. В таблице 19 приведены параметры

модели для этого диода.

Можно задать для модели предельные зна-

чения напряжения, тока и мощности. Эти па-

раметры, перечисленные в таблице 20, не вли-

яют на электрическое поведение модели и не

масштабируются множителем Area. Они поз-

воляют LTspice проверить использование ди-

ода в номинальных режимах.

Источник напряжения, 

управляемый напряжением

Имя компонента: E, E2. Есть три типа ис-

точников напряжения, управляемых напря-

жением.

Синтаксис: Exxx <+узел> <–узел> <+уп-

равляющий узел> <–управляющий узел>

<коэффициент передачи>. Это источник

с линейной зависимостью выходного напря-

жения, имеющий постоянный коэффициент

Таблица 17. Параметры модели конденсатора

Начальное напряжение (используется, если только
модификатор UIC включен в .TRANZанализ)

Температура компонента 
(в соответствующей директиве .MODEL)

Температурный коэффициент емкости

Количество включенных параллельно устройств

Шунтирующий резистор, параллельный Lser

Эквивалентная параллельная емкость

Эквивалентное параллельное сопротивление

Эквивалентная последовательная индуктивность

ic

temp

tc

m

RLshunt

Cpar

Rpar

Lser

Эквивалентное последовательное сопротивлениеRser

ПараметрОбозначение

Таблица 18. Параметры идеализированной 

модели диода

Таблица 19. Параметры модели диода

Таблица 20. Предельно допустимые параметры 

модели диода

∞

0

Ron

1

1/Gmin

∞

0

∞

В

В

Ом

Ом

Ом

А

В

А

Обратное пробивное
напряжение

Прямое пороговое
напряжение до начала

проводимости 

Обратное сопротивление

Сопротивление 
в прямом включении

Сопротивление 
в запертом состоянии

Ограничение тока
в обратном включении

Протяженность
квадратичного участка

характеристики 
в обратном включении

Ограничение тока 
в прямом включении

Vrev

Vfwd

Rrev

Ron

Roff

Revilimit

Revepsilon

Ilimit

0В
Протяженность

квадратичного участка
характеристики

Epsilon

Значение 
по умолчанию

Единица 
измерения

Параметр
Обозна+

чение

3

0,6

2

50

10

1

0,5

1×10–7

0,67 Ge

1,11 Si

2

40

3

1

0

0

0

27

0

0

2

1

0,5

0

0

1×10–14

∞

1×10–10

0,5

1,11

0

?

–

В

нс

1/°С–2

1/°C

°С

1/°C

Ом

–

–

–

–

А

А

А

А

–

эВ

пФ

В

Температурный коэффициент тока насыщения

Контактная разность потенциалов

Время переноса заряда

Квадратичный температурный коэффициент для Rs

Линейный температурный коэффициент для Rs

Температура

Линейный температурный коэффициент для Ikf

Объемное сопротивление

Коэффициент эмиссии для тока Isr

Коэффициент инжекции

Коэффициент лавинного умножения

Коэффициент фликкерZшума

Параметр тока рекомбинации

Ток насыщения

Максимальный ток при высоком уровне инжекции

Ток при пробивном напряжении

Коэффициент нелинейности барьерной емкости
прямосмещенного перехода

Ширина запрещенной зоны

Барьерная емкость при нулевом смещении

Обратное пробивное напряжение 

Xti

Vj

Tt

Trs2

Trs1

Tnom

Tikf

Rs

Nr

N

M

Kf

Isr

Is

Ikf

Ibv

Fc

Eg

Cjo

BV

11–Показатель степени в формуле для фликкерZшумаAf

ПримерЗначение по умолчаниюЕдиница измеренияПараметрОбозначение

Вт

А

А

А

Максимальное значение 
рассеиваемой мощности

Среднеквадратичное значение тока

Среднее значение тока

Максимальное значение тока

diss

Irms

Iave

Ipk

ВМаксимальное значение напряженияVpk

Единица 
измерения

Параметр
Обозна+

чение
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передачи. Он воспроизводит выходное на-

пряжение между узлами <+узел> <–узел>,

зависящее от входного напряжения между

узлами <+управляющий узел> <–управляю-

щий узел>.

Синтаксис: Exxx <+узел> <–узел> <+уп-

равляющий узел> <–управляющий узел>

table=(<пара значений>, <пара значений>, ѕ).

Используется табличная форма задания ко-

эффициента передачи в виде списка пар зна-

чений. Второе число в паре равно выходному

напряжению, когда управляющее напряжение

равно первому числу этой пары. Выходное на-

пряжение изменяется линейно, когда управ-

ляющее напряжение изменяется между задан-

ными точками. Если управляющее напряже-

ние выходит за пределы диапазона, заданного

в таблице, выходное напряжение экстраполи-

руется как постоянное напряжение в соответ-

ствующей крайней точки таблицы.

Синтаксис: Exxx <+узел> <–узел> <+уп-

равляющий узел> <–управляющий узел>

Laplace=<функция(и)> [window=<временной

интервал>] [nfft=<число>] [mtol=<число>].

Передаточная функция этого источника на-

пряжения определяется преобразованием

Лапласа.

Синтаксис: Exxx <+узел> <–узел> value=

{<выражение>}. Это альтернативный синтак-

сис для источника напряжения с произволь-

ным поведением B.

Синтаксис: Exxx <+узел> <–узел> POLY(<N>)

(+узел управляющего источника 1, –узел уп-

равляющего источника 1) (+узел управляю-

щего источника 2, –узел управляющего ис-

точника 2) ѕ (+узел управляющего источ-

ника N, –узел управляющего источника N)

<коэффициенты полиномаѕ>. Это уста-

ревшая форма моделирования произволь-

ного поведения, описываемого полиномом.

Используется для управления имеющимися

поведенческими моделями Linear Technology.

Примечание. Лучше использовать источ-

ник тока G, шунтированный сопротивлени-

ем, для имитации источника E. Источник то-

ка, управляемый напряжением, шунтирован-

ный сопротивлением, обсчитывается быстрее

и вызывает меньше проблем со сходимостью,

чем источник напряжения, управляемый на-

пряжением. Кроме того, ненулевое выходное

полное сопротивление чаще встречается

в практических схемах.

Источник тока, управляемый током

Имя компонента: F.

Синтаксис: Fxxx <+узел> <–узел> <имя уп-

равляющего источника напряжения> <коэф-

фициент передачи>. Этот элемент цепи обес-

печивает ток между узлами <+узел> <–узел>.

Выходной ток равняется произведению ко-

эффициента передачи на ток через независи-

мый источник напряжения.

Синтаксис: Fxxx <+узел> <–узел> value=

{<выражение>}. Это альтернативный синтак-

сис для источника тока с произвольным по-

ведением B.

Синтаксис: Fxxx <+узел> <–узел> POLY(<N>)

<V1 V2ѕ VN> <коэффициенты полиномаѕ>.

Это устаревшая форма моделирования произ-

вольного поведения, описываемого полиномом.

Используется для управления имеющимися по-

веденческими моделями Linear Technology.

Источник тока, 

управляемый напряжением

Имя компонента: G, G2. Есть три типа ис-

точников тока, управляемых напряжением.

Синтаксис: Gxxx <+узел> <–узел> <+уп-

равляющий узел> <–управляющий узел>

<коэффициент передачи>. Линейный источ-

ник с постоянным коэффициентом переда-

чи, выходной ток которого течет между узла-

ми <+узел> <–узел> и зависит от входного

напряжения между узлами <+управляющий

узел> <–управляющий узел>.

Синтаксис: Gxxx <+узел> <–узел> <+уп-

равляющий узел> <–управляющий узел>

table=(<пара значений>, <пара значений>, ѕ).

Источник с табличной формой задания ко-

эффициента передачи. Таблица представля-

ет собой список пар значений. Второе число

в паре равно выходному току, когда управ-

ляющее напряжение равно первому числу

этой пары. Выходной ток изменяется линей-

но, когда управляющее напряжение изменя-

ется между заданными точками. Если управ-

ляющее напряжение выходит за пределы ди-

апазона, заданного в таблице, выходной ток

экстраполируется как постоянный ток в со-

ответствующей крайней точке таблицы.

Синтаксис: Gxxx <+узел> <–узел> <+уп-

равляющий узел> <–управляющий узел>

Laplace=<функция(и)> [window=<временной

интервал>] [nfft=<число>] [mtol=<число>].

Функция передачи этого элемента схемы

определена преобразованием Лапласа.

Синтаксис: Gxxx <+узел> <–узел> value=

{<выражение>}. Это альтернативный синтак-

сис для источника тока с произвольным по-

ведением B.

Синтаксис: Gxxx <+узел> <–узел> POLY(<N>)

<(+узел управляющего источника 1, –узел

управляющего источника 1) (+узел управля-

ющего источника 2, –узел управляющего ис-

точника 2) ѕ (+узел управляющего источ-

ника N, –узел управляющего источника N)

<коэффициенты полиномаѕ>. Это уста-

ревшая форма моделирования произволь-

ного поведения, описываемого полиномом.

Используется для управления имеющимися

поведенческими моделями Linear Technology.

Источник напряжения, 

управляемый током

Имя компонента: H.

Синтаксис: Hxxx <+узел> <–узел> <имя

управляющего источника напряжения> <ко-

эффициент передачи>. Напряжение, прило-

женное между узлами <+узел> <–узел>, ли-

нейно зависит от тока через управляющий

источник напряжения, умноженного на ко-

эффициент передачи.

Синтаксис: Hxxx <+узел> <–узел> value=

{<выражение>}. Это альтернативный синтак-

сис для источника напряжения с произволь-

ным поведением B.

Синтаксис: Hxxx <+узел> <–узел> POLY(<N>)

<управляющий источник напряжения 1 уп-

равляющий источник напряжения 2 ѕ уп-

равляющий источник напряжения 3> <ко-

эффициенты полиномаѕ>. Это устаревшая

форма моделирования произвольного пове-

дения, описываемого полиномом. Использу-

ется для управления имеющимися поведен-

ческими моделями Linear Technology.

Источник тока

Имя компонента: CURRENT.

Синтаксис: Ixxx <+узел> <–узел> <ток>

[AC=<амплитуда>] [load]. Это источник по-

стоянного тока между узлами <+узел> <–узел>.

Если источник используется как нагрузка, он

должен быть потребителем, и в таком случае

ток стремится к нулю, если напряжение меж-

ду узлами <+узел> <–узел> стремится к нулю

или имеет отрицательное значение. Цель это-

го варианта — в моделировании токовой на-

грузки источника питания, который не дает

ток, если выходное напряжение равно нулю.

При этом применяется ключевое слово load.

Для анализа на переменном токе исполь-

зуется амплитудное значение переменного

тока на анализируемой частоте.

Синтаксис: Ixxx <+узел> <–узел> PULSE

(Ioff Ion Tdelay Trise Tfall Ton Tperiod Ncycles).

Это источник импульсного тока, параметры

модели которого приведены в таблице 21.

Синтаксис: Ixxx <+узел> <–узел> SINE

(Ioffset Iamp Freq Td Theta Phi Ncycles). Так

записывается источник синусоидального то-

ка, параметры модели которого приведены

в таблице 22.
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Таблица 21. Параметры модели 

источника импульсного тока

число

с

с

с

с

с

А

Количество импульсов в серии
(опускается для источника

с непрерывной генерацией)

Период следования импульсов

Длительность импульса

Длительность заднего фронта

Длительность переднего фронта

Время задержки

Максимальное значение тока

Ncycles

Tperiod

Ton

Tfall

Trise

Tdelay

Ion

АНачальное значение токаIoff

РазмерностьПараметрОбозначение

Таблица 22. Параметры модели источника

синусоидального тока

число

°

1/с

с

Гц

А

Количество циклов 
(опускается для источника
с непрерывной генерацией)

Фаза

Коэффициент затухания

Время задержки

Частота

Амплитуда переменной
составляющей

Ncycles

Phi

Theta

Td

Freq

Iamp

АПостоянная составляющая токаIoffse

РазмерностьПараметрОбозначение



На этапах времени, которые меньше, чем

Td, и после завершения Ncycles выходной ток

описывается выражением:

Ioffset+Iamp�sin(pi�phi/180).

Для Td<time<Ncycles/Freq ток равен:

Ioffset+Iamp�exp(–(time–Td)�Theta)�
�sin(2pi�Freq(time–Td)+pi�phi/180).

Коэффициент затухания Theta — аналог

постоянной времени затухания.

Синтаксис: Ixxx <+узел> <–узел> EXP

(I1 I2 Td1 Tau1 Td2 Tau2). Это источник экс-

поненциального тока с параметрами модели,

приведенными в таблице 23.

Для времени меньше Td1 ток равен I1.

На участке времени Td1<time<Td2 ток опи-

сывается выражением:

I1+(I2–I1)�(1–exp(–(time–Td1)/Tau1)).

Для времени больше Td2 ток описывается

выражением:

I1+(I2–I1)�(1–exp(–(time–Td1)/Tau1))�
�(I1–I2)�(1–exp(–(time–Td2)/Tau2)).

Синтаксис: Ixxx <+узел> <–узел> SFFM(Ioff

Iamp Fcar MDI Fsig). Параметры модели ис-

точника синусоидального тока с частотной

модуляцией приведены в таблице 24.

Выходной сигнал описывается следующей

функцией:

Ioff+Iamp�sin((2pi�Fcar�time)+
+MDI�sin(2pi�Fsig�time)).

Синтаксис: Ixxx <+узел> <–узел> tbl=(<на-

пряжение,ток>, <напряжение,ток>, ѕ). Ток

этого источника определяется как функция

напряжения на выходных узлах в табличной

форме. Такая форма используется для моде-

лирования особенностей нагрузки.

Синтаксис: Ixxx <+узел> <–узел> <значе-

ние> step (<значение1>, [<значение2>],

[<значение3>, ѕ]) [load]]. Это специальная

форма для источника тока. Ток определен как

список токов, такая форма используется при

ступенчатом изменении нагрузки при анали-

зе переходного процесса. В этом способе мо-

делирование проводится, пока для первого

тока в списке, <значение1>, не будет достиг-

нуто установившееся состояние. Тогда ток

переключается к следующему значению

в списке, <значение2>. Процесс повторяет-

ся, пока список не будет исчерпан. Если ди-

рективой .tran не определен шаг step, то ис-

пользуются оригинальные <значения>.

Синтаксис: Ixxx <+узел> <–узел> R=<зна-

чение>. Это вообще-то не источник тока,

а резистор. Такая форма используется, что-

бы моделировать сопротивление нагрузки,

когда нагрузка записана в списке соединений

как источник тока.

Синтаксис: Ixxx <+узел> <–узел> PWL(t1

i1 t2 i2 t3 i3ѕ). Так описывается источник

тока с кусочно-линейной функцией.

На отрезке времени меньше t1 ток равен i1.

В течение времени между t1 и t2 ток изменя-

ется линейно между i1 и i2. Допускается лю-

бое количество точек время-ток. Для време-

ни, больше указанного в последней точке, ток

равен последнему значению в списке. 

Синтаксис: Ixxx <+узел> <–узел> wavefile=

<имя файла> [chan=<номер канала>]. Такая

модель позволяет использовать файл .wav

в качестве входного для LTspice. <Имя фай-

ла> — это либо полный, абсолютный путь

к файлу .wav, либо относительный путь, оп-

ределяемый каталогом, содержащим модели-

руемую схему или список соединений.

Двойные кавычки могут использоваться

для определения пути. Файл .wav может со-

держать до 65 536 каналов, пронумерованных

от 0 до 65 535. Следует определить использу-

емый канал. По умолчанию используется пер-

вый канал под номером 0. Файл .wav интер-

претируется как имеющий полную шкалу

от –1 до 1 A.

Этот источник применяется только в .TRAN-

анализе.

Полевой транзистор 

с управляющим p-n-переходом (JFET)

Имя компонента: NJF, PJF.

Синтаксис: Jxxx <узел стока> <узел зат-

вора> <узел истока> <имя модели> [коэф-

фициент кратности area] [проводимость]

[IC=<Vds,Vgs>] [temp=<температура>].

Примеры:

J1 0 in out MyJFETmodel

.model MyJFETmodel NJF(Lambda=.001)

J2 0 in out MyPJFETmodel

.model MyPJFETmodel PJF(Lambda=.001)

Для определения особенностей полевого

транзистора с управляющим p-n-переходом

используется директива .MODEL. Ключе-

вые слова NJF и PJF в списке параметров мо-

дели определяют проводимость транзисто-

ра. Коэффициент кратности определяет ко-

личество идентичных устройств данной

модели, включенных параллельно.

Модель JFET получена из модели Ших-

мана-Ходжеса, дополненной током реком-

бинации затвора и реакцией на ионизиру-

ющие воздействия. Характеристики на по-

стоянном токе определены параметрами

VTO и BETA, которые связывают измене-

ние тока стока с напряжением затвора;
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Таблица 23. Параметры модели источника

экспоненциального тока

с

с

с

с

А

Постоянная времени нарастания

Начало заднего фронта

Постоянная времени нарастания

Начало переднего фронта

Максимальное значение тока

Tau2

Td2

Tau1

Td1

I2

АНачальное значение токаI1

РазмерностьПараметрОбозначение

Таблица 24. Параметры модели источника

синусоидального тока с частотной модуляцией

Гц

–

Гц

А

Частота сигнала

Индекс частотной модуляции

Частота несущей

Амплитуда переменной
составляющей

Fsig

MDI

Fcar

Iamp

АПостоянная составляющая токаIoff

РазмерностьПараметрОбозначение

Таблица 25. Параметры модели полевого транзистора

–2,0

50

100

100

0,6

1×10–4

1×10–14

5

1

1×10–3

1,1

3

0

–2,0

0

27

0

0

1

2

2

1

0

0

0

1×10–14

1

0,5

0

0

0

1×10–4

1

0

–

В/°C

В

В

°C

Ом

Ом

В

–

–

–

1/В

–

А

А

–

–

п

пФ

%/°C

А/В2

–

1/В

Температурный коэффициент тока Is

Температурный коэффициент порогового напряжения

Пороговое напряжение

Напряжение ионизации перехода затвор–канал

Номинальная температура

Объемное сопротивление области истока

Объемное сопротивление области стока

Контактная разность потенциалов p�nZперехода затвора

Коэффициент эмиссии для тока Isr

Выбор уравнения шумов

Коэффициент неидеальности перехода затвор–канал

Коэффициент модуляции длины канала

Коэффициент, определяющий плотность фликкерZшума

Параметр тока рекомбинации перехода затвор–канал

Ток насыщения p�nZперехода затвор–канал

Коэффициент теплового шума канала

Коэффициент нелинейности емкостей переходов 
при прямом смещении

Емкость перехода затвор–исток при нулевом смещении

Емкость перехода затвор–сток при нулевом смещении

Экспоненциальный температурный коэффициент крутизны

Крутизна

Параметр легирования

Коэффициент ионизации

Xti

VtoTc

Vto

Vk

Tnom

Rs

Rd

Pb

Nr

nlev

N

Lambda

KF

Isr

Is

gdsnoi

Fc

Cgs

Cgd

BetaTce

Beta

B

alpha

1–
Показатель степени, определяющий зависимость спектральной

плотности фликкерZшума от тока через переход
AF

ПримерЗначение по умолчаниюЕдиница измеренияПараметрОбозначение
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LAMBDA, который определяет выходную

проводимость, и Is, током насыщения двух

переходов. Включены два омических сопро-

тивления, Rd и Rs. Накопление заряда мо-

делируется нелинейными емкостями обед-

ненного слоя для обоих переходов, которые

изменяются в степени –1/2 приложенного

к переходу напряжения и определены па-

раметрами Cgs, Cgd и PB. Добавлен пара-

метр B. Параметры модели полевого тран-

зистора приведены в таблице 25.

Взаимная индуктивность

Имя компонента: нет, помещается в виде

текста на схеме.

Синтаксис: Kxxx L1 L2 [L3ѕ] <коэффици-

ент связи>. L1 и L2 — обозначения катушек

индуктивности в схеме. Коэффициент связи

может находиться в пределах от –1 до 1.

Строка K1 L1 L2 L3 L4 1 эквивалентна ше-

сти строкам при одинаковом коэффициенте

связи между каждой из пар обмоток:
•• K1 L1 L2 1;
•• K2 L2 L3 1;
•• K3 L3 L4 1;
•• K4 L1 L3 1;
•• K5 L2 L4 1;
•• K6 L1 L4 1.

Рекомендуется начинать моделирование

с коэффициента связи, равного 1. Это устра-

нит индуктивность рассеивания, которая мо-

жет вызвать звон на очень высоких частотах,

если отсутствует демпфирование, и замед-

лить моделирование. Однако коэффициент

связи –1 или 1 может привести к проблемам

с моделированием, если в директиве .tran

присутствует модификатор uic.

Индуктивность

Имя компонента: IND, IND2.

Синтаксис: Lxxx <+узел> <–узел> <индук-

тивность> [ic=<начальный ток>] [Rser=<зна-

чение>] [Rpar=<значение>] [Cpar=<значе-

ние>] [m=<значение>] [tc1=<значение>]

[tc2=<значение>] [temp=<значение>].

Можно задать эквивалентное последова-

тельное сопротивление, последовательную

индуктивность, параллельное сопротивление

и параллельную шунтирующую емкость.

На рис. 51 изображена эквивалентная схема

индуктивности.

Параметры индуктивности приведены

в таблице 26.

Предпочтительнее включить в состав ка-

тушки индуктивности паразитные Rpar, Rser

и Cpar, чем специально предусматривать их.

LTspice использует собственную технологию

моделирования схемы для моделирования та-

кой физической катушки индуктивности без

внутренних узлов. Это делает матрицу моде-

лирования меньше, ускоряет вычисления

и уменьшает вероятность несходимости при

малых шагах времени.

По умолчанию LTspice будет вычислять по-

тери мощности в катушках индуктивности

при расчете переходного процесса для ИИП.

Эти потери обычно незначительны, и их

расчет при желании может быть выключен.

Отключите “Supply a min. inductor damping if

no Rpar is given” на странице “Tools =>Control

Panel =>Hacks!” Эта установка будет сохра-

нена при перезапуске программы. По умол-

чанию также присутствуют последователь-

ные сопротивления 1 мОм, не упомянутые

в описании взаимной индуктивности. Нали-

чие Rser позволяет SwitcherCAD III объеди-

нять индуктивности по эквивалентной схеме

Нортона вместо эквивалентной схемы Теве-

нина, чтобы уменьшить размер матрицы ли-

неаризованной схемы. Если нежелательно,

чтобы такое минимальное сопротивление

присутствовало в схеме, необходимо явно ус-

тановить Rser = 0 для конкретной катушки

индуктивности. При этом в процедуре ана-

лиза переходного процесса для катушки ин-

дуктивности будет использована более слож-

ная эквивалентная схема Тевенина.

В LTSpice есть два варианта нелинейных

индуктивностей. Каждый из них — это по-

веденческая индуктивность, описываемая

выражением для потока. Ток через индук-

тивность в выражении записывается ключе-

вым словом x. Пример записи в списке со-

единений:

*

L1 N001 0 Flux=1m*tanh(5*x)

I1 0 N001 PWL(0 0 1 1)

.tran 1

.end

В примере скорость изменения тока dI/dt

задана равной 1 А/с, поэтому значение ин-

дуктивности можно считывать как напряже-

ние в узле N001, естественно, заменив воль-

ты на генри.

Другая нелинейная катушка индуктивно-

сти в LTspice базируется на гистерезисной мо-

дели магнитопровода, предложенной Джо-

ном Чаном. Эта модель определяет петлю ги-

стерезиса только тремя параметрами: Hc, Bs

и Br. Параметры модели индуктивности с сер-

дечником перечислены в таблице 27.

Верхняя и нижняя ветви основной петли

гистерезиса описываются как:

и

.

График этой функции изображен на рис. 52.

Hc и Br — точки пересечения предельной

петли гистерезиса с осями H и B. Bs — точка

пересечения оси B с асимптотической пря-

мой, приблизительно Bsat(H) = Bs+μ0�H, по-

скольку H стремится к бесконечности.

Начальная кривая намагничивания:

Bmag(H) = 0,5�[Bup(H)+Bdn(H)].

Абсолютная и дифференциальная магнит-

ные проницаемости сердечника — функции H

и предшествующих значений H. На рис. 53

изображена асимметричная частная петля

гистерезиса типового феррита для силовых

устройств.

Отметим, что напряженность магнитно-

го поля H в воздушном зазоре не пропор-

циональна току в обмотке. LTspice опреде-

ляет магнитные поля в магнитопроводе и за-

зоре в предположении равенства площадей

поперечного сечения магнитопровода и ко-

роткого или равномерно распределенного

зазора.

Следующий пример демонстрирует зави-

симость индуктивности L1, представляю-

щей собой катушку на сердечнике с зазором,

от протекающего тока:

www.kit+e.ru

Рис. 51. Эквивалентная схема катушки индуктивности

Таблица 26. Параметры модели индуктивности

Рабочая температура

Квадратичный температурный коэффициент индуктивности

Линейный температурный коэффициент индуктивности

Начальный ток (используется, 
если только модификатор uic включен в .tranZанализ)

Количество включенных параллельно устройств

Шунтирующий резистор, параллельный Lser

Эквивалентная параллельная емкость

Эквивалентное параллельное сопротивление

temp

tc2

tc1

ic

m

RLshunt

Cpar

Rpar

Эквивалентное последовательное сопротивлениеRser

Параметр
Обозна+

чение

Таблица 27. Параметры модели индуктивности

с сердечником

–

м2

м

м

Т

Т

Количество витков

Площадь поперечного сечения

Ширина воздушного зазора

Средняя длина магнитной силовой линии

Индукция насыщения

Остаточная индукция

N

A

Lg

Lm

Bs

Br

АмперZвиток/мКоэрцитивная силаHc

Единица 
измерения

Параметр
Обозна+

чение
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*
N001 0 Hc=16. Bs=.44 Br=.10 A=0.0000251
+ Lm=0.0198 Lg=0.0006858 N=1000
I1 0 N001 PWL(0 0 1 1)
.tran .5
.options maxstep=10u
.end

Схема и результаты моделирования изо-

бражены на рис. 54. Как и в предыдущем

примере, значения индуктивности эквива-

лентны значениям напряжения в узле (N001).

Намагничивание сердечника идет по началь-

ной кривой намагничивания, так что можно

заметить, что сначала магнитная проницае-

мость увеличивается по сравнению с началь-

ным значением, а затем с ростом тока умень-

шается вплоть до насыщения сердечника.

Поскольку воздушный зазор уменьшает вли-

яние изменения магнитной проницаемости

на индуктивность катушки, чтобы заметить

увеличение магнитной проницаемости, нуж-

но увеличить масштаб изображения V(N001),

что и сделано в окне графиков в правом верх-

нем углу рис. 54. Максимальное значение со-

ответствует напряженности магнитного по-

ля, равной коэрцитивной силе Hc. ■

Окончание следует

Рис. 54. Моделирование начальной кривой намагничивания

Рис. 52. Предельная петля гистерезиса магнитного сердечника Рис. 53. Асимметричная частная петля гистерезиса феррита
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